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About This Guide

This guide describes how to install Novell® ZENworks® 7 Server Management. The guide is 
divided into the following sections:

Part I, “Overview,” on page 17
Part II, “Preparation,” on page 27
Part III, “Installation,” on page 63
Part IV, “Upgrade,” on page 139
Part V, “Interoperability,” on page 263
Part VI, “Uninstallation,” on page 283
Part VII, “Appendixes,” on page 311

Audience

This guide is intended for ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to Novell Documentation Feedback site (http://www.novell.com/
documentation/feedback.html) and enter your comments there.

Documentation Updates

For the most recent version of this guide, the Web HTML and updated PDF versions are available on 
the ZENworks 7 Web site (http://www.novell.com/documentation/zenworks7/index.html).

Additional Documentation

For the latest documentation on configuring and using ZENworks 7 Server Management, see the 
Novell ZENworks 7 Server Management Administration Guide.

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux* or UNIX*, should use forward slashes as required by your software.
About This Guide 15
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IOverview

The information in this section includes the following:

Chapter 1, “What Is ZENworks Server Management?,” on page 19
Overview 17
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1What Is ZENworks Server 
Management?

Novell® ZENworks® 7 Server Management is an integrated system for managing multiple servers 
throughout a multiple-platform, enterprise-wide network. Server Management consists of several 
components that can be used together or separately, depending on your network management needs.

For the latest version of this guide, see the ZENworks 7 Server Management Installation Guide 
(http://www.novell.com/documentation/zenworks7/index.html) on the Web.

For information on upgrading, see Part IV, “Upgrade,” on page 139.

Review the following sections to determine which Server Management components to install:

Section 1.1, “Policy-Enabled Server Management,” on page 19
Section 1.2, “Management and Monitoring Services,” on page 24

1.1  Policy-Enabled Server Management
ZENworks Server Management provides management roles for your network servers:

If you have a Linux-only environment, see Novell ZENworks 7 Linux Management Installation 
Guide (http://www.novell.com/documentation/zlm72/lm7install/data/front.html) and Novell 
ZENworks 7 Linux Management Administration Guide (http://www.novell.com/documentation/
zlm72/lm7admin/data/front.html).

For more help in determining which Policy-Enabled Server Management components you might 
want to install:

Section 1.1.1, “Policy and Distribution Services Server Roles,” on page 20

Component Description

Policy and 
Distribution 
Services

Policy and Distribution Services ensures consistent configuration and behavior of 
NetWare®, Windows*, Linux, and Solaris* servers by establishing policies that define 
particular server configuration and behavior based on specific conditions. In addition, 
you can use Policy and Distribution Services to automatically distribute and install new 
and updated software, individual executable files, databases, documents, text files, and 
so on, to servers anywhere in your network.

Server 
Inventory

Server Inventory gathers a complete record of all hardware and software from 
inventoried NetWare, Windows, and Linux servers anywhere in your network. By 
accessing a centralized Inventory database from ConsoleOne®, you can query, view, or 
generate reports on the inventory information. Inventory information can be rolled up 
across servers for large networks.

Remote 
Management

Remote Management enables you to control NetWare and Windows servers located 
anywhere in your network from ConsoleOne, as if you are at the server console. The 
Remote Management Agent installed on each managed server ensures that Remote 
Management sessions are secure.
What Is ZENworks Server Management? 19
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Section 1.1.2, “Server Inventory Server Roles,” on page 21
Section 1.1.3, “Remote Management Terminology,” on page 22

1.1.1  Policy and Distribution Services Server Roles
Although you can install Policy and Distribution Services objects to only one tree at a time, you can 
install Policy and Distribution Services software to all NetWare and Windows servers in your 
network in one run of the installation program. Therefore, you can set up the roles for each of these 
servers during installation.

You can also install Policy and Distribution Services software to any NetWare or Windows server 
when running the installation program, regardless of the server’s Novell eDirectoryTM tree or 
Microsoft* domain, because you can browse both trees and domains during installation.

Policy and Distribution Services software can even be installed to servers that are not in a tree or 
domain by inserting the Novell ZENworks 7 Server Management with Support Pack 1 Program CD 
on that server and installing directly.

There are two Tiered Electronic Distribution objects that define the role of a server. The role you 
select determines what software is installed on the server. The objects are Distributors, Databases, 
and Subscribers. The following sections explain their roles.

Distributor Servers and Databases

The Distributor server does much of the distribution work. It compiles software and policy packages 
and distributes them to other servers.

To initially install Policy and Distribution Services, choose one server that exceeds the minimum 
server requirements and make it the Distributor server. This can be either a NetWare or Windows 
server (see Section 5.3.2, “NetWare Server Requirements,” on page 48 or Section 5.3.3, “Windows 
Server Requirements,” on page 50).

You are not required to always use this server as a Distributor, because it also has the Subscriber 
software installed on it. Therefore, you can simply select any server that exceeds the minimum 
server requirements for first-time installation purposes.

If you later need to reassign Distributions created on this first Distributor to another Distributor, you 
can do so in ConsoleOne by right-clicking a Distribution object and selecting Assign New 
Distributor. However, all files on the first Distributor that pertain to the Distribution being 
reassigned must be copied to or already exist on the files system of the new Distributor.

For related information, see “Deleting a Distributor Object and How Its Distributions Are Affected” 
in the Novell ZENworks 7 Server Management Administration Guide.

Subscriber Servers

The Subscriber servers receive distributions of policies and software. You can manage your 
network’s servers by installing the Subscriber software on every server.

Make a note of all servers that you want to manage with Policy and Distribution Services. You need 
to install the Subscriber software on each of these servers.
 ZENworks 7 Server Management Installation Guide
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For large or complex networks, we recommend that you install Subscriber software incrementally to 
groups of servers. For example, you might want to roll out Policy and Distribution Services in 
phases.

To install Subscriber software to your servers incrementally, determine installation groupings for 
your servers. You will install to the first group of servers using the instructions in this Installation 
Guide.

You can install to the other groups of servers later using the instructions in “Post-Installation Setup” 
in the Novell ZENworks 7 Server Management Administration Guide.

1.1.2  Server Inventory Server Roles
Server Inventory lets you gather complete hardware and software inventory information for all 
NetWare and Windows servers in your network. Using a centralized database, the network 
administrator can query, view, or report this inventory information using Novell ConsoleOne. 
ZENworks 7 Server Management also provides roll-up of inventory information across servers for 
large networks.

The following sections describe the components of Server Inventory.

Management console: A Windows workstation or server running Novell ConsoleOne with 
ZENworks Server Management Server Inventory ConsoleOne snap-ins installed. The 
management console provides the interface where you manage and administer your network.

For more information about the system requirements of the management console, see 
Chapter 4, “Installation Machine and Management Workstation Requirements,” on page 41.
Inventoried servers: A server whose hardware and software data you want to scan and 
maintain in a central repository. To gather complete hardware and software inventory for a 
server, you must install the Inventory Agent on that server. 
Identify the inventoried servers and determine each server’s Distinguished Name (DN).

IMPORTANT: For Windows servers, the server’s DNS short name must be the same as the 
server’s name. Either rename Windows servers where the server’s name does not match its 
DNS short name before running the installation, or do not select these servers for installation of 
Server Inventory.

For more information about the system requirements of the inventoried server, see Chapter 4, 
“Installation Machine and Management Workstation Requirements,” on page 41.
Inventory server: A server where you run the Inventory service. The Inventory server collects 
the inventory data from a group of inventoried servers and loads it into the Inventory database. 
If you want to collect the inventory for the Inventory server, you must install the Inventory 
Agent on the Inventory server. 
Identify the servers that you want to be your Inventory servers.
Database server: A server where your Inventory database is running. The database can run on 
an Inventory server or on a different server. 
An Inventory database is repository of inventory data for all of the inventoried servers.
During installation, you need to identify the server where you want the database files to reside. 
The Inventory database and related database files are installed on the servers you specify. You 
can install the database on the same server as you have selected for the Inventory server or on 
to a different server.
What Is ZENworks Server Management? 21
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If you choose to install the Sybase database and it is already running on the server, be sure to 
quit the database process by entering Q at the Sybase prompt, before proceeding with the 
installation program.
XML Proxy server: If you want to send or roll up the scan data to an Inventory server that is 
across the firewall, you must configure a NetWare or Windows server to run the XML Proxy 
service.
During the ZENworks Server Management installation program, you need to identify the server 
where you want to run the XML Proxy Service.

The focus of the Installation Guide is to set up a pilot system so that you can better understand 
ZENworks Server Management Server Inventory. The pilot system consists of a management 
console, an Inventory server, an Inventory database running Sybase*, and one or more inventoried 
servers, as shown in Figure 1-1:

Figure 1-1   Server Inventory Pilot System 

This setup has the following features:

The Inventory server and the inventoried servers reside on the same Novell eDirectory tree.
The Inventory server has inventoried servers attached to it.
The Inventory server has an Inventory database attached to it.

The Inventory scanning cycle is as follows:

1. The Inventory scanner sends hardware and software information from the inventoried servers 
to the Inventory server as per the scan schedule.

2. The Inventory server stores the inventory information in the Inventory database.
3. At the management console, you can view and retrieve the inventory information from the 

Inventory database using Inventory tools such as Reporting, Summary, etc.

Before you install Server Inventory in your production environment, you must plan and decide the 
Inventory server tree hierarchy for your company. You should organize your inventory deployment 
based on your network and information requirements. For detailed information, see “Server 
Inventory” in the Novell ZENworks 7 Server Management Administration Guide.

1.1.3  Remote Management Terminology
Remote Management enables you to remotely manage NetWare 5.1/6/6.5 or Windows 2000/2003 
servers from your management console. Using Remote Management, you can remotely diagnose 
and resolve problems that might otherwise require visits to client computers.

Management
Console

Windows 
Workstation

Inventory
Database

Inventory
Server

Inventoried
Servers
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The ZENworks Server Management Remote Management setup consists of a Windows machine 
(called the management console) used to manage one or more remote servers (called managed 
servers) as shown in Figure 1-2:

Figure 1-2   Remote Management Functionality

The following sections describe components of Remote Management.

Management Console

A Windows workstation or server running Novell ConsoleOne with the ZENworks Server 
Management Remote Management ConsoleOne snap-ins installed. The management console 
provides the interface to manage and administer your network.

A remote operator is a user who can remotely view, control, and manage servers.

An administrator is a person who has the rights to install Remote Management. All administrators 
are remote operators, but not all remote operators are administrators.

Management Server

A server with Novell eDirectory and the ZENworks Server Management Distributor components. 
The eDirectory and Distributor components should be installed only if you want policy-enabled 
Remote Management. Your management server can be a managed server.

Managed Server

A NetWare 5.1/6/6.5 or Windows 2000/2003 server that you want to remote control or view. To 
remotely view or control a server, you must install the ZENworks Server Management Remote 
Management Agent on it.
What Is ZENworks Server Management? 23
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1.2  Management and Monitoring Services
The Management and Monitoring Services component of Novell ZENworks Server Management 
provides industry standards-based monitoring, management, and reporting for heterogeneous 
network environments.

Table 1-1   Management and Monitoring Services Components

Figure 1-3 illustrates where the ZENworks Server Management components are installed:

Figure 1-3   Where the Management and Monitoring Services Components are Installed

The following sections describe components of Management and Monitoring Services:

Section 1.2.1, “Management Site Services,” on page 25
Section 1.2.2, “Server Management Agent,” on page 25
Section 1.2.3, “Management Console,” on page 25
Section 1.2.4, “Traffic Analysis Agent,” on page 25
Section 1.2.5, “Advanced Trending Agent,” on page 25

Component Description

Management
Site Services

Management Site Services includes automatic network discovery, network topology 
mapping, alarm management, role-based administration, statistical reporting, and MIB 
tools.

Traffic 
Analysis Agent

Traffic Analysis Agent monitors network traffic, captures data, and collects statistics for 
monitored network segments, nodes, and devices on NetWare and Windows servers. It 
includes tools to help you review and analyze the gathered data.

Server 
Management 
Agent

Server Management Agent provides SNMP-based management agents for NetWare, 
Windows, and Linux servers. These SNMP-based agents supply real-time server 
performance data, along with information about server alarms and events. Using 
Server Management, you can perform tasks such as trending, graphing, and fault 
management.

Advanced 
Trending Agent

The Advanced Trending Agent gathers and stores the trend data (historic data) for any 
parameter instrumented by an SNMP agent, if it is defined by a MIB variable and not 
just pre-configured MIB variables.

Management Console

Windows 2000/EP

Management Server

NetWare 6.5

Windows 2000/2003

Server

NetWare

Server

• Managed Servers

• Traffic Analysis Agent

• Advanced Trending Agent

• Managed Servers

• Traffic Analysis Agent

• Advanced Trending Agent

Linux

Server

• Managed Servers

• Advanced Trending Agent
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1.2.1  Management Site Services
Management Site Services includes the following:

Alarm Management
Database Administration
MIB Tools Administration
Monitoring Services
Network Discovery
Reporting
Role-Based Services
Topology Mapping
View Builder
Unified View for Services
Database Object Editor
NetWare Trap Administration

1.2.2  Server Management Agent
Monitors all of the NetWare, Windows, or Linux servers that you want to manage.

1.2.3  Management Console
Novell ConsoleOne on Windows provides the interface where you can manage and administer your 
network.

1.2.4  Traffic Analysis Agent
Monitors all of the traffic on Ethernet, Token Ring, or Fiber Distributed Data Interface (FDDI) 
network segments. This agent is available on NetWare and Windows. To monitor the network traffic 
of a segment, you need only one Traffic Analysis Agent per segment.

1.2.5  Advanced Trending Agent
Gathers and stores the trend data (historic data) for any parameter instrumented by an SNMP agent, 
if it is defined by a MIB variable. This agent is available on NetWare, Windows, and Linux.
What Is ZENworks Server Management? 25
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IIPreparation

For a successful installation of Novell® ZENworks® 7 Server Management, you need to know and 
use the following information for fulfilling requirements and installing the software:

The Novell eDirectoryTM tree for the ZENworks objects
Tree containers where you want the ZENworks objects to be created
Your network servers’ platforms
Hardware and software requirements for the target servers
Requirements for the installer and installation machine
Requirements for the management workstations

The following sections will help you to gather and use the information listed above to prepare for 
installing Server Management software in your network:

Chapter 2, “Information You Need to Know,” on page 29
Chapter 3, “Prerequisites,” on page 33
Chapter 4, “Installation Machine and Management Workstation Requirements,” on page 41
Chapter 5, “Server Requirements,” on page 45
Preparation 27
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2Information You Need to Know

The following information is needed for installing any of the Novell® ZENworks® 7 Server 
Management components:

Section 2.1, “General Information,” on page 29
Section 2.2, “Platform-Dependent Information,” on page 30

2.1  General Information
Table 2-1   Information Needed to Install Server Management

Information Needed Explanation

eDirectory tree name You need only one tree for creating and managing ZENworks objects. If you 
have more than one eDirectory tree in your network, decide which one to use 
for ZENworks.

For ease of management, you can create a “ZENworks” tree dedicated to only 
ZENworks objects. Then, when schema extensions are needed for ZENworks, 
they only need to be done on this dedicated tree. For more information on a 
dedicated ZENworks tree, see Section 3.2, “Novell eDirectory Requirement,” 
on page 33 in this guide and “Using a ZENworks Tree” in the Novell ZENworks 
7 Desktop Management Administration Guide.

If you do not have eDirectory installed in your network (no NetWare servers), 
determine which Windows, Linux, or Solaris server you want to have eDirectory 
installed on.

Installation machine To install to NetWare and Windows servers, decide if you will use a Windows 
workstation or a Windows server. You should identify your installation machine, 
because it needs to fulfill the minimum requirements listed in Chapter 4, 
“Installation Machine and Management Workstation Requirements,” on 
page 41.

Server platforms These are the servers where you will install the Server Management 
components. Supported platforms include NetWare, Windows, Linux, and 
Solaris (depending on the component).

For information on which Server Management components are supported on a 
particular server platform, see Table 5-1 on page 45.

Target servers Identify the servers where you want install the Server Management 
components, and which components are to be installed on each server. For 
more information, see Part I, “Overview,” on page 17.

Databases See Section 1.1.1, “Policy and Distribution Services Server Roles,” on page 20, 
Section 1.1.2, “Server Inventory Server Roles,” on page 21, and Section 1.2, 
“Management and Monitoring Services,” on page 24 for information to help you 
determine where you want to install databases.
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2.2  Platform-Dependent Information
The following sections provide the information you need to know that is specific to a component 
and its installation method on the supported platforms:

Section 2.2.1, “Information for Installing Policy-Enabled Server Management on NetWare and 
Windows Servers,” on page 30
Section 2.2.2, “Information for Installing Policy and Distribution Services on Linux and Solaris 
Servers,” on page 30

2.2.1  Information for Installing Policy-Enabled Server 
Management on NetWare and Windows Servers
You need to know the following information before running the installation program:

Table 2-2   Information Needed before Running the Installation Program

2.2.2  Information for Installing Policy and Distribution Services 
on Linux and Solaris Servers
You need to know the following information before running the installation script:

Table 2-3   Information Needed before Running the Installation Script

Information Needed Explanation

eDirectory containers 
for the ZENworks 
objects

We recommend that you create containers to enhance your ability to manage 
the ZENworks objects. You learn about the recommended containers in 
Section 3.3, “eDirectory Container Requirements,” on page 36, and instructions 
for creating the containers are provided in Section 3.3.2, “Creating the 
ZENworks Containers,” on page 38.

Distributor servers You need at least one server to have the Distributor software installed on it. See 
Section 1.1.1, “Policy and Distribution Services Server Roles,” on page 20 for 
information to help you determine where you want to install Distributors.

Information Needed Explanation

Server DNS name The installation script must be able to authenticate to a server that holds a 
replica of the eDirectory tree where you want Distributor and/or Subscriber 
objects created. This could be a Linux, Solaris, NetWare, or Windows server. 
You must know either the fully qualified DNS hostname or the IP address of the 
server in order for the installation script to identify it in your network. For 
example:

Server1.Servers.novell.com

Username To enable the installation script to authenticate to the eDirectory server, you 
must know the fully distinguished username and password for a user with 
Admin-equivalent rights to the tree. For example:

admin.novell
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When providing object names during installation, you need to include the object’s context with the 
object name. For example:

Distributor-Linux-01.Distributors.ZENworks.Novell

IMPORTANT: Do not use double-byte or extended characters in the object names or object 
contexts.

Object contexts You need to determine the eDirectory context where you want the installation 
script to create Distributor and Subscriber objects. You can only use an existing 
container. Therefore, you might want to create a container before running the 
installation script. For example:

Distributors.ZENworks.Novell
Linux.Subscribers.ZENworks.Novell
Solaris.Subscribers.ZENworks.Novell

If you have already installed Policy and Distribution Services on NetWare or 
Windows servers, the eDirectory tree might already have the necessary 
containers for the Distributor and Subscriber objects.

Distributor object name If the Linux or Solaris server where you are installing Policy and Distribution 
Services will function as a Distributor, you must choose a unique name for the 
Distributor object. The name you choose should retain the Linux or Solaris 
server’s identity. For example:

Distributor-Linux-01

Subscriber object name If the Linux or Solaris server where you are installing Policy and Distribution 
Services will function as a Subscriber, you must choose a unique name for the 
Subscriber object. The name you choose should retain the Linux or Solaris 
server’s identity. For example:

Subscriber-Solaris-02

Database object’s DN If you want a Distributor that you are installing to write to a database, you need 
to know the database object’s DN, such as:

database.novell

Information Needed Explanation
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3Prerequisites

This section lists common requirements that must be met before you begin to install the Novell® 
ZENworks® 7 Server Management software:

Section 3.1, “Installation User Rights,” on page 33
Section 3.2, “Novell eDirectory Requirement,” on page 33
Section 3.3, “eDirectory Container Requirements,” on page 36
Section 3.4, “DNS Requirement,” on page 39

After meeting the general ZENworks Server Management installation requirements listed in this 
section, continue with Chapter 5, “Server Requirements,” on page 45.

3.1  Installation User Rights
The network account of the user who installs any component of ZENworks Server Management 
must have the following rights in order to perform the installation:

Supervisor rights at the root of the tree to extend the eDirectory schema

Extending the schema needs to be done only once, no matter how many ZENworks Server 
Management components you install. Also, if you have multiple trees, you only need to extend 
the schema on the trees where the ZENworks objects are to be installed.
Supervisor rights at the root of the tree to make the Distributor a trustee of Root during 
installation
Creation of some ZENworks objects includes adding trustees to the root of the tree. However, 
trustees can be manually added after installation if the installation user does not have sufficient 
rights to the root of the tree during installation. 
Read and Create rights in any containers where ZENworks objects are created
File rights to all NetWare servers where ZENworks Server Management components are to be 
installed
Administrator rights to all Windows servers where ZENworks Server Management 
components are to be installed
Administrator rights to the Windows workstation where the ZENworks Server Management 
snap-ins to Novell ConsoleOne® are to be installed

3.2  Novell eDirectory Requirement
Server Management is administered using eDirectory objects. Therefore, Server Management 
requires that eDirectory be installed somewhere in your network. If you have NetWare in your 
network, you already have eDirectory available.

If you have more than one eDirectory tree in your network, decide which tree you want to use for 
managing the ZENworks Server Management objects, which are created in the tree you select for 
Server Management installation.
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However, for ease of management, you can create a dedicated “ZENworks” tree for installing and 
managing ZENworks objects. For more information on how ZENworks Desktop Management uses 
a dedicated ZENworks tree, see “Using a ZENworks Tree” in the Novell ZENworks 7 Desktop 
Management Administration Guide.

IMPORTANT: If you have Desktop Management installed to a dedicated ZENworks tree, you must 
use that same tree for Server Management if you intend to create Desktop Application Distributions.

In you have a non-NetWare network, eDirectory only needs to be installed on one Windows, Linux, 
or Solaris server.

Do the following to meet the eDirectory requirement:

Section 3.2.1, “eDirectory Minimums by Platform,” on page 34
Section 3.2.2, “Checking the eDirectory Version,” on page 34
Section 3.2.3, “Upgrading eDirectory on NetWare Servers,” on page 35
Section 3.2.4, “Upgrading eDirectory on Windows Servers,” on page 35
Section 3.2.5, “Installing or Upgrading eDirectory on Linux or Solaris Servers,” on page 36

3.2.1  eDirectory Minimums by Platform
Where you need to fulfill the eDirectory requirement, the minimum version required by Server 
Management depends on the platform and which version of eDirectory you have installed.

For all supported NetWare, Windows 2000 Server, Linux, and Solaris server platforms, the 
following applies:

If eDirectory 8.6.x is installed:  Only version 8.6.2 is supported.
If eDirectory 8.7.x is installed:  Only versions 8.7.1 and 8.7.3 or later are supported.
Version 8.7.3 for Windows is provided on the Novell ZENworks 7 with Support Pack 1 
Companion 1 CD.

For a Windows Server 2003 server (such as in a Windows-centric network), to install eDirectory on 
that platform, it must be version 8.7.3 or later in order for Server Management to work with that 
server.

3.2.2  Checking the eDirectory Version
To determine whether you have eDirectory installed, or which version is installed:

“Checking on NetWare” on page 34
“Checking on Windows” on page 35
“Checking on Linux and Solaris” on page 35

Checking on NetWare

1 On a NetWare server’s console prompt, enter:
version
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or
modules ds

The version of eDirectory is displayed with other information.

Checking on Windows

1 On a Windows server, click Start > Settings > Control Panel.
2 Select Add/Remove Programs.
3 Scroll to view the eDirectory entry, which displays its version.

Checking on Linux and Solaris

1 On a Linux or Solaris server, run ndsstat.
The ndsstat utility displays information related to eDirectory servers, such as the eDirectory 
tree name, the fully distinguished server name, and the eDirectory version. In the following 
example, eDirectory 8.7.1 is the product version (marketing string), and 10510.65 is the binary 
version (internal build number).
osg-dt-srv17:/>ndsstat
Tree Name: SNMP-HPUX-RASH
Server Name: .CN=osg-dt-srv17.O=novell.T=SNMP-HPUX-RASH.
Binary Version: 10510.65
Root Most Entry Depth: 0
Product Version: NDS/UNIX - NDS eDirectory v8.7.1 [DS]

For information on running ndsstat, see its man page (ndsstat.1m).

3.2.3  Upgrading eDirectory on NetWare Servers
If version 8.6.2 or 8.7.1 or later is not installed on a NetWare server, see your eDirectory 
documentation (http://www.novell.com/documentation) for instructions on upgrading a NetWare 
server to version 8.7.1 or 8.7.3.

3.2.4  Upgrading eDirectory on Windows Servers
If version 8.6.2, 8.7.1, or 8.7.3 or later is not installed a Windows 2000/2003 server (where needed), 
and you need to install or upgrade eDirectory:

1 Novell eDirectory must be licensed. You can download the files you need for the eDirectory 
8.7.x evaluation license from the Novell eDirectory 8.7.x Evaluation License Download Web 
site (http://www.novell.com/products/edirectory/licenses/eval_87.html). Novell eDirectory 
8.7.3 for Windows that is on the Novell ZENworks 7 with Support Pack 1 Companion 1 CD 
includes a licensing wizard that prompts for these files during installation.
For more information about purchasing or upgrading eDirectory, see Novell eDirectory (http://
www.novell.com/products/nds).

2 On the main installation menu, click Companion Programs and Files > Novell eDirectory for 
Windows 2K, which asks you to load the Companion 1 CD and then proceeds to unzip the 
eDirectory installation files.
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IMPORTANT: When you are prompted to accept an extraction location (the default is 
c:\docume~1\admini~1\locals~1\temp), this \temp directory might contain many files. 
Therefore, add to the path something similar to \Temp\eDirInstall so that you can easily 
locate the setup.exe file for installing eDirectory.

3 Follow the installation program’s instructions.
You are asked for the evaluation license that you downloaded in Step 1.

4 If you need to install Novell Certificate ServerTM and LDAP as part of eDirectory on an 
inventory server, see Novell Product Documentation (http://www.novell.com/documentation) 
for instructions.

3.2.5  Installing or Upgrading eDirectory on Linux or Solaris 
Servers
If version 8.6.2, 8.7.1, or 8.7.3 or later is not installed a Windows 2000/2003 server (where needed), 
and you need to install or upgrade eDirectory:

1 See the eDirectory documentation Web site (http://www.novell.com/documentation/edir873/
index.html).

2 Under the Installation Guide heading, click:

Installing or Upgrading Novell eDirectory on Linux
or
Installing or Upgrading Novell eDirectory on Solaris

3 Follow the instructions.

3.3  eDirectory Container Requirements
ZENworks Server Management is directory-enabled, which means that its eDirectory objects are 
created in the eDirectory tree during installation, allowing you to use those objects to configure and 
manage Server Management.

The default container for installing Server Management objects is the container where the NCP 
Server objects reside. We recommend that when you have the option to change it, you do not use the 
default container. If you are using a dedicated ZENworks tree, it will not have any NCP Server 
objects in it, so you need to select the context.

You should create specific ZENworks object containers before starting the installation. The 
following sections will help you to do this:

Section 3.3.1, “Containers for ZENworks Objects,” on page 36
Section 3.3.2, “Creating the ZENworks Containers,” on page 38

3.3.1  Containers for ZENworks Objects
For ease of management, we recommend that you place all of your ZENworks objects in containers 
similar to the following in Figure 3-1:
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Figure 3-1   ZENworks Object Containers

Most of these containers only apply to Policy and Distribution Services. For example, Server 
Management can use the SM container, Desktop Management can use a DM container, HandHeld 
Management can use an HM container, but all ZENworks products can use the Databases container.

If Server Inventory or Management and Monitoring Services is installed using a Standalone Pre-
configure option, they require a location for the Server Package object. The Policies container 
shown above is recommended.

All other Server Inventory or Management and Monitoring Services objects are automatically 
placed in the same container as the server’s NCP Server object, unless you are using a ZENworks 
tree. In that case, the context in the server’s tree where its NCP Server object resides is displayed. 
However, if that same context does not exist in the ZENworks tree, you must change it, because the 
program does not create these eDirectory contexts.

Other issues concerning where to place ZENworks objects in a tree:

“Location of the ZENworks Container” on page 37
“Operating-System-Specific Containers” on page 38
“Dedicated ZENworks Tree” on page 38

Location of the ZENworks Container

When not using a dedicated ZENworks tree, the ZENworks container should be placed as high in 
the tree as possible, because the full tree path from the root to where you have user-definable 
policies is limited to 64 characters. Long paths to where user-defined policies are stored could cause 
them to have only a few characters available to name them.

In Figure 3-2 on page 38, SM represents Server Management. Other ZENworks products could use 
similar abbreviations, such as DM for Desktop Management and HM for Handhelds Management. 
These short abbreviations help to minimize use of the 64 characters.

A dedicated ZENworks tree can help in reducing the number of characters used, because the 
ZENworks Organizational Unit isn’t necessary.
Prerequisites 37



38 Novell

novdocx (en)  16 A
pril 2010
Operating-System-Specific Containers

Only one Service Location Package (containing the Tiered Electronic Distribution policy) can be 
associated with a given container. In order to set up multiple Tiered Electronic Distribution policies 
that allow you to define default operating system-specific values for attributes in the Subscriber (and 
Distributor) objects, you need the Subscriber objects to be grouped so that you can apply platform-
specific Tiered Electronic Distribution policies.

Therefore, we recommend that you place your Subscriber objects in operating system-specific 
containers, as shown in Figure 3-1 on page 37.

Dedicated ZENworks Tree

NCP Server objects do not exist in a dedicated ZENworks tree. Figure 3-2 provides an example of 
how you can organize a dedicated ZENworks tree:

Figure 3-2   Dedicated ZENworks Object Tree

A tree dedicated to ZENworks objects has the following benefits:

Improved management in having fewer objects in the tree.
You won’t need to extend the schema on your production tree when you have new ZENworks 
schema extensions to apply.
Because the ZENworks OU isn’t necessary, and if your tree has ZENworks as part of its name, 
such as ZENworks_Boston, everything can be moved up one level.
By excluding the ZENworks container, you can have seven more usable characters within the 
65 character limit, such as for more descriptive ZENworks object names.

3.3.2  Creating the ZENworks Containers
If you want to use a dedicated ZENworks tree, you must create that tree before beginning the 
following procedure.

1 Start ConsoleOne from the copy installed on your workstation.
2 In ConsoleOne, select the tree where you want the Server Management objects created.
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3 Right-click the context where you want to create the Server Management containers, then click 
New > Object.
This should be as high in the tree as possible.

4 Select Organizational Unit, then click OK.
5 Specify a container name, such as ZENworks, then click OK.

The example in Step 2 uses Novell for the container name.

IMPORTANT: Do not use double-byte or extended characters in object names.

6 Right-click the ZENworks container, then click New > Object.
7 Create OUs similar in name and arrangement to those depicted in Step 2.
8 Continue with Section 3.4, “DNS Requirement,” on page 39.

3.4  DNS Requirement
DNS name usage is required when installing ZENworks Server Management, except that 
Management and Monitoring Services does not require DNS.

If you do not have DNS in use for the servers where you want to install the Server Management 
software (Policy and Distribution Services, Server Inventory, and Remote Management), see 
Appendix D, “Ensuring Successful DNS Name Resolution,” on page 335 for information on setting 
it up.

If DNS is in use on your network, you must have a DNS name server that can perform both forward 
and reverse hostname resolution for all servers where ZENworks Server Management components 
are installed. For more information, see Appendix D, “Ensuring Successful DNS Name Resolution,” 
on page 335.
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4Installation Machine and 
Management Workstation 
Requirements

Some requirements are shared by both installation and management machines, and some are specific 
to a machine’s role for Novell® ZENworks® 7 Server Management:

Section 4.1, “General Workstation Requirements,” on page 41
Section 4.2, “Installation-Specific Machine Requirements,” on page 42
Section 4.3, “Management-Specific Workstation Requirements,” on page 42
Section 4.4, “Installing ConsoleOne 1.3.6e,” on page 43

After completing the workstation requirements, continue with Chapter 5, “Server Requirements,” on 
page 45.

4.1  General Workstation Requirements
The following requirements must be met by both installation and management workstations:

Pentium* III processor or later

Includes other Pentium-compatible processors.
At least 256 MB RAM with virtual memory (swap space) enabled (additional RAM improves 
ConsoleOne® performance on the management workstation)
Novell ClientTM 4.90 Support Pack 1a
To determine the current version on your workstation, right-click NetWare Services in the 
system tray, then click Novell Client Properties.
To install: Insert the Novell ZENworks 7 with Support Pack 1 Companion 1 CD and on the 
main installation menu, click Companion Programs and Files > Novell Client, which uses a 
link on that CD to the Novell Software Downloads Web site where you can obtain the 
executable.
or
Download the latest Novell Client for your version of Windows from Novell Software 
Downloads (http://download.novell.com).
(Optional) Internet Explorer 6 SP1 or later for the ability to view the product Readme (an 
HTML file) during installation, and Novell documentation on the Web after installation
To determine your version in Internet Explorer, click Help, then click About Internet Explorer.
Only Internet Explorer 6 SP1 is supported for Novell iManager.
To download, see Internet Explorer (http://www.microsoft.com/windows/ie/default.asp).
Automatic character encoding for creating and displaying extended characters in eDirectory 
object names
In Internet Explorer, click View > Encoding > Auto-Select.
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ConsoleOne 1.3.6 or later for creating ZENworks-specific containers in eDirectory before 
installation and for managing Server Management after installation
You can have the ConsoleOne snap-ins for ZENworks Server Management installed on 
multiple workstations during the installation process, so that you can manage ZENworks 
Server Management from each of those workstations. To do so, make sure you have installed 
ConsoleOne 1.3.6e from the Novell ZENworks 7 with Support Pack 1 Companion 1 CD on 
each workstation where you want the snap-ins to be installed.
For instructions to install ConsoleOne, see Section 4.4, “Installing ConsoleOne 1.3.6e,” on 
page 43.
70 MB free disk space for a local workstation installation of ConsoleOne

4.2  Installation-Specific Machine Requirements
Installation of Server Management requires access to your target eDirectory tree from your 
installation machine (a workstation or a server). In addition, the following minimum requirements 
must be met:

Windows 2000 (Professional SP4 or Server SP4), Windows Server 2003 (Standard or 
Enterprise Editions), or Windows XP Professional SP1a
Windows display screen area set to at least 1024 x 768 to accommodate the Installation Wizard
Access to a DNS name server
For more information, see Appendix D, “Ensuring Successful DNS Name Resolution,” on 
page 335.

4.3  Management-Specific Workstation 
Requirements
ZENworks Server Management uses ConsoleOne for administration of ZENworks objects in 
eDirectory. After installation, any workstation where you run ConsoleOne to manage ZENworks 
Server Management must meet the following minimum requirements:

Windows 2000 Professional SP4 or Windows XP Professional SP1a

Windows servers (2000/2003) can also be used as a management workstation if it has Novell 
Client 4.9 installed.

IMPORTANT: ZENworks Server Management does not support using a server’s console to 
run an instance of ConsoleOne installed on that NetWare server. To use the server’s installation 
of ConsoleOne, you must map a drive from a workstation to that server and run ConsoleOne 
from the workstation.

(Optional) Access to iManager 2.5 or later installed on a NetWare, Windows, Linux, or Solaris1 
server
1 For ZENworks 7 with Support Pack 1 (SP1), the Server Management snap-ins are not 
supported on Solaris servers.
In addition to ConsoleOne, you can use iManager to manage the Tiered Electronic Distribution 
objects used by Policy and Distribution Services. For plug-in installation instructions, see 
Section 6.1.2, “Web-Based Management for Policy and Distribution Services,” on page 96.
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WARNING: Earlier versions of iManager cannot be used with ZENworks 7 Server 
Management with SP1.
If you plan to upgrade incrementally, you need to maintain the older version of iManager that 
you are using to manage ZENworks for Servers 3.x in order to continue to manage those 
servers. Because you cannot have two different versions of iManager installed to the same 
machine, select a different machine for installing iManager 2.x.

To install iManager on a Windows machine: Insert the Novell ZENworks 7 with Support Pack 1 
Companion 1 CD and on the main installation menu, click Companion Programs and Files > 
Novell iManager, which automatically executes the installation file from that CD.

IMPORTANT: For a Windows Server 2003 machine, iManager 2.5 or later requires 
eDirectory 8.7.3; however, eDirectory does not need to be installed on this Windows machine, 
it only needs to be available somewhere on the network for iManager to access.

To install iManager on other platforms:
For NetWare 6, iManager 2.6 installation is available on the Novell ZENworks 7 with 
Support Pack 1 Companion 1 CD. Browse for \Novell 
iManager\iMan_26_NW60_Standalone.exe to run the installation program for 
installing to NetWare 6. This file is also available on the Novell download Web site (http:/
/download.novell.com/).
For NetWare 6.5, iManager 2.6 installation is only available by upgrading NetWare 6.5 to 
Support Pack 1 or later.
For Linux or Solaris, you must download the iManager installation file from Novell 
Software Downloads (http://download.novell.com).

(Remote Management only) IP protocol stack

4.4  Installing ConsoleOne 1.3.6e
Because you administer ZENworks Server Management primarily through ConsoleOne, you must 
have ConsoleOne 1.3.6 or later installed on at least one workstation or server before you install 
ZENworks Server Management. To determine your current version in ConsoleOne, click Help, then 
click About ConsoleOne.

To install ConsoleOne:

1 Insert the Novell ZENworks 7 with Support Pack 1 Companion 1 CD and on the main 
installation menu, click Companion Programs and Files > Novell ConsoleOne.
This runs the executable from the Companion 1 CD, displaying the WinZip Self-Extractor 
dialog box.

2 Click Setup.
After the files have been extracted, the installation program starts.

3 Click Next to begin the installation.
4 Review the License Agreement, then click Accept to continue.
5 Browse to and select the location where you want to install ConsoleOne, then click Next twice.

On a NetWare server, you might choose sys:\public\mgmt
On a Windows server or workstation, you might choose c:\novell
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If you have an older version of ConsoleOne installed on the workstation that you use for a 
previous version of ZENworks Server Management, you can specify a different path. For 
example, change the \1.2 directory to \1.3 or \1.3.6.

6 Select any languages in addition to English that you want to install, then click Next twice.
7 After reviewing the summary of products to be installed, click Finish.

Objects are analyzed and the installation is performed. 
8 When the installation completes, click Close.
9 Repeat these steps for each machine where you want to have access to Server Management 

through ConsoleOne.

IMPORTANT: ZENworks Server Management does not support running ConsoleOne in a 
NetWare server’s graphical console from the instance of ConsoleOne installed on that NetWare 
server. To use a NetWare server’s installation of ConsoleOne, you must map a drive from a 
workstation to that server and run ConsoleOne from the workstation. However, this is slower 
than running ConsoleOne directly from a workstation.
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5Server Requirements

The following sections provide information on the server requirements for ZENworks Server 
Management:

Section 5.1, “Supported Platforms for ZENworks 7 Server Management,” on page 45
Section 5.2, “Tested Platforms for ZENworks 7 Server Management Support Pack 1 Interim 
Release 4,” on page 46
Section 5.3, “Policy-Enabled Server Management,” on page 47
Section 5.4, “Management and Monitoring Services,” on page 56

5.1  Supported Platforms for ZENworks 7 Server 
Management
Novell® ZENworks® 7 Server Management software components are supported on the following 
server platforms with minimum support/service packs: 

Table 5-1   Supported Platforms for ZENworks 7 Server Management

Supported Server Platforms for 
Installing the Software

Policy and 
Distribution 
Services

Server 
Inventory 
Agent

Server 
Inventory 
Database 
and Server

Remote 
Management

Management 
and Monitoring 
Services

NetWare 5.1 SP5, SP6, SP7, or 
SP8

Yes Yes 1 Yes Yes Yes 2

NetWare 6 SP4 or SP5 Yes Yes Yes Yes Yes 2

NetWare 6.5 SP1.1, SP2, SP3, 
SP4, SP5, SP6, SP7, or SP8

Yes Yes Yes Yes Yes

Linux 3 Yes No Yes Yes 4 Yes 5

Solaris 9 Yes No No No No

Windows 2000 Server SP4 or 
Windows 2000 TS

Yes Yes Yes Yes Yes 5

Windows Server 2003 ES, AS, 
and TS, including SP2

Yes Yes Yes Yes Yes 5

Novell Open Enterprise Server 
(OES) SP1 or SP2

Yes Yes 6 Yes 6 , 9 Yes 6 Yes 7

Novell Open Enterprise Server 
(OES) 2 SP1 X86

Yes No Yes 9 No Yes 5

Novell Open Enterprise Server 
(OES) 2 SP1 X86-64

Yes No Yes 9 No Yes 5

Citrix* Presentation Server 8 No Yes Yes Yes Yes 5
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1 Only for the Inventory Agent.
2 For more detail, see Section 5.4.2, “NetWare Server Requirements,” on page 56.
3 Includes:

SUSE® Linux Enterprise Server (SLES) 8
SUSE Linux Standard Server (SLSS) 8
SLES 9, including SP1, SP2, and SP3

   SLES 10, including SP1, SP2
SLSS 9, including SP1 and SP2
Red Hat* Advanced Server 2.1
Red Hat Enterprise Server 2.1
Red Hat Enterprise Linux* AS 3 and 4
Red Hat Enterprise Linux ES 3 and 4

4 SSH can be used for controlling Linux devices.
5 Only for the Server Management Agent and the Advanced Trending Agent.
6 Only the OES NetWare kernel.
7 For managed servers only. For site servers, only the NetWare version of OES.
8 For managed servers and the Inventory Agent only.
9  Yes for Inventory database and No for Inventory Server.

Server requirements are organized by platform under the following headings:

Section 5.3, “Policy-Enabled Server Management,” on page 47
Section 5.4, “Management and Monitoring Services,” on page 56

5.2  Tested Platforms for ZENworks 7 Server 
Management Support Pack 1 Interim Release 4
Novell® ZENworks® 7 Server Management SP1 IR4 software components are tested on the 
following server platforms with minimum support/service packs: 

Table 5-2   Tested Platforms for ZENworks 7 Server Management SP1 IR4

Tested Server Platforms for 
Installing the Software

Policy and 
Distribution 
Services

Server 
Inventory 
Agent

Server 
Inventory 
Database 
and Server

Remote 
Management

Management 
and Monitoring 
Services

NetWare 6.5 SP8 Yes Yes Yes Yes Yes

Linux 1 Yes No Yes Yes 2 Yes 3

Windows Server 2003 SP2 ES Yes Yes Yes Yes Yes 3

Novell Open Enterprise Server 
(OES) SP2

Yes Yes 4 Yes 4 , 6 Yes4 Yes 5
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1 Includes:

SLES 9 SP4
   SLES 10 including SP2 and SP3
2 SSH can be used for controlling Linux devices.
3 Only for the Server Management Agent and the Advanced Trending Agent.
4 Only the OES NetWare kernel.
5 For managed servers only. For site servers, only the NetWare version of OES.
6  Yes for Inventory database and No for Inventory Server.

Server requirements are organized by platform under the following headings:

Section 5.3, “Policy-Enabled Server Management,” on page 47
Section 5.4, “Management and Monitoring Services,” on page 56

5.3  Policy-Enabled Server Management
This section contains the minimum server requirements for Policy and Distribution Services, Server 
Inventory, and Remote Management:

Section 5.3.1, “General Server Requirements,” on page 47
Section 5.3.2, “NetWare Server Requirements,” on page 48
Section 5.3.3, “Windows Server Requirements,” on page 50
Section 5.3.4, “Linux and Solaris Server Requirements,” on page 51
Section 5.3.5, “Role-Specific Server Requirements,” on page 54

5.3.1  General Server Requirements
The following sections provide general requirements information:

“Mixed eDirectory Environments” on page 48
“NetWare Support Packs” on page 48
“Windows Service Packs” on page 48

Novell Open Enterprise Server 
(OES) 2 SP1 X86 or (OES) 2 SP2 
X86

Yes No Yes6 No Yes 3

Novell Open Enterprise Server 
(OES) 2 SP1 X86-64  or (OES) 2 
SP2 X86-64

Yes No Yes6 No Yes 3

Tested Server Platforms for 
Installing the Software

Policy and 
Distribution 
Services

Server 
Inventory 
Agent

Server 
Inventory 
Database 
and Server

Remote 
Management

Management 
and Monitoring 
Services
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Mixed eDirectory Environments

ZENworks Server Management can run in a mixed eDirectory environment. For example, your 
network might have both eDirectory 8.x and NDS® 6.x or 7.x installed. However, ZENworks Server 
Management cannot run in a mixed NetWare environment in a cluster (see Section F.3.1, “Meeting 
System Requirements for Clustering,” on page 345).

eDirectory 8.6.2 or 8.7.1 or later is required for ZENworks Server Management so that its objects 
can be placed in the tree during installation of the product. eDirectory must be installed with the 
master replica somewhere in your network, but not necessarily on a server where you are installing 
the ZENworks Server Management software.

The only requirement for any Policy and Distributions Services server is that it can communicate 
with the server where the eDirectory master replica (of the partition where its NCP Server object 
resides) is installed. Therefore, you do not need to install eDirectory on each server where you want 
to install Policy and Distributions Services. However, Server Inventory requires eDirectory to be 
running on each Inventory server.

NetWare Support Packs

To determine the current Support Pack version on a NetWare server, enter version at the server’s 
main console prompt.

You can download Support Packs from Novell Support (http://support.novell.com).

Windows Service Packs

To determine the Service Pack level on a Windows server, right-click My Computer > Properties.

You can download Service Packs from Microsoft (http://www.microsoft.com).

5.3.2  NetWare Server Requirements
Following are the common NetWare minimum requirements for Policy and Distribution Services 
and Server Inventory:

Table 5-3   Common Minimum NetWare Requirements for Policy and Distribution Services and Server Inventory

Requirement Policy and Distribution 
Services Inventory Server Inventory Agent Server

Novell eDirectory 8.6.2 or 8.7.1 1 8.6.2 or 8.7.1 8.6.2 or 8.7.1

Cache for the Policy and 
Distribution database file

32 MB N/A N/A

Free Disk Space 35 MB for Policy and 
Distribution Services 
files

100 MB for Inventory 
with database; 25 MB for 
Inventory alone

N/A

Disk Space for 
ConsoleOne® Snap-Ins

70 MB 70 MB N/A

Database File Location Any volume other than 
sys:

Any volume other than 
sys:

N/A
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1 For more information, see Section 3.2, “Novell eDirectory Requirement,” on page 33.
2 Wherever Pentium is mentioned in these requirements, all Pentium-compatible processors are 
included.

Following are the platform-specific NetWare minimum requirements for Policy and Distribution 
Services and Server Inventory:

Table 5-4   Platform-Specific Minimum NetWare Requirements for Policy and Distribution Services and Server 
Inventory

1 Only for the Inventory Agent.

IP Address N/A Valid IP address and IP 
Services installed

Valid address

Subscriber N/A N/A Object and software only 
(Server Inventory, 
Inventory Agent, and 
Remote Management)

For more information, 
see Section 6.1, 
“Installation on NetWare 
and Windows Servers,” 
on page 65.

Server CPU Type Pentium III 2

To enhance Policy and 
Distribution Services 
efficiency, it is more 
important to increase the 
amount of RAM than to 
increase the processor 
speed.

Pentium III Pentium III

Requirement Policy and Distribution Services Server Inventory

NetWare 5.1: Support Pack 
Version

5 5 1

NetWare 6: Support Pack Version 4 4

NetWare 6.5: Support Pack 
Version

1a 1a

NetWare 5.1: Server RAM Policy/Distribution: 384 MB; 512 MB is 
recommended for larger deployments of 
Policy and Distribution Services.

384 MB; 512 MB is 
recommended

NetWare 6/6.5: Server RAM 512 MB 512 MB

Requirement Policy and Distribution 
Services Inventory Server Inventory Agent Server
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5.3.3  Windows Server Requirements
The following information applies to all Windows versions:

DNS:  All target Windows servers should have fully qualified DNS names. For more 
information, see Section 3.4, “DNS Requirement,” on page 39.

IMPORTANT: For Windows servers, the server’s DNS short name must be the same as the 
server’s name. Either rename Windows servers where the server’s name does not match its 
DNS short name before running the installation, or do not select these servers for installing 
Server Inventory.

Windows-centric network environment:  You can run Policy and Distribution Services in a 
Windows-centric network when you install eDirectory 8.7.1 on at least one Windows 2000 
server, such as a Distributor server. To install eDirectory on a Windows Server 2003 server, 
eDirectory 8.7.3 is required.
Installing eDirectory on a Windows server allows you to manage the ZENworks eDirectory 
objects in a Windows-centric network. All of the Windows servers in your network do not 
require eDirectory, just one server.
Local Windows server installation:  In order to install locally on a Windows 2000/2003 
server, that server must have the required Novell Client running. Otherwise, the installation 
program does not run on that instance of Windows.
However, you can install to a Windows server that does not have Novell Client running on it, 
but not locally. Just run the installation program on a workstation that does have the client 
running, then on the Server Selection page, browse for and select the Windows server that 
doesn’t have the client so that you can install ZENworks 7 Server Management to it.
Mixed network environment:  ZENworks Server Management can run in a mixed eDirectory 
environment. For example, your network might have both eDirectory 8.x and NDS 6.x or 7.x 
installed.
eDirectory 8.6.2 or 8.7.1 or later is required for ZENworks Server Management so that its 
objects can be placed in the tree during installation of the product. eDirectory must be installed 
with the master replica somewhere in your network, but not necessarily on a server where you 
are installing the ZENworks Server Management software. However, Server Inventory requires 
eDirectory to be running on each Inventory server.
The only requirement for any Policy and Distributions Services server is that it can 
communicate with the server where the eDirectory master replica (of the partition where its 
NCP Server object resides) is installed.

Following are the common Windows minimum requirements for Policy and Distribution Services 
and Server Inventory:

Table 5-5   Common Minimum Windows Requirements for Policy and Distribution Services and Server Inventory

Requirement Policy and Distribution Services Server Inventory

Server CPU Type Pentium III Pentium III

Server RAM 512 MB 512 MB
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Following are the platform-specific minimum requirements for the Server Management 
components:

Table 5-6   Platform-Specific Minimum Windows Requirements for Policy and Distribution Services and Server 
Inventory

1 No service pack is required for Windows Server 2003.

5.3.4  Linux and Solaris Server Requirements
Meet the following requirements before running the installation script:

“Hardware and Software Requirements” on page 51
“Server Accessibility Requirements” on page 52
“Management Requirements” on page 53

Hardware and Software Requirements

Following are the minimum system requirements for Policy and Distribution Services on Linux or 
Solaris servers. Server Inventory and Remote Management cannot be installed on Linux or Solaris.

Free Disk Space 35 MB 100 MB for inventory with database; 25 MB for 
inventory alone

Disk Space for 
ConsoleOne Snap-Ins

50 MB 50 MB

eDirectory N/A N/A

Subscriber N/A Object and software only (Server Inventory, 
Inventory Agent, and Remote Management)

For more information, see Section 6.1, 
“Installation on NetWare and Windows 
Servers,” on page 65.

Requirement Policy and Distribution Services Server Inventory

Windows 2000 Service Pack Version 1 4 4

Requirement Policy and Distribution Services Server Inventory
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Table 5-7   Minimum Linux or Solaris Requirements for Policy and Distribution Services

IMPORTANT: The hostname of the Linux or Solaris server where you install Policy and 
Distribution Services must be the same as its DNS short name.

Server Accessibility Requirements

The following might need to be set up for accessing a Linux or Solaris server:

“Samba” on page 52
“DNS Hostname” on page 53

Samba

Samba is not needed for installing Policy and Distribution Services to a Linux or Solaris server. 
However, if you plan to access the Linux or Solaris Subscriber server from a Windows client via a 
mapped drive, you must configure Samba on the Subscriber server to provide the shared folders.

For information concerning the Samba usage for Desktop Application Distributions, see “Client 
Access in Linux” in the Novell ZENworks 7 Server Management Administration Guide.

Requirement Linux Solaris

Operating System Version Distributions supported:

SLES 8
SLES 9
SLES 10
SLSS 8
SLSS 9
Red Hat Advanced Server 2.1
Red Hat Enterprise Server 2.1
Red Hat Enterprise Linux AS 3
Red Hat Enterprise Linux ES 3

9 (the release level Is displayed 
by the uname -r command)

Machine Type IBM* compatible PC Sun* Microsystems

Supported Processors Intel* for Linux SPARC* for Solaris

Server RAM 128 MB minimum; 
256 MB recommended

256 MB minimum

Server CPU Type 200 MHz Pentium
or faster

N/A

Free Space for Policy and 
Distribution Services Files

150 MB 195 MB
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DNS Hostname

If you edit the tednode.properties configuration file, the installation script used to install Policy 
and Distribution Services on Linux and Solaris servers (see Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114) displays the fully qualified DNS hostname of the local Linux or 
Solaris server as obtained from one of the following locations, depending on your system search 
order:

DNS (Domain Name System)
NIS (Network Information Service)
/etc/hosts file on the Linux or Solaris server

The installation script requests confirmation of the displayed information. Without the correct DNS 
information, Policy and Distribution Services does not function properly on the server. Do one of the 
following:

If the DNS entry is correct, type y, then press Enter.
If the DNS entry is incorrect:

1. Type n, then press Enter.
2. Specify the correct fully qualified DNS hostname, then press Enter.
3. Type y to confirm the modified DNS hostname, then press Enter.

After the DNS entry is correct, the installation script next prompts for the password corresponding 
to the user you supplied for the user_Name parameter.

The installation script logs its actions in the following file:

/var/opt/novell/log/zenworks/zfs-pds-install.log

If the installation does not complete successfully, you can print this log file. To look up installation 
errors, see Appendix H, “Installation Error Messages,” on page 373. Resolve the problem and 
perform a successful installation.

Management Requirements

In addition to fulfilling the server requirements for the Linux or Solaris server where you are 
installing Policy and Distribution Services, the following requirements must be met somewhere in 
your network:

Novell eDirectory 8.6.2 or 8.7.1 or later must be running on at least one server (NetWare, 
Windows, Linux, or Solaris) in your network. This is required for installing and managing the 
Distributor and Subscriber objects that are created for your Linux or Solaris servers.

For more information, see Section 3.2, “Novell eDirectory Requirement,” on page 33.
At least one NetWare or Windows server is required in your network to support the Server 
Management database. The Server Management database currently cannot be created on a 
Linux or Solaris server. The database is optional, but is recommended for historical reporting 
and for reporting on policies distributed to multiple servers.
The Server Management database stores log messages for reporting purposes, detailing the 
successes and failures of Distribution processing and policy statuses. The server where it 
resides must meet the system requirements listed in Chapter 5, “Server Requirements,” on 
page 45. 
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To administer Policy and Distribution Services on Linux or Solaris servers using ConsoleOne, 
version 1.3.6 or later must be installed on a Windows workstation. ConsoleOne is required for 
managing ZENworks Server Management. For information on installing ConsoleOne, see 
Section 4.4, “Installing ConsoleOne 1.3.6e,” on page 43.
To administer Policy and Distribution Services on Linux or Solaris servers using iManager, 
version 2.5 or 2.6 must be installed on a Windows or NetWare server and be accessible from a 
Windows workstation, or installed on a Linux server where it can be run. iManager is optional, 
but recommended for managing Distributions using the Tiered Distribution view.
For more information on installing iManager, see Section 4.3, “Management-Specific 
Workstation Requirements,” on page 42.

5.3.5  Role-Specific Server Requirements
Some servers might require additional configuration specific to their Server Management role:

“Inventory Database Server” on page 54
“Remote Management Servers” on page 55

Inventory Database Server

Following are the minimum requirements for the Inventory Database server only:

Table 5-8   Minimum Inventory Database Server Requirements

Component Minimum Hardware and Software Requirements

Database 
Requirements

Sybase ASA 8.0.2 is installed automatically when you choose to install the 
inventory database.

NetWare 6 SP3

NetWare 6.5

Windows 2000 Server SP4

Windows Server 2003 Standard Edition

Windows Server 2003 Enterprise Edition

Oracle* can be used as an alternative to Sybase. Oracle 9.2.0.6 or Oracle 10g R1 
on:

Windows 2000 Server SP4

Windows Server 2003 Standard Edition

Windows Server 2003 Enterprise Edition

SLES 9 SP1 or Solaris versions supported by Oracle

MS SQL can be used as an alternative to Sybase:

(Recommended) MS SQL version 2000 SP3a

RAM 
Requirements

Recommended minimum memory on the database is 512 MB with minimum 
cache size of 128 MB

768 is minimum and 1 GB or higher is recommended at the Root Server level with 
a cache size of 256 MB
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IMPORTANT: Inventory database files should not be installed on an NFS-mounted volume of a 
NetWare server.

Remote Management Servers

For Remote Management servers, in addition to the basic ZENworks Server Management 
installation requirements, the following requirements must be met for full Remote Management 
functionality:

Table 5-9   Minimum Remote Management Server Requirements

We recommend that you install Remote Management from the Novell ZENworks 7 Server 
Management with Support Pack 1 Program CD. However, if you need to copy the CD structure to a 
hard drive, the path between the root of the hard drive and the first CD directory can contain only 
directory names that conform to the 8.3-character DOS file naming convention. If any long directory 
names exist in the path, the installation program does not work.

Before you can install ZENworks Server Management Remote Management, you must perform the 
following tasks:

“Determining and Preparing the Management Server” on page 56
“Determining and Preparing the Managed Server” on page 56

Hard Disk 
Requirements

Recommended minimum hard disk space on a lowest level server with 10,000 
servers is 5 GB. 

The minimum hard disk space on the topmost level server (Root Server) is 20 GB. 

Depending on the number of servers attached, the hard disk size might vary from 
1 GB to 25 GB.

Requirement Minimum Hardware and Software Requirements

Management 
Server

See Chapter 5, “Server Requirements,” on page 45.

Managed 
Server

NetWare 5.1/6/6.5

Windows 2000/2003

2 MB hard disk space on the drive where Windows is installed

Internet Explorer 5.x

If you want to install the policy enforcer, you must have the required support pack 
installed (that contains the required JVM*) and Policy and Distribution Services on 
your managed server

Component Minimum Hardware and Software Requirements
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Determining and Preparing the Management Server

After determining the Management Server, you must perform the following task:

If you want to set up a policy-enabled Remote Management session for Windows 2000/2003 
servers, make sure that you have installed the Distributor on the Management server. To install 
the Distributor, see Section 6.1, “Installation on NetWare and Windows Servers,” on page 65.

Determining and Preparing the Managed Server

After determining which servers you want to remotely manage, you must perform the following 
tasks:

Make sure that you have uninstalled the Remote Management component that ships with the 
NetWare client, if installed.
If you want to set up Remote Management for Windows 2000/2003 servers through using the 
Server Remote Management policy, make sure that you have installed the Subscriber on the 
managed servers. To install the Subscriber, see Section 6.1, “Installation on NetWare and 
Windows Servers,” on page 65.

IMPORTANT: For Windows servers, the server’s DNS short name must be the same as the 
server’s name. Either rename Windows servers where the server’s name does not match its 
DNS short name before running the installation, or do not select these servers for installing 
Remote Management.

5.4  Management and Monitoring Services
This section contains the minimum server requirements for Management and Monitoring Services:

Section 5.4.1, “General Server Requirements,” on page 56
Section 5.4.2, “NetWare Server Requirements,” on page 56
Section 5.4.3, “Windows Server Requirements,” on page 58
Section 5.4.4, “Linux Server Requirements,” on page 58
Section 5.4.5, “Role-Specific Server Requirements,” on page 59

5.4.1  General Server Requirements
ZENworks Server Management can run in a mixed eDirectory environment. For example, your 
network might have both eDirectory 8.x and NDS 6.x or 7.x installed.

eDirectory 8.7.3 or later is required for ZENworks Server Management so that its objects can be 
placed in the tree during installation of the product. The server on which the site-server is installed 
must have a Read-Write replica of eDirectory.

5.4.2  NetWare Server Requirements
Following are the common NetWare minimum requirements for Management and Monitoring 
Services:
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Table 5-10   Common Minimum NetWare Server Requirements for Management and Monitoring Services Components

Following are the platform-specific NetWare minimum requirements for Management and 
Monitoring Services:

Table 5-11   Platform-Specific Minimum NetWare Server Requirements for Management and Monitoring Services 
Components

Requirement Management Server Server Management 
Agent Server

Traffic Analysis 
Agent Server

Advanced Trending 
Agent Server

Novell eDirectory 8.7.3 or later N/A N/A N/A

Free Disk Space 170 MB free disk 
space; extra disk 
space might be 
required for 
discovery or alarm 
data

1 MB; extra disk 
space for trending 
information

1.5 MB; extra disk 
space for trending 
information

1.5 MB; extra disk 
space for trending 
information

Disk Space for 
ConsoleOne Snap-
Ins (if installed on 
the server)

50 MB N/A N/A N/A

IP Address Static Valid IP/IPX* 
address

Valid IP/IPX 
address

Valid IP address 
(IPX is not 
supported)

Server CPU Type Pentium III Processor meeting 
OS requirements

Processor meeting 
OS requirements

Processor meeting 
OS requirements

Requirement Management Server Server Management 
Agent Server

Traffic Analysis 
Agent Server

Advanced Trending 
Agent Server

NetWare 5.1: 
Support Pack 
Version

Not supported on 
this platform

7 7 7

NetWare 6: 
Support Pack 
Version

Not supported on 
this platform

4 4 4

NetWare 6.5: 
Support Pack 
Version

2 2 2 2

NetWare 5.1: 
Server RAM

Not supported on 
this platform

128 MB 128 MB 128 MB

NetWare 6: Server 
RAM

Not supported on 
this platform

256 MB 256 MB 256 MB

NetWare 6.5: 
Server RAM

1 GB 512 MB 512 MB 512 MB

NetWare 6.5 OES 1 GB 512 MB 512 MB 512 MB
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5.4.3  Windows Server Requirements
DNS:  All target Windows servers should have fully qualified DNS names. For more information, 
see Section 3.4, “DNS Requirement,” on page 39.

Following are the common Windows minimum requirements for Management and Monitoring 
Services:

Table 5-12   Common Minimum Windows Server Requirements for Management and Monitoring Services Components

Following are the platform-specific minimum requirements for Management and Monitoring 
Services:

Table 5-13   Platform-Specific Minimum Windows Server Requirements for Management and Monitoring Services 
Components

1 No service pack is required for Windows Server 2003.

5.4.4  Linux Server Requirements
Management and Monitoring Services is not supported on Solaris.

Windows 2000 Server or 
Windows Server 2003 
Requirement

Management and 
Monitoring Services: 
Server Management 
Agent

Management and 
Monitoring Services: 
Traffic Analysis Agent

Management and 
Monitoring Services: 
Advanced Trending Agent

Server CPU Type 250 MHz Pentium 250 MHz Pentium 250 MHz Pentium

Free Disk Space 2.5 MB with extra disk 
space for trending 
information

2.5 MB with extra disk 
space for trending 
information

2.5 MB with extra disk 
space for trending 
information

IP Address Valid IP/IPX Valid IP/IPX Valid IP address (IPX is 
not supported)

Windows 2000 Server or 
Windows Server 2003 
Requirement

Management and 
Monitoring Services: 
Server Management 
Agent

Management and 
Monitoring Services: 
Traffic Analysis Agent

Management and 
Monitoring Services: 
Advanced Trending Agent 

Service Pack Version 1 4 or later 4 or later 4 or later

Novell eDirectory N/A N/A N/A

Server RAM 128 MB 128 MB 128 MB
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Table 5-14   Minimum Linux Requirements for Management and Monitoring Services

5.4.5  Role-Specific Server Requirements
Before you start installing the Management and Monitoring Services software, you must prepare the 
target Management server, Managed servers, the management console, and the Traffic Analysis 
agent. For details on preparing each of the systems, refer to the following sections:

Following are the minimum requirements and preparations for Management and Monitoring 
Services servers:

“Management Server” on page 60
“Server Management Agent” on page 60

Requirement Linux

Operating System Version Distributions supported:

SLES 9
SLSS 9
Red Hat Enterprise Linux AS 3
Red Hat Enterprise Linux ES 3
Open Enterprise Server (Linux) 

Perl package v5.6.1 or above must be installed

Machine Type IBM compatible PC

Supported Processors Intel

Server RAM 128 MB minimum; 
256 MB recommended

Server CPU Type 200 MHz Pentium
or faster

Free Space for Management and Monitoring 
Services Files

10 MB

SNMP Package for Management and Monitoring 
Services

net-snmp rpm package version 5.0.6 or above 
must be installed and must support the dlmod 
option 

or

ucd-snmp (ucdsnmp) rpm package version 4.2.6 
or above must be installed and must support the 
dlmod option

NOTE: The snmp agent installed on the device 
must support the dlmod option. To check, enter:

snmpd -H 2>&1 | grep dlmod 

If this returns an empty line, the dlmod option is not 
supported. Check with your distributor on how to 
acquire an SNMP version that supports the dlmod 
option.
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“Traffic Analysis Agent” on page 61
“Advanced Trending Agent” on page 61

Management Server

Before you install the Management and Monitoring Services software, you must verify the 
following:

Verify that you have access to Windows 2000/XP to install the Management server and 
Managed servers.
Verify that all replicas on your tree are in sync. If they are not, errors can occur when installing 
ZENworks eDirectory objects. It is required that you have a read/write replica of the eDirectory 
tree on your server.
Verify that the sys:\etc\hosts file has the proper entry to map the hostname to the IP 
address.
Close all applications running on the console to ensure that the installation goes smoothly.
(Recommended) Verify that Sybase is not running on the server where you are installing the 
ZENworks database.

NOTE: Installing Management and Monitoring Services or Policy and Distribution Services to 
a server automatically starts Sybase. If you are installing Management and Monitoring Services 
to a server where you have already installed Policy and Distribution Services, you must stop 
the Policy and Distribution Services and quit Sybase at the server before installing other 
services. To quit Sybase, go to the server console, and enter q on the Sybase screen.

Server Management Agent

Before you install the Management and Monitoring Services software, you must verify the 
following:

For Windows 2000/2003 servers, create a shared directory on any drive before installing the 
management agents, and assign all rights to the share.

By default, the Windows administrative shares, such as C$ and D$, cannot be used for 
installing the management agents. You have to manually create a share for installing the agents.

NOTE: On Windows Server 2003, a shared folder by default has read-only permission. You 
need to manually change this permission to Full Control and Write.

Authenticate to the tree that contains all of the NetWare and Windows 2000/2003 servers that 
you want to manage.

TIP: You do not need to map a drive to all of the managed servers, but you need Admin or 
equivalent rights to the managed servers.

For Windows 2000/2003 servers, install and configure the SNMP service. For information, see 
Appendix E, “Installing and Configuring the Windows SNMP Service,” on page 341.
Allocate the appropriate free disk space. For example, to capture one year of trend data, you 
must have at least 50 MB of free disk space on your server.
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Traffic Analysis Agent

Before you install the software, you must:

For Windows 2000/2003 servers, before installing the management agents, create a shared 
directory on any drive and assign all rights to the share.

By default, the Windows administrative shares, such as C$ and D$, cannot be used for 
installing the management agents. You have to manually create a share for installing the agents.

NOTE: On Windows Server 2003, a shared folder by default has read-only permission. You 
need to manually change this permission to Full Control and Write.

Allocate the appropriate amount of free disk space. To capture one year of trend data, you must 
have at least 25 MB of free disk space on the server for each monitored Ethernet adapter, and at 
least 50 MB of disk space on the server for each monitored FDDI ring adapter or token ring 
adapter.
Authenticate to the tree that contains all of the NetWare and Windows 2000/2003 servers that 
you want to manage.

TIP: You do not need to map a drive to all of the managed servers, but you need Admin or 
equivalent rights to the managed servers.

For Windows 2000/2003 servers, install and configure the SNMP service. For information, see 
Appendix E, “Installing and Configuring the Windows SNMP Service,” on page 341.
Install promiscuous mode LAN drivers on NetWare or promiscuous mode NDISLAN drivers 
on Windows 2000/2003 servers.
For Windows 2000/2003 servers, bind TCP/IP to the network segments monitored by the agent.

Advanced Trending Agent

Before you install the Management and Monitoring Services software, you must verify the 
following:

For Windows 2000/2003 servers, before installing the management agents, create a shared 
directory on any drive and assign all rights to the share.

By default, the Windows administrative shares, such as C$ and D$, cannot be used for 
installing the management agents. You have to manually create a share for installing the agents.

NOTE: On Windows Server 2003, a shared folder by default has read-only permission. You 
need to manually change this permission to Full Control and Write.

Authenticate to the tree that contains all of the NetWare and Windows 2000/2003 servers that 
you want to manage.

TIP: You do not need to map a drive to all of the managed servers, but you need Admin or 
equivalent rights to the managed servers.

For Windows 2000/2003 servers, install and configure the SNMP service. For information, see 
Appendix E, “Installing and Configuring the Windows SNMP Service,” on page 341.
Allocate the appropriate free disk space. For example, to capture one year of trend data, you 
must have at least 50 MB of free disk space on your server.
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IIIInstallation

The following sections provide instructions for installing the various components of Novell® 
ZENworks® 7 Server Management:

Chapter 6, “Policy-Enabled Server Management Installation,” on page 65

Policy-Enabled Server Management (Policy and Distribution Services, Server Inventory, and 
Remote Management) can be installed on NetWare® and Windows servers using a graphical 
interface that is run from the Novell ZENworks 7 Server Management with Support Pack 1 
Program CD.

You can also install Policy and Distribution Services on a Windows workstation for instances 
where you need the Subscriber service, but do not have a server available. For more 
information, see Section 6.2, “Installation on Windows Workstations,” on page 101.

Policy and Distribution Services can also be installed on Linux and Solaris servers using a 
script that is available on the Program CD, and Server Inventory can be installed on Linux 
servers using a script that is available on the Program CD. However, Remote Management 
cannot be installed on Linux and Solaris.
Chapter 7, “Management and Monitoring Services Installation,” on page 131
Management and Monitoring Services can be installed on NetWare and Windows servers using 
a graphical interface that is run from the Program CD.
Management and Monitoring Services can also be installed on Linux and Solaris servers using 
a script that is available on the Program CD.

To upgrade a previous version of ZENworks to version 7, see Part IV, “Upgrade,” on page 139.

For issues dealing with interoperability between ZENworks Server Management and ZENworks 
Desktop Management, see Part V, “Interoperability,” on page 263.

If you want to reinstall ZENworks 7 Server Management (which resets configuration information), 
for NetWare and Windows servers you can use the GUI installation program; for Linux and Solaris 
servers you should use the installation script (see Section 6.3, “Installation on Linux and Solaris 
Servers,” on page 114).
Installation 63



64 Novell

novdocx (en)  16 A
pril 2010
 ZENworks 7 Server Management Installation Guide



6
novdocx (en)  16 A

pril 2010
6Policy-Enabled Server 
Management Installation

This section provides instructions to help you install Novell® ZENworks® 7 Policy-Enabled Server 
Management (Policy and Distribution Services, Server Inventory, and Remote Management) where 
ZENworks has not been previously installed.

If any version of ZENworks Server Management exists on any of your servers, you must upgrade 
those servers. For instructions, see Part IV, “Upgrade,” on page 139.

New in ZENworks 7 is the ability to install Policy and Distribution Services to a workstation. For 
more information, see Section 6.2, “Installation on Windows Workstations,” on page 101.

If you have a mixed operating system environment (such as NetWare, Windows, and Linux or 
Solaris), you should install to the NetWare® and Windows servers first, because you may need the 
eDirectoryTM instance installed on the NetWare or Windows server for creating the ZENworks 
eDirectory objects.

You can also use the installation program to reinstall a clean version of ZENworks 7 over itself, such 
as for resetting a test environment, because reinstalling resets configurations to the defaults that you 
establish when running the installation program.

Use the following sections to install ZENworks 7 Server Management:

Section 6.1, “Installation on NetWare and Windows Servers,” on page 65
Section 6.2, “Installation on Windows Workstations,” on page 101
Section 6.3, “Installation on Linux and Solaris Servers,” on page 114
Section 6.4, “Post-Installation Tasks,” on page 117

6.1  Installation on NetWare and Windows 
Servers
If you are installing only to workstations, go to Section 6.2, “Installation on Windows 
Workstations,” on page 101.

The following sections provide instructions for installing Policy-Enabled Server Management to 
NetWare or Windows servers:

Section 6.1.1, “Policy-Enabled Server Management,” on page 65
Section 6.1.2, “Web-Based Management for Policy and Distribution Services,” on page 96

6.1.1  Policy-Enabled Server Management
To install Policy-Enabled Server Management, do the following in order:

1. “Pre-Installation Checklist” on page 66
2. “Starting the Installation Program” on page 68
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3. “Extending the Schema” on page 69
4. “Policy-Enabled Server Management” on page 73
5. “eDirectory Tree for Creating Objects” on page 76
6. “Server Selection” on page 77
7. “File Installation Locations and Options” on page 83
8. “Distributor Object Properties” on page 84
9. “Subscriber Object Properties” on page 86

10. “Database Settings” on page 88
11. “Inventory Standalone Configuration” on page 89
12. “Inventory Proxy Service Configuration” on page 90
13. “Remote Management Configuration” on page 91
14. “Policy and Distribution Services Database Logging” on page 92
15. “Installation Summary” on page 93
16. “Verifying That the Policy and Distributions Services Agents Are Loaded” on page 94

Pre-Installation Checklist

Review the Readme for any last-minute information concerning installation.

Readme_servers.html is located in the \readmes\en directory on the Novell ZENworks 7 
Server Management with Support Pack 1 Program CD, and is also accessible from an 
installation menu option.
Make sure you have fulfilled all of the installation requirements in Part II, “Preparation,” on 
page 27.
If you are also installing Policy and Distribution Services remotely to workstations, the target 
workstations must have one of the following Windows operating systems installed:

Windows 2000 SP4 or later
Windows XP SP1 or later
The Novell ClientTM is not required to be installed or running on workstations where you install 
to them remotely.
To install from a hard drive instead of the Program CD, copy the CD structure to a location on 
your installation machine’s hard drive.
We recommend that you install Server Management from the Program CD.

IMPORTANT: If you copy the Program CD structure to the installation machine’s hard drive, 
the path between the root of the hard drive and the first CD directory can contain only directory 
names that conform to the 8.3-character DOS file naming convention. If any long directory 
names exist in the path, the installation program does not work.

If you are reinstalling Server Inventory, you must perform the following tasks before 
reinstalling:
1. Identify the servers that need Server Inventory reinstalled.
2. Stop the Inventory service.

On a NetWare Inventory server: At the server console prompt, enter:
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sys:\system\invstop.ncf

NOTE: If you do not want the Sybase database to be stopped automatically when you 
stop the Inventory services, comment out the Unload dbsrv8.nlm line in the 
sys:\system\invstop.ncf file.

On a Windows 2000/2003 Inventory server: In the Control Panel, double-click 
Administrative Tools > Services, right-click Novell Inventory Service, then click Stop.

3. Stop the Inventory database.
On NetWare: At the Sybase console prompt, press the Q key.
On Windows 2000/2003: In the Control Panel, double-click Administrative Tools > 
Services, right-click Novell Database - Sybase, then click Stop.

4. If Java has not been unloaded on the target NetWare servers, unload java.nlm (at the server 
console, enter java -exit).
Because this command stops all Java processes running on the server, verify that all Java 
processes can be stopped while you are installing Server Management.
If you have any instance of Novell ConsoleOne® running on a target server via a mapped drive 
from a workstation, or running from the installation machine, exit those instances of 
ConsoleOne before running the installation program.
If ConsoleOne is running on a target server via a mapped drive on your installation machine, or 
it is running from the installation machine, the ZENworks Server Management snap-ins for 
ConsoleOne fails to be installed at those locations.
On the workstation you use to install Server Management, if you have not already done so, log 
in to all eDirectory trees where you are installing the Server Management software.
Authentication: You are automatically authenticated to all of the target NetWare servers in the 
trees you are logged in to during installation, so that you can select those servers for installing 
the Server Management software.
Schema extension: You must extend the schema for ZENworks Server Management on one of 
these trees. Regardless of where a target server resides, its associated Distributor or Subscriber 
object is created in the tree where you extended the schema.
Inventory trees: Make sure that the eDirectory trees with servers where you want to install the 
Inventory server or the Inventory database components have the ZENworks Server 
Management schema extended prior to installing the Inventory software.
Also, if you want to install Proxy Service along with other Server Inventory or Policy and 
Distribution Services components to different servers residing on different eDirectory trees, log 
into the tree having the server where you want to install the other Server Inventory or the Policy 
and Distribution Services components.
If you install software to any Windows servers, make sure you have authenticated to the servers 
or a domain containing the servers.
This enables you to select Windows servers for installing the Distributor and Subscriber 
software. However, if you are not logged in to a Windows server before starting the installation, 
you can authenticate during installation using a username and password in the Add Server 
dialog box where you select the Windows server for installation.
If you install software to any Windows servers, make sure you have closed the Services 
window on each Windows server.
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The installation program automatically stops all ZENworks Server Management services. 
However, the Server Management services cannot be registered if the Services window is left 
open during installation to the server.
If you are installing the Inventory server component, make sure that the name of the target 
server and the tree in which the server resides does not contain the # character.

Continue with “Starting the Installation Program” on page 68.

Starting the Installation Program

1 Do one of the following to display the main installation menu:
On the installation machine, insert the Novell ZENworks 7 Server Management with 
Support Pack 1 Program CD.
The main menu is displayed. If it is not automatically displayed after inserting the CD, run 
winsetup.exe at the root of the CD.

If you copied the contents of the Program CD to a hard drive, run winsetup.exe from 
that hard drive location.

IMPORTANT: If you copied the Program CD structure to the installation machine’s hard 
drive, the path between the root of the hard drive and the first CD directory can contain 
only directory names that conform to the 8.3-character DOS file naming convention. If 
any long directory names exist in the path, the installation program does not work.

2 Select the Server Management option.
3 Continue with “Extending the Schema” on page 69.
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Extending the Schema

The schema must be extended on the eDirectory tree where you want to create the ZENworks 
objects.

You can also update a 90-day Evaluation License to a full license by identifying the tree where 
ZENworks objects have been created and entering a license code.

Figure 6-1   ZENworks Server Management Installation Menu

To extend the schema:

1 Select the Server Management option to display the ZENworks Server Management menu.
2 To extend the schema for ZENworks Server Management objects, click Schema Extensions and 

Product Licensing to display the ZENworks License Agreement page.
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3 If you agree with the Software License Agreement, click Accept > Next to display the 
eDirectory Tree for Creating Objects page; otherwise, click Decline > Cancel to exit.
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4 Select the tree where you want the ZENworks objects created, then click OK to display the 
ZENworks Server Management Licensing page.
The Login button allows you to log into the tree if you are not already authenticated.
ZENworks Server Management schema extensions need to be done only once per tree. If you 
have multiple trees, you need to extend the schema only on the trees where you are installing 
the ZENworks objects.
Schema extensions for all ZENworks Server Management components (Policy and 
Distribution Services, Server Inventory, Remote Management, and Management and 
Monitoring Services) are installed at the same time when extending the schema.

5 Enter a license code, or leave the field blank and click Next to display the Summary page.
You should have received the license code when you purchased the product. If not, contact 
Novell, Inc. (http://www.novell.com/licensing).
If you leave the field blank, the 90-day Evaluation License is in effect. You can enter a license 
code at a later date. For more information, see Appendix B, “Upgrading a 90-day Evaluation 
License,” on page 315.
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6 To extend the schema, click Finish.
After the schema extension process has completed, the Server Management installation menu is 
displayed.

7 Continue with “Policy-Enabled Server Management” on page 73.
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Policy-Enabled Server Management

Figure 6-2   ZENworks Server Management Installation Menu

1 Click Policy-Enabled Server Management to start the installation program.
The License Agreement page is the first installation page displayed when the program has 
loaded.
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2 If you agree with the Software License Agreement, click Accept > Next to display the 
Installation Type page; otherwise, click Decline > Cancel to exit.
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3 On the Installation Type page, click Next to perform a new installation and display the 
Installation Options page.
or
To install from a saved installation configuration file, click Template Installation, browse for or 
specify the path and filename, then click Next.
The configuration file populates the remaining wizard pages from the installation settings you 
previously established when saving the file. This allows you to more quickly rerun the 
installation when you need to make only a few or no changes to the settings in order to install.

4 On the Installation Options page, click Next to accept the defaults and display the eDirectory 
Tree for Creating Objects page, or configure the options, then click Next.

Create eDirectory objects: For a first-time installation, this check box must be selected. 
Other uses for this option are:

Select this check box to reinstall Distributor software. This is required for re-creating 
the Distributor’s eDirectory object.
Select this check box to install additional Subscribers. This creates the Subscriber’s 
eDirectory object, installs its Subscriber software, and assigns its trusted tree to be 
the tree that you select in the next installation page.
Deselect this check box to only reinstall Subscriber software, such as to a server that 
already had a Subscriber object created for it.
Deselect this check box to only install Subscriber software to a server that does not 
have a server object in any eDirectory tree, such as a Windows server that is in a 
Microsoft domain. You can identify its trusted tree in a later installation page.
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Deselect this check box to independently install the ConsoleOne snap-ins, the 
Inventory Agent, or the Proxy Service. You do not need to access an eDirectory tree 
to install these items.
Select this check box to install or reinstall the Inventory server or Inventory database.

Install software files: This check box must be selected to install the Distributor or 
Subscriber software. Other uses for this option are:

Deselect this check box when only installing eDirectory objects.
Deselect this check box when installing or reinstalling the Inventory server or 
Inventory database.

Pause file copying when necessary to display messages and report errors: By default, 
this check box is selected. Deselect this check box to have an unattended installation; you 
can check the installation logs later.

5 Continue with:
“eDirectory Tree for Creating Objects” on page 76, if the Create eDirectory Objects check 
box is selected.
“Server Selection” on page 77, if the Create eDirectory Objects check box is deselected.

eDirectory Tree for Creating Objects

This page is displayed only if you selected the Create eDirectory Objects option on the Installation 
Options page.

Figure 6-3   eDirectory Tree for Creating Objects Page

1 Browse for the target tree, click OK > Next to display the Server Selection page.
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This is the tree where you want the ZENworks objects to be created during installation.
This installation page displays only if you selected installation of ZENworks Server 
Management objects.
This automatically becomes the trusted tree for all Subscriber servers selected in the next 
installation page. The trusted tree is where the Subscriber receives its configuration updates.

IMPORTANT: If you selected the Create eDirectory Objects check box on the Installation 
Options page, both NetWare and Windows servers will have eDirectory Subscriber objects 
created in the tree that you identified in the eDirectory Tree for Creating Objects page. 
However, if you deselected this check box, you should identify a trusted tree for each 
Subscriber in the File Installation Paths and Options page.
On the File Installation Paths and Options page, you can create different configurations for 
different sets of objects. Therefore, you can select objects that might have different installation 
paths and different trusted trees.
For more information on trusted trees, see “Subscriber Software Configuration and Trusted 
Trees” in the Novell ZENworks 7 Server Management Administration Guide.

2 Continue with “Server Selection” on page 77.

Server Selection

Figure 6-4   Server Selection for Server Management Page

1 On the Server Selection page, if you installed ConsoleOne on your installation machine, enable 
the ConsoleOne snap-ins check box for the Local Machine option.
Local Machine refers to the Windows machine you are using to perform the installation.
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Workstation:  If Local Machine is a Windows 2000/XP workstation, you can install the 
ZENworks Server Management ConsoleOne snap-ins for Policy and Distribution Services, 
Server Inventory, and Remote Management. You can also install the Policy and Distribution 
Services Subscriber software to the local machine; however, you cannot install the Distributor 
software, Server Inventory, or Remote Management to the local machine.
Server:  If Local Machine is Windows 2000 Server (with or without eDirectory installed), you 
can install the following:

ZENworks Server Management ConsoleOne snap-ins for Policy and Distribution 
Services, Server Inventory, and Remote Management
Policy and Distribution Services Subscriber software
Remote Management Agent
Inventory Agent
Inventory Proxy service
Inventory database

IMPORTANT: If you choose to install the Inventory database on a server without 
eDirectory installed, the database objects are not created automatically. You must 
manually create the database objects. For more information, see “Setting Up the Inventory 
Database” in the Novell ZENworks 7 Server Management Administration Guide.

The Inventory server can only be installed on a Windows server that also has eDirectory 
installed.

2 On the Server Selection page, click Add Servers to display the Add Servers dialog box.

For more information on using the Add Servers dialog box, click its Help button.
3 Browse for the servers and workstations where you want to install Server Management 

software, then click OK.
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IMPORTANT: You cannot add a cluster object using this field, or you will receive an 
“Unknown Host” error. Instead, add cluster objects by browsing for the objects and adding 
them into the Available Servers list box.

The selected machines are displayed below the Local Machine option on the server selection 
page.
Add Servers dialog box:  The Add Servers option displays the Add Servers dialog box, where 
you can browse for both NetWare and Windows servers and Windows workstations by 
selecting either NetWare trees or Microsoft domains from a drop-down box. You can select 
machines individually or in multiples (using Ctrl and Shift). You can also select groups of 
machines by selecting eDirectory containers, Windows workgroups, and Microsoft domains.

To install to a Windows server or workstation that does not have the Novell Client running 
on it (and therefore you cannot install to it locally), browse for and select this Windows 
server or workstation so that you can include it separately in the list for installing 
ZENworks.
The Inventory server can only be installed on a Windows server that also has eDirectory 
installed.
You can choose to install the Inventory database on a server that does not have eDirectory 
installed, but the database objects are not created automatically. You must manually create 
the database objects. For more information on how to manually create the database 
objects, see the Novell ZENworks 7 Server Management Administration Guide.
Make sure you have selected all of the NetWare and Windows servers and workstations 
before exiting the Add Servers dialog box.
Also browse for the workstations where you want the ConsoleOne snap-ins installed. You 
must have previously installed ConsoleOne to each of these workstations.

IMPORTANT: If you choose to remotely install the Inventory Agent or the Remote 
Management Agent on Windows Server 2003 configured as Domain Controller, you must 
specify the hostname or the IP address of the server in the Add Server Via Hostname/IP Address 
field.

External Subscribers: The installation program requires an eDirectory context for placing 
Subscriber objects. If you add a Windows server or workstation from a Microsoft domain that 
does not have an eDirectory object, in another installation page you are asked to browse and 
select an eDirectory context where the Subscriber object can be created and associated with the 
Windows server or workstation.
However, if you intend for this Windows machine to be used only as an External Subscriber, do 
not install the Subscriber object and software at this time. Instead, you can later install the 
Subscriber software locally on that machine (which does not have a Subscriber object), then 
create the External Subscriber object for it in ConsoleOne. For more information on External 
Subscribers, see “External Subscribers” in the Novell ZENworks 7 Server Management 
Administration Guide.

4 Configure each server and workstation listed on this page.
You can configure a group of selected servers with the same options by selecting the group and 
right-clicking the group. This displays the Custom Selection dialog box illustrated below:
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When you select a role for the group, it applies to each server where it’s applicable. Repeat 
selecting groups and roles as necessary.
You cannot configure a group of selected workstations by selecting the group and right-clicking 
the group. The Custom Selection feature only works for servers.
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The following options are available for each server listed, as shown above. (Workstations only 
have the ConsoleOne and Policy and Distribution Services server options available.)
ZENworks Policy-Enabled Management Services 
The following three options are all selected by default:

Policy and Distribution Services server: Select this check box for each server and 
workstation that you want to be a Subscriber.
Inventory Agents: Select this check box for each server that you want to inventory.
If you want to install the Inventory Agent, you must also select the Policy and 
Distribution Services server option.
Remote Management: Select this check box for each server that you want to remotely 
manage.

Additional Options 
The installation program detects whether these options are already installed on a target server 
and dims the option label. You can still select the check box to reinstall the component.

Distributor: The Subscriber service is installed automatically to all target servers. Select 
this check box to also make a server a Distributor.
Server Management database: This is the Policy and Distribution Services database that 
the Distributor logs to. You should install it on the same server as the Distributor in order 
to minimize network traffic for database logging.
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IMPORTANT: You can install the database to multiple servers per run of the installation 
program; however, you can only install one database per server. On the Database Settings 
page, you are able to individually configure each database that is being installed. On the 
Database Logging page, you can identify which of the databases being installed is to be 
the one database for initial logging.

Inventory database: Select this check box for the servers where you want to install the 
Inventory database to run on Sybase.

IMPORTANT: If you want to use the Inventory database with an existing Oracle or MS 
SQL setup, do not select this option during the Server Inventory installation. Follow the 
steps in “Setting Up the Inventory Database” in the Novell ZENworks 7 Server 
Management Administration Guide.

Inventory server: Select this check box for the server where you want to run the 
Inventory services.

WARNING: If you choose to install on servers in which you have logged into but which 
do not reside in the tree you have selected in Step 1 on page 76, the installation program 
proceeds and creates eDirectory objects in the tree having the server.

Inventory Proxy server: Select this check box for the servers where you want to install 
and configure an XML Proxy server.
If you want to send or roll up the scan data to an Inventory server that is across the 
firewall, you must configure a NetWare or Windows server to run the XML Proxy service.
ConsoleOne snap-ins: For any server where you installed ConsoleOne, enable this check 
box.

IMPORTANT: ZENworks Server Management does not support using a server’s console 
to run an instance of ConsoleOne installed on that NetWare server. To use the server’s 
installation of ConsoleOne, you must map a drive from a workstation to that server and 
run ConsoleOne from the workstation.

5 When you have finished configuring the selected machines, click Next to display the File 
Installation Paths and Options page.
If you have invalid DNS names, you could receive an error message asking whether to continue 
installing using IP addresses. Either fix the DNS name problems, or continue by using IP 
addresses for the affected machines. For information on configuring DNS, see Appendix D, 
“Ensuring Successful DNS Name Resolution,” on page 335.

IMPORTANT: 1) During installation, ZENworks Server Management updates .ncf files with 
installation path information. Because NetWare uses a DOS code page instead of a Windows 
code page, double-byte or extended characters cannot be used in paths, or the .ncf files do not 
execute. Therefore, do not use double-byte or extended characters in any part of an installation 
path, including a NetWare volume name.
2) If you continue with only IP addresses, you must manually enter the correct DNS hostname 
on the Other tab in the server object’s properties for each server in order to use Server 
Management.

6 Continue with “File Installation Locations and Options” on page 83.
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File Installation Locations and Options

This page is displayed only if you chose the ZENworks Policy-Enabled Management Services 
option for one or more machines. This includes Policy and Distribution Services, Server Inventory, 
and Remote Management.

Figure 6-5   File Installation Paths and Options Page

1 Click Next to accept the defaults on the File Installation Locations and Options page, or 
configure the following fields, then click Next to display the Distributor Object Properties page.
Software installation volume/drive: If you change the beginning of the path to a different 
volume or drive, then all subsequent paths displayed in the installation program automatically 
matches your change.

IMPORTANT: Do not use double-byte or extended characters in any part of an installation 
path, including a NetWare volume name.

Each field on this page is configurable per machine. You can make configuration changes 
machine by machine, or select multiple machines and make the same configuration changes to 
all of them. For example, you might want the same installation volume for all of your NetWare 
servers.
Trusted tree: If you deselected installation of eDirectory objects for ZENworks Server 
Management, an empty Trusted tree field is displayed and must be filled in.
When you install the Subscriber software to a machine in another tree or in a Microsoft 
domain, and you do not want to create a Subscriber object in your Distributor’s tree, you must 
identify the trusted tree for the Subscriber.
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The trusted tree has two purposes:
To locate a Distributor that can give the Tiered Electronic Distribution configuration 
information to the Subscriber
To indicate which tree to accept policies from
If you do not select a tree to be recognized as the Subscriber’s trusted tree during 
installation of only the Subscriber software (no object installation), your Policy Package 
Distributions cannot extract and be enforced on that Subscriber, because policies often 
point to objects in a tree.

Launch Policy and Distribution Services on startup: Leave this check box selected to have 
the installation program configure the startup processes to automatically launch Policy and 
Distribution Services any time a server is started.
Start services when the installation is finished: Leave this check box selected, because the 
Subscribers’ passwords are reset when the service starts.

2 Continue with the applicable section for the installation page that is displayed next:
“Distributor Object Properties” on page 84
“Subscriber Object Properties” on page 86
“Database Settings” on page 88
“Inventory Standalone Configuration” on page 89
“Inventory Proxy Service Configuration” on page 90
“Remote Management Configuration” on page 91
“Policy and Distribution Services Database Logging” on page 92
“Installation Summary” on page 93

Distributor Object Properties

This page is displayed only if you chose the ZENworks Policy-Enabled Management Services 
option for one or more servers.
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Figure 6-6   Distributor Object Properties Page

You can change the default settings for Distributors individually, or in groups by selecting multiple 
Distributors listed in the left pane.

To change the defaults for any of the Distributors:

1 Select one or more Distributors in the left pane, then edit the following fields as necessary:
Object name: The default Distributor object name includes the server’s name.

IMPORTANT: Do not use double-byte or extended characters in object names.

If you want to rename the Distributor objects, we recommend that you maintain the 
servers’ identities in their names, including the fact that they are Distributors.
To rename each Distributor object, you need to repeat Step 1, because you cannot give the 
same object name to multiple Distributors.
Container: The location of the Distributor server’s NCP Server object is the default.
We recommend that you use the containers that you may have created for Distributor 
objects (see Section 3.3, “eDirectory Container Requirements,” on page 36).
Where eDirectory is not installed on a Windows server, that server will not have a default 
container object displayed. You must select a container for the Distributor object.
Working directory: For NetWare servers, the default working directory is on the sys: 
volume.
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If you change any part of the default path, such as a directory name, and that new entry 
does not yet exist on the server, the Distributor creates that new path the first time it needs 
to use it.
The default volume on a NetWare server is sys:. If the working directory has the potential 
to become quite large because you expect to have many very large Distributions and/or 
many revisions of large Distributions for this Distributor, we recommend that you specify 
a different volume. However, for most Distributors, you can retain the sys: volume.

2 Repeat Step 1 for each different Distributor or set of Distributors.
3 Click Next to display the Subscriber Object Properties page.
4 Continue with the applicable section for the installation page that is displayed next:

“Subscriber Object Properties” on page 86
“Database Settings” on page 88
“Inventory Standalone Configuration” on page 89
“Inventory Proxy Service Configuration” on page 90
“Remote Management Configuration” on page 91
“Policy and Distribution Services Database Logging” on page 92
“Installation Summary” on page 93

Subscriber Object Properties

This page is displayed only if you chose the ZENworks Policy-Enabled Management Services 
option for one or more machines.

Figure 6-7   Subscriber Object Properties Page
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You can change the default settings for Subscribers individually, or in groups by selecting multiple 
Subscribers listed in the left pane.

To change the defaults for any of the Subscribers:

1 Select one or more Subscribers in the left pane, then edit the following fields as necessary:
Object name: The default Subscriber object name includes the server’s or workstation’s 
name.

IMPORTANT: Do not use double-byte or extended characters in object names.

If you want to rename the Subscriber objects, we recommend that you maintain the 
servers’ or workstations’ identities in their names, including the fact that they are 
Subscribers.
To rename each Subscriber object, you need to repeat Step 1, because you cannot give the 
same object name to multiple Subscribers.
Container: The location of the Subscriber server’s NCP Server object is the default. If 
you select a workstation for installing Policy and Distribution Services (the Subscriber 
software), this field is blank for the workstation.
If you have created containers for Subscriber objects, we recommend using these 
containers (see Section 3.3, “eDirectory Container Requirements,” on page 36).
For ease of management, you should use the same context for all Subscriber servers of the 
same operating system type. For example, place all NetWare Subscriber servers’ objects 
under a NetWare container and all Windows Subscriber servers’ objects under a Windows 
container.
Where eDirectory is not installed on a Windows server, that server does not have a default 
container object displayed. You must select a container for the Subscriber object.
Working directory: If you change any part of the default path, such as a directory name, 
and that new entry does not yet exist on the server, the Subscriber creates that new path the 
first time it needs to use it.
For NetWare servers, the default working directory is on the sys: volume.
Working context: If you anticipate Desktop Application Distributions will be received by 
a Subscriber, browse for where you want related objects to be stored.
You can add a working context later in ConsoleOne for any Subscriber that receives 
Desktop Application Distributions.

2 Repeat Step 1 for each different Subscriber or set of Subscribers.
3 Click Next to display the Database Settings page.
4 Continue with the applicable section for the installation page that is displayed next:

“Database Settings” on page 88
“Inventory Standalone Configuration” on page 89
“Inventory Proxy Service Configuration” on page 90
“Remote Management Configuration” on page 91
“Policy and Distribution Services Database Logging” on page 92
“Installation Summary” on page 93
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Database Settings

This page is displayed only if you chose to install the Policy and Distribution Services database (the 
Server Management Database option) or the Server Inventory database (the Inventory Database 
option) on a server.

Figure 6-8   Database Settings Page

1 Click Next to accept the defaults, or for each database being installed, edit the applicable fields:

TIP: You can multiple-select databases to provide the same information for each of them.

Database path: The default for NetWare servers is sys: and for Windows servers is C:. You 
can change either of these defaults.

IMPORTANT: We strongly recommend that for the Server Management database on NetWare 
servers, you change sys: to another NetWare volume, because database files can become very 
large.

Object name: The default name is Server Management Database_server_name, which you can 
change. However, if you select the same container for all database objects, each must have a 
unique object name.
A database object is not created for the Server Inventory database.
Container: The default container is where the server’s NCP Server object resides. We 
recommend that you use the container that you created for database objects in Section 3.3, 
“eDirectory Container Requirements,” on page 36.
For ease of management, we also recommend that you place all database objects in the same 
container.
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2 Click Next and continue with the applicable section for the installation page that is displayed 
next:

“Inventory Standalone Configuration” on page 89
“Inventory Proxy Service Configuration” on page 90
“Remote Management Configuration” on page 91
“Policy and Distribution Services Database Logging” on page 92
“Installation Summary” on page 93

Inventory Standalone Configuration

This page is displayed only if you chose to install Inventory Server and the Inventory Database on 
the same server.

Figure 6-9   Inventory Standalone Configuration Page

1 To automatically create the Server Package and start the Inventory Services, click the 
Configure standalone box to enable it.
You can select one or more Inventory servers in the left pane to have the same configuration.

IMPORTANT: If you have already configured Server Package policies for these servers, do 
not enable the Configure standalone check box. You can manually configure the policy to act 
as a standalone feature wherever applicable.

2 To specify the container for the Server Package object, browse for and select the container.
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You can select one or more Inventory servers in the left pane to assign the same container for 
creating the Server Package.

3 Continue with the applicable section for the installation page that is displayed next.
“Inventory Proxy Service Configuration” on page 90
“Remote Management Configuration” on page 91
“Policy and Distribution Services Database Logging” on page 92
“Installation Summary” on page 93

Inventory Proxy Service Configuration

This page is displayed only if you chose the Inventory Proxy Server option for one or more servers.

Figure 6-10   Inventory Proxy Service Configuration Page

1 To configure the port number of the Inventory Proxy service, if you do not use the default port 
of 65000, specify the port number in the Proxy port field.
You can select one or more Inventory Proxy servers in the left pane to assign the same port 
number.
You must specify a value between 0 and 65535. Ensure that the port number is not used by 
other services on the server.

2 Continue with the applicable section for the installation page that is displayed next.
“Remote Management Configuration” on page 91
“Policy and Distribution Services Database Logging” on page 92
“Installation Summary” on page 93
 ZENworks 7 Server Management Installation Guide



novdocx (en)  16 A
pril 2010
Remote Management Configuration

This page is displayed only if you chose the Remote Management option for one or more Windows 
servers.

Figure 6-11   Remote Management Configuration Page

Use this dialog box to configure the password for the Remote Management Agent and install Mirror 
Driver on the managed server. You can either use the default password or specify a password.

1 To set the default password for the Remote Management Agent, select the Use default 
password check box. The default password is “novell.”

2 To use a password other than the default password, specify another password in the Password 
field.
If a previous installation of ZENworks 7 Remote Management Agent is detected on the 
machine and a password is set, the Password field is not displayed. 
This password is used for establishing a Remote Management session with the managed 
servers. 
Use a password of ten or fewer ASCII (non-extended) characters. The password is case 
sensitive and cannot be blank. You can choose to proceed without specifying any password, but 
you will not be able to establish the Remote Control session with the server.

3 You can install Mirror Driver only if your target server is a Windows 2000/2003 server. The 
Mirror Driver option provides video adapter independence and coexistence with other Remote 
Control solutions. If this check box is selected, InstallShield overrides video driver checks and 
suppresses any Windows messages. If you do not want this driver, you can deselect it 
(optimization is disabled).
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IMPORTANT: Mirror Driver is not yet signed by Microsoft.

4 Continue with the applicable section for the installation page that is displayed next:
“Policy and Distribution Services Database Logging” on page 92
“Installation Summary” on page 93

Policy and Distribution Services Database Logging

This page is displayed if you chose to install the Policy and Distribution Services database (the 
Server Management database option) on a server, or if you are installing Policy and Distribution 
Services on a workstation, because its Subscriber needs to know where to log its information to.

This page eliminates the need to configure a ZENworks Database policy (in the Service Location 
Package) for the Distributor being installed, so that Server Management can begin logging to a 
database immediately after installing. At your convenience after installation, you can set up any 
other installed databases by configuring Service Location Packages for each of them so that they can 
be used by their Distributors.

Figure 6-12   Policy and Distribution Services Database Logging Page

1 To determine logging for a Server Management database that you configured in a previous 
installation page, select one of the following:
Log to an existing Server Management database: Select an existing database file for 
logging by browsing for and selecting the database object, rather than log to one of the 
databases being installed.
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Log to a Server Management database that will be installed: One of the database objects 
that you configured in a previous installation page is displayed. However, you can select a 
different database object that is being installed by clicking the down-arrow. This option is not 
available for a workstation installation of the Subscriber software.
Do not log to a Server Management database: You can elect to not log to a database at this 
time, even though you have configured a database in the previous installation page.

2 Click Next to continue with “Installation Summary” on page 93.

Installation Summary

Figure 6-13   Installation Summary Page

1 To save the current installation configuration for future use, click the Save the following 
configuration check box, then specify a path and filename for the template file.
You can use this template file to repeat the ZENworks Server Management installation. It can 
save time in re-entering information and re-selecting servers and workstations. When you rerun 
the installation using a template, you can make changes to the fields and selected servers and 
workstations in the installation pages that are populated by the template.

2 On the Installation Summary page, click Finish to begin the installation process.
You can click Back to make changes if you discover errors or omissions in the summary.

3 After the installation program has finished, review the installation log file to determine whether 
any components failed to install.
The log file is located in the installation machine’s temporary directory as determined in its 
Windows environment settings. For example:
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c:\temp\_resnnn.txt

where nnn is increased incrementally each time a new installation log is created.
If you receive error messages during installation, see Appendix H, “Installation Error 
Messages,” on page 373.

4 If necessary, rerun the installation program.
Select only the components that failed to install.
A reinstallation does not require the schema to be extended again.

5 After successfully installing the software, click Exit to close the main installation program.
At this time, Server Management objects have been created, the software is installed, and the 
Server Management agents should be starting.

6 To verify that the ZENworks processes are running, continue with “Verifying That the Policy 
and Distributions Services Agents Are Loaded” on page 94.

The following NetWare registry entries are made in \\my 
server\software\novell\ZENWORKS\zfs\:

PDS
PDSDB
Inventory Database Server
RconsoleJ Agent for NetWare
Inventory Server
Inventory Agent

Verifying That the Policy and Distributions Services Agents Are Loaded

To verify that the Policy and Distributions Services agents are running on the target servers and 
workstations:

“Verifying on NetWare Servers” on page 94
“Verifying on Windows Servers and Workstations” on page 95

Verifying on NetWare Servers

To verify if ZENworks Server Management is running properly on a NetWare server:

1 On the target server’s console, press Ctrl+Esc to view the loaded software programs, such as:

ASA 8.0.3 ...
ZENworks (if Policy and Distribution Services is installed)
ZENworks Inventory Service
ZENworks Web Server (if only Inventory Server or Inventory Proxy Service is installed)

2 If the ZENworks service is not displayed, review the following file:
\zenworks\zfs-startup.log

This file contains information about why the agent did not start. Use this information to 
reinstall ZENworks Server Management to the server.
This file is used to log startup problems only.

3 Repeat Step 1 and Step 2 for each NetWare server.
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4 If necessary, rerun the installation program (see “Starting the Installation Program” on 
page 68).

5 Continue with the next applicable section:
If you have installed to Windows servers, continue with “Verifying on Windows Servers 
and Workstations” on page 95.
To install the Policy and Distribution Services plug-ins for iManager, continue with 
Section 6.1.2, “Web-Based Management for Policy and Distribution Services,” on 
page 96.
Or, continue with Section 6.4, “Post-Installation Tasks,” on page 117.

Verifying on Windows Servers and Workstations

To verify if ZENworks Server Management is running properly on a Windows server or 
workstation:

1 On the target server or workstation, open the Control Panel, double-click Admin Tools > 
Services, then determine if the following services are running:

Novell Inventory Service
Novell Database - Sybase
Novell ZENworks Service Manager 1

1 This is the only service to look for where you have installed the Subscriber software on a 
workstation.

2 If the services are not displayed, do the following:
2a Close the Services window.
2b Click Start > Run, then enter the following command:

zenworks\pds\bin\dservices.bat

This stops the ZENworks Server Management services and unregisters them. This is done 
to make sure a clean state exists for registering the services.

2c Click Start > Run, then enter the following command:
zenworks\pds\bin\sservices.bat

This registers the ZENworks Server Management services.
2d Open the Control Panel, double-click Admin Tools > Services, then start the services by 

right-clicking each one and selecting Start.
3 Repeat Step 1 and Step 2 for each Windows server or workstation.
4 If necessary, rerun the installation program (see “Starting the Installation Program” on 

page 68).
5 Continue with the next applicable section:

To install the Policy and Distribution Services plug-ins for iManager, continue with 
Section 6.1.2, “Web-Based Management for Policy and Distribution Services,” on 
page 96.
Or, continue with Section 6.4, “Post-Installation Tasks,” on page 117
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6.1.2  Web-Based Management for Policy and Distribution 
Services
You can use Novell iManager 2.0.2, 2.5 or 2.6 in addition to ConsoleOne 1.3.6 to make some Tiered 
Electronic Distribution administration and agent monitoring tasks easier. iManager enables you to 
perform Policy and Distribution Services tasks from any location where a supported version of 
Internet Explorer or Mozilla Firefox is available.

Using iManager, you can:

Create, modify, and delete Tiered Electronic Distribution objects (Distributor, Subscriber, 
Distribution, Channel, Subscriber Group, and External Subscriber).
View a graphical representation of your distribution system, which makes it easy to track a 
Distribution from Distributor to end node Subscriber, no matter how many parent Subscribers 
the Distribution passes through. This eliminates the need to visit each server or to read log files.
Display a browser-based console, called the Remote Web Console, for each Distributor Agent 
and Policy/Package Agent in your system. From the Remote Web Console, you can review the 
configuration of any agent, monitor the activities of any agent, and control many agent 
functions, such as forcing an action on a Distributor, Subscriber, or Policy Package to happen 
immediately, or monitoring the status of a Distribution, Subscriber, or Policy Package.

The iManager plug-ins shipped with ZENworks 7 work with iManager 2.0.2, 2.5, and 2.6.

To install Novell iManager 2.6, see Section 4.3, “Management-Specific Workstation Requirements,” 
on page 42.

The processes for installing the iManager plug-ins is different for iManager 2.0.2 and iManager 2.5 
or 2.6 in ZENworks 7 with SP1 and earlier:

“Installing the Plug-ins to iManager 2.0.2” on page 96

IMPORTANT: If you installed iManager to a Linux or Solaris server, you can use this GUI 
installation program to install the Policy and Distribution Services plug-ins to iManager on the 
Linux or Solaris server.

“Installing the Plug-ins to iManager 2.5 or 2.6” on page 101

Installing the Plug-ins to iManager 2.0.2

To install the Policy and Distribution Services plug-ins for iManager:

1 Make sure that Tomcat and iManager are loaded on the server where you install the plug-ins.
If these processes are not running on this server, the authentication performed when clicking 
Next in Step 5 fails.

2 Do one of the following to display the main installation menu:
On the installation machine, insert the Novell ZENworks 7 Server Management with 
Support Pack 1 Program CD.
The startup page is displayed. If the startup page is not automatically displayed after 
inserting the CD, run winsetup.exe at the root of the CD.
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If you copied the contents of the Program CD to a hard drive, run winsetup.exe from 
that hard drive location.
If you copied the Program CD structure to the installation machine’s hard drive, the path 
between the root of the hard drive and the first CD directory can contain only directory 
names that conform to the 8.3-character DOS file naming convention. If any long 
directory names exist in the path, the installation program does not work.

3 Click Web-based management components to display the License Agreement page.
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4 Accept the License Agreement, then click Next to view the Login Information page.
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5 Fill in the fields:

IMPORTANT: Tomcat and iManager must be loaded on the specified server in order for 
authentication of the following information to succeed.

DNS/IP address: Specify the address of the server where iManager is installed.
Port: Specify the port number to use when communicating with iManager. It will most likely 
be 443 if SSL is used; if not, use 8080.
Use SSL: By default, this check box is not selected. If you have iManager configured to use 
SSL, you should enable this check box.
iManager username: Specify the iManager (fully-distinguished) login name of the user with 
rights to iManager. This must be entered in the format indicated (for example, 
cn=admin.o=novell). Installation cannot continue if the username does not authenticate.
iManager password: Specify the iManager password of the user running the installation 
program.
Install the Policy and Distribution Services plug-ins to Novell iManager: Select the check 
box to install the Remote Web Console and Tiered Electronic Distribution plug-ins to iManager 
so that you can manage these components from a Web browser.
Install the ZENworks certificate authority: Select the check box to install the ZENworks 
certificate authority servlet for inter-server communications security. This provides additional 
security to ensure that data received from outside your secured network is from a trusted 
source, that it has not been tampered with en route, and that the data received can be trusted by 
other machines. This is accomplished through the use of signed security certificates and digital 
signatures.

6 Click Next to view the Summary page.
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The installation summary indicates that the selected Web components are installed to the 
Tomcat installation directory.

7 Click Finish.
8 When the installation has completed, click Yes to view the installation log file.

If the log file contains errors, you can print it for reference. To look up error messages, see 
Appendix H, “Installation Error Messages,” on page 373. Correct the error, then repeat the 
installation steps.
The ZENworks Server Management role in iManager should still be set up, because the 
information for it is stored in eDirectory.
To reinstall the Novell Certificate Signer, follow the instructions in the Novell ZENworks 7 
Server Management Administration Guide.

9 After successfully installing the iManager plug-ins, close the log file.
10 For iManager to recognize the new plug-ins, stop Tomcat, then restart Tomcat:

NetWare 
Stop: tc4stop.ncf
Start: tomcat4.ncf
Windows 
In the Services window, start or stop the Tomcat service by right-clicking the service and 
selecting the option.
Linux 
Restart: /etc/init.d/tomcat4 restart
or
Stop: /etc/init.d/tomcat4 stop
Start: /etc/init.d/tomcat4 start
OES Linux 
Restart: /etc/init.d/novell-tomcat4 restart
or
Stop: /etc/init.d/novell-tomcat4 stop
Start: /etc/init.d/novell-tomcat4 start

11 Continue with the next applicable section:
If you performed this iManager installation task while upgrading, return to “Upgrade the 
Novell iManager Plug-Ins” on page 209.
To install Policy and Distribution Services (Subscriber only) locally on a Windows 
workstation, or remotely to several Windows workstations, continue with Section 6.2, 
“Installation on Windows Workstations,” on page 101.
To install on Linux or Solaris servers, continue with Section 6.3, “Installation on Linux 
and Solaris Servers,” on page 114
If you do not install on Linux or Solaris servers, continue with Section 6.4, “Post-
Installation Tasks,” on page 117
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Installing the Plug-ins to iManager 2.5 or 2.6

1 Locate the Novell iManager plug-in module (NPM) on the Novell ZENworks 7 with Support 
Pack 1 Companion 1 CD:
\Novell iManager\ZFS Plugins NPM\ZFS_PolyDistPlugins.npm

2 Follow the instructions in your iManager documentation to install the NPM:
iManager 2.5: see the Novell iManager 2.5 Installation Guide (http://www.novell.com/
documentation/imanager25/)
iManager 2.6: see the Novell iManager 2.6 documentation (http://www.novell.com/
documentation/imanager26/) 

3 Continue with the next applicable section:
If you performed this iManager installation task while upgrading, return to “Upgrade the 
Novell iManager Plug-Ins” on page 209.
To install Policy and Distribution Services (Subscriber only) locally on a Windows 
workstation, or remotely to several Windows workstations, continue with Section 6.2, 
“Installation on Windows Workstations,” on page 101.
To install on Linux or Solaris servers, continue with Section 6.3, “Installation on Linux 
and Solaris Servers,” on page 114
If you do not install on Linux or Solaris servers, continue with Section 6.4, “Post-
Installation Tasks,” on page 117

6.2  Installation on Windows Workstations
Beginning with ZENworks 7, you have the option to install Policy and Distribution Services to a 
workstation. For locations where you need the Subscriber service, but do not have a server available, 
you can install the Policy and Distribution Services software (Subscriber only) to a workstation. 
This workstation can then act as a parent Subscriber to pass data on to other workstations in its 
locale.

For example, you need to transmit a file set across a slow WAN link to numerous workstations, but 
you do not have a server on the workstations’ side of the WAN link. Without a Subscriber server on 
that side of the WAN, you normally must transmit that same file set repeatedly over the wire to each 
workstation. Instead, you can install the Subscriber software to a workstation. Then you only need to 
transmit that file set once over the wire to this Subscriber workstation, and let the Subscriber 
software retransmit it to each of the other workstations.

Remote Management and Server Inventory cannot be installed on a workstation using this 
installation. If you want Remote Management to be installed on the workstation, use the ZENworks 
Desktop Management installation options. For more information, see “Manually Installing the 
Desktop Management Agent” in the Novell ZENworks 7 Desktop Management Installation Guide.

Review the prerequisites before installing:

Section 6.2.1, “Prerequisites for a Workstation Installation,” on page 101
Section 6.2.2, “Installing to the Workstation,” on page 102

6.2.1  Prerequisites for a Workstation Installation
Review the Readme for any last-minute information concerning installation.
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Readme_servers.html is located in the \readmes\en directory on the Novell ZENworks 7 
Server Management with Support Pack 1 Program CD, and is also accessible from an 
installation menu option.
The target workstation must have one of the following Windows operating systems installed:

Windows 2000 SP4 or later
Windows XP SP1 or later
If you are installing locally to the workstation, you must have the Novell Client installed and 
running in order for the installation program to run.
You do not need the Novell Client on the target workstations that you are installing to remotely.
ConsoleOne 1.3.6 installed (but only if you optionally select to install the ZENworks 7 Policy 
and Distribution Services snap-ins to the workstation)
If you have any instance of Novell ConsoleOne running on a target server via a mapped drive 
from a workstation, or running from the installation machine, exit those instances of 
ConsoleOne before running the installation program.
If ConsoleOne is running on a target server via a mapped drive on your installation machine, or 
it is running from the installation machine, the ZENworks Server Management snap-ins for 
ConsoleOne are not installed at those locations.
70 MB free disk space for the installation of the ConsoleOne snap-ins
If you install remotely to a workstation, make sure that on the installation machine you have 
authenticated to the workstation or to a domain containing the workstation.
This enables you to select Windows workstations for installing the Subscriber software. 
However, if you are not logged in to a Windows workstation before starting the installation, 
you can authenticate during installation by providing a username and password in the Add 
Server dialog box where you select the Windows workstation for installation.

Continue with Section 6.2.2, “Installing to the Workstation,” on page 102.

6.2.2  Installing to the Workstation
This installation can be performed locally on a Windows machine, or remotely from an installation 
workstation. Both options are covered in the following steps.

You can also use this installation to reinstall to the workstation if the Subscriber software becomes 
corrupted.

To install the Policy and Distribution Services Subscriber software:

1 On an installation workstation to install the Subscriber software remotely, or on the workstation 
where you want to locally install the Subscriber software, insert the Novell ZENworks 7 Server 
Management with Support Pack 1 Program CD.
The main menu is displayed. If it is not automatically displayed after inserting the CD, run 
winsetup.exe at the root of the CD.
 ZENworks 7 Server Management Installation Guide



novdocx (en)  16 A
pril 2010
2 Select the Server Management option.
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3 Click Policy-Enabled Server Management to start the installation program.
The License Agreement page is the first installation page displayed when the program has 
loaded.
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4 If you agree with the Software License Agreement, click Accept, then click Next to display the 
Installation Type page; otherwise, click Decline > Cancel to exit.
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5 On the Installation Type page, click Next to perform a new installation and display the 
Installation Options page.
or
To install from a saved installation configuration file, click Template installation, browse for or 
specify the path and the filename, then click Next.

6 On the Installation Options page, configure the installation options, then click Next.
Create eDirectory objects:  

For a first-time installation, this check box must be selected, unless you want the 
workstation to act as an External Subscriber.
For more information on External Subscribers, see “External Subscribers” in the 
Novell ZENworks 7 Server Management Administration Guide.
Deselect this check box if you only want to reinstall the Subscriber software, such as 
to a workstation that already has a Subscriber object created for it.
Deselect this check box if you only want to install the Subscriber software to a 
workstation that does not have an object in any eDirectory tree, such as a Windows 
server that is in a Microsoft domain. You can identify its trusted tree in a later 
installation page.

Install software files: Select this option to install the Subscriber software. If you are only 
installing eDirectory objects, deselect this check box.
Pause file copying when necessary to display messages and report errors: By default, 
this check box is selected. If you want to have an unattended installation (and review the 
installation logs later), deselect this check box.
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7 Browse for and select the target tree, click OK, then click Next to display the Server Selection 
page.
This is the tree where you want the ZENworks objects to be created during installation.
This automatically becomes the trusted tree for all Subscriber workstations selected in the next 
installation page. The trusted tree provides the Subscriber its configuration updates.

IMPORTANT: If you selected the Create eDirectory objects check box on the Installation 
Options page, the Windows workstations will have eDirectory Subscriber objects created in the 
tree that you identified in the eDirectory Tree for Creating Objects page. However, if you 
deselected this check box, you should identify a trusted tree for each Subscriber in the File 
Installation Paths and Options page.
On the File Installation Paths and Options page, you can create different configurations for 
different sets of objects. Therefore, you can select objects that might have different installation 
paths and different trusted trees.
For more information on trusted trees, see “Subscriber Software Configuration and Trusted 
Trees” in the Novell ZENworks 7 Server Management Administration Guide.
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8 If you want to install remotely to one or more workstations, on the Server Selection page, click 
Add servers to display the Add Servers dialog box; otherwise, skip to Step 11.

9 In the Add Servers dialog box, do any of the following to select the workstations:
Browse for the Windows workstations by selecting the Microsoft domains from a drop-
down list.
Select workstations individually or in multiples (using Ctrl and Shift).
Select groups of workstations by selecting Windows workgroups and Microsoft domains.
Specify a workstation by its IP address or DNS name.

Make sure that you have selected all of the Windows workstations before exiting the Add 
Servers dialog box.
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The selected workstations are displayed below the Local Machine option on the Server 
Selection page.
For more information on using the Add Servers dialog box, click its Help button.

10 Click OK to display the Server Selection page:

11 Configure the Local Machine option and each workstation listed on this page.
Local Machine refers to the Windows machine you are using to perform the remote installation, 
or the workstation where you are installing Server Management locally.
The following two options are available for the selected workstations and Local Machine:

ConsoleOne snap-ins: Select this check box to install the Policy and Distribution 
Services snap-ins to the instance of ConsoleOne located on the workstation.
You must have previously installed ConsoleOne 1.3.6 to the workstation.
Policy and Distribution Services server: Select this check box to install the Subscriber 
software on the workstation.

You cannot select and configure a group of workstations. The Custom Selection feature only 
works with a group of servers.

12 When you have finished configuring the selected workstations, click Next to display the File 
Installation Locations and Options page.
If you are not installing to a server, a warning is displayed. Click OK to continue.
If you have invalid DNS names, you could receive an error message asking whether to continue 
installing using IP addresses. Either fix the DNS name problems, or continue by using IP 
addresses for the affected workstations. For information on configuring DNS, see Appendix D, 
“Ensuring Successful DNS Name Resolution,” on page 335.
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13 Configure the options on the File Installation Locations and Options page:
Software installation volume/drive: If you change the beginning of the path to a different 
drive, then all subsequent paths displayed in the installation program automatically match your 
change.
Each field on this page is configurable per workstation. You can make configuration changes 
individually, or select multiple workstations and make the same configuration changes to all of 
them. For example, you might want the same installation drive for all of your workstations.
Trusted tree: If you deselected installation of eDirectory objects for ZENworks Server 
Management, the Trusted tree field is displayed and must be filled in.
When you install the Subscriber software to a workstation in another tree or in a Microsoft 
domain, and you do not want to create a Subscriber object in your Distributor’s tree, you must 
identify the trusted tree for the Subscriber workstation.
The trusted tree has two purposes:

To locate a Distributor that can give the Tiered Electronic Distribution configuration 
information to the Subscriber
To indicate which tree to accept policies from
If you do not select a tree to be recognized as the Subscriber workstation’s trusted tree 
during installation of only the Subscriber software (no object installation), your Policy 
Package Distributions cannot extract and be enforced on that Subscriber workstation, 
because policies often point to objects in a tree.

Launch Policy and Distribution Services on startup: Leave this check box selected to have 
the installation program configure the startup processes to automatically launch Policy and 
Distribution Services any time a workstation is started.
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Start services when the installation is finished: Leave this check box selected, because the 
Subscribers’ passwords are reset when the service starts.

14 Click Next to display the Subscriber Object Properties page:

15 Select one or more Subscribers in the left pane, then edit the following fields as necessary:
Object name: The default Subscriber object name includes the server’s name.

IMPORTANT: Do not use double-byte or extended characters in object names.

If you want to rename the Subscriber objects, we recommend that you maintain the 
servers’ identities in their names, including the fact that they are Subscribers.
To rename each Subscriber object, you need to repeat Step 1, because you cannot give the 
same object name to multiple Subscribers.
Container: The location of the Subscriber server’s NCP Server object is the default.
If you have created containers for Subscriber objects, we recommend using these 
containers (see Section 3.3, “eDirectory Container Requirements,” on page 36).
You should use the same context for all Subscriber servers of the same operating system 
type. For example, place all NetWare Subscriber servers’ objects under a NetWare 
container and all Windows Subscriber servers’ objects under a Windows container.
Where eDirectory is not installed on a Windows server, that server does not have a default 
container object displayed. You must select a container for the Subscriber object.
Working directory: For NetWare servers, the default working directory is on the sys: 
volume.
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If you change any part of the default path, such as a directory name, and that new entry 
does not yet exist on the server, the Subscriber creates that new path the first time it needs 
to use it.
Working context: (Optional) If you anticipate Desktop Application Distributions will be 
received by a Subscriber, browse for and select where you want related objects to be 
stored.
You can add a working context later in ConsoleOne for any Subscriber that receives 
Desktop Application Distributions.

16 Repeat Step 15 for each different Subscriber or set of Subscribers, then click Next to display the 
Database Logging page:

17 To determine logging for a Server Management database that you configured in a previous 
installation, select one of the following:
Log to an existing Server Management database: Instead of logging data to one of the 
databases that is being installed, select an existing database file for logging by browsing for and 
selecting the database object.
Log to a Server Management database that will be installed: This option is not available 
for a workstation installation of the Subscriber software.
Do not log to a Server Management database: You can elect to not log data to a database at 
this time, even though you have configured a database in a previous installation.

18 Click Next to continue with the Installation Summary page:
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19 To save the current installation configuration for future use, click the Save the following 
configuration check box, then specify a path and filename for the template file.
You can use this template file to repeat the ZENworks Server Management installation. It can 
save time in re-entering information and re-selecting workstations. When you rerun the 
installation using a template, you can make changes to the fields and selected workstations in 
the installation pages that are populated by the template.

20 On the Installation Summary page, click Finish to begin the installation process.
You can click Back to make changes if you discover errors or omissions in the summary.

21 After the installation program has finished, review the installation log file to determine whether 
any components failed to install.
The log file is located in the installation machine’s temporary directory as determined in its 
Windows environment settings. For example:
c:\temp\_resnnn.txt

where nnn is increased incrementally each time a new installation log is created.
If you receive error messages during installation, see Appendix H, “Installation Error 
Messages,” on page 373.

22 If necessary, rerun the installation program.
Select only the components that failed to install.

23 After successfully installing the software, click Exit to close the main installation program.
At this time, Server Management objects have been created, the software is installed, and the 
Server Management agents should be starting.
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24 To verify that the ZENworks processes are running, go to the target server, open the Control 
Panel, double-click Admin Tools > Services, then determine if the Novell ZENworks Service 
Manager service is running.
If the service is not displayed, do the following:
24a Close the Services window.
24b Click Start > Run, then enter the following command:

zenworks\pds\bin\dservices.bat

This stops the ZENworks Server Management services and unregisters them. This is done 
to make sure a clean state exists for registering the services.

24c Click Start > Run, then enter the following command:
zenworks\pds\bin\sservices.bat

This registers the ZENworks Server Management services.
24d Open the Control Panel, double-click Admin Tools > Services, then start the services by 

right-clicking each service and selecting the Start option.
25 Repeat Step 24 for each Windows workstation where you installed the Subscriber software.
26 If necessary, rerun the installation program (see Step 1).
27 Continue with the next applicable section:

To install the Policy and Distribution Services on Linux or Solaris servers, continue with 
Section 6.3, “Installation on Linux and Solaris Servers,” on page 114.
Continue with Section 6.4, “Post-Installation Tasks,” on page 117.

6.3  Installation on Linux and Solaris Servers
This section provides you with instructions for installing Novell ZENworks Server Management on 
Linux or Solaris servers.

The Policy and Distribution Services component is supported on the Linux and Solaris platforms; 
however, the Server Inventory and Remote Management components are not supported on Linux or 
Solaris.

If your network also includes NetWare and Windows servers, it is easiest to install Policy and 
Distribution Services to one of those platforms first, as described in Section 6.1, “Installation on 
NetWare and Windows Servers,” on page 65, because the database files must be created on NetWare 
or Windows servers. The database stores log messages for reporting purposes, detailing the 
successes and failures of distribution processing. If necessary, you can install the Policy and 
Distribution Services software on the Linux or Solaris servers first, then create the databases 
afterwards on the NetWare or Windows servers.

An installation script on the Novell ZENworks 7 Server Management with Support Pack 1 Program 
CD is used to install the Linux or Solaris version of the software on a single Linux or Solaris server. 
It also creates the necessary ZENworks objects in Novell eDirectory. For information on installing 
or upgrading eDirectory in a Linux-only or Solaris-only environment, see Section 3.2.5, “Installing 
or Upgrading eDirectory on Linux or Solaris Servers,” on page 36.

The most straightforward way to run this script is to insert the Program CD into the CD drive of the 
Linux or Solaris server where you want to install Policy and Distribution Services. Installation 
solutions that eliminate physically moving from server to server are left to the discretion of the 
Linux or Solaris administrator.
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The Linux or Solaris server where you install Policy-Enabled Server Management can function as a 
Distributor, a Subscriber, or both:

Distributor: The Distributor Agent gathers and sends the Distributions to Subscriber servers. 
The Distributions can consist of policies, new and updated software, individual executables, 
databases, documents, text files, and so on.
Subscriber: The Policy/Package Agent receives and extracts the Distributions. The Policy/
Package Agent then enforces the policies, installs the software, updates the files, and so on.

At the Linux or Solaris server where you want to install Policy and Distribution Services:

1 Log in as root.
2 If you are running X Windows on the Linux or Solaris server, open an XTerm window.
3 Place the Novell ZENworks 7 Server Management with Support Pack 1 Program CD in the 

server’s CD drive.
4 Review the Readme for any last-minute information concerning installation.

Readme_servers.html is located in the \readmes\en directory on the Program CD.
5 To run the Policy and Distribution Services installation script, do one of the following in an 

XTerm window:
Enter one of the following commands:
Red Hat Linux: /mnt/cdrom/ZfS/TedPol/platform/zfs-pds-install
SUSE Linux: /media/cdrom/ZfS/TedPol/platform/zfs-pds-install
where platform is either Linux or Solaris.
Change to the directory where the Policy and Distribution Services installation script is 
located:
cd /device_directory/ZfS/TedPol/platform

where device_directory represents the mount point for the CD device and platform is 
either Linux or Solaris.
Then enter:
./zfs-pds-install

6 Press Enter to display the license agreement, press the Spacebar to scroll through the license 
agreement, type y, then press Enter to accept the license agreement.
The script installs software from the j2re and novell-zen-zfs RPM files.

7 To configure Server Management, respond to the prompts as they are displayed.
The information that you gathered under Section 2.2, “Platform-Dependent Information,” on 
page 30 is needed at this time.
Any information that is displayed within parentheses and before the colon represents defaults 
that are accepted if you press the Enter key. However, you can specify your own information 
before pressing Enter if the displayed default is not desired.

TIP: If you are using an XTerm window, it should be opened wide enough so that any entry 
you might make fits on one line. If your entry wraps, and you need to backspace to change it, 
you can only backspace to the beginning of the wrapped line. If that happens, press Enter to 
display the script prompt again if the information you had entered does not represent an 
acceptable entry. However, if you press Enter on a blank entry and there is a default shown, that 
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default is used. Because you cannot return to a previous script prompt, if you do not want the 
default, or your entry is incorrect (but acceptable by the installation program) you must then 
enter Ctrl+C to stop the installation and start over with Step 5.

7a Specify the DNS name of a server where a replica of the eDirectory tree exists. For 
example:
smnw6.novell.com

7b Enter the user DN that has admin rights to the root of the tree. For example:
admin.servers.novell

7c Enter the admin user’s password.
Nothing is displayed as you type the password to indicate the characters you are typing.
If you have specified a correct username and password, “Authentication successful” and 
the tree’s name are displayed.

8 If the correct DNS name is displayed within the parentheses, press Enter to accept it.
or
If the correct name is not displayed, enter the correct DNS name before pressing Enter.
If you have DNS set up correctly, the DNS name of the Linux or Solaris server where this script 
is running should be displayed within the parentheses. For example, 
SMLX1.provo.novell.com.

9 If you want this server to be a Distributor, type y and press Enter.
9a Enter the Distributor object’s name. For example:

Distributor_SMLX1

9b Enter an existing eDirectory container where the Distributor object can be created. For 
example:
Distributors.SM.ZENworks.Novell

10 Enter the Subscriber object’s name. For example:
Subscriber_SMLX1

11 Enter an existing eDirectory container where the Subscriber object can be created. For 
example:
Linux.Subscribers.SM.ZENworks.Novell
or
Solaris.Subscribers.SM.ZENworks.Novell

Keep your servers in containers named for their platforms. For more information, see 
Section 3.2, “Novell eDirectory Requirement,” on page 33.

12 If you already have a ZENworks database installed in your network and want this server to log 
to it, enter the DN of the database object, such as:
Server Management Database_SMNW6.Databases.ZENworks.Novell

13 Review the information displayed for how to start the Policy and Distribution Services agent 
and how to reconfigure it if the service does not start.

14 To verify that the agent is running, enter the following:
/etc/init.d/novell-zfs status

The following agent should be listed:
Novell ZENworks Server Management
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If the agent does not start, review the zfs-startup.log file in the /var/opt/novell/log/
zenworks directory.

15 If the installation was successful, repeat Step 1 through Step 14 on each Linux server.
16 Continue with Section 6.4, “Post-Installation Tasks,” on page 117.

6.4  Post-Installation Tasks
After installing the Novell ZENworks Server Management software to NetWare, Windows, Linux, 
and Solaris servers, there are tasks that cannot be automated within the installation processes that 
you should perform to complete the installation. The following sections give details about these 
tasks.

The first section contains tasks that should be done for all of the Server Management components. 
The other four sections are divided by component, and are listed by the components that can be 
installed.

Perform the necessary tasks in each of the following sections for the Server Management 
components you have installed:

Section 6.4.1, “Policy and Distribution Services,” on page 117
Section 6.4.2, “Server Inventory,” on page 121

6.4.1  Policy and Distribution Services
The following tasks are specific to the Policy and Distribution Services component:

“Restarting the Novell Servlet Gateway on NetWare 5.1 Servers” on page 117

If you have a Novell Servlet Gateway running on a server where you installed Server 
Management, you need to restart the gateway’s Java process manually.
“Creating the Policy and Distribution Database” on page 118
To provide reporting capability for a Linux or Solaris Distributor server, follow these 
instructions to create a database on a NetWare or Windows server.
“Configuring the Policy and Distribution Services Agents on Servers with Multiple Network 
Addresses” on page 119
If a server where you have installed the Policy and Distribution Services agents has multiple 
network addresses on your network, follow these instructions.
“Using Policy and Distribution Services” on page 120
This section contains suggestions on what you can do next with Policy and Distribution 
Services.

Restarting the Novell Servlet Gateway on NetWare 5.1 Servers

The installation program stops all Java processes before installing ZENworks Server Management. 
After the Server Management installation is completed, the installation program attempts to 
automatically restart all of the Java applications that it had stopped before installing. Occasionally, 
there are Java process that the installation program cannot restart.
Policy-Enabled Server Management Installation 117



118 Novell

novdocx (en)  16 A
pril 2010
On NetWare 5.1 servers, the Novell Servlet Gateway application cannot be restarted automatically 
by the installation program. If you have this Java process running on a NetWare 5.1 server where 
you installed ZENworks, you need to restart it manually.

Creating the Policy and Distribution Database

The Policy and Distribution database stores log messages for reporting purposes, detailing the 
successes and failures of Distribution processing and policy statuses. The database file currently 
cannot be created on a Linux or Solaris server. Therefore, if you want database logging by any Linux 
or Solaris Distributor or by the Policy/Package Agent, you must install the database on a NetWare or 
Windows server.

If you have not previously installed a database with a Database object in the eDirectory tree where 
the Linux or Solaris Distributor object resides, and you want database logging for the Linux and 
Solaris servers, perform the following procedure at a Windows installation machine:

1 If you have not already done so, log in to the eDirectory tree where the Distributor and 
Subscriber objects are created.

2 Insert the Novell ZENworks 7 Server Management with Support Pack 1 Program CD.
The initial installation program window appears. If it does not display automatically after 
inserting the CD, run winsetup.exe at the root of the CD.

3 Click Server Management, then select Policy-Enabled Server Management.
4 Accept the License Agreement, then click Next.

New Installation is selected by default.
5 Click Next.

Policy and Distribution Services is selected by default.
6 Click Next. 

The Create eDirectory objects and Install software files options are selected by default.
7 Click Next.
8 Select the eDirectory tree where you want to create the ZENworks Database object, click OK, 

then click Next.
9 In the Server Selection dialog box, click Add servers.

10 If the NetWare or Windows server where you want to create the Policy and Distribution 
database file has a corresponding eDirectory object, browse the eDirectory tree, then select the 
Server object.
or
For a Windows server in a Microsoft domain, in the List servers by drop-down list, click 
Microsoft Domain, expand the domain, then select the server.

11 Move the selected server from the Available Servers list box into the Selected Servers list box, 
then click OK.

12 Back in the Server Selection dialog box, on the line for the selected server, mark the Database 
column, then click Next.

13 Fill in the fields:
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Database path: Keep in mind that the Policy and Distribution database can become very large.
On NetWare, the default database path is sys:\zenworks. You should change the 
database path to use a volume other than sys:.
On Windows, the default database path is c:\zenworks. Whether this is an appropriate 
location depends on the size of the C: drive and the space available on other drives on the 
server.

Object name: The default object name is “ZENworks Database.” You can rename it if you 
plan to install multiple databases.
Container: Browse to and select the container object where you want the ZENworks Database 
object created. You could place it with other Tiered Electronic Distribution objects, or in the 
same container where the Server object resides.

14 Click Next.
The installation summary lists the server where the database file is installed and the eDirectory 
object that is created for it.

15 Click Finish.
16 When the installation is complete, click View log file to review what the installation program 

has done.
If the installation log file contains errors, you can print it for reference. To look up installation 
errors, see Appendix H, “Installation Error Messages,” on page 373. Resolve the problem, then 
repeat the installation successfully.

17 Close the log file, then exit the installation program.

Configuring the Policy and Distribution Services Agents on Servers with Multiple 
Network Addresses

If a server where you have installed the Policy and Distribution Services agents has multiple 
network addresses on your network, some additional configuration is necessary before you start the 
agents. This situation arises when the server has one or both of the following characteristics:

Multiple NICs
Multiple DNS hostnames

Perform the following tasks as necessary:

“Ensuring Successful Forward and Reverse DNS Lookups” on page 119
“Ensuring the Correct NIC is Recognized as the Primary Host” on page 120

Ensuring Successful Forward and Reverse DNS Lookups

To ensure that forward and reverse DNS lookups are successful, you need to edit a configuration file 
for each applicable server. The following steps apply to servers on all supported platforms:

1 Open the following file in a text editor:
Installation_path\zenworks\zfs-startup.xml

2 Search for the following class:
<Class>com.novell.application.zenworks.ted.TED</Class>

3 Edit the following parameter that is listed under the class:
<Parameter Name="Hosts" />
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If the parameter does not exist, create it and insert it in the parameter list.
Change it to include the DNS hostnames or IP addresses of your hosts. For example:
<Parameter Name="Hosts">192.68.1.203</Parameter>

Note the addition of the closing > character after the "Hosts" name and the closing </
Parameter> code. Your DNS hostnames and IP addresses go between the codes as show 
above.
Do not list those that are bound to the server’s NIC card.
If you list more than one host, your list of DNS hostnames and IP addresses should be 
delimited by a semicolon (;). For example:
<Parameter 
Name="Hosts">192.68.1.203;192.68.1.204;server001.provo.novell.com</
Parameter>

You can mix DNS hostnames and IP addresses in the list.
4 Save your changes, then close the file.

Ensuring the Correct NIC is Recognized as the Primary Host

If you have multiple NICs, a server might not recognize the card that is used for your network access 
as the primary host card. To ensure that the correct NIC is recognized as the primary host:

1 In the text editor, open the following file:
Installation_path\zenworks\zfs-startup.xml

2 Search for the following class:
<Class>com.novell.application.zenworks.ted.TED</Class>

3 Edit the following parameter that is listed under the class:
<Parameter Name="PrimaryHost" />

If the parameter does not exist, create it and insert it in the parameter list.
Change it to include the IP addresses of the proper NIC card. For example:
<Parameter Name="PrimaryHost">192.68.1.203</Parameter>

Note the addition of the closing > character after the "PrimaryHost" name and the closing </
Parameter> code. The IP address goes between the codes as show above.
If the PrimaryHost parameter already has a DNS hostname, change it to the IP address.

4 Save your changes, then exit the text editor.

Using Policy and Distribution Services

To take full advantage of Policy and Distribution Services, you can further configure your 
distribution system and server policies by doing the following:

Determining which Distributions you need, including server policies
Creating the Distributions and their related Channels
Determining whether other Distributors are needed
Installing the other Distributors
Creating a routing hierarchy for each Distributor
Configuring parent Subscribers where necessary
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Associating Subscribers with Distribution Channels
Sending your Distributions

To do this, you need to understand Policy and Distribution Services, know what Distributions you 
need, and plan your distribution system. The degree of planning depends on the size and complexity 
of your network, and the size and frequency of your Distributions.

To understand Policy and Distribution Services, plan how to configure your distribution system, 
configure server policies, and create new Distributions, see “Post-Installation Setup” in the Novell 
ZENworks 7 Server Management Administration Guide.

6.4.2  Server Inventory
The following tasks are specific to the Server Inventory component. You must perform them in the 
order listed before starting the Server Inventory service on the Inventory server.

1. “Creating the Policy Packages” on page 121
2. “Creating and Configuring the Tiered Electronic Distribution Objects” on page 123
3. “Configuring the Distribution Object for Server Inventory” on page 123
4. (Optional) “Configuring the Inventory Database Object on a NetWare Server” on page 124
5. “Configuring the Policies on the Servers” on page 124
6. “Configuring the Distributor and the Subscriber Object” on page 127
7. (Optional) “Installing the ODBC Drivers” on page 128
8. “Starting the Inventory Service” on page 128
9. “Starting the Samba Service” on page 129

Creating the Policy Packages

Server Inventory requires policy packages in the eDirectory tree that can hold the server policies that 
you can later configure and enable. 

To determine which Policy Package objects to create, first determine which policies you need. For 
Server Inventory, you must create the following policy packages:

Service Location Package or Server Package
Distributed Server Package

To create Policy Package objects, do the following as applicable:

“Creating the Policy Package Containers” on page 121
“Creating the Service Location Package” on page 122
“Creating the Server Package” on page 122
“Creating the Distributed Server Package” on page 123

Creating the Policy Package Containers

Policy packages are eDirectory objects that contain collections of policies grouped according to the 
object types. You should create an Organizational Unit (OU) for holding the policy packages.
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Consider the following when determining where to place this OU:

Whether you have partitions in your tree
The 256-character limit in eDirectory for the full distinguished name
The search policy is used to locate the policy package

For Server Inventory, create two containers, one for Tiered Electronic Distribution objects and the 
other for the Server Inventory policy packages.

To create a container:

1 In ConsoleOne, right-click the container where you want the container for the policy packages 
placed.

IMPORTANT: If you have partitions that are accessed across a WAN, make sure that the 
Policy Package objects are in the same partition as the Server object so that the Policy/Package 
Agents loads. Also make sure that the Search policy does not require searching outside the 
partition where the Server object exists. 

2 Click New > Object > Organizational Unit, then click OK.
3 Name the container (for example, Policies), then click OK.
4 Continue with “Creating the Service Location Package” on page 122.

or
Continue with “Creating the Server Package” on page 122.
You should do one or the other of these packages, as necessary.

Creating the Service Location Package

The Service Location package is required to enable the Database Location policy and to associate 
the database object with the container under which the Inventory Service object is located.

1 Right-click the policy package’s container, then click New > Policy Package.
The Policy Package Wizard is displayed.

2 From the Policy Packages list, select Service Location Package, then click Next.
3 Specify a name for the Service Location Package.
4 Click Next, then click Finish.
5 Continue with “Creating the Server Package” on page 122.

or
Continue with “Creating the Distributed Server Package” on page 123.

Creating the Server Package

The Server package is required to enable the Database Location policy and to associate the database 
object with the Inventory Service object of the Inventory server.

IMPORTANT: If you chose to configure the Inventory Standalone Pre-Configuration settings 
during the installation, the Server Package is automatically created by the Installation program.
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To create the Server Package:

1 Right-click the policy package’s container, then click New > Policy Package.
The Policy Package Wizard is displayed.

2 From the Policy Packages list, select Server Package, then click Next.
3 Specify a name for the Server Package.
4 Click Next, then click Finish.
5 Continue with “Creating the Distributed Server Package” on page 123.

Creating the Distributed Server Package

The Distributed Server package is required to distribute the Server Inventory policy among the 
inventoried servers.

1 Right-click the policy package’s container, then click New > Policy Package.
The Policy Package Wizard is displayed.

2 From the Policy Packages list, select Distributed Server Package, then click Next.
3 Specify a name for the Distributed Server Package.
4 Click Next, then click Finish.
5 Continue with “Creating and Configuring the Tiered Electronic Distribution Objects” on 

page 123.

Creating and Configuring the Tiered Electronic Distribution Objects

For Server Inventory, you must create and configure the following Tiered Electronic Distribution 
objects:

TED Distribution
TED Channel

For more information on how to create and configure the Tiered Electronic Distribution objects, see 
“Tiered Electronic Distribution” in the Novell ZENworks 7 Server Management Administration 
Guide.

Continue with “Configuring the Distribution Object for Server Inventory” on page 123.

Configuring the Distribution Object for Server Inventory

You must configure the Distribution object for distributing the Server Inventory policies.

1 From ConsoleOne, right-click the Distribution object, then click Properties.
2 Click the Type tab.
3 Select Policy Package from the Select Type drop-down list.
4 Click Add.
5 Select the Distributed Server package that has the Server Inventory policy.
6 Click the Schedule tab.
7 Modify the schedule.
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8 Click Apply, then click Close.
9 Continue with “Configuring the Inventory Database Object on a NetWare Server” on page 124.

Configuring the Inventory Database Object on a NetWare Server

If you install Sybase on a NetWare server that has CIFS as a default component, the server IP 
address or DNS name of the Inventory database_server_name object might not be configured 
correctly after the Sybase installation.

To configure the database object correctly:

1 Open ConsoleOne, then double-click the Inventory database object.
2 At the ZENworks Database page of the database object, enter the server IP address or DNS 

name of the server where the inventory database is installed.
3 Continue with “Configuring the Policies on the Servers” on page 124.

Configuring the Policies on the Servers

In a Standalone Server scenario, a single server acts as the Inventory server and also the database 
server. There is no requirement for roll-up of inventory data. 

To know which policies should be configured for the Server Inventory that is deployed in a 
production environment, see “Setting Up Server Inventory” in the Novell ZENworks 7 Server 
Management Administration Guide.

If you chose to install Inventory Server and Inventory Database (Sybase) during installation of 
Server Management, the Inventory Standalone Configuration dialog box was displayed. If you 
selected the Configure standalone check box in this dialog box, the installation program 
automatically created the Server Package, configured the Database Location policy within the 
Server Package, and started the Inventory Services. When the Server Management installation is 
complete, you need to create only the Server Inventory policy. However, if you did not choose the 
standalone option, then you must create both the Database Location and Server Inventory policies.

Perform the following applicable tasks to configure the policies:

“Configuring the Database Location Policy” on page 124
“Configuring the Server Inventory Policy” on page 126

Configuring the Database Location Policy

The Database Location policy contains the location of the Inventory database. You can associate the 
Database object with a container under which the Inventory Service object is located through using 
the Service Location Package, or with an Inventory server through using the Server Package.

IMPORTANT: If you configure the Service Location Package and the Server Package, the Server 
Package settings override the Service Location Package settings.

To associate the Database object with a container under which the Inventory Service object is 
located:

1 In ConsoleOne, right-click the Service Location Package, then click Properties to display the 
Policies page.
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2 Select the check box under the Enabled column for the ZENworks Database policy.
3 Click Properties to display the Inventory Management page.
4 Browse to the DN of the Inventory Database object (Inventory database_server_name), then 

click OK.
For a Sybase database, the database object is automatically created during the Server Inventory 
installation except if you are installing on a Windows 2000/2003 server without eDirectory 
installed. To manually create the database object, see “Setting Up the Sybase Inventory 
Database” in the Novell ZENworks 7 Server Management Administration Guide.
For an Oracle database, you must create the database object and configure the object. For more 
information, see “Setting Up the Oracle Inventory Database” in the Novell ZENworks 7 Server 
Management Administration Guide.
For a MS SQL database, you must configure the database object. For more information, see 
“Setting Up the MS SQL Server 2000 or MS SQL Server 2005 Inventory Database” in the 
Novell ZENworks 7 Server Management Administration Guide.

5 Click OK.
6 Click the Associations tab, then click Add.
7 Browse to select the container under which the Inventory Service object is located, then click 

OK.
8 Click Apply, then click Close.
9 Continue with “Configuring the Server Inventory Policy” on page 126.

To associate the Database object with an Inventory server:

1 In ConsoleOne, right-click the Server Package, click Properties to display the Policies page.
2 Select the check box under the Enabled column for the ZENworks Database policy.
3 Click Properties to display the Inventory Management page.
4 Browse to and select the DN of the Inventory Database object (Inventory 

database_server_name), then click OK. 
For a Sybase database, the database object is automatically created during the Server Inventory 
installation except if you are installing on a Windows 2000/2003 server without eDirectory 
installed. To manually create the database object, see “Setting Up the Sybase Inventory 
Database” in the Novell ZENworks 7 Server Management Administration Guide.
For an Oracle database, you must create the database object and configure the object. For more 
information, see “Setting Up the Oracle Inventory Database” in the Novell ZENworks 7 Server 
Management Administration Guide.
For a MS SQL database, you must configure the database object. For more information, see 
“Setting Up the MS SQL Server 2000 or MS SQL Server 2005 Inventory Database” in the 
Novell ZENworks 7 Server Management Administration Guide.

5 Click OK.
6 Click the Associations tab, then click Add.
7 Browse to select an Inventory server object, then click OK.
8 Click Apply, then click Close.
9 Continue with “Configuring the Server Inventory Policy” on page 126.
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Configuring the Server Inventory Policy

The Server Inventory policy contains the IP address or the DNS name of the Inventory server to 
which the inventory data is sent. This policy also contains the inventory scanning schedule for the 
associated inventoried server. You must configure the Server Inventory policy for each inventoried 
server.

To configure the Server Inventory policy package:

1 In ConsoleOne, right-click a Distributed Server Package, then click Properties to display the 
Policies tab.

2 Click Policies, then click NetWare or Windows, depending on the operating system of the 
inventoried server.

3 Select the check box under the Enabled column for the Server Inventory policy.
4 Click Properties to display the Server Inventory Policy page.
5 In the General tab, configure the following settings:

5a Browse to select the DN of the Inventory Service object.
This setting specifies that the scanner sends the server scan data to this Inventory server.

5b Select the DNS name or the IP address of the Inventory server.
5c If the roll-up is to an Inventory server that is across the firewall, specify the IP address and 

the port number of the proxy server.
6 (Optional) Customize the Inventory scan for the inventoried servers:

6a To customize the hardware scan for the inventoried servers, click the Hardware Scan tab 
and configure the following settings:
Enable DMI scan: Includes DMI scanning of Windows inventoried servers.
Enable WMI scan: Includes WMI scanning of Windows inventoried servers.

6b To customize the software scan for the inventoried servers on which Novell ZENworks for 
Servers 3.0 or ZENworks for Servers 3.0.2 is installed, click the Software Scan tab and 
configure the following settings:

IMPORTANT: Do not configure the settings for the inventoried servers where 
ZENworks 7 Server Management is installed.

Enable software scan: Enables software scanning for the Windows inventoried servers 
associated with the Inventory policy. The scan program collects software information for 
the inventoried servers and stores it in the Inventory database.
Custom scan editor: Enables you to customize the list of application details to scan for at 
the Windows inventoried servers. The Inventory scanner scans for the details of the 
applications listed in the Custom Scan Editor. 
For example, specify the following details in the Custom Scan Editor: Vendor 
Name=Microsoft; Product Name=Microsoft Office; Product Version=10.0; 
FileName=winword.exe; File Size=1 MB.
The Inventory scanner scans for the winword.exe file having a size of 1 MB on the 
inventoried servers. If the file is found, the scanner stores “Microsoft;Microsoft 
Office;10.0” for “winword.exe;1 MB” in the Inventory database.
Product identification number: Enables you to scan for the product identification 
number of the Microsoft applications installed on the inventoried servers. 
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6c Click the Configuration Editor tab; if required, modify the settings of the following .ini 
files:
Asset information: Scans for vendor-specific information from DMI. For more 
information on how to configure the Asset Information, see “Scanning for Vendor-
Specific Asset Information from DMI” in the Novell ZENworks 7 Server Management 
Administration Guide.
Zipped names: Customizes the hardware scanning of Jaz* and Zip* drives. For more 
information, see “Customizing the Hardware Scanning Information of Jaz and Zip Drive 
Vendors” in the Novell ZENworks 7 Server Management Administration Guide.
SWRules: Configure the SWRules file for the Windows inventoried servers on which 
Novell ZENworks for Servers 3.0 or ZENworks for Servers 3.0.2 is installed. Do not 
configure the settings for inventoried servers where ZENworks 7 Server Management is 
installed.
The SWRules option customizes the software scanning information of vendors and 
products. For more information, see “Customizing the Software Inventory Information To 
Be Scanned For ZENworks for Servers 3.x Inventoried Servers” in the Novell ZENworks 7 
Server Management Administration Guide.
HWRules: Customizes the nominal size of monitors. For more information on how to 
configure the HWRules .ini file, see “Customizing the Hardware Information for 
Monitor Size” in the Novell ZENworks 7 Server Management Administration Guide.

7 Click the Policy Schedule tab.
8 Modify the schedule, click Apply, then click Close. 
9 In the Distributed Server Package property page, click the Distribution tab, then click Add.

10 Browse to add the Distribution object, then click OK.
11 Click Apply, then click Close.
12 In ConsoleOne, right-click the Inventory Service object (Inventory Service_server_name), 

click Properties, then click the Inventory Service Object Properties tab.
13 Ensure that the Enable scan of machines check box is selected, then click OK.

This setting ensures that scanning is selected for the inventoried servers associated with the 
selected Inventory server.

14 Continue with “Configuring the Distributor and the Subscriber Object” on page 127.

Configuring the Distributor and the Subscriber Object

To configure the Distributor and the Subscriber object, see “Policy and Distribution Services” in the 
Novell ZENworks 7 Server Management Administration Guide.

If the inventoried servers are residing on a different eDirectory tree or on the Windows server that 
does not have eDirectory installed, you must create and configure an External Subscriber object for 
sending Distributions to Subscribers residing on inventoried servers in other trees. For more 
information on External Subscribers, see “Policy and Distribution Services” in the Novell ZENworks 
7 Server Management Administration Guide.

Continue with “Installing the ODBC Drivers” on page 128.
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Installing the ODBC Drivers

Before running the inventory reports, review the following:

Make sure that the appropriate ODBC client for Sybase, Oracle, or MS SQL is installed on the 
machine running ConsoleOne. The ODBC driver is automatically configured on the machine 
when you invoke the Inventory report.

To install the ODBC driver for the Sybase database:
1. In the Novell ZENworks 7 with Support Pack 1 Companion 2 CD, open the \database 

drivers directory.
2. Follow the instructions in the ODBCreadme.txt file in the \database drivers directory. 

The information helps you to set up the address of the Sybase database and verify that you 
can make a connection.

For Oracle, you must install the appropriate client for ODBC. For example, for Oracle 9i 
Inventory database, install the Oracle 9i client because Inventory reports are not compatible 
with either the older or the later version of the client.

For MS SQL, the client is available on all Microsoft Windows operating systems. 
Make sure that at least MDAC 2.6 SP1 (Microsoft Data Access Component) is installed 
particularly on a Windows NT machine for running Crystal Reports. To check the version of 
MDAC on your box, click Control panel > ODBC Data sources > the About tab pane. The 
minimum version required is 3.520.7326.0. If the version you have does not match the 
minimum requirement, you need to upgrade the ODBC core components by downloading from 
Microsoft Download Center (http://www.microsoft.com/downloads/).

If you need to start or stop the Inventory services, see “Starting the Inventory Service” on page 128.

If you need to start Samba, see “Starting the Samba Service” on page 129.

Starting and Stopping the Inventory Service

This section provides information on the following topics:

“Starting the Inventory Service” on page 128
“Stopping the Inventory Service” on page 129

Starting the Inventory Service

Table 6-1   Starting Inventory Services

Platform Inventory Server Steps

NetWare To start all Inventory services:

1. At the server console prompt, enter startinv.

To start a specific Inventory service:

1. At the server console prompt, enter startser Inventory_service.
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After starting the Inventory service, make sure that the Inventory services are up and running. To list 
all services, enter ListSer * at the Inventory server console prompt. If the services are not up and 
running, check the Server Status log. For more information on the Server Status log, see 
“Monitoring Server Inventory Using Status Logs” in the Novell ZENworks 7 Server Management 
Administration Guide.

Stopping the Inventory Service

Table 6-2   Stopping Inventory Services

Starting the Samba Service

If the Inventory server component is installed on a Linux machine, ensure that the Samba service is 
up and running by entering /etc/init.d/smb status at the Linux Inventory server console 
prompt.

Windows 2000/2003 To start all Inventory services:

1. In the Control Panel, double-click Administrative Tools, then double-click 
Services.

2. Right-click Novell Inventory Service, then click Start.

To start a specific Inventory service:

1. At the server console prompt, go to 
ZENworks_installation_directory\zenworks\inv\server\wm
inv\bin.

2. Enter startser Inventory_service.

Platform Inventory Server Steps

NetWare To stop all Inventory services:

1. At the server console prompt, enter stopser *.

To stop a specific Inventory service:

1. At the server console prompt, enter stopser Inventory_service.

Windows 2000/2003 To stop all Inventory services:

1. In the Control Panel, double-click Administrative Tools, then double-click 
Services.

2. Right-click Novell Inventory Service, then click Stop.

To stop a specific Inventory service:

1. At the server console prompt, go to 
ZENworks_installation_directory\zenworks\inv\server\wm
inv\bin.

2. Enter stopser Inventory_service.

Platform Inventory Server Steps
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If the service is not running, you must manually start the Samba service after the installation to 
enable the Inventory server to receive the inventory scans from the inventoried workstations. To 
manually start the Samba service, enter /etc/init.d/smb start at the Linux Inventory server 
console prompt.
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7Management and Monitoring 
Services Installation

This section provides instructions to help you install Novell® ZENworks® 7 Server Management 
Management and Monitoring Services to the following platforms where an older version of 
ZENworks has not previously been installed:

Section 7.1, “Installation on NetWare and Windows,” on page 131
Section 7.2, “Installation on Linux,” on page 134

7.1  Installation on NetWare and Windows
This section provides instructions to help you install the Management and Monitoring Services 
component of Novell ZENworks Server Management to NetWare® and Windows servers.

For more information on understanding and planning your Management and Monitoring Services 
and for advanced setup and administration, see “Management and Monitoring Services” in the 
Novell ZENworks 7 Server Management Administration Guide.

The following topics explain the installation procedure in detail:

Section 7.1.1, “Installing the Server Software,” on page 131
Section 7.1.2, “Installing the ConsoleOne Snap-Ins,” on page 133
Section 7.1.3, “Post-Installation Tasks,” on page 133

7.1.1  Installing the Server Software
1 If you haven’t already done so, log in with Admin or equivalent rights to the target 

management server and the container containing the target management server.
2 Insert the Novell ZENworks 7 Server Management with Support Pack 1 Program CD.

The startup page appears. If the startup page is not automatically launched after inserting the 
CD, you can launch it by running winsetup.exe at the root of the CD. 

IMPORTANT: If you copied the Program CD structure to the installation machine’s hard 
drive, the path between the root of the hard drive and the first CD directory can contain only 
directory names that conform to the 8.3-character DOS file naming convention. If any long 
directory names exist in the path, the installation program does not work.

3 If you have not already done so, extend the schema.
The schema must be extended on the eDirectoryTM tree where you want to create the ZENworks 
objects. For more information on how to extend the schema, see “Extending the Schema” on 
page 69.

4 Click Management and Monitoring Services > Site Management Services and Agents.
If you restart the target Management server after you mapped a drive at the workstation, the 
installation might no longer recognize the mapped drive. Detach the tree from NetWare 
Connection, disconnect the mapped drive, and remap the volume. 
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We recommend that you do not install on the sys: volume of your target Management server.
5 Click Next at the Welcome screen.
6 If you agree with the Software License Agreement, click Yes > Next; otherwise, click No then 

click Exit setup to exit.
7 Select the desired ZENworks Server Management components listed in the following table:

IMPORTANT: You need Admin or equivalent rights to the target servers. Create a shared 
folder on all Windows 2000/2003 servers where you are installing the ZENworks agents.

8 Click Next.
9 Select a NetWare server to be a Management Site Server, specify the location (volume and 

path) where the software should be installed, then click Next.
10 If the site server has multiple addresses configured, then select the IP address where 

Management site services have to be installed and click Next.
11 Enter the license code if you have not already done so when extending the schema, then click 

Next.
12 Specify the path to the database file.

IMPORTANT: If the selected server has RAM of 4 GB or more, the following error message 
might be displayed: “Management Site Server requires a minimum of 512 MB of RAM for 
proper functioning. The server you have selected does not have 512 MB of RAM.” Ignore this 
message.

13 If you are installing Management and Monitoring Services for the first time, select the option to 
provide the copy of the empty database files. 
If you want to copy Management and Monitoring Services Novell ConsoleOne® snap-ins to the 
Management Site Server ConsoleOne, select the option to copy the ConsoleOne snap-ins to the 
Management Site Server.

14 If you do not need to reconfigure your discovery parameters beyond the default settings (for 
example, using SNMP community names other than PUBLIC), start the autodiscovery process 
and the back-end services:
14a To start the autodiscovery process, select Start the autodiscovery process.
14b To start the back-end services, select Start the back-end services on the server.

15 Specify a name for the service locator object and specify the context.
Other management objects also need to be created in this context. If multiple management sites 
are used, specify a context that is readily accessible. The default name and context are provided 
based on the Management server you selected in Step 9.

Server Components Install On 

Management Site Services Management server

Server Management Agent All NetWare and Windows servers that you want to manage

Traffic Analysis Agent One server (NetWare or Windows 2000/2003) per segment

Advanced Trending Agent All NetWare, Windows, and Linux servers that you want to 
manage
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16 Click Next.
17 If you selected to install only Server Management Agent, Traffic Analysis Agent, or Advanced 

Trending Agent in Step 7, you need to select the site server or specify the IP address, which is 
used for updating the destination of the traps.

18 Select the NetWare and Windows 2000/2003 servers, the agents to install on each server, and 
the destination folder for the software, then click Next.

19 Review the summary list of selections you made in the preceding steps.
To change a setting, click Back; otherwise, click Finish to start the installation.
For Managed servers on NetWare, the ZENworks agents are automatically started. For 
Managed servers on Windows 2000/2003, you must restart Windows 2000/2003 after you 
install the agents.

20 If you chose not to start all of the back-end services and the autodiscovery process during 
installation, after the installation is completed enter startmms at the command prompt to 
manually start the back-end services and the autodiscovery process.

21 Continue with the next applicable section:
To install the ConsoleOne snap-ins for Management and Monitoring Services, continue 
with Section 7.1.2, “Installing the ConsoleOne Snap-Ins,” on page 133.
Or, continue with Section 7.1.3, “Post-Installation Tasks,” on page 133.

7.1.2  Installing the ConsoleOne Snap-Ins
You can install multiple management consoles for accessing data on a management server. You must 
have Admin rights to the workstation to install the management console software on a Windows 
2000/XP workstation. 

To install the ZENworks Server Management ConsoleOne software:

1 To install to a remote server, log in as an administrator or as a user with Admin equivalent 
rights.

2 Insert the Novell ZENworks 7 Server Management with Support Pack 1 Program CD.
If the startup page is not automatically launched after inserting the CD, you can launch it by 
running winsetup.exe at the root of the CD. 

3 Click Management and Monitoring Services > Site Management ConsoleOne Snap-ins.
4 Specify a destination folder for the snap-ins or click Next to accept the default destination 

folder.
The snap-in files are installed.

5 Select to view the Readme file, then click Finish.
6 Continue with Section 7.1.3, “Post-Installation Tasks,” on page 133.

7.1.3  Post-Installation Tasks
After installing the Novell ZENworks Management and Monitoring Services software to NetWare, 
Windows, and Linux servers, perform the following tasks:

“Starting the Management Console” on page 134
“Installing the ODBC Drivers” on page 134
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Starting the Management Console

You can begin using the management console to manage and monitor your network after you have 
started the management server.

To start the management console:

1 Log in to the eDirectory tree containing the Management server.
2 To start ConsoleOne, click ZENworks Console in ZENworks Server Management 7 on the 

Windows Start menu.
3 Start Management and Monitoring Services, then click ZfS Sites to begin managing your 

network. 

TIP: If you did not start the autodiscovery process and the back-end services during 
installation, you cannot expand the site and use the Atlas view until you complete the discovery 
process. To manually start the services on NetWare, at the command prompt enter startmms.

4 Expand the site, click Atlas > Atlas View.
or
Click the + sign to expand the view.

5 Continue with “Installing the ODBC Drivers” on page 134.

Installing the ODBC Drivers

Before running the Management and Monitoring Services reports you must make sure that the 
appropriate ODBC client for Sybase on the machine running ConsoleOne. The ODBC driver is 
automatically configured on the machine when you invoke the report

To install the ODBC driver for the Sybase database,

1 In the Novell ZENworks 7 with Support Pack 1 Companion 2 CD, open the \database 
drivers directory.

2 Follow the instructions in the ODBCreadme.txt file in the \database drivers directory. The 
information helps you to set up the address of the Sybase database and verify that you can make 
a connection.

3 Make sure that at least MDAC 2.6 SP1 (Microsoft Data Access Component) is installed 
particularly on a Windows NT machine for running Crystal Reports. To check the version of 
MDAC on your box, click Control panel > ODBC Data sources > the About tab pane. The 
minimum version required is 3.520.7326.0. If the version you have does not match the 
minimum requirement, you need to upgrade the ODBC core components by downloading from 
Microsoft Download Center (http://www.microsoft.com/downloads/).

4 To install Management and Monitoring Services on Linux, continue with Section 7.2, 
“Installation on Linux,” on page 134.
Otherwise, you are finished installing Management and Monitoring Services.

7.2  Installation on Linux
This section provides you with instructions for installing Management and Monitoring Services 
agents on Linux servers. Before you begin this process, you should thoroughly understand and plan 
your implementation.
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You can use the Management and Monitoring Services installation script to install the following 
agents on a single Linux server:

Linux Management Agent: Manages and monitors Linux servers. This includes fault 
management and performance management.
Advanced Trending Agent: Collects the trend data for SNMP variables. This includes 
threshold configuration and SNMP Trap generation.

You install Management and Monitoring Services’ agents individually on each Linux server using 
the Linux installation script on the Novell ZENworks 7 Server Management with Support Pack 1 
Program CD. All examples provided in the installation steps are case sensitive. Make sure that you 
copy the values as written in the installation steps.

Perform the following tasks in order:

1. Section 7.2.1, “Installing the Management and Monitoring Services Agents,” on page 135
2. Section 7.2.2, “Configuring the SNMP Service on Linux,” on page 136

7.2.1  Installing the Management and Monitoring Services 
Agents
At the Linux server where you want to install Management and Monitoring Services’ agents:

1 Log in as root.
2 Place the Novell ZENworks 7 Server Management with Support Pack 1 Program CD in the CD 

drive.
If auto-mount does not occur, mount the CD drive manually.

3 Review the Readme for any last-minute information concerning installation.
The product Readme is located in the \document\en directory on the Program CD.

4 If you are running X Windows, open an XTerm window on the Linux server console.
5 In the server prompt, change to the directory where the Management and Monitoring Services 

installation script is located:
cd /device_directory/ZfS/SvrMgmt/mms/Linux

where device_directory represents the mount point for the CD device and platform is Linux.
The installation script is named:

MMS_Linux_Install.pl

NOTE: The font used for the examples in this step is used throughout this section for case-
sensitive text that must be typed exactly as provided in the example.

6 To run the Management and Monitoring Services installation script, enter:
./MMS_Linux_Install.pl

The Welcome page is displayed.
7 Press Enter to display the license agreement, press the Spacebar to scroll through the license 

agreement, type y, then press Enter to accept the license agreement.
8 Type one of the numbers, separated by a space or a comma, to specify what you want to install:
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1 Linux Management Agent
2 Advanced Trending Agent
3 Both
For example, type 3, then press Enter.
The Linux Management Agent, Advanced Trending Agent, or both are installed based on the 
option you select. 

9 To confirm your selection, type y, then press Enter.
The installation script uses the Red Hat Package Manager (RPM) to install the program files. 
Installation progress displays on the page.

10 If you selected to install the Advanced Trending Agent in Step 8 at the end of installation, 
specify the IP address of the server and the community string where the traps need to be sent, 
then type q to quit. 
You can also add multiple trap targets.
You can manually add the Trap Targets by editing the snmpd.conf file that is used by the 
SNMPD Master Agent. In order for you to manage alarms from ConsoleOne, you must specify 
the IP address of the destination machine that is your site server. You can also specify multiple 
IP addresses. For more information, see “Management and Monitoring Services” in the Novell 
ZENworks 7 Server Management Administration Guide.
For Linux Management Agent, you need to manually edit the configuration file. For more 
information, see the Novell ZENworks 7 Server Management Administration Guide.

11 Press Enter to continue the installation.
12 Review the log file to determine the success or failure status of the installation.

The installation script logs all actions in the /var/opt/novell/zenworks/log/zfs-mms-
install.log file. Open this log file to verify if Management and Monitoring Services is 
installed successfully on the Linux server.
You can also refer to Appendix H, “Installation Error Messages,” on page 373 to troubleshoot 
specific errors.

13 If the installation was successful, repeat Step 1 through Step 12 for each Linux server.
14 After you have installed the Management and Monitoring Services’ agents on your Linux 

server, you need to restart the SNMP daemon and the agents on each server. For more 
information, see “Starting the Agents on Linux Servers” on page 332 or “Stopping the Agents 
on Linux Servers” on page 333.

IMPORTANT: Make sure that the line “rocommunity public 127.0.0.1” exists in the /
etc/snmp/snmpd.conf file and that it is not commented out before you start the SNMP 
daemon.

15 Continue with Section 7.2.2, “Configuring the SNMP Service on Linux,” on page 136.

7.2.2  Configuring the SNMP Service on Linux
To access the Management and Monitoring Services’ agents on the Linux machine, you must 
configure the SNMP Service on your Linux machine. 
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The SNMP service on Linux uses the settings that are read from the snmpd.conf file located in the /
etc/snmp/ directory. To change the settings of the service, you can directly edit the configuration 
file. For the service to pick up the configuration changes, restart the SNMP service after you modify 
the snmpd.conf file.

To provide read-only access to all of the OIDs in the MIB tree required for the local host and the site 
server, add the following lines in the snmpd.conf file:

rocommunity <read_community> localhost .1
rocommunity <read_community> <site_server_IP address> .1

For help on the settings, enter man snmpd.conf.

To provide write access for the site server, add the following lines in the snmpd.conf file:

view mmsWriteView included .1.3.6.1.4.1.23.2.102
view mmsWriteView included .1.3.6.1.2.1.16.18
com2sec mmsWriteUser <site_server_IP address> <write_community>
group mmsWriteGroup v1 mmsWriteUser
group mmsWriteGroup v2 mmsWriteUser
access mmsWriteGroup ““ any noauth exact none mmsWriteView none

NOTE: You must specify the <read_community> in the NXPCON for NetExplorerTM to discover 
this on the Linux machine.

For the views to display, you must specify the <read_community> and the <write_community> in 
the SNMP Properties tab in the Property page.
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IVUpgrade

You can upgrade to Novell® ZENworks® 7 Server Management with Support Pack 1 (SP1) from 
previous versions of ZENworks for Servers (2 or 3.0.2), ZENworks Server Management (6.5, 6.5 
SP1, or 6.5 SP2), or ZENworks 7 Server Management.

You should not use an upgrade program to reinstall any ZENworks 7 Server Management with SP1 
component. Instead, use the installation program (see Part III, “Installation,” on page 63).

In the following sections, the first provides an upgrade overview, the second and third describe 
what’s new in ZENworks 7 Server Management and ZENworks 7 Server Management with SP1 
(after ZENworks 6.5 SP1 Server Management was released; for ZENworks 6.5 SP2 enhancements, 
see What’s New (http://www.novell.com/documentation/zenworks65/sminstall/data/aftfgrq.html) in 
the ZENworks 6.5 Server Management Installation Guide.) The other sections provide the different 
upgrade options for Server Management:

Chapter 8, “Overview,” on page 141
Chapter 9, “What’s New in Version 7,” on page 145
Chapter 10, “What’s New in Support Pack 1,” on page 151
Chapter 11, “Version 6.5 or Later Policy and Distribution Services,” on page 155
Chapter 12, “Version 3.0.2 Policy and Distribution Services,” on page 185
Chapter 13, “Server Inventory,” on page 227
Chapter 14, “Remote Management,” on page 249
Chapter 15, “Management and Monitoring Services,” on page 253
Chapter 16, “ManageWise 2.7,” on page 259
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8Overview

Review the following to understand how to upgrade to Novell® ZENworks® 7 Server Management 
with Support Pack 1 (SP1):

Section 8.1, “Upgrading from ZENworks for Servers 2,” on page 141
Section 8.2, “Upgrading from ZENworks for Servers 3.0.2,” on page 141
Section 8.3, “Upgrading from ZENworks 6.5 or Later,” on page 143

8.1  Upgrading from ZENworks for Servers 2
If ZENworks for Servers 2 is installed in the same network as ZENworks 7 Server Management 
with SP1, there is no interoperability between these two ZENworks versions. In other words, you 
cannot do an incremental upgrade from version 2 to version 7 and have interoperability between 
version 7 and version 2 servers. For more information, see Section 17.1.1, “Interoperability with 
ZENworks for Servers 2,” on page 265.

You can upgrade from ZENworks for Servers 2 to ZENworks 7 Server Management with SP1, but 
only indirectly for the following Server Management components:

Policy and Distribution Services
Server Inventory
Remote Management
Management and Monitoring Services

There are two methods for upgrading ZENworks for Servers 2 components to ZENworks 7 Server 
Management with SP1:

Uninstall version 2: Then install ZENworks 7 Server Management with SP1 new. You cannot 
upgrade directly to ZENworks 7 Server Management with SP1 from ZENworks for Servers 2.

For instructions on uninstalling version 2, see ZENworks for Servers 2 documentation Web site 
(http://www.novell.com/documentation/lg/zfs2/index.html). Under Policy and Distribution 
Services, click Uninstalling ZENworks for Servers Policy and Distribution Services.
Upgrade first to version 3.0.2: Then upgrade from version 3.0.2 to ZENworks 7 Server 
Management with SP1 using the instructions in this guide (see Section 8.2, “Upgrading from 
ZENworks for Servers 3.0.2,” on page 141).
For instructions to upgrade to version 3.0.2, go to the ZENworks for Servers 3.0.2 
documentation Web site (http://www.novell.com/documentation/lg/zfs302/index.html). Under 
Installation, click Upgrading ZENworks for Servers 2.

Continue with Section 8.2, “Upgrading from ZENworks for Servers 3.0.2,” on page 141.

8.2  Upgrading from ZENworks for Servers 3.0.2
Review the following sections to upgrade to ZENworks 7 Server Management with SP1:

Section 8.2.1, “Upgrade Order,” on page 142
Overview 141
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Section 8.2.2, “Upgrade Methods,” on page 142
Section 8.2.3, “Upgrade Instructions,” on page 143

8.2.1  Upgrade Order
ZENworks for Servers 3.0.2 components must be upgraded independently to ZENworks 7 Server 
Management with SP1 components. We recommend the following upgrade order:

1. Extend the Schema (required before upgrading any component) using the instructions in 
Chapter 12, “Version 3.0.2 Policy and Distribution Services,” on page 185.

2. Upgrade Policy and Distribution Services using the instructions in Chapter 12, “Version 3.0.2 
Policy and Distribution Services,” on page 185.

IMPORTANT: If you have External Subscriber servers to upgrade from version 3.0.2 (or 
version 3 SP2), to successfully send Distributions to those External Subscriber servers from 
Distributors that have been upgraded to version 7 with SP1 you must do one of the following:

Before upgrading the Distributor that you will use to send the Server Package Distribution 
(for CPKs), update your External Subscriber servers with the Interim Release 4 CPK 
before you upgrade those servers to version 7 with SP1; then, upgrade the Distributor 
server to version 7 with SP1 and thereafter upgrade the External Subscriber servers to 
version 7 with SP1 using the CPK upgrade Distributions from any version 7 with SP1 
Distributor server.

Using the GUI upgrade, upgrade both the Distributor servers and External Subscriber servers 
to version 7 with SP1 at the same time. Then you can send version 7 with SP1 
Distributions to the upgraded External Subscriber servers.

After upgrading the Distributor and External Subscriber servers to version 7 with SP1, delete 
the ted.cfg file on the upgraded Distributor server, then restart the Distributor service. 
Then you can send version 7 with SP1 Distributions to the upgraded External Subscriber 
servers.

3. Upgrade Server Inventory using the instructions in Chapter 13, “Server Inventory,” on 
page 227. (Server Inventory requires Policy and Distribution Services to be upgraded first.)

4. Upgrade Remote Management using the instructions in Chapter 14, “Remote Management,” on 
page 249.

5. Upgrade Management and Monitoring Services using the instructions in Chapter 15, 
“Management and Monitoring Services,” on page 253.

8.2.2  Upgrade Methods
There are two methods for upgrading the ZENworks for Servers 3.0.2 components to ZENworks 7 
Server Management with SP1:

GUI upgrade program: For NetWare and Windows servers, various options in the wizard that 
you run from the Novell ZENworks 7 Server Management with Support Pack 1 Program CD 
provide upgrading for each of the Server Management components.

For all platforms, this method must be used to upgrade the Distributor and Subscriber 
eDirectoryTM objects.
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For Linux and Solaris servers for the Policy and Distribution Services component, upgrading 
Distributors is done using a script, which detects an existing ZENworks for Servers version and 
provides the upgrade option.

Distributor objects for Linux or Solaris Distributor servers must be upgraded first using the 
GUI upgrade program.
Server Software Package: You can use the .cpk file available on the Novell ZENworks 7 with 
Support Pack 1 Compaion 3 CD to upgrade each of the Server Management components for 
the each of the supported operating systems (except for Distributors on Linux and Solaris 
servers). This method simply requires creation of Software Package Distributions to be sent to 
the Subscriber servers that you want to upgrade.
This method does not upgrade Subscriber eDirectory objects. That must be done using the GUI 
upgrade program.
For Server Inventory, only the Inventory Agent can be upgraded using a Server Software 
Package (.cpk file).

For issues dealing with interoperability between ZENworks Server Management and ZENworks 
Desktop Management, see Part V, “Interoperability,” on page 263.

To review what’s new in ZENworks 7, see Chapter 9, “What’s New in Version 7,” on page 145.

To review what’s new in ZENworks 7 with SP1, see Chapter 10, “What’s New in Support Pack 1,” 
on page 151.

8.2.3  Upgrade Instructions
Continue with the applicable upgrade section:

Chapter 12, “Version 3.0.2 Policy and Distribution Services,” on page 185
Chapter 13, “Server Inventory,” on page 227
Chapter 14, “Remote Management,” on page 249
Chapter 15, “Management and Monitoring Services,” on page 253
Chapter 16, “ManageWise 2.7,” on page 259

8.3  Upgrading from ZENworks 6.5 or Later
There are three methods for upgrading the ZENworks 6.5 Policy-Enabled Server Management 
components to version 7:

GUI wizard: For NetWare and Windows servers, various menu options in the installation 
program run from the Novell ZENworks 7 Server Management with Support Pack 1 Program 
CD access wizards for upgrading each of the Server Management components: Policy and 
Distribution Services, Server Inventory, Remote Management, and Management and 
Monitoring Services.
Script: For the Policy and Distribution Services component only, upgrading Linux and Solaris 
servers to ZENworks 7 with SP1 can be done using a script included on the Novell ZENworks 7 
Server Management with Support Pack 1 Program CD.
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Server Software Package: You can use the .cpk files available on the Novell ZENworks 7 
with Support Pack 1 Compaion 3 CD to upgrade the Policy-Enabled Server Management 
components for the each of the supported operating systems. This method simply requires 
creation of Software Package Distributions to be sent to the Subscriber servers that you want to 
upgrade.
For Server Inventory, only the Inventory Agent can be upgraded using a Server Software 
Package.
You cannot upgrade Management and Monitoring Services using a Server Software Package.

Continue with the applicable section:

To review what’s new in ZENworks 7 Server Management, see Chapter 9, “What’s New in 
Version 7,” on page 145.
To review what’s new in ZENworks 7 Server Management with SP1, see Chapter 10, “What’s 
New in Support Pack 1,” on page 151.
For issues dealing with interoperability between ZENworks Server Management and 
ZENworks Desktop Management, see Part V, “Interoperability,” on page 263.
To upgrade to ZENworks 7 Server Management with SP1 (except ZENworks for Servers 3.0.2 
Policy and Distribution Services), continue with:

Chapter 11, “Version 6.5 or Later Policy and Distribution Services,” on page 155
Chapter 13, “Server Inventory,” on page 227
Chapter 14, “Remote Management,” on page 249
Chapter 15, “Management and Monitoring Services,” on page 253
Chapter 16, “ManageWise 2.7,” on page 259
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9What’s New in Version 7

The following sections describe what’s new in Novell® ZENworks® 7 Server Management after 
version 6.5 Support Pack 1 (SP1) shipped:

Section 9.1, “General Changes,” on page 145
Section 9.2, “Policy and Distribution Services,” on page 147
Section 9.3, “Server Inventory,” on page 147
Section 9.4, “Remote Management,” on page 148
Section 9.5, “Management and Monitoring Services,” on page 148

For information on what changed between versions 6.5 SP1 and 6.5 SP2 of Novell ZENworks 
Server Management, see What’s New (http://www.novell.com/documentation/zenworks65/
sminstall/data/aftfgrq.html) in the ZENworks 6.5 Server Management Installation Guide.

9.1  General Changes
Section 9.1.1, “Supported Platforms Updated,” on page 145
Section 9.1.2, “Installation and Upgrade Methods Changed,” on page 145
Section 9.1.3, “New Sybase Version for the ZENworks Databases,” on page 146

9.1.1  Supported Platforms Updated
ZENworks 7 Server Management added support for the following platforms:

SUSE® Linux Enterprise Server 9 SP1 and SP2
SUSE Linux Standard Server 9 SP1 and SP2
Red Hat Advanced Server 4 _x86
Red Hat Enterprise Server 4 _x86

The following platforms are generally not supported by ZENworks 7 Server Management:

NetWare 4.x
NetWare 5.0
Windows NT* 4

For more information, see Chapter 5, “Server Requirements,” on page 45.

9.1.2  Installation and Upgrade Methods Changed
Upgrading Policy and Distribution Services using the GUI installation program has changed in 
ZENworks 7. Upgrading for Management and Monitoring Services remains unchanged.

In ZENworks 6.5 Policy-Enabled Server Management, you have the following menu options for 
installing version 6.5 or upgrading to version 6.5 from version 3.0.2:
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Table 9-1   Options for Installing v6.5 or Upgrading from v3.0.2

In ZENworks 6.5 SP1 Policy-Enabled Server Management, you have the following new menu 
option for upgrading to SP1:

Table 9-2   Options for upgrading to SP1

In ZENworks 7 Policy-Enabled Server Management, you now have the following menu options for 
installing and upgrading:

Table 9-3   Options for Installing v7 or Upgrading to v7

9.1.3  New Sybase Version for the ZENworks Databases
Upgrading from a previous version of ZENworks using the graphical upgrade program or the .cpk 
file on the Novell ZENworks 7 with Support Pack 1 Companion 2 CD upgrades the Sybase engine to 
version 8.0.2, if it is not already at that version.

Menu Option Components Installed or Upgraded

Install Policy-Enabled Server 
Management

Does either of the following:

Installs Policy and Distributions Services, Server Inventory, and 
Remote Management

Upgrades Server Inventory and Remote Management

Policy and Distribution Services 
Upgrade

Upgrades the following from version 3.0.2:

Policy and Distribution Services

Menu Option Components Installed or Upgraded

Upgrade Policy-Enabled Server 
Management

Upgrades the following from version 6.5 to SP1:

Policy and Distribution Services

Server Inventory

Remote Management

Menu Option Components Installed or Upgraded

Install Policy-Enabled Server 
Management

Does either of the following:

Installs Policy and Distributions Services, Server Inventory, and 
Remote Management

Upgrades Server Inventory and Remote Management

Upgrade v6.5 Policy and 
Distribution Services

Upgrades Policy and Distribution Services from versions 6.5 or 6.5 
SP1.

Upgrade v3.0.2 Policy and 
Distribution Services

Upgrades Policy and Distribution Services from version 3.0.2.
 ZENworks 7 Server Management Installation Guide



novdocx (en)  16 A
pril 2010
If a zfslog.db file exists for the previous version of ZENworks, it is not replaced. If it does not 
exist, a new file is installed during the upgrade.

9.2  Policy and Distribution Services
Policy and Distributions Services for ZENworks 7 is generally the same as ZENworks 6.5 SP1, with 
the following differences:

New upgrade options: For an explanation of the new upgrade options, see Section 9.1.2, 
“Installation and Upgrade Methods Changed,” on page 145.
New workstation installation option: With ZENworks 7, you can install Policy and 
Distribution Services (Subscriber only) to a workstation (see Section 6.2, “Installation on 
Windows Workstations,” on page 101).

9.3  Server Inventory
Server Inventory in ZENworks 7 Server Management provides the following new features:

Section 9.3.1, “Upgrading Server Inventory from Previous Versions of ZENworks Server 
Management to ZENworks 7 Server Management,” on page 147
Section 9.3.2, “Quickly and Easily Viewing the Inventory Data,” on page 147
Section 9.3.3, “Setting Up the Oracle9i Inventory Database on a UNIX Server,” on page 148
Section 9.3.4, “Setting Up the Oracle10g Inventory Database on Windows or UNIX Servers,” 
on page 148
Section 9.3.5, “Improving the Throughput of the ZENworks 7 Inventory Storer,” on page 148
Section 9.3.6, “Connecting the Linux Inventory Server and ConsoleOne to the MS SQL 2000 
Inventory Database,” on page 148

9.3.1  Upgrading Server Inventory from Previous Versions of 
ZENworks Server Management to ZENworks 7 Server 
Management
Upgrading Server Inventory from ZENworks for Servers 3.0.2, ZENworks 6.5 Server Management, 
or ZENworks 6.5 SP1/SP2 Server Management, or ZENworks 7 Server Management to ZENworks 
7 with SP1 Server Management is supported.

9.3.2  Quickly and Easily Viewing the Inventory Data
Server Inventory provides a new tool known as Quick Reports to easily retrieve and view the data 
from the ZENworks Inventory database. Each Quick Report contains a list of inventory components 
and a query that you define using the Quick Report wizard. 

For detailed information, see “Quickly and Easily Viewing the Inventory Data Using Quick 
Reports” in “Server Inventory” in the Novell ZENworks 7 Server Management Administration 
Guide.
What’s New in Version 7 147



148 Novell

novdocx (en)  16 A
pril 2010
9.3.3  Setting Up the Oracle9i Inventory Database on a UNIX 
Server
You can now set up the Oracle9i Inventory database on a UNIX server. 

For detailed information, see “Creating the Oracle9i Inventory Database on a UNIX Server” in 
“Server Inventory” in the Novell ZENworks 7 Server Management Administration Guide.

9.3.4  Setting Up the Oracle10g Inventory Database on 
Windows or UNIX Servers
You can now set up the Oracle10g R1 Inventory database on Windows or UNIX servers. 

For detailed information, see “Setting Up the Oracle Inventory Database” in “Server Inventory” in 
the Novell ZENworks 7 Server Management Administration Guide.

9.3.5  Improving the Throughput of the ZENworks 7 Inventory 
Storer
You can now improve the throughput of the ZENworks Inventory Storer by deploying multiple Root 
Servers to directly store the inventory data to the Oracle 9.2.0.6 Inventory database.

For detailed information, see “Improving the Throughput of the Inventory Storer” in “Server 
Inventory” in the Novell ZENworks 7 Server Management Administration Guide.

9.3.6  Connecting the Linux Inventory Server and ConsoleOne 
to the MS SQL 2000 Inventory Database
To set up the Inventory database for MS SQL Server 2000, you must perform the following steps:

1. Configuring the Inventory Database for MS SQL Server 2000
2. Connecting the Linux Inventory Server and ConsoleOne to the Inventory Database Running 

MS SQL 2000

For detailed information, see “Setting Up the MS SQL Server 2000 or MS SQL Server 2005 
Inventory Database” in “Server Inventory” in the Novell ZENworks 7 Server Management 
Administration Guide.

9.4  Remote Management
Remote Management for ZENworks 7 is the same as for ZENworks 6.5 SP1. Nothing new is added 
for version 7.

9.5  Management and Monitoring Services
Management and Monitoring Services in ZENworks 7 Server Management provides the following 
new features:

Section 9.5.1, “Managing NetWare Traps,” on page 149
Section 9.5.2, “Rule Based Alarm Manager,” on page 149
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9.5.1  Managing NetWare Traps
You can enable, disable and specify time intervals for NetWare and NDS Traps for multiple 
NetWare server from ConsoleOne.

9.5.2  Rule Based Alarm Manager
You can create rules for managing incoming alarms and performing various actions on it. The 
alarms are processed based on the rules you have created. The rules can be created from the 
combination of following parameters:

Source Address
Severity
State
Alarms
Varbinds for traps
Time
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10What’s New in Support Pack 1

The following sections describe what’s new in Novell® ZENworks® 7 Server Management with 
Support Pack 1 (SP1):

Section 10.1, “Policy and Distribution Services,” on page 151
Section 10.2, “Server Inventory,” on page 151
Section 10.3, “Remote Management,” on page 152
Section 10.4, “Management and Monitoring Services,” on page 152
Section 10.5, “New in Release 2, Interim Release 1,” on page 152
Section 10.6, “New in SP1 Interim Release 3a,” on page 152
Section 10.7, “New in SP1 Interim Release 4,” on page 153

10.1  Policy and Distribution Services
Policy and Distributions Services in ZENworks 7 with SP1 provides the following new features:

Section 10.1.1, “Password for Remote Web Console,” on page 151

10.1.1  Password for Remote Web Console
Added the ability to create a password to secure the features of Remote Web Console in Novell 
iManager.

For more information, see “Setting Up Passwords for Remote Web Console” in the Novell 
ZENworks 7 Server Management Administration Guide.

10.2  Server Inventory
Server Inventory in ZENworks 7 with SP1 provides the following new features:

Section 10.2.1, “MS SQL 2005 for the Inventory Database,” on page 151
Section 10.2.2, “Oracle 10g R2 for the Inventory Database,” on page 151

10.2.1  MS SQL 2005 for the Inventory Database
With SP1, the MS SQL 2005 database is available for use with the Inventory database.

For more information, see “Setting Up the MS SQL Server 2000 or MS SQL Server 2005 Inventory 
Database” in the Novell ZENworks 7 Server Management Administration Guide.

10.2.2  Oracle 10g R2 for the Inventory Database
With SP1, the Oracle 10g R2 database is available for use with the Inventory database.

For more information, see “Setting Up the Oracle Inventory Database” in the Novell ZENworks 7 
Server Management Administration Guide.
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10.3  Remote Management
Remote Management in ZENworks 7 with SP1 is the same as ZENworks 7. Nothing new is added 
for SP1 in Beta 1.

10.4  Management and Monitoring Services
Management and Monitoring Services in ZENworks 7 with SP1 provides the following new 
features:

Section 10.4.1, “Probe Manageability Enhancement,” on page 152
Section 10.4.2, “VLAN Atlas,” on page 152
Section 10.4.3, “Support for Multiple NIC,” on page 152

10.4.1  Probe Manageability Enhancement
You can launch Probe Manageability tool at any level below Atlast and perform the MIB Discovery 
on multiple nodes. This will display the details of all discovered and undiscovered MIBs.

For more information, see “Using the Probe Manageability Tool” in the Novell ZENworks 7 Server 
Management Administration Guide.

10.4.2  VLAN Atlas
Because VLAN Atlas is a custom atlas, all operations that are possible in a custom atlas are possible 
for VLAN Atlas, as well. 

For more information, see “VLAN Atlas” in the Novell ZENworks 7 Server Management 
Administration Guide.

10.4.3  Support for Multiple NIC 
With SP1, you can run the MMS Site Server on a NetWare server with multiple NICs or multiple IP 
addresses.

10.5  New in Release 2, Interim Release 1
ZENworks Server Management Support Pack 1, Release 2, Interim Release 1 includes two new 
additions to the supported platforms:

SUSE Linux Enterprise Server 10 SP1
Windows Server 2003 SP2

10.6  New in SP1 Interim Release 3a
ZENworks Server Management Support Pack 1 Interim Release 3a  includes two new additions to 
the supported platforms:

SLES 9 SP 4
SLES 10 SP2
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NetWare 6.5 SP7
OES 2.0

10.7  New in SP1 Interim Release 4
ZENworks Server Management Support Pack 1 Interim Release 4  includes two new additions to the 
supported platforms:

OES (Linux) 2.0 SP1 32-bit
OES (Linux) 2.0 SP1 64-bit
Netware 6.5 SP8
eDirectory 8.8 SP4
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11Version 6.5 or Later Policy and 
Distribution Services

Novell® ZENworks® 7 Server Management with Support Pack 1 (SP1) provides upgrading Policy 
and Distribution Services from ZENworks 6.5 Server Management, ZENworks 6.5 SP1 or SP2 
Server Management, or ZENworks 7 Server Management.

The following sections explain how to upgrade to version 7:

Section 11.1, “Upgrading Using a Wizard or Script,” on page 155
Section 11.2, “Upgrading Using a Server Software Package,” on page 177

11.1  Upgrading Using a Wizard or Script
There are two platform-based options for upgrading to ZENworks 7 with SP1 using a wizard or 
script:

NetWare and Windows servers: For these platforms, the wizards are started on the Windows 
workstation from installation menu options run from an executable file run from the Novell 
ZENworks 7 Server Management with Support Pack 1 Program CD.

Policy and Distribution Services can be upgraded to ZENworks 7 with SP1 using this method. 
However, if you want to use a GUI upgrade program for version 3.0.2 Policy and Distributions 
Services, you must use the upgrade program described in Chapter 12, “Version 3.0.2 Policy and 
Distribution Services,” on page 185, and not the upgrade program described in this section.

The Distributor and Subscriber servers can be upgraded to ZENworks 7 with SP1 in any order.
Linux and Solaris servers: For these platforms, a script file is used. It is provided on the 
Novell ZENworks 7 with Support Pack 1 Companion 2 CD and is run locally on each Linux or 
Solaris server to be upgraded.
Only Policy and Distribution Services 6.5 or later can be upgraded using this method.

To automate installation to multiple Subscriber servers on all supported platforms, we recommend 
upgrading these servers using the Server Software Package method (see Section 11.2, “Upgrading 
Using a Server Software Package,” on page 177), which can be used to upgrade all previous 
versions (3.0.2, 6.5, 6.5 SP1, and 6.5 SP2).

To upgrade to ZENworks 7 with SP1 Policy and Distribution Services using a wizard or script, 
continue with the applicable sections:

Section 11.1.1, “Upgrade Concepts and Issues,” on page 156
Section 11.1.2, “Selecting the Servers to Upgrade,” on page 158
Section 11.1.3, “Upgrading Policy-Enabled Server Management on NetWare and Windows 
Servers,” on page 159
Section 11.1.4, “Upgrading Policy and Distribution Services on Linux and Solaris Servers,” on 
page 175
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11.1.1  Upgrade Concepts and Issues
Review the following to understand what the upgrade does, and to understand the issues involved:

“What the Upgrade Does and Does Not Do” on page 156
“Upgrading Servers Incrementally” on page 157
“Upgrading Servers on Multiple Trees” on page 157
“Cluster Issues with Upgrading” on page 157

What the Upgrade Does and Does Not Do

In the following table, the applicable Server Management components are indicated for the upgrade 
actions:

Table 11-1   Upgrade Actions

Action P

Upgrades ZENworks for Servers 3.0.2 Policy and Distribution Services to ZENworks 7 with SP1. F

Upgrades ZENworks Server Management 6.5, 6.5 SP1, 6.5 SP2, or 7 Policy and Distribution 
Services to ZENworks 7 with SP1.

T

Installs Policy and Distribution Services components where they were previously not installed. F

Upgrades Novell eDirectoryTM objects. T

The GUI wizard upgrades the ZENworks 6.5 Policy and Distribution Services software to version 7 on 
the servers where it discovers upgradable software. It uses the installation paths where ZENworks 
6.5 was installed.

T

The script upgrades ZENworks 6.5 Policy and Distribution Services software to version 7 on the 
Linux or Solaris machines where you locally run the script.

T

In the GUI wizard, you cannot select or deselect any check boxes. Their status is determined by the 
wizard when you select the machines for upgrading.

T

The wizard automatically stops and restarts the services, if they are running. It leaves the services in 
the same state they were in before upgrading.

T

The services are not restarted if they are not running before the wizard started. T

You have an option to restart the services if they are not running before the wizard started. F

Files are always copied, replacing both older and newer files with the upgraded files. Files copied to 
locations outside of the ZENworks directories are replaced only if they are older.

T

If you already have a hook driver installed on the machine where you are upgrading, the hook driver 
is uninstalled during the upgrade.

–

The wizard upgrades the ConsoleOne® snap-ins to ZENworks 7 with SP1 on both the installation 
workstation and any target servers where ConsoleOne is found by the wizard. For the ConsoleOne 
check box to show as selected, version 6.5 or later of the snap-ins must have been previously 
installed.

T

In the wizard, you cannot select workstations where ConsoleOne is installed to update the Server 
Management snap-ins there. You must run the wizard on each workstation where you have the snap-
ins installed in order to locally update them.

T
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NOTE: P = Policy and Distribution Services; T = true; F = false; and, – = not applicable.

Upgrading Servers Incrementally

You can upgrade all ZENworks servers to version 7 in one pass, or incrementally (such as for 
geographical locations).

The wizard copies files to each server, one server after another. If you have many Subscribers, 
consider the time that it might take to upgrade them. If that time frame is too long, select your target 
Subscribers in groups so that you can upgrade one group at a time, or use the software package 
upgrade method.

Because upgrading Policy and Distribution Services on Linux and Solaris servers is done locally one 
at a time using a script, incremental upgrading doesn’t apply. If you want to perform incremental 
upgrades of groups of Linux or Solaris servers, consider using a Server Software Package. 

For more information on upgrading with software packages, see Section 11.2, “Upgrading Using a 
Server Software Package,” on page 177.

Upgrading Servers on Multiple Trees

When selecting servers in the wizard, you select them by their NCP Server objects, not their 
ZENworks objects. If your ZENworks servers reside in multiple trees, you must be logged into each 
of those trees to be able to select the servers.

You can also upgrade servers across multiple trees by using a Server Software Package (see 
Section 11.2, “Upgrading Using a Server Software Package,” on page 177).

Cluster Issues with Upgrading

Review the following cluster issues:

“Upgrading Cluster Ready versus Cluster Aware Servers” on page 157
“Cannot Upgrade Clustered Servers Using the Server Software Packages” on page 158

Upgrading Cluster Ready versus Cluster Aware Servers

When you select servers for installing ZENworks 7 with SP1, you can select both the virtual server’s 
cluster object and the NCP Server objects of the node servers in the cluster, and the installation 
program allows you to install to both the virtual server and its nodes. However, if you install 
ZENworks 7 with SP1 to both, you will have two different locations for the zfs.ncf startup file and 
it will be run from both locations, causing errors. Therefore, you must know whether you installed 
Server Management in a cluster ready or cluster aware environment before you select where to 
install ZENworks 7 with SP1.

The ZENworks 6.5 Policy and Distribution Services plug-ins for iManager are not upgraded by the 
Policy-Enabled Server Management menu option. You must do this with the Web-Based 
Management Components menu option after you have exited the upgrade wizard. This task is 
covered in “Upgrading the Novell iManager Plug-Ins” on page 167.

Also, if you have iManager 2.0.2, 2.5, or 2.6 installed, you can install the plug-ins for the first time 
using the task covered in “Upgrading the Novell iManager Plug-Ins” on page 167.

T

Action P
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If your ZENworks servers are installed as cluster ready:

You must select only the virtual server object to install ZENworks 7 with SP1
The ZENworks 7 with SP1 installation copies files to each node in the cluster
The ZENworks 7 with SP1 installation sets up one zfs.ncf file for the cluster

If your ZENworks servers are installed as cluster aware:

You must select only the node servers’ NCP Server objects to install ZENworks 7 with SP1
The ZENworks 7 with SP1 installation copies files to each node in the cluster
The ZENworks 7 with SP1 installation sets up the zfs.ncf file on each node’s server

For more information, see Appendix F, “ZENworks Server Management in a Clustered 
Environment,” on page 343.

Cannot Upgrade Clustered Servers Using the Server Software Packages

The Novell ZENworks 7 with Support Pack 1 Companion 2 CD includes the following Server 
Software Package for Policy and Distribution Services:

zsm7_polydist.cpk

Server Software Packages cannot be used to upgrade clustered servers to ZENworks 7 with SP1 for 
the following reasons:

Server Software Packages do not have eDirectory access
Server Software Packages can only update the local box, leaving the other nodes not updated

11.1.2  Selecting the Servers to Upgrade
Incremental issues: In determining which servers you want to upgrade to ZENworks 7 with 
SP1, consider any incremental upgrade issues. For more information, see “Upgrading Servers 
Incrementally” on page 157.
Servers to be upgraded using a wizard: If you plan to run the wizard, you might be able to 
wait until you are running the wizard to determine which servers to upgrade, because you can 
use one of the following methods for selecting NetWare® and Windows servers:

If a small percentage of your servers have an earlier version of ZENworks installed on 
them, and you know the NCP Server object names of the servers that have ZENworks 
installed on them, you can individually select those servers when you are running the 
wizard.
If a large percentage (or all) of your servers have an earlier version of ZENworks installed 
on them, you can select all of the servers in the tree or selected context. Only those that 
have upgradable ZENworks components installed on them are listed on the Server 
Selection page for upgrading.
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Servers to be upgraded using a Server Software Package: If you plan to use the Server 
Software Package method, determine which servers you want to upgrade:

If a small percentage of your servers have an earlier version of ZENworks installed on 
them, you can include all of your Subscriber servers in the Channel that you create for the 
Distribution. When you select a Subscriber server to be upgraded that also has the 
Distributor software on it, that software is also upgraded.
If a large percentage of your servers have an earlier version of ZENworks installed on 
them and you want to upgrade them incrementally, such as by geographic region, identify 
which servers you want in each group so that you can subscribe them to the Channels that 
you create for each group.

When upgrading using a software package, you can create a unique Channel for the upgrade 
Distribution, then subscribe the Subscribers to be upgraded to that Channel.
Servers to be upgraded using a script: If you do not plan to use the Server Software Package 
method for upgrading Linux or Solaris servers, identify the servers where you need to run the 
script.

11.1.3  Upgrading Policy-Enabled Server Management on 
NetWare and Windows Servers
To upgrade ZENworks 6.5 or 7 Policy-Enabled Server Management to ZENworks 7 with SP1, 
perform the following tasks in order:

1. “Pre-upgrade Checklist” on page 159
2. “Upgrading to ZENworks 7 with SP1” on page 160
3. “Upgrading the Novell iManager Plug-Ins” on page 167
4. “Starting the Services” on page 173
5. “Verifying That the Services Are Running Successfully” on page 173
6. “Verifying That the Server Is Upgraded” on page 174
7. “Repeating the Upgrade” on page 175
8. “Post-Upgrade Manual Distribution Task” on page 175

Pre-upgrade Checklist

Review the Novell ZENworks 7 Server Management with Support Pack 1 Readme on the 
ZENworks 7 Web site (http://www.novell.com/documentation/zenworks7/index.html) for any 
last-minute information concerning upgrading to version 7.
Make sure that a previous version of ZENworks Server Management is installed on the servers 
you want to upgrade to version 7.
Make note of any clustered servers and determine whether they have ZENworks installed as 
cluster ready or cluster aware. For more information, see “Cluster Issues with Upgrading” on 
page 157.
If you have any instance of ConsoleOne running on a target server via a mapped drive from a 
workstation, or it is running from the installation machine, exit those instances of ConsoleOne 
before running the installation program.
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If ConsoleOne is running on a target server via a mapped drive on your installation machine, or 
if it is running from the installation machine, the ZENworks Server Management snap-ins for 
ConsoleOne cannot be installed at those locations.
If you have not already done so, log in to the eDirectory trees that contain the NCP Server 
objects for the servers where you are updating the ZENworks software.
You are automatically authenticated to all of the target NetWare servers in the trees you are 
logged in to during installation, so that you can select those servers for installing the Server 
Management software.
If you are not logged in to a tree, you cannot select its server objects during the upgrade 
process.
You can run the wizard as many times as necessary.
If you install software to any Windows servers, make sure that you have authenticated to those 
servers.
This enables you to select Windows servers from their domains for installing the Distributor 
and Subscriber software. However, if you are not logged in to a Windows server before starting 
the installation, you can authenticate during installation using a username and password in the 
Add Server dialog box where you select the Windows server for installation.
If you install software to any Windows servers, make sure you have closed the Services 
window on each Windows server.
The installation program automatically stops all ZENworks Server Management services. 
However, the Server Management services cannot be registered if the Services window is left 
open during installation to the server.

Upgrading to ZENworks 7 with SP1

To upgrade previous versions of ZENworks to ZENworks 7 Server Management with SP1, do the 
following tasks in order:

1. “Start the Installation Program” on page 160
2. “Select the Servers to Upgrade” on page 164
3. “Review the Upgrade Summary” on page 166

Start the Installation Program

1 On the upgrade workstation, insert the Novell ZENworks 7 Server Management with Support 
Pack 1 Program CD.
The startup screen is displayed. If the startup screen is not automatically displayed after 
inserting the CD, run winsetup.exe at the root of the CD.
We recommend that you upgrade Policy and Distribution Services from the Program CD. 
However, if you need to copy the CD structure to a hard drive, the path between the root of the 
hard drive and the first CD directory can contain only directory names that conform to the 8.3-
character DOS file naming convention. If any long directory names exist in the path, the 
upgrade program does not work.
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2 On the main menu, select Server Management.
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3 Select Upgrade Policy-Enabled Server Management to start the wizard and display the License 
Agreement page.
 ZENworks 7 Server Management Installation Guide



novdocx (en)  16 A
pril 2010
4 If you agree to the Software License Agreement, click Accept, then click Next; otherwise, click 
Cancel to exit.
The Server Selection page is displayed with only the Local Machine option and its ConsoleOne 
snap-ins check box enabled, if the ZENworks snap-ins are installed on that machine.

5 Continue with “Select the Servers to Upgrade” on page 164.
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Select the Servers to Upgrade

Figure 11-1   Support Pack Upgrade Server Selection Page

1 On the Server Selection page, click Add servers to display the Add Servers dialog box.
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2 Browse for the NCP Server objects for the servers that you want to upgrade, then click OK.
You can browse for NetWare servers by selecting eDirectory Trees from a drop-down box, or 
browse for Windows servers by selecting Microsoft Domains (or Microsoft Active Directory) 
from a drop-down box. You can select servers in the following ways:

Select servers individually or in multiples by using the Ctrl and Shift keys.
Select servers in groups by selecting eDirectory containers, Windows workgroups, or 
Microsoft domains, then clicking the Add All Servers button.
Select all NetWare servers in the tree by selecting the tree and then clicking the Add All 
Servers button.

IMPORTANT: If you select Add All Servers, the Selected Servers list box includes servers that 
cannot be upgraded (such as those that do not have ZENworks 6.5 installed). Then, when you 
click OK to continue, those servers are not included on the Server Selection page. However, for 
each server that is not included, a message is displayed indicating this, and you must click OK 
to continue. To speed up the process, if you can determine in the Selected Servers list box 
which servers do not have ZENworks 6.5 installed, remove them from this list before clicking 
OK to continue to the Server Selection page.

For more information on using the Add Servers dialog box, click its Help button.
Make sure that you have selected all of the NetWare and Windows servers that you want to 
upgrade to version 7 before exiting the Add Servers dialog box.
The selected servers are displayed below the Local Machine option on the Server Selection 
page:
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The ZENworks components that have been previously installed that are eligible to be upgraded 
to version 7 are indicated by a check mark in their check boxes. Click the plus signs to expand 
the tree structure to view the components. You cannot enable or disable any of the check boxes. 
They only show what is upgraded.

3 You cannot install version 7 to both a virtual server’s cluster object and the NCP Server objects 
for each of its nodes; therefore, if you have selected both, you must remove one or the other to 
prevent errors caused by zfs.ncf being run from two different locations in the cluster.
For more information, see “Cluster Issues with Upgrading” on page 157.

4 Click Next and continue with “Review the Upgrade Summary” on page 166.

Review the Upgrade Summary

Figure 11-2   Support Pack Upgrade Summary Page

1 On the Installation Summary page, review the information to determine if the wizard will do 
what you planned.
You can click Back to make changes.

2 Click Finish to begin the upgrade process.
3 After the upgrade wizard has finished, review the installation log file to determine whether any 

components failed to install.
The log file is located in the installation machine’s temporary directory as determined in its 
Windows environment settings. For example:
%temp%\_resnnn.txt

where nnn is increased incrementally each time a new log is created.
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4 After successfully upgrading the software, click Exit to close the wizard.
At this time, the software is upgraded to version 7 and the Server Management services should 
be restarting on the upgraded servers, if those services are running on the server prior to being 
upgraded.
If a server did not have its Server Management services running before it was upgraded, you 
must restart them manually. These instructions are provided in the one of the next sections.

5 Continue with “Upgrading the Novell iManager Plug-Ins” on page 167.
or
Continue with “Starting the Services” on page 173.

Upgrading the Novell iManager Plug-Ins

This section is only applicable to Policy and Distribution Services.

If you have Novell iManager 2.0.2, 2.5, or 2.6 installed in your network, and you need to upgrade 
the iManager plug-ins to ZENworks 7 with SP1, or install the plug-ins for the first time, the 
processes for installing the iManager plug-ins is different for iManager 2.0.2 and iManager 2.5 or 
2.6 in ZENworks 7 with SP1 and earlier:

“Upgrading the Plug-ins to iManager 2.0.2” on page 167
“Upgrading the Plug-ins to iManager 2.5 or 2.6” on page 172

Upgrading the Plug-ins to iManager 2.0.2

1 On the upgrade workstation, insert the Novell ZENworks 7 Server Management with Support 
Pack 1 Program CD.
The startup screen is displayed. If the startup screen is not automatically displayed after 
inserting the CD, run winsetup.exe at the root of the CD.
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2 On the main menu, select Server Management.
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3 Select Web-Based Management Components to start the wizard and display the License 
Agreement page.
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4 To accept the License Agreement, click Accept, then click Next to view the Login Information 
page.
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5 Fill in the fields:
DNS/IP address: Specify the address of the server where iManager is installed.
Port:  Specify the port number to use when communicating with iManager. It is most likely 
443 if SSL is used; if not, use 8080.
Use SSL: By default, this check box is not selected. If you have iManager configured to use 
SSL, you should enable this check box.
iManager username: Specify the iManager (fully distinguished) login name of the user with 
rights to iManager. This must be entered in the format indicated (for example, 
cn=admin.o=novell). Installation cannot continue if the username cannot authenticate.
iManager password: Specify the iManager password of the user running the wizard.
Install the Policy and Distribution Services plug-ins to Novell iManager: Select the check 
box to install the Remote Web Console and Tiered Electronic Distribution plug-ins to iManager 
so that you can manage these components from a Web browser.
Install the ZENworks certificate authority: Select the check box to install the ZENworks 
certificate authority servlet for inter-server communications security. This provides additional 
security to ensure that data received from outside your secured network is from a trusted 
source, that it has not been tampered with en route, and that the data received can be trusted by 
other machines. This is accomplished through the use of signed security certificates and digital 
signatures.

6 Click Next to view the Summary page.

The installation summary indicates that the selected Web components are to be installed to the 
Tomcat installation directory.

7 Click Finish.
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8 When the installation has completed, click Yes to view the installation log file.
If the log file contains errors, you can print it for reference. To look up error messages, see 
Appendix H, “Installation Error Messages,” on page 373. Correct the error, then repeat the 
installation steps.
The ZENworks Server Management role in iManager should still be set up, because the 
information for it is stored in eDirectory.

9 After successfully upgrading the iManager plug-ins, close the log file.
10 If you installed the plug-ins to iManager 2.5, do the following:

10a Log in to iManager 2.5.
10b When prompted with an install/upgrade task, install the new or updated plug-ins.

11 For iManager to recognize the new plug-ins, stop Tomcat, then restart Tomcat:
NetWare 
Stop: tc4stop.ncf
Start: tomcat4.ncf
Windows 
In the Services window, stop then start the Tomcat service by right-clicking the service 
and selecting the options.
Linux 
Restart: /etc/init.d/tomcat4 restart
or
Stop: /etc/init.d/tomcat4 stop
Start: /etc/init.d/tomcat4 start
OES Linux 
Restart: /etc/init.d/novell-tomcat4 restart
or
Stop: /etc/init.d/novell-tomcat4 stop
Start: /etc/init.d/novell-tomcat4 start

12 Continue with “Starting the Services” on page 173.

Upgrading the Plug-ins to iManager 2.5 or 2.6

1 Locate the Novell iManager plug-in module (NPM) on the Novell ZENworks 7 with Support 
Pack 1 Companion 1 CD:
\Novell iManager\ZFS Plugins NPM\ZFS_PolyDistPlugins.npm

2 Follow the instructions in your iManager documentation to install the NPM:
iManager 2.5: see the Novell iManager 2.5 Installation Guide (http://www.novell.com/
documentation/imanager25/)
iManager 2.6: see the Novell iManager 2.6 documentation (http://www.novell.com/
documentation/imanager26/)

3 Continue with “Starting the Services” on page 173.
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Starting the Services

If the upgrade did not automatically stop and restart the services, or the services are not running 
before you upgraded the server, and you want the services to be running at this time, start the 
services at this time.

“On NetWare Servers” on page 173
“On Windows Servers” on page 173

On NetWare Servers

1 Enter the following command at the server’s main console prompt:
zfs

This starts all of the Policy and Distribution Services services, including the database.

Continue with “On Windows Servers” on page 173 or “Verifying That the Services Are Running 
Successfully” on page 173.

On Windows Servers

1 Open the Control Panel.
2 Double-click Admin Tools, then double-click Services.
3 Start the Novell ZENworks Service Manager service.

This starts all of the Policy and Distribution Services services, including the database.

Continue with “Verifying That the Services Are Running Successfully” on page 173.

Verifying That the Services Are Running Successfully

“On NetWare Servers” on page 173
“On Windows Servers” on page 173

On NetWare Servers

1 On each server’s console, press Ctrl+Esc to view the services:

ASA 8.0.3 ... (if the Sybase database is installed)
ZENworks (for Policy and Distribution Services)

2 If any service is missing, that component was not successfully started.
For steps to start a service, see “On NetWare Servers” on page 173.

3 After successfully starting the services, continue with “On Windows Servers” on page 173 or 
“Verifying That the Server Is Upgraded” on page 174.

On Windows Servers

1 On each Windows server, open the Control Panel, double-click Admin Tools > Services, then 
determine if the following services are running:

Novell Database - Sybase
Novell ZENworks Service Manager

2 If any service is not running, that component was not successfully started.
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For steps to start a service, see “On Windows Servers” on page 173.
3 After successfully starting the services, continue with “Verifying That the Server Is Upgraded” 

on page 174.

Verifying That the Server Is Upgraded

“Using iManager” on page 174
“On a NetWare Server” on page 174
“On a Windows Server” on page 174

Using iManager

1 Log in to iManager.
2 Under the ZENworks Server Management role, select Remote Web Console.
3 Identify a server (NetWare or Windows), then click OK.

You can either enter the IP address or DNS name, or browse for the server’s ZENworks object.
4 In the Display field, select Policy/Package Agent from the drop-down list.
5 Under the Configuration tab, review the version information.

“ZENworks 7 Server Management with SP1” should be displayed.
6 Repeat these steps for each upgraded server.

On a NetWare Server

1 At the NetWare server’s main console prompt, enter the following command:
zfsversion

The zfsversion command also writes a listing of ZENworks .jar files and their dates to:
volume:\zenworks\zfsversion.log

2 View the current Server Management version information.
If version 7 was applied correctly, it should read:
ZENworks Server Management - 7

3 Repeat these steps for each upgraded server.
4 If the version is correct for each server, continue with “On a Windows Server” on page 174 or 

“Repeating the Upgrade” on page 175.

On a Windows Server

1 On the Windows server, run \zenworks\zfsversion.bat.
This creates a zfsversion.log file in the \zenworks directory.

2 Open the log file to view the current Server Management version information.
3 Repeat these steps for each upgraded server.
4 If the version is correct for each server, continue with “Repeating the Upgrade” on page 175.
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Repeating the Upgrade

You might need to run the GUI wizard again for the following reasons:

If you are upgrading incrementally, repeat the upgrade instructions beginning with “Upgrading 
to ZENworks 7 with SP1” on page 160.

You can also do this at a later date, because ZENworks 6.5 servers that are upgraded to 
version 7 work with version 6.5 servers that are not yet upgraded to version 7. In other words, 
ZENworks 6.5 Distributors can send its Distributions to ZENworks 7 with SP1 Subscribers.
If you have other workstations where the Server Management snap-ins to ConsoleOne are 
installed, you can repeat the upgrade instructions beginning with “Upgrading to ZENworks 7 
with SP1” on page 160 on each of those machines to upgrade them. You do not need to select 
any servers. This ConsoleOne upgrade on workstations can be performed at any time.
If you have Linux or Solaris servers to upgrade, continue with Section 11.1.4, “Upgrading 
Policy and Distribution Services on Linux and Solaris Servers,” on page 175. Otherwise, you 
have completed upgrading Policy-Enabled Server Management to ZENworks 7 with SP1, 
except for the following post-upgrade task:

“Post-Upgrade Manual Distribution Task” on page 175

Post-Upgrade Manual Distribution Task

Manual Distributions created in ZENworks 6.5 or later do not work in version 7. You must re-create 
them using the version 7 Manual Distribution Wizard.

For steps on creating manual Distributions, see “Manually Importing and Exporting Distributions” 
in the Novell ZENworks 7 Server Management Administration Guide.

11.1.4  Upgrading Policy and Distribution Services on Linux 
and Solaris Servers
The script for Linux and Solaris servers detects the existence of ZENworks 6.5 or later software and 
asks whether you want to upgrade or install. We recommend using the upgrade option, which is 
documented in the following steps.

To upgrade, do the following:

“Running the Upgrade Script” on page 175
“Verifying That the Server Is Upgraded” on page 176

Running the Upgrade Script

Perform the following tasks individually on each Linux and Solaris server to upgrade it from 
ZENworks 6.5 or later Server Management to version 7:

1 Review the Novell ZENworks 7 Server Management with Support Pack 1 Readme on the 
ZENworks 7 Web site (http://www.novell.com/documentation/zenworks7/index.html) for any 
last-minute information concerning upgrading to version 7.

2 Log in as root.
3 If you are running X Windows on the Linux or Solaris server, open an XTerm window.
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4 To run the Policy and Distribution Services script, enter one of the following commands in an 
XTerm window:
Red Hat Linux: /mnt/cdrom/ZfS/TedPol/platform/zfs-pds-upgrade
SUSE Linux: /media/cdrom/ZfS/TedPol/platform/zfs-pds-upgrade
where platform is either Linux or Solaris.

5 Press Enter to display the license agreement, press the Spacebar to scroll through the license 
agreement, type y, then press Enter to accept the license agreement.
The following is displayed (including errors, if any) for a Linux installation while the server is 
upgraded:
Installing the novell-zen-zfs RPM...
Preparing...         ######################################## [100%]
   1:novell-zen-zfs    ########################################### [100%]

Error messages are displayed at this point. After any error messages, the upgrade concludes by 
displaying the following:
ZENworks Server Management Policy and Distribution Services has been 
restarted.
You may check its status by running:
  /etc/init.d/novell-zfs status
You can reconfigure this service by running:
  /opt/novell/bin/zfs-pds-configure

6 To verify that Policy and Distribution Services is running, enter:
/etc/init.d/novell-zfs status

Policy and Distribution Services is now ready to use on your Linux or Solaris server.
7 Repeat Step 2 through Step 6 on each ZENworks 6.5 or later Server Management server to be 

upgraded.
8 Continue with “Verifying That the Server Is Upgraded” on page 176.

Verifying That the Server Is Upgraded

“Using iManager” on page 176
“On a Linux Server” on page 177
“On a Solaris Server” on page 177

Using iManager

1 Log in to iManager.
2 Under the ZENworks Server Management role, select Remote Web Console.
3 Identify a Linux or Solaris server, then click OK.

You can either enter the IP address or DNS name, or browse for the server’s ZENworks object.
4 In the Display field, select Policy/Package Agent from the drop-down list.
5 Under the Configuration tab, review the version information.

“ZENworks 7 Server Management with SP1” should be displayed.
6 Repeat these steps for each upgraded Linux or Solaris server.
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7 Continue with “On a Linux Server” on page 177 or “On a Solaris Server” on page 177, if 
necessary.
Otherwise, you have completed upgrading your Linux servers to ZENworks 7 Server 
Management with SP1.

On a Linux Server

1 At the Linux server’s console, enter the following command:
rpm -q novell-zen-zfs

or
rpm -qa / grp novell-zen

2 If version 7 was upgraded to correctly, it should read:
novell-zen-zfs-7
novell-zen-zws-7

3 Repeat these steps on each upgraded Linux server.
4 Continue with “On a Solaris Server” on page 177, if necessary.

Otherwise, you have completed upgrading your Linux servers to ZENworks 7 Server 
Management with SP1.

On a Solaris Server

1 At the Solaris server’s console, enter the following command:
pgkinfo -L novellzfs

2 If version 7 was upgraded to correctly, it should read:
novell-zen-zfs-7
novell-zen-zws-7

3 Repeat these steps on each upgraded Solaris server.
You have completed upgrading your Linux servers to ZENworks 7 Server Management with 
SP1.

11.2  Upgrading Using a Server Software Package
This method allows you to automatically upgrade Subscriber servers on all supported platforms 
where the ZENworks 6.5 Subscriber software is installed, including NetWare, Windows, Linux, and 
Solaris.

For Server Inventory, this method only upgrades the Inventory Agent on NetWare and Windows 
servers. Management and Monitoring Services cannot be upgraded using a Server Software 
Package.

Section 11.2.1, “Upgrade Concepts and Issues,” on page 178
Section 11.2.2, “Pre-Upgrade Checklist,” on page 179
Section 11.2.3, “Upgrading Policy and Distribution Services with the Server Software 
Package,” on page 179
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11.2.1  Upgrade Concepts and Issues
When you upgrade ZENworks 6.5 Policy-Enabled Server Management to version 7 using the Server 
Software Package upgrade method, you use the zsm7_polydist.cpk upgrade file contained on the 
Novell ZENworks Companion 3 CD to create the Software Package Distribution. Then you send it to 
all of the Subscriber servers that you want to upgrade.

Review the following to understand what the upgrading does, and to understand the issues involved:

“What the Upgrade Server Software Package Does” on page 178
“What the Upgrade Server Software Package Does Not Do” on page 178
“Upgrading Servers on Multiple Trees” on page 179
“Upgrading Incrementally” on page 179

What the Upgrade Server Software Package Does

Upgrades the ZENworks 6.5 Server Management software to version 7 using the installation 
paths where ZENworks 6.5 was installed.
Automatically stops and restarts the services for all supported platforms (NetWare, Windows, 
Linux, and Solaris).

IMPORTANT: The ZENworks Server Management service must be running in order for the 
Subscriber to receive and extract the Software Package Distribution containing the upgrade 
.cpk file. The services on the Subscriber are then stopped during upgrading.

Always copies files to the ZENworks directories, whether the existing files are new newer or 
older than the upgrade files. However, files copied to locations outside of the ZENworks 
directories are replaced only if they are older.
Upgrades the ConsoleOne snap-ins on the Subscriber servers where the ZENworks 6.5 snap-ins 
to ConsoleOne are installed.

What the Upgrade Server Software Package Does Not Do

The Software Package Distribution is not delivered to the Subscriber server if the ZENworks 
Server Management service is not running.
The software package does not install new software on ZENworks 6.5 Server Management 
servers where it was not originally installed. Only existing software is upgraded.
The software package does not upgrade ZENworks for Servers 3.0.2 servers to ZENworks 6.5.
ZENworks eDirectory objects are not upgraded because there are no changes to them between 
ZENworks 6.5 and 7.
The ZENworks 6.5 Server Management snap-ins for ConsoleOne are not installed to the local 
machine during upgrading. You must do this with the wizard. This task is covered in 
Section 11.1.3, “Upgrading Policy-Enabled Server Management on NetWare and Windows 
Servers,” on page 159.
The ZENworks 6.5 Server Management plug-ins for iManager are not installed during 
upgrading. You must do this with a wizard menu option after you have finished upgrading with 
the server package. This task is covered in “Upgrading the Novell iManager Plug-Ins” on 
page 167.
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Upgrading Servers on Multiple Trees

You can upgrade Subscriber servers on multiple trees, because you can send Software Package 
Distributions to Subscribers on multiple trees.

Upgrading Incrementally

You can upgrade all ZENworks 6.5 servers to version 7 in one distribution of the .cpk file, or 
incrementally (such as geographical locations) by setting up different Channels for each Subscriber 
grouping, but using the same Distribution.

11.2.2  Pre-Upgrade Checklist
Make sure you have done the following to prepare the ZENworks 6.5 servers that you have targeted 
for upgrading to version 7:

Review the Novell ZENworks 7 Server Management with Support Pack 1 Readme on the 
ZENworks 7 Web site (http://www.novell.com/documentation/zenworks7/index.html) for any 
last-minute information concerning upgrading.
Make sure that ZENworks 6.5 Server Management is installed on the servers you want to 
upgrade to version 7.
Make sure you have fulfilled all of the installation requirements listed in Part II, “Preparation,” 
on page 27.
Extend the schema to ZENworks 7 Server Management with SP1 in the tree where objects for 
the servers you are upgrading reside.
For information on extending the schema, see “Extending the Schema” on page 69.
Make sure the ZENworks services are running on the Subscriber server so that it can receive 
and extract the Software Package Distribution containing the zsm7_polydist.cpk file that is 
used to upgrade the server.
The services are automatically stopped during upgrading and restarted after the upgrade has 
finished.

11.2.3  Upgrading Policy and Distribution Services with the 
Server Software Package
Using the Tiered Electronic Distribution component of ZENworks 7 Server Management with SP1, 
you can automatically distribute and install the software packages to all Subscriber servers that are 
running the Subscriber and Policy/Package Agent software.

To upgrade using a Server Software Package, do the following in order:

1. “Creating and Sending the Server Software Package Distribution” on page 180
2. “Determining If the Software Package Was Installed Successfully” on page 181
3. “Verifying that the Services Have Started” on page 182
4. “Installing the Snap-ins and Plug-ins” on page 182
5. “Verifying That the Servers Have Been Upgraded” on page 183
6. “Repeating for Server Groups” on page 183
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Creating and Sending the Server Software Package Distribution

1 Select a ZENworks 7 with SP1 Distributor server and copy zsm7_polydist.cpk to the 
Distributor’s file system.
The .cpk file is located in:
Program_CD\zenworks7\zenworks server management - software pkgs\pds

2 Write down where you copied zsm7_polydist.cpk on the Distributor server for when you 
create its Server Package Distribution.

3 Determine which Subscriber servers you want to upgrade with the software package.
If you created a list during preparation, continue with Step 4.
Distributor servers’ software are upgraded to version 7 when their Subscribers are upgraded.

4 Set each Subscriber’s Extract schedule.
Use care in setting your Subscriber’s Extract schedule. If the schedule is set to Run Immediate 
and either the Subscriber is running on the same server as the Distributor, or the Subscriber is a 
parent and is forwarding the Distribution on to subordinate Subscribers, you might interrupt the 
sending of the Distribution to Subscribers because the update process involves unloading Java. 
With Java unloaded, Distributions are temporarily halted until Java is reloaded and the 
Channel’s Send schedule fires.
If the Subscriber is a parent that is sending the Distribution to subordinate Subscribers, it is in 
the process of sending the Distribution when the software package tries to unload Java. 
However, the Distributions continue from where they left off after Java is started again.

5 Create a Distribution for this software package.
You can have only one software package per Distribution object. Although the software allows 
more than one software package to be selected in a single Distribution object, this is not 
permitted when distributing zsm7_polydist.cpk. The reason is that installing a software 
package unloads and reloads Java, which can prevent the remaining software packages from 
being successfully processed from a single Distribution object.
Be sure to set the Distribution’s Build schedule.

IMPORTANT: The Distribution containing zsm7_polydist.cpk must be built, sent, 
extracted, and installed before sending any other Distributions containing other software 
packages for upgrading other Server Management components.

For detailed instructions on creating Distributions, see “Tiered Electronic Distribution” in the 
Novell ZENworks 7 Server Management Administration Guide.

6 To set up a Channel for this Distribution:
6a Create a Channel specifically for this software package upgrade.
6b Set the Channel’s Send schedule to Immediate.

If you want to wait and not immediately send the upgrade, you can set it to Never until you 
are ready to send it, then set it to Immediate.

6c Associate the Distribution with this Channel so that it is sent based on the Channel’s Send 
schedule.

7 Associate the Subscribers that you identified in Step 3 with the Channel.
8 Send the Distribution.
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For example, refresh the Distributor to build the Distribution so that it can be sent and 
extracted. You do not need to set or change the Distributor’s Refresh schedule if you refresh the 
Distributor manually.
To refresh the Distributor manually, in ConsoleOne right-click the Distributor object and select 
Refresh Distributor.
For detailed instructions on sending Distributions, see “Tiered Electronic Distribution” in the 
Novell ZENworks 7 Server Management Administration Guide.
The Distribution is automatically created when the Distribution’s Build schedule starts. The 
Distribution is automatically sent when the Channel’s Send schedule starts. It is extracted 
according to the Subscriber server’s Extract schedule. At that point, the Subscriber server 
should be upgraded to ZENworks 7 with SP1.

9 Set the Channel used to send the upgrade software package to Inactive, so that this upgrade 
won’t be sent again to these Subscribers.

10 Continue with “Determining If the Software Package Was Installed Successfully” on page 181.

Determining If the Software Package Was Installed Successfully

1 Determine which components of the software package are installed successfully by using one 
of the following methods:

iManager: Use the Tiered Electronic Distribution view in iManager to see information 
for every software package that was installed.
Reports: If you use Tiered Electronic Distribution for installation, use Server 
Management reporting to verify the success or failure of individual components of a 
software package.
Log files: Use the log files contained on the Subscriber Servers to verify the success or 
failure:
For file copying messages:

For general log file messages:

Linux:  Enter the following command:
rpm -q novell-zen-zfs

This should return:
novell-zen-zfs-6.5-1

Solaris:  Enter the following command:
pgkinfo -l novlzfs

This should return:
VERSION: 6.5-1

NetWare and 
Windows

volume_or_drive\temp\zsm7_polydist.cpk\copylog.txt

NetWare volume_or_drive\temp\zsm7_polydist.cpk\netware\upgrade.log

Windows volume_or_drive\temp\zsm7_polydist.cpk\upgrade.log
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Each software package can consist of several components. It is possible that some of these 
components can be successfully installed and others fail. For example, a server platform might 
exist for one of the servers to receive the Distribution, but the platform is not contained in the 
requirements for the software package. Therefore, success for the software packages included 
in the installation means that one or more components are successfully installed.
Because several components could fail to install, and the Software Package installation might 
still appear as successful, we recommend that you review the success or failure of each 
component of the software package to verify that the components needed on a specific server 
are installed successfully.

2 Continue with “Verifying that the Services Have Started” on page 182.

Verifying that the Services Have Started

1 Verify that the Policy and Distribution Services is running on NetWare servers:
1a On each target server’s console, press Ctrl+Esc to view the services.
1b Check whether the following services are listed:

ASA 8.0.3 ... (Sybase database)
ZENworks (for Policy and Distribution Services)

1c If any service is missing, that component was not successfully started.
For steps to start a service, see “On NetWare Servers” on page 173.

1d After successfully starting the services, continue with Step 2.
2 Verify that the Policy and Distribution Services is running on Windows servers:

2a On each Windows server, open the Control Panel, double-click Admin Tools, then click 
Services.

2b Determine if the following services are running:

Novell Database - Sybase
Novell ZENworks Service Manager

2c If any service is not running, that component was not successfully started.
For steps to start a service, see “On Windows Servers” on page 173.

2d After successfully starting the services, continue with Step 3.
3 To verify that Policy and Distribution Services is running on Linux or Solaris servers, enter in 

an XTerm window on each server:
/etc/init.d/novell-zfs status

4 Continue with “Installing the Snap-ins and Plug-ins” on page 182.

Installing the Snap-ins and Plug-ins

1 If you have instances of ConsoleOne that need the snap-ins upgraded, follow the instructions in 
Section 11.1.3, “Upgrading Policy-Enabled Server Management on NetWare and Windows 
Servers,” on page 159, then continue with Step 2.

2 If you have Novell iManager 2.0.2 or 2.5 installed on a server in your network, and you need to 
upgrade the iManager plug-ins, follow the instructions under “Upgrading the Novell iManager 
Plug-Ins” on page 167.

3 Continue with “Verifying That the Servers Have Been Upgraded” on page 183.
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Verifying That the Servers Have Been Upgraded

“Using iManager” on page 183
“On a NetWare Server” on page 183
“On a Windows Server” on page 183

Using iManager

1 Log in to iManager.
2 Under the ZENworks Server Management role, select Remote Web Console.
3 Identify a server (any supported platform), then click OK.

You can either enter the IP address or DNS name, or browse for the server’s ZENworks object.
4 In the Display field, select Policy/Package Agent from the drop-down list.
5 Under the Configuration tab, review the version information.

“ZENworks 7 Server Management with SP1” should be displayed.
6 Repeat these steps for each upgraded server.
7 If the version is correct, continue with “Repeating for Server Groups” on page 183.

On a NetWare Server

1 At the NetWare server’s main console prompt, enter the following command:
zfsversion

The zfsversion command also writes a listing of ZENworks .jar files and their dates to:
volume:\zenworks\zfsversion.log

2 View the current Server Management version information.
If version 7 was upgraded to correctly, it should read:
ZENworks Server Management - 7

3 Repeat these steps for each upgraded server.
4 If the version is correct, continue with “On a Windows Server” on page 183 or “Repeating for 

Server Groups” on page 183.

On a Windows Server

1 On the Windows server, run \zenworks\zfsversion.bat.
This creates a zfsversion.log file in the \zenworks directory.

2 Open the log file to view the current Server Management version information.
3 Repeat these steps for each upgraded server.
4 If the version is correct, continue with “Repeating for Server Groups” on page 183.

Repeating for Server Groups

For each incremental grouping of servers to be upgraded, repeat the procedures from “Creating and 
Sending the Server Software Package Distribution” on page 180 through “Verifying That the 
Servers Have Been Upgraded” on page 183.
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12Version 3.0.2 Policy and 
Distribution Services

This section provides you with instructions for upgrading Novell® ZENworks® for Servers 3.0.2 
Policy and Distribution Services to ZENworks 7 Server Management with Support Pack 1 (SP1) 
using one of the following methods:

GUI for NetWare or Windows servers (a menu option in the GUI upgrade program):
Upgrades Novell ZENworks eDirectoryTM objects
Is required for Distributors, but is optional for Subscribers

Script for Linux or Solaris servers (a script run from the Novell ZENworks 7 Server 
Management with Support Pack 1 Program CD):

Requires that you use the GUI upgrade program first to upgrade the eDirectory objects
Must be performed manually on each server
Is required for Distributors, but is optional for Subscribers

(Optional) CPK for all supported platforms (a Server Software Package upgrade file 
contained on the Novell ZENworks 7 with Support Pack 1 Compaion 3 CD):

Requires that you use the GUI upgrade program first to upgrade the eDirectory objects
Cannot be used to upgrade Distributors, which must be upgraded first using the script or 
the GUI upgrade program
Is useful for automating Subscriber upgrades
Is more efficient for upgrading Linux and Solaris servers, because you do not have to 
manually visit each machine as you do with the script method

Before upgrading, you must meet all of the installation requirements outlined in Part II, 
“Preparation,” on page 27.

IMPORTANT: If you are using NICI for Distribution encryption in ZENworks for Servers 3.0.2, 
you should upgrade to NICI 2.6.4; however, if you already have NICI 2.4.6 installed, it is optional 
whether you upgrade to NICI 2.6.4, because these versions are compatible with each other. For more 
information on NICI and encryption security, see Appendix G, “Installing Additional Security for 
Non-Secured Connections,” on page 361.

To upgrade, choose one of the following methods:

Section 12.1, “Upgrade Using the Program CD,” on page 186

This method uses either a Windows GUI program for NetWare and Windows servers, or a 
script for Linux and Solaris servers.
Section 12.2, “Upgrade Using a Server Software Package,” on page 218
This optional method provides automated upgrading of the ZENworks software on Subscriber 
servers. You simply create a Software Package Distribution and send it to the Subscribers 
servers that are to be upgraded.
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IMPORTANT: The Server Software Package cannot upgrade eDirectory objects.

Advantages for upgrading the Subscriber software using a Software Package Distribution:
Upgrades numerous servers in less time than in using the GUI upgrade program
Upgrades servers across multiple trees
Very useful when incrementally upgrading the Subscriber servers in your network
Provides upgrade access to machines that are not accessible using the GUI upgrade 
program
Is more efficient for upgrading Linux and Solaris servers

IMPORTANT: If you have External Subscriber servers to upgrade from version 3.0.2 (or version 3 
SP2), to successfully send Distributions to those External Subscriber servers from Distributors that 
have been upgraded to version 7 with SP1 you must do one of the following:

Before upgrading the Distributor that you will use to send the Server Package Distribution (for 
CPKs), update your External Subscriber servers with the Interim Release 4 CPK before you 
upgrade those servers to version 7 with SP1; then, upgrade the Distributor server to version 7 
with SP1 and thereafter upgrade the External Subscriber servers to version 7 with SP1 using the 
CPK upgrade Distributions from any version 7 with SP1 Distributor server.
Using the GUI upgrade, upgrade both the Distributor servers and External Subscriber servers to 
version 7 with SP1 at the same time. Then you can send version 7 with SP1 Distributions to the 
upgraded External Subscriber servers.
After upgrading the Distributor and External Subscriber servers to version 7 with SP1, delete 
the ted.cfg file on the upgraded Distributor server, then restart the Distributor service. Then 
you can send version 7 with SP1 Distributions to the upgraded External Subscriber servers.

12.1  Upgrade Using the Program CD
Using this method, there are two platform-based options for upgrading:

NetWare and Windows servers: For these platforms, the GUI installation program is started 
on the Windows workstation where the Novell ZENworks 7 Server Management with Support 
Pack 1 Program CD is inserted. Upgrade options are available in the program’s menus.

This method must be used first to upgrade eDirectory objects and NetWare or Windows 
Distributor servers.
Linux and Solaris servers: For these platforms, a script file is used. It is provided on the 
Novell ZENworks 7 Server Management with Support Pack 1 Program CD, and is run locally 
on each Linux or Solaris server to be upgraded.
This method must be used first to upgrade eDirectory objects and Linux or Solaris Distributor 
servers.

To automate installation to multiple Subscriber servers, we recommend upgrading these servers 
using the Server Software Package method (see Section 12.2, “Upgrade Using a Server Software 
Package,” on page 218).

To upgrade ZENworks for Servers 3.0.2 Policy and Distribution Services to ZENworks 7 with SP1:

Section 12.1.1, “Upgrade Concepts and Issues,” on page 187
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Section 12.1.2, “Upgrade Preparation,” on page 189
Section 12.1.3, “Upgrading NetWare and Windows Servers,” on page 190
Section 12.1.4, “Upgrading Linux and Solaris Servers,” on page 215

12.1.1  Upgrade Concepts and Issues
Using the GUI upgrade program, you can upgrade ZENworks for Servers 3.0.2 Tiered Electronic 
Distribution objects and servers to ZENworks 7 Server Management with SP1.

Review the following to understand what the GUI upgrade program does, and to understand the 
issues involved:

“What the Upgrade Program Does” on page 187
“What the Upgrade Program Does Not Do” on page 188
“Upgrading Servers on Multiple Trees” on page 188
“Upgrading Distributors First” on page 188
“Incremental Upgrading and Interoperability” on page 189
“Determining Whether to Upgrade Incrementally” on page 189
“Cluster Issues with Upgrading” on page 189

After reviewing this section, continue with Section 12.1.2, “Upgrade Preparation,” on page 189.

What the Upgrade Program Does

Upgrades the ZENworks for Servers 3.0.2 Novell eDirectoryTM objects to version 7 in the tree 
that you have selected. The upgrade is done only for the Distributor and Subscriber objects.
Maintains the existing attributes for each updated eDirectory object, so that you do not need to 
reconfigure the objects.
Maintains all working directories, so that Distributions created in ZENworks for Servers 3.0.2 
can be upgraded and used in version 7.
Upgrades to the ZENworks 7 Server Management with SP1 software using the installation 
paths where ZENworks for Servers 3.0.2 was installed.
Files are always copied in the ZENworks directories, replacing both older and newer files with 
the upgrade files. Files copied to other locations outside of the ZENworks directories are 
replaced only if they are older.
The reason for replacing both older and newer files in the ZENworks directories is that version 
3.0.2 files from a support pack that is more recent than the release of version 7 needs to be 
replaced with the older-dated version 7 files in order to have the correct files for version 7.
When you select to upgrade a Subscriber, the ZENworks for Servers 3.0.2 Policy Package 
Agent is automatically upgraded to the ZENworks 7 Server Management with SP1 Policy/
Package Agent.

In summary, the upgrade program upgrades the objects and installs the software on the Distributor 
and Subscriber servers.
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What the Upgrade Program Does Not Do

The upgrade program does not install ZENworks 7 Server Management with SP1 to servers 
where ZENworks for Servers 3.0.2 was not installed. It only upgrades existing ZENworks for 
Servers 3.0.2 objects and software.
The schema is not automatically extended. You must do this before upgrading. This task is 
covered in the upgrade steps.
The ZENworks 7 Server Management with SP1 snap-ins for ConsoleOne® are not installed to 
the local machine during upgrading. You must do this with the installation program after you 
have exited the upgrade program. This task is covered in the upgrade steps.
The ZENworks 7 Server Management with SP1 plug-ins for iManager are not installed by the 
upgrade program. You must do this with an installation program menu option after you have 
exited the upgrade program. This task is covered in the upgrade steps.
Does not upgrade the ConsoleOne snap-ins on servers where ConsoleOne is installed. This 
must be done using the installation program.
File Distributions are not re-baselined, which must be done manually. File Distributions that 
are not re-baselined causes a “Local class compatibility” error at the time of building or 
extracting, and the Distribution is not processed. This task is covered in the upgrade steps.

In summary, the upgrade program does not install ZENworks 7 Server Management with SP1 where 
ZENworks for Servers 3.0.2 was not installed. The ZENworks for Servers objects are necessary for 
identifying the servers to upgrade.

Upgrading Servers on Multiple Trees

The upgrade program discovers your target servers by their corresponding Distributor or Subscriber 
objects contained in the tree. You can only select one tree when running the upgrade program. 
Therefore, if you have multiple trees with ZENworks for Servers 3.0.2 objects, you need to run the 
upgrade program twice per tree: once for the Distributors, then again for the Subscribers.

However, if you use the software package method to upgrade your Subscribers (see Section 12.2, 
“Upgrade Using a Server Software Package,” on page 218), you can upgrade Subscribers across 
multiple trees.

Upgrading Distributors First

Whether upgrading incrementally or all at once, for the following reasons we recommend that you 
upgrade all of your Distributors first, then upgrade your Subscribers:

Version 7 Distributors can send their version 7 Distributions to version 7 Subscribers.
Version 7 Distributors can send their version 7 Distributions to version 3.0.2 Subscribers.
It is the Interim Release 1 requirement for ZENworks for Servers 3.0.2 that makes this 
possible. For more information, see Section 17.1.2, “Interoperability with ZENworks for 
Servers 3.x,” on page 265.
Version 3.0.2 Distributors can send their version 3.0.2 Distributions to version 3.0.2 
Subscribers.
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However, version 3.0.2 Distributors cannot send their version 3.0.2 Distributions to version 7 
Subscribers.
This is the main reason for upgrading the Distributors first. If you upgraded some Subscribers 
before upgrading the Distributor that sends them its Distributions, the Distributions fail because 
of the Distribution version and Subscriber version conflict.

After a ZENworks for Servers 3.0.2 Distributor is converted to ZENworks 7 Server Management 
with SP1, before it sends any of its Distributions, it converts them to ZENworks 7 Server 
Management with SP1 Distributions when it builds them.

Incremental Upgrading and Interoperability

For a variety of reasons, you might need to upgrade your ZENworks for Servers 3.0.2 Subscriber 
objects incrementally. For example, you may have too many servers to upgrade all of them in one 
session. Interoperability issues can exist when upgrading incrementally.

For interoperability between ZENworks 7 with SP1 Subscribers and ZENworks for Servers 3.0.2 
Subscribers when upgrading incrementally, you must have Interim Release 1 installed on all version 
3.0.2 Subscriber servers. For more information, see Section 17.1, “Version Interoperability,” on 
page 265.

Determining Whether to Upgrade Incrementally

Consider the following in determining whether to upgrade your Subscribers incrementally:

Number of Subscribers: If you have many Subscribers, consider the time it might take to 
upgrade them in one session. If that time frame is too long, select your target Subscribers in 
groups so that you can upgrade one group at a time.
Desktop Application Distributions: If you have ZENworks for Servers 3.0.2 Desktop 
Application Distributions, you should maintain one ZENworks for Servers 3.0.2 Distributor for 
sending Desktop Application Distributions to the ZENworks for Servers 3.0.2 Subscribers 
requiring them.
The upgrade process is then:

1. Upgrade the ZENworks for Servers 3.0.2 Distributor to version 7 that was sending 
Desktop Application Distributions.

2. Rebuild the Desktop Application Distributions as version 7 Distributions, but do not allow 
them to be sent yet.

3. Upgrade the version 3.0.2 Subscribers that need the upgraded Desktop Application 
Distributions.

4. Send the upgraded Desktop Application Distributions.

Cluster Issues with Upgrading

The upgrade program automatically upgrades clusters.

12.1.2  Upgrade Preparation
The servers you want to upgrade must meet all of the same server requirements for installation of 
ZENworks 7 Server Management with SP1 that are provided in Chapter 5, “Server Requirements,” 
on page 45.
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WARNING: If you intend to upgrade incrementally, be aware that some system requirements for 
ZENworks 7 Server Management with SP1 should not be applied to servers where you will continue 
to use ZENworks for Servers 3.0.2 Interim Release 1. Meet the server requirements only for the 
servers you are upgrading to ZENworks 7 Server Management with SP1.

You need to know the following information to upgrade ZENworks for Servers 3.0.2 objects and 
servers to ZENworks 7 Server Management with SP1:

“Trees to Upgrade” on page 190
“Distributor Servers to Upgrade” on page 190
“Subscriber Servers to Upgrade” on page 190

Trees to Upgrade

Determine the trees where ZENworks for Servers 3.0.2 objects have been installed. You need to 
extend the schema on these trees before upgrading. Extending the ZENworks 7 Server Management 
with SP1 schema does not remove the ZENworks for Servers 3.0.2 schema extensions. ZENworks 
schema extensions are additive.

If you have ZENworks for Servers 3.0.2 installed across multiple trees, you should first upgrade the 
Distributors per tree, then upgrade the Subscribers in those trees using either the upgrade program or 
.cpk file method (which allows upgrading multiple trees at a time using a Distribution).

Distributor Servers to Upgrade

The upgrade program displays all ZENworks for Servers 3.0.2 Distributor objects in the tree. Plan to 
upgrade all of the Distributors in a given tree at the same time.

For ZENworks for Servers 3.0.2 servers that are both a Distributor and Subscriber, the Subscriber 
software is also upgraded when you upgrade the Distributor software.

Subscriber Servers to Upgrade

The upgrade program displays all ZENworks for Servers 3.0.2 Subscriber objects in the tree.

If you plan to upgrade incrementally within a tree, determine the groups of servers that you want to 
upgrade. For more information, see “Incremental Upgrading and Interoperability” on page 189.

Continue with Section 12.1.3, “Upgrading NetWare and Windows Servers,” on page 190.

12.1.3  Upgrading NetWare and Windows Servers
If you have ZENworks for Servers 3.0.2 objects installed to multiple trees, repeat the following 
upgrade instructions for each tree. Also, if you are upgrading Subscribers incrementally, repeat the 
following upgrade instructions for each increment.

To upgrade ZENworks for Servers 3.0.2 to ZENworks 7 Server Management with SP1, perform the 
following tasks in order:

1. “Pre-Upgrade Checklist” on page 191
2. “Upgrade Steps” on page 191
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3. “Complete the Upgrade” on page 203
4. “Re-Baseline File Distributions” on page 211

Pre-Upgrade Checklist

Review the Novell ZENworks 7 Server Management with Support Pack 1 Readme for any last-
minute information concerning upgrading.

Readme_servers.html is located in the \readmes\en directory on the Novell ZENworks 7 
Server Management with Support Pack 1 Program CD, and is also accessible from an 
installation menu option.
Make sure your upgrade workstation has met the requirements listed in Chapter 4, “Installation 
Machine and Management Workstation Requirements,” on page 41.

IMPORTANT: Make sure you have updated each of your ConsoleOne installations, because 
you will be updating to the ZENworks 7 Server Management with SP1 snap-ins when 
completing the upgrade process (see “Upgrade the ConsoleOne Snap-Ins” on page 204).

Make sure you have met all of the server requirements listed in Chapter 5, “Server 
Requirements,” on page 45.
If you have not already done so, log in to the eDirectory tree where you are updating the 
ZENworks for Servers 3.0.2 objects to version 7.
If you are not logged in to this tree, you cannot select it during the upgrade process.
You can upgrade Distributors and Subscribers one tree at a time. You can run the upgrade 
program as many times as necessary.
You must extend the schema for ZENworks 7 Server Management with SP1 on this tree.
If you upgrade the software on any Windows servers, make sure you have closed the Services 
window on each Windows server to be upgraded.
The upgrade program automatically stops all ZENworks Server Management services. 
However, the Server Management services cannot be registered if the Services window is left 
open while upgrading the server.

Continue with “Upgrade Steps” on page 191.

Upgrade Steps

To upgrade ZENworks for Servers 3.0.2 to ZENworks 7 Server Management with SP1, do the 
following tasks in order:

1. “Disable the Distribution Channels” on page 192
2. “Extend the Schema” on page 192
3. “Start the Upgrade Program” on page 198
4. “Select the Objects for Upgrading” on page 200
5. “Configure the Upgrade Locations and Options” on page 202
6. “Upgrade Summary” on page 203
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Disable the Distribution Channels

If you re-baselined your version 3.0.2 File Distributions when updating to Interim Release 2, you 
should disable the Channels if you do not want Distributions being sent and extracted while you are 
upgrading. However, this is not required, because a Distribution being extracted on a Subscriber can 
be interrupted by an upgrade process, then pick up where it left off after the upgrade has finished.

If you did not update ZENworks for Servers 3.0.2 to Interim Release 2, you must disable all 
Channels where File Distributions are listed. File Distributions must be re-baselined after upgrading 
to prevent a “Local class compatibility” error at the time of building or extracting, which causes the 
Distribution to not be processed. In order to prevent distribution errors in this situation, Distributions 
should not be sent between Distributors and Subscribers until they have been upgraded. Steps to re-
baseline File Distributions are provided in “Re-Baseline File Distributions” on page 211.

To disable the applicable Channels:

1 In ConsoleOne, multiple-select the Channel objects for the Channels you need to disable.
These should be all Channels where a File Distribution is listed.

2 Right-click the selected objects, then click Properties of multiple objects.
3 Select each of the Channels listed on the Objects to Modify tab, then click the General Settings 

tab.
4 Click the Active check box to deselect it, then click OK to exit the properties.
5 Exit ConsoleOne.
6 Continue with “Extend the Schema” on page 192.

Extend the Schema

1 On the upgrade workstation, insert the Novell ZENworks 7 Server Management with Support 
Pack 1 Program CD.
The startup screen is displayed. If the startup screen is not automatically displayed after 
inserting the CD, run winsetup.exe at the root of the CD.
We recommend that you upgrade Policy and Distribution Services from the Program CD. 
However, if you need to copy the CD structure to a hard drive, the path between the root of the 
hard drive and the first CD directory can contain only directory names that conform to the 8.3-
character DOS file naming convention. If any long directory names exist in the path, the 
upgrade program does not work.
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2 Select Server Management.
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3 If you have not yet extended the schema for version 7, select Schema extension and product 
licensing; otherwise, skip the following steps and continue with “Start the Upgrade Program” 
on page 198.
To upgrade ZENworks for Servers 3.0.2 to ZENworks 7 Server Management with SP1, you 
must extend the schema on the trees where you are updating the ZENworks objects.
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4 If you agree with the Software License Agreement, click Accept, then click Next to display the 
eDirectory Tree for Creating Objects page; otherwise, click Decline and Cancel to exit.
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5 Select the tree where you want the ZENworks objects created, then click OK to display the 
ZENworks Server Management Licensing page.

IMPORTANT: Select the Extend schema check box only if you are extending the schema for 
the first time. If you are running the Extend schema menu option only to enter a product license 
code, deselect this box.

The Login button allows you to log into the tree if you are not already authenticated.
ZENworks Server Management schema extensions need to be done only once for a tree. If you 
have multiple trees, you need to extend the schema only on the trees where you are installing 
ZENworks objects.
Schema extensions for Policy and Distribution Services are installed at the same time when 
extending the schema.

6 Enter a license code, or leave the field blank and click Next to display the Summary page.
You should have received the license code when you purchased the product.
If you leave the field blank, the 90-day Evaluation License is in effect. You can return to this 
page at a later date to enter a license code.
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7 To extend the schema, click Finish.
After the schema extension process has completed, the main installation menu is displayed.

8 Continue with “Start the Upgrade Program” on page 198.
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Start the Upgrade Program

Figure 12-1   Upgrade from ZfS 3 Menu Option

1 Select Upgrade v3.0.2 Policy and Distribution Services.
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2 If you agree with the Software License Agreement, click Accept, then click Next; otherwise, 
click Cancel to exit.
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3 Select the tree where you have Distributor and Subscriber objects to be upgraded.
If necessary, you can click the Login button to authenticate to the tree.

4 There are two configuration options:
Container: To avoid searches across WAN links, specify a container.
The tree walking process the installation program must use to search for Distributor and 
Subscriber objects could take hours, even causing the workstation to seem to hang. By 
specifying a container, these objects are only searched within that container and its 
subcontainers.
Update the Subscriber files: By default, this check box is selected.
To upgrade both the Subscriber files and objects, select this box. However, if you plan to 
upgrade your Subscriber servers using the .cpk file in a Distribution, deselect this box so 
that only the Subscriber objects are upgraded.

IMPORTANT: The Subscriber objects must be upgraded using the GUI upgrade 
program. They are not upgraded by the .cpk file.

5 Click Next and continue with “Select the Objects for Upgrading” on page 200.

Select the Objects for Upgrading

Figure 12-2   Select the Objects for Upgrading Page
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The objects listed are all of the ZENworks for Servers 3.0.2 (or unknown version) objects in the 
selected tree for all supported platforms. All of the check box options are dependent on each other. 
Any combination can cause a different set of servers to be displayed.

1 Configure the selection as necessary:
1a Check one or both of the following boxes, as applicable:

Distributors: You must upgrade Distributors first, because ZENworks 7 Server 
Management with SP1 Subscribers cannot receive Distributions from ZENworks for 
Servers 3.0.2 Distributors; however, ZENworks for Servers 3 Subscribers can receive 
Distributions from ZENworks 7 Server Management with SP1 Distributors, except as 
explained concerning Desktop Application Distributions.
To upgrade only Distributors, click the Subscribers check box to deselect all 
Subscribers. If you have already upgraded the Distributors, click the Distributors 
check box to deselect all Distributors.
Subscribers: You can upgrade all of the listed Subscribers, or upgrade groups of 
Subscribers at different times. To upgrade only groups of Subscribers, select the 
check boxes for the Subscribers that you do not want to upgrade at this time.
For all supported platforms, Subscriber objects must be upgraded using this GUI 
upgrade program.

By default, both boxes are selected. For more information, see “Determining Whether to 
Upgrade Incrementally” on page 189.

1b Software versions to upgrade:
Version 3.0.2: This causes all ZENworks for Servers 3.0.2 servers to be displayed.
Version 3/Unknown: This causes servers with ZENworks for Servers 3, 3 Support 
Pack 1, or any unknown version to be displayed.

1c Server platforms to upgrade:
NetWare: Displays only NetWare servers that match the other criteria (Distributor, 
Subscriber, versions).
Windows: Displays only Windows servers that match the other criteria (Distributor, 
Subscriber, versions).
Linux/Solaris/Unknown: Displays only Linux, Solaris, or platform unknown 
servers that match the other criteria (Distributor, Subscriber, versions).

By default, all platform boxes are selected. Servers are sorted by platform in the listing.
2 Click Next and continue with “Configure the Upgrade Locations and Options” on page 202.
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Configure the Upgrade Locations and Options

Figure 12-3   File Upgrade Locations and Options Page

1 On the File Upgrade Paths and Options page, select one or more objects in the Selected servers 
list.
Select objects individually or in groups, depending on whether their servers share the same 
installation paths and Server Management software starting methods.
The Software installation volume/drive field is for display only. The previous installation path 
is detected and used.

2 To have servers for the selected objects automatically start ZENworks 7 Server Management 
with SP1 on server startup, select the Launch Policy and Distribution Services on startup check 
box (which is selected by default).

3 To have the upgrade program automatically start Policy and Distribution Services after 
upgrading, select the Start services when the upgrade is finished check box (which is selected 
by default).

4 Repeat Step 1 through Step 3 for each group of selected objects.
5 Click Next and continue with “Upgrade Summary” on page 203.
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Upgrade Summary

Figure 12-4   Upgrade Summary Page

1 On the Upgrade Summary page, click Finish to begin the upgrade process.
2 If you upgraded Distributors and now want to upgrade Subscribers, repeat the steps in 

“Upgrade Steps” on page 191.
3 If you upgraded one tree and want to upgrade another at this time, repeat the steps in “Upgrade 

Steps” on page 191.
4 Continue with “Complete the Upgrade” on page 203.

Complete the Upgrade

To complete the upgrade process, do the following tasks in order:

1. “Upgrade the ConsoleOne Snap-Ins” on page 204
2. “Upgrade the Novell iManager Plug-Ins” on page 209
3. “Start Policy and Distribution Services” on page 209
4. “Verify That the Policy and Distribution Services Agents Are Loaded on NetWare Servers” on 

page 210
5. “Verify That the Policy and Distribution Services Agents Are Loaded on Windows Servers” on 

page 211
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Upgrade the ConsoleOne Snap-Ins

When upgrading, you should have updated the instance of ConsoleOne to the ZENworks 7 Server 
Management with SP1 snap-ins on the workstation that you used for upgrading. However, if you 
need to upgrade that or other instances of ConsoleOne with the snap-ins, continue in this section; 
otherwise, skip to “Upgrade the Novell iManager Plug-Ins” on page 209.

Make sure you have already upgraded to the newest version of ConsoleOne from the Novell 
ZENworks 7 with Support Pack 1 Companion 1 CD (see Section 4.4, “Installing ConsoleOne 
1.3.6e,” on page 43). This is required before installing the ZENworks 7 Server Management with 
SP1 snap-ins to any instance of ConsoleOne on a workstation or server.

To install the ZENworks 7 Server Management with SP1 snap-ins for ConsoleOne:

1 On a workstation or server where the ConsoleOne snap-in need to be upgraded to version 7, 
insert the Novell ZENworks 7 Server Management with Support Pack 1 Program CD.
The main menu is displayed. If it is not automatically displayed after inserting the CD, run 
winsetup.exe at the root of the CD.

2 Select the Server Management option.
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3 Select Install Policy-Enabled Server Management to start the installation program.
The License Agreement page is the first installation page displayed when the program has 
loaded.
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4 If you agree with the Software License Agreement, click Accept, then click Next to display the 
Installation Type page; otherwise, click Decline and click Cancel to exit.
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5 On the Installation Type page, click Next to perform a new installation and display the 
Installation Options page.

6 On the Installation Options page, click the Create eDirectory objects option to deselect the box, 
then click Next to display the Server Selection page.
You do not need tree access to update the ConsoleOne snap-ins.
The Install software files option must be selected to install the ConsoleOne snap-ins.
The Pause file copying option is optional.
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On the Server Selection page, the Local Machine option is selected for the ConsoleOne snap-
ins check box.

7 Click Next to display the Installation Summary page.
Local Machine is the workstation or server where you are running this program.
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8 Click Finish to install the ConsoleOne snap-ins to the local machine.
9 Repeat Step 1 through Step 8 for each machine where you need to upgrade the ConsoleOne 

snap-ins.
10 If you installed the ConsoleOne snap-ins as part of upgrading with the GUI installation 

program, continue with “Upgrade the Novell iManager Plug-Ins” on page 209.
Or, if you installed the ConsoleOne snap-ins as part of upgrading with the software package, 
continue with Step 13 on page 225 under Upgrading with the Server Software Package.

Upgrade the Novell iManager Plug-Ins

If you have Novell iManager 2.0.2 installed in your network, and you need to upgrade the iManager 
plug-ins to ZENworks 7 with SP1, follow the instructions under Section 6.1.2, “Web-Based 
Management for Policy and Distribution Services,” on page 96, then return to this section.

Continue with “Start Policy and Distribution Services” on page 209.

Start Policy and Distribution Services

If you chose not to auto-start Policy and Distribution Services after the upgrade completes, you must 
start Policy and Distribution Services on servers where you have upgraded from ZENworks for 
Servers 3.0.2.

1 On a server where you upgraded from ZENworks for Servers 3.0.2 to ZENworks 7 Server 
Management with SP1, do the appropriate procedure for your platform:
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2 Repeat Step 1 for each server that you upgraded.
3 If you upgraded NetWare servers, continue with “Verify That the Policy and Distribution 

Services Agents Are Loaded on NetWare Servers” on page 210.
Or, if you upgraded only Windows servers, continue with “Verify That the Policy and 
Distribution Services Agents Are Loaded on Windows Servers” on page 211.

Verify That the Policy and Distribution Services Agents Are Loaded on NetWare Servers

1 On the target server’s console, press Ctrl+Esc to view the loaded software programs.
2 If the ZENworks Server Management service is not displayed, review the \zenworks\zfs-

startup.log file, which contains information about why the agent did not start.
Zfs-startup.log is used to log startup problems only.

3 If the ASA 8.0.2 service is not displayed, review the \zenworks\zfs-startup.log file, which 
contains information about why the Sybase engine database did not start.

4 Repeat Step 1 through Step 3 for each NetWare server.
5 Rerun the upgrade program as necessary (see “Upgrade Steps” on page 191).
6 If you upgraded Windows servers, continue with “Verify That the Policy and Distribution 

Services Agents Are Loaded on Windows Servers” on page 211.
Or, if you have File Distributions, you may need to re-baseline them. If so, continue with “Re-
Baseline File Distributions” on page 211.
Or, if you have Linux or Solaris Distributor servers to upgrade, continue with Section 12.1.4, 
“Upgrading Linux and Solaris Servers,” on page 215.
Or, if you planned to upgrade Subscriber servers using the software package method, continue 
with Section 12.2, “Upgrade Using a Server Software Package,” on page 218.
Otherwise, you have completed upgrading NetWare and Windows servers.

Server Platform Procedure

Windows 2000/2003 Do the following on each Windows server:

1. Open the Control Panel.

2. On Windows 2000/2003, double-click Admin Tools, then 
double-click Services.

3. Start the Novell ZENworks Service Manager service.

The Novell Sybase Database service is automatically started 
by the installation program.

NetWare 5.1 and NetWare 6.x To start ZENworks Server Management, enter the following 
command at the server’s console prompt:

sys:\zenworks\zfs.ncf

After you have started ZENworks Server Management in this 
manner, and after the server has rebooted once, the full path is no 
longer be needed for starting the software—you only need to enter 
zfs thereafter.

The database is automatically started by the upgrade program.
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Verify That the Policy and Distribution Services Agents Are Loaded on Windows Servers

1 On the target server, open the Control Panel, double-click Admin Tools > Services, then 
determine if the following services are running:

Novell Database - Sybase
Novell ZENworks Service Manager

2 If the services are not displayed, do the following:
2a Close the Services window.
2b Click Start > Run, then enter the following command:

zenworks\pds\bin\dservices.bat

This stops the ZENworks Server Management services and unregisters them. This is done 
to make sure clean state exists for registering the services.

2c Click Start > Run, then enter the following command:
zenworks\pds\bin\sservices.bat

This registers the ZENworks Server Management services.
2d Open the Control Panel, double-click Admin Tools > Services, then start the services.

3 Repeat Step 1 and Step 2 for each Windows server.
4 Rerun the upgrade program as necessary (see “Upgrade Steps” on page 191).
5 If you have File Distributions, you may need to re-baseline them. If so, continue with “Re-

Baseline File Distributions” on page 211.
Or, if you have Linux or Solaris Distributor servers to upgrade, continue with Section 12.1.4, 
“Upgrading Linux and Solaris Servers,” on page 215.
Or, if you planned to upgrade Subscriber servers using the software package method, continue 
with Section 12.2, “Upgrade Using a Server Software Package,” on page 218.
Otherwise, you have completed upgrading NetWare and Windows servers.

Re-Baseline File Distributions

After upgrading to ZENworks 7 Server Management with SP1, all ZENworks for Servers 3.0.2 File 
Distributions must be re-baselined in order to incorporate new code contained only in the upgraded 
Distributor and Subscriber software. Otherwise, a “Local class compatibility.” error at the time of 
building or extracting is given, and File Distributions fails to process.

Review the following to re-baseline the Distributions:

“Understanding Baselining” on page 212
“Re-Baselining the Distributions” on page 212

However, if you had updated ZENworks for Servers 3.0.2 to Interim Release 2 before upgrading, 
you will have re-baselined those Distributions at that time. Therefore, you have completed 
upgrading your NetWare and Windows servers. Do one of the following:

If you have Linux or Solaris Distributor servers to upgrade, continue with Section 12.1.4, 
“Upgrading Linux and Solaris Servers,” on page 215.
If you planned to upgrade Subscriber servers using the software package method, continue with 
Section 12.2, “Upgrade Using a Server Software Package,” on page 218.
Version 3.0.2 Policy and Distribution Services 211



212 Novell

novdocx (en)  16 A
pril 2010
Understanding Baselining

The first time a File Distribution is sent, the entire content of the Distribution is sent. This is known 
as the “baseline” Distribution. To minimize network traffic and rebuilding time, File Distributions 
can have “deltas” sent, instead of the entire Distribution. A delta is a file made up of the differences 
between the last version of a Distribution and its newer version.

Deltas are useful for minimizing network traffic and bandwidth utilization, and are particularly 
useful with very large Distributions that change often, but have minimal changes.

The Maximum Revisions field on the General tab of the Distribution object’s properties allows you 
to determine how many deltas are built and sent before the entire Distribution built and sent again. 
The default for this field is 10.

Using this default value, the next 9 revisions are all deltas. Then, the 10th revision becomes a new 
baseline with the entire Distribution being rebuilt and sent. This causes all of the temporary files 
relative to that Distribution to be removed from the Distributor’s working directory and to be 
replaced by the new baseline files. The baseline-deltas cycle is then repeated.

Continue with “Re-Baselining the Distributions” on page 212.

Re-Baselining the Distributions

There are two methods to force re-baselining of File Distributions:

Changing the Maximum Revisions field back to 1

By changing this value back to 1, the next time the File Distribution is built, a new baseline is 
created.
Deleting the Distribution’s directory
The File Distribution is automatically be re-baselined the next time the Distribution’s Build 
schedule starts.

In both methods, re-baselining occurs the next time the File Distribution is built. Therefore, to speed 
up the re-baselining time, you may need to force rebuilding of the Distributions.

IMPORTANT: If you have more than 50 File Distributions, you should not re-baseline them all at 
once. This could force the Distributor to perform a lot of work all at once, and, depending on the 
Send schedule for these Distributions, could result in high network traffic in sending all of the new 
baselines at the same time.

Also, it could result in the Subscriber having a heavy workload if it is receiving and extracting 
several File Distributions that have been re-baselined.

We recommend you plan to re-baseline and send your File Distributions in small groups of 10 to 20 
at a time.

To re-baseline File Distributions, review the following two methods and select the one that is most 
applicable for you:

“Change the Maximum Revisions Value to 1” on page 213
“Delete the Distribution’s Directory” on page 214
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Change the Maximum Revisions Value to 1

1 In ConsoleOne:
1a Right-click a File Distribution object and click Properties.
1b Click the General Settings tab.
1c If you want to preserve the current value in the Maximum Revisions field, make a note of 

it.
Because this value can vary between the Distributions, you cannot multiple-select 
Distribution objects to change it.

1d Change the Maximum Revisions value to 1.
1e Click OK to close the Distribution’s properties.
1f Repeat steps Step 1a through Step 1e for each File Distribution.

1g Multiple-select the Distributor objects owning the File Distributions.
1h Right-click the selected Distributor objects, then click Refresh Distributors.

2 In iManager, for each Build schedule that is not already set to Run Immediately, if you do not 
want to wait for its schedule to start, do the following; otherwise, skip to Step 3:
2a Under the ZENworks Server Management role, click Remote Web Console.
2b Browse for and select a Distributor that owns one of the File Distributions that you 

modified in Step 1d, then click OK.
2c On the Distributions tab, click Build Distribution.
2d Select the File Distributions to be rebuilt, then click OK.
2e Click OK to start building the selected Distributions.

Each File Distribution whose maximum revisions value was set to 1 is rebuilt as a new 
baseline.

2f Repeat steps Step 2a through Step 2e for each Distributor that owns one of the File 
Distributions that you previously modified to have a Maximum Revision value of 1.

3 After the File Distributions have been rebuilt, in ConsoleOne:
3a Right-click a File Distribution object and click Properties.
3b Click the General Settings tab.
3c If you want to preserve the current value in the Maximum Revisions field, make a note of 

it.
3d Change the Maximum Revision value from 1 back to its original value (that you noted in 

Step 1c).
3e Click OK to close the Distribution’s properties.
3f Repeat steps Step 3a through Step 3e for each File Distribution.

3g Multiple-select the Distributor objects owning the File Distributions.
3h Right-click the selected Distributor objects and click Refresh Distributors.

You have completed re-baselining the File Distributions. They are sent and extracted according to 
the Channel and Send schedules involved.
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Do one of the following:

If you have Linux or Solaris Distributor servers to upgrade, continue with Section 12.1.4, 
“Upgrading Linux and Solaris Servers,” on page 215.
If you planned to upgrade Subscriber servers using the software package method, continue with 
Section 12.2, “Upgrade Using a Server Software Package,” on page 218.

Delete the Distribution’s Directory

After you have completed upgrading Policy and Distribution Services:

1 In ConsoleOne, right-click a Distributor object for a Distributor that owns one of the File 
Distributions that you need to re-baseline, then select Properties.

2 On the General > Settings tab, note the Distributor’s working directory.
3 On the Distributions tab, note the distinguished name for each File Distribution, then exit the 

Distributor’s properties.
4 Repeat Step 1 through Step 3 for each Distributor that owns one of the File Distributions that 

you need to re-baseline.
5 Using a file management application, under the Distributor’s working directory that you noted 

in Step 2, delete all of the directories that match the distinguished names of the File 
Distributions that you noted in Step 3.

6 Repeat Step 5 for each Distributor server where you noted File Distributions to be deleted.
7 In ConsoleOne, multiple-select these Distributors, right-click them, then click Refresh 

Distributors.
8 For each Build schedule that is not already set to Run Immediately, if you do not want to wait 

for its schedule to start, do the following in iManager:
8a Under the ZENworks Server Management role, click Remote Web Console.
8b Browse for and select a Distributor that owns one of the File Distributions that you are re-

baselining, then click OK.
8c On the Distributions tab, click Build Distribution.
8d Select the File Distributions to be rebuilt, then click OK.
8e Click OK to start building the selected Distributions.
8f Repeat steps Step 8a through Step 8e for each Distributor that owns one of the File 

Distributions that you are re-baselining.

You have completed setting up re-baselining of the File Distributions. The next time the Build 
schedules start for these Distributions, a new baseline version is built. Then they are sent and 
extracted according to the Channel and Send schedules involved.

Do one of the following:

If you have Linux or Solaris Distributor servers to upgrade, continue with Section 12.1.4, 
“Upgrading Linux and Solaris Servers,” on page 215.
If you planned to upgrade Subscriber servers using the software package method, continue with 
Section 12.2, “Upgrade Using a Server Software Package,” on page 218.
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12.1.4  Upgrading Linux and Solaris Servers
It is assumed that you have already extended the schema in the tree where the Linux and Solaris 
Distributor and Subscriber objects reside. If not, follow the instructions in “Extend the Schema” on 
page 192 before continuing in this section.

Perform the following tasks to upgrade your Linux and Solaris servers from ZENworks for Servers 
3.0.2 to ZENworks 7 Server Management with SP1:

1. “Upgrade the Linux or Solaris Operating System” on page 215
2. “Upgrade the Distributor and Subscriber Objects” on page 216
3. “Upgrade the Linux and Solaris Servers” on page 216

Upgrade the Linux or Solaris Operating System

In most cases, you need to upgrade your Linux or Solaris operating systems before you upgrade 
ZENworks for Servers 3.0.2 to ZENworks 7 Server Management with SP1.

The following table lists the corresponding versions of the Linux and Solaris operating systems that 
are supported at minimum:

Table 12-1   Minimum Supported Linux and Solaris Operating Systems for Upgrading

The Red Hat Linux Advanced Server 2.1 and the Red Hat Linux Enterprise Server 2.1 operating 
systems are supported in both versions of ZENworks. Therefore, if you have ZENworks for Servers 
3.0.2 installed on either the Red Hat Linux Advanced Server 2.1 or the Red Hat Linux Enterprise 
Server 2.1 operating system, skip to “Upgrade the Distributor and Subscriber Objects” on page 216.

SUSE® Linux was not supported in ZENworks for Servers 3.0.2. However, the following Linux 
operating systems are supported in ZENworks 7 Server Management with SP1:

SUSE Linux Enterprise Server (SLES) 8, 9, and 9 SP1
SUSE Linux Standard Server (SLSS) 8, 9, and 9 SP1

You can use any SUSE Linux version as replacement for a non-supported Linux operating system. 
However, the file system is different between SUSE Linux and the Red Hat Linux, requiring you to 
install ZENworks 7 Server Management with SP1 fresh.

In order to upgrade ZENworks for Servers 3.0.2 on machines running Red Hat Linux 7.1, 7.2, 7.3, 8 
or 9, you must upgrade to a supported Red Hat operating system.

ZENworks for Servers 3.0.2 ZENworks 7 Server Management with SP1

Red Hat Linux 7.1, 7.2, 7.3, 8 and 9 None

Red Hat Linux Advanced Server 2.1 Red Hat Linux Advanced Server 2.1

Red Hat Linux Enterprise Server 2.1 Red Hat Linux Enterprise Server 2.1

Red Hat Enterprise Linux AS 2 Red Hat Enterprise Linux AS 3 or 4

Red Hat Enterprise Linux ES 2 Red Hat Enterprise Linux ES 3 or 4

Solaris 8 Solaris 9
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To prepare Linux and Solaris servers for upgrading to ZENworks 7 Server Management with SP1:

1 For a Linux or Solaris operating system that is no longer supported, upgrade it to a version 
supported by ZENworks 7 Server Management with SP1.

WARNING: When upgrading the Linux or Solaris operating system, it is very important to 
preserve the file system so that the ZENworks software and files are preserved for upgrading; 
especially the Distribution files. If you do not preserve the file system, you need to install 
ZENworks 7 Server Management with SP1 fresh and you will lose all Distributions owned by 
the version 3.0.2 Linux or Solaris Distributors.

2 Continue with “Upgrade the Distributor and Subscriber Objects” on page 216.

Upgrade the Distributor and Subscriber Objects

You must first upgrade the Distributor and Subscriber objects using the GUI upgrade program. If 
you already did this when upgrading the NetWare or Windows platforms to ZENworks 7 Server 
Management with SP1, skip to “Upgrade the Linux and Solaris Servers” on page 216; otherwise:

1 Follow the steps in Section 12.1.3, “Upgrading NetWare and Windows Servers,” on page 190, 
with the following adjustments to the steps:

eDirectory Tree for Upgrading Objects page: By default, the Update the Subscriber 
files check box is selected. Because you only need to upgrade objects, deselect this check 
box.
Select the Objects to Upgrade page: The upgrade program displays a list of upgrade 
candidates based on the check boxes that are selected at the bottom of the page. Make sure 
that the necessary check boxes are selected, For example, deselect the NetWare and 
Windows check boxes, and make sure the Linux/Solaris/Unknown check box is selected.
All of the Linux and Solaris Distributor and Subscriber servers in your tree are listed on 
this page. Click the check boxes in the Upgrade column for each Linux or Solaris server 
to be upgraded.
Incremental Upgrade Issue: If you are upgrading Linux and Solaris servers 
incrementally, only select the check boxes in the Upgrade column for those servers to be 
upgraded at this time.

2 Continue with “Upgrade the Linux and Solaris Servers” on page 216.

Upgrade the Linux and Solaris Servers

The script for Linux and Solaris servers detects the existence of ZENworks for Servers 3.0.2 
software and asks whether you want to upgrade or install. We recommend using the upgrade option, 
which is documented in the following steps.

IMPORTANT: We strongly recommend that you upgrade your Distributor servers first, then 
upgrade your Subscriber servers. Otherwise, you can have version 3.0.2 Distributions being sent to 
version 7 Subscribers, which will fail.

To upgrade a Linux or Solaris server:

1 Log in as root.
2 If you are running X Windows on the Linux or Solaris server, open an XTerm window.
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3 Place the Novell ZENworks 7 Server Management with Support Pack 1 Program CD in the 
server’s CD-ROM drive.

4 Review the Novell ZENworks 7 Server Management with Support Pack 1 Readme for any last-
minute information concerning installation.
Readme_servers.html is located in the \readmes\en directory on the Program CD.

5 To run the Policy and Distribution Services script, enter one of the following commands in an 
XTerm window:
Red Hat Linux: /mnt/cdrom/ZfS/TedPol/platform/zfs-pds-install
SUSE Linux: /media/cdrom/ZfS/TedPol/platform/zfs-pds-install
where platform is either Linux or Solaris.

6 Press Enter to display the license agreement, press the Spacebar to scroll through the license 
agreement, type y, then press Enter to accept the license agreement.
The script installs software from the j2re .rpm or .pkg file.
The script detects that an earlier version of Policy and Distribution Services is installed on the 
server and asks:
Would you like to upgrade or reinstall? (u/r)

7 To upgrade, type u and press Enter.
We recommend that you upgrade in order to retain the server’s current Policy and Distribution 
Services settings. The remaining information in these steps assumes that you select the upgrade 
option.
The following is displayed (including errors, if any) for a Linux installation while the server is 
upgraded:
Installing the novell-zen-zfs RPM...
Preparing...         ######################################## [100%]
   1:novell-zen-zfs    ########################################### [100%]

Error messages are displayed at this point. After any error messages, the upgrade concludes by 
displaying the following:
ZENworks Server Management Policy and Distribution Services has been 
restarted.
You may check its status by running:
  /etc/init.d/novell-zfs status
You can reconfigure this service by running:
  /opt/novell/bin/zfs-pds-configure

8 To verify that Policy and Distribution Services is running, enter:
/etc/init.d/novell-zfs status

Policy and Distribution Services is now ready to use on your Linux or Solaris server.
9 Repeat Step 1 through Step 8 on each Distributor or Subscriber server.

10 To upgrade Remote Management, see Chapter 14, “Remote Management,” on page 249.
To upgrade Management and Monitoring Services, see Chapter 15, “Management and 
Monitoring Services,” on page 253.
Otherwise, you have completed upgrading Policy and Distribution Services.
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12.2  Upgrade Using a Server Software Package
This method allows you to automate the upgrading of Subscriber servers on all supported platforms 
where the Subscriber software is installed, including NetWare, Windows, Linux, and Solaris.

Section 12.2.1, “Upgrade Concepts and Issues,” on page 218
Section 12.2.2, “Preparing to Upgrade with the Server Software Package,” on page 222
Section 12.2.3, “Upgrading with the Server Software Package,” on page 222

12.2.1  Upgrade Concepts and Issues
You can upgrade ZENworks for Servers 3.0.2 Interim Release 1 Subscriber servers to ZENworks 7 
Server Management with SP1 using the Server Software Package upgrade method. The 
zsm7_polydist.cpk upgrade file is provided on the Novell ZENworks 7 with Support Pack 1 
Companion 2 CD for creating the Software Package Distribution. Then you send it to all of the 
Subscriber servers that you want to upgrade.

Review the following to understand what the upgrading does, and to understand the issues involved:

“Upgrading the Distributors First” on page 218
“Upgrading the Subscriber Objects First” on page 218
“The Interim Release 2 Requirement” on page 219
“What the Upgrade Server Software Package Does” on page 219
“What the Upgrade Server Software Package Does Not Do” on page 219
“Upgrading Servers on Multiple Trees” on page 220
“Cluster Issues with Upgrading” on page 220

Upgrading the Distributors First

You must first upgrade all of your Distributor servers using the Policy and Distribution Services 
Upgrade menu option in the GUI installation program that is run from the Novell ZENworks 7 
Server Management with Support Pack 1 Program CD.

After a ZENworks for Servers 3.0.2 Distributor is converted to ZENworks 7 Server Management 
with SP1, before it sends any of its Distributions, it converts them to ZENworks 7 Server 
Management with SP1 Distributions when it builds them.

Upgrading the Subscriber Objects First

The Server Software Package upgrade method does not upgrade the Subscriber objects. You must do 
this first using the GUI upgrade program.

The following conditions exist when you upgrade using the Server Software Package method:

When upgrading, the password used by the Subscriber is reset in both the Subscriber object and 
in the Tiered Electronic Distribution software installed on the Subscriber server.
Because you must upgrade the Subscriber objects first using the GUI upgrade program, until 
the Server Management software is upgraded on the Subscriber servers using the .cpk file, the 
Subscriber passwords do not match.
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Because the Subscriber passwords are not matched during the time interval between when you 
upgrade the objects and upgrade the software, the following Server Management functionality does 
not work:

Desktop Application Distributions
Trusted tree usage

Both of these require eDirectory access, which is the purpose of the Subscriber password.

Therefore, we recommend that you plan your upgrade so that a minimal amount of time will exist 
between when you upgrade the objects and the software.

IMPORTANT: If you are upgrading incrementally, do not upgrade all of your Subscriber objects at 
the same time. Only upgrade the Subscriber objects in conjunction with when you plan to upgrade 
their servers’ software.

The Interim Release 2 Requirement

The Interim Release 2 software update for ZENworks for Servers 3.0.2 (or 3 SP2) is required to be 
installed on a Subscriber server that you want to update using the Server Software Package method.

For instructions, see TID 2968433 in the Novell Support Knowledgebase (http://support.novell.com/
search/kb_index.jsp).

What the Upgrade Server Software Package Does

Maintains all working directories, so that Distributions created in ZENworks for Servers 3.0.2 
can be upgraded and used in version 7.
Upgrades to the ZENworks 7 Server Management with SP1 software using the installation 
paths where ZENworks for Servers 3.0.2 was installed.
Files are always copied in the ZENworks directories, replacing both older and newer files with 
the upgrade files. Files copied to other locations outside of the ZENworks directories are 
replaced only if they are older. The reason for replacing both older and newer files in the 
ZENworks directories is that version 3.0.2 files from a support pack that is more recent than the 
release of version 7 needs to be replaced with the older-dated version 7 files in order to have the 
correct files for version 7.
The ZENworks for Servers 3.0.2 Policy Package Agent is automatically upgraded to the 
ZENworks 7 Server Management with SP1 Policy/Package Agent.
Upgrades the ConsoleOne® snap-ins on the Subscriber servers where ConsoleOne is installed.

In summary, the software package upgrades the objects and installs the software on all Subscriber 
servers where you send the Software Package Distribution.

What the Upgrade Server Software Package Does Not Do

Distributors cannot be upgraded using the software package. This must be done first using the 
GUI installation program.
This upgrade software package does not upgrade the ZENworks for Servers 3.0.2 Novell 
eDirectoryTM Subscriber objects to version 7. You must use the GUI upgrade program to 
upgrade the objects.
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The software package does not upgrade to ZENworks 7 Server Management with SP1 on 
servers where ZENworks for Servers 3.0.2 was not installed. It only upgrades existing 
ZENworks for Servers 3.0.2 Subscriber objects and software.
The schema is not automatically extended. In order to have an upgraded Distributor for sending 
the Software Package Distribution containing the upgrade .cpk file, you would have already 
extended the schema using the GUI installation program.

IMPORTANT: Server Software Packages do not check to see whether the schema has been 
properly upgraded. The installation of the .cpk files will complete without error; however, the 
software will not run correctly because of the missing schema extensions. We recommend that 
you extend the schema before upgrading using the .cpk files; however, you can do this 
immediately after upgrading.

The ZENworks 7 Server Management with SP1 snap-ins for ConsoleOne are not installed to 
the local machine during upgrading. You must do this with the installation program after you 
have exited the upgrade program. You may have already done this when upgrading the 
Distributors. This task is covered in the upgrade steps.
The ZENworks 7 Server Management with SP1 plug-ins for iManager are not installed during 
upgrading. You must do this with an installation program menu option after you have exited the 
upgrade program. You may have already done this when upgrading the Distributors. This task 
is covered in the upgrade steps.

In summary, the upgrade program does not install ZENworks 7 Server Management with SP1 where 
ZENworks for Servers 3.0.2 was not installed. ZENworks Subscriber objects are necessary for 
identifying where to send the Software Package Distribution containing the .cpk upgrade file.

Upgrading Servers on Multiple Trees

You can upgrade Subscriber servers on multiple trees, because you can send Software Package 
Distributions to Subscribers on multiple trees.

Cluster Issues with Upgrading

If you are installing zsm7_polydist.cpk to servers in a clustered environment, you must install the 
.cpk file individually for each node in the cluster so that any files that need to be written to the sys: 
volume can be updated.

For example, the following information is known:

The Subscriber software resides on the shared volume of the cluster
Files such as sys:\system\zenworks.properties must be updated on each node in the 
cluster
Most Server Management files are updated on the cluster’s shared volume
The active server node in the cluster runs the Subscriber software from the shared volume
Only one node can be running the Subscriber software at a time (the one that is actively 
representing the cluster)
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Then, you have two ways to update the cluster’s nodes: through iManager or by renaming the 
Distribution:

“Updating Through iManager” on page 221
“Updating by Renaming the Distribution” on page 221

Updating Through iManager

To update all cluster nodes:

1 Update the active node’s server by sending a Distribution containing the .cpk file to it.
This updates any support pack files that need to be copied to the sys: volume. It also updates 
the Tiered Electronic Distribution and policies software, such as the .ncf files that are installed 
on a cluster’s volume.
Because filenames and dates are checked during software package installation, running this 
.cpk file repeatedly does not reinstall the files on the cluster’s shared volume. Only the node 
currently running the Subscriber software is updated.

2 Bring the currently active node’s server down to create a cluster failover condition.
This causes the next node in the predefined sequence to start the Subscriber software and take 
over for the cluster.

3 In iManager, access Remote Web Console as the Subscriber, click the Distributions tab, click 
the Received Distributions tab, select the Distribution that contains the .cpk file, click OK, 
then click Extract.

4 Repeat Step 2 through Step 3 until all nodes have been updated.
5 Restart each of the servers in the cluster that were downed.

The primary node’s server should take over again.

Updating by Renaming the Distribution

Alternatively, to update all cluster nodes:

1 Update the active node’s server by sending a Distribution containing the .cpk file to it.
This updates any support pack files that need to be copied to the sys: volume. It also updates 
the Tiered Electronic Distribution and policies software, such as the .ncf files that are installed 
on a cluster’s volume.
Because filenames and dates are checked during software package installation, running this 
.cpk file repeatedly does not reinstall the files on the cluster’s shared volume. Only the node 
currently running the Subscriber software is updated.

2 Bring the currently active node’s server down to create a cluster failover condition.
This causes the next node in the predefined sequence to start the Subscriber software and take 
over for the cluster.

3 Rename the Distribution that you sent in Step 1.
If you do not rename the Distribution when it is resent, the Subscriber software on the cluster 
volume being used by the current node thinks that it has already been received and doesn’t 
receive and extract it again.

4 Send the Distribution.
This updates the current node with the support pack.
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5 Repeat Step 2 through Step 4 until all nodes within the cluster have been updated.
6 Restart each of the servers in the cluster that were downed.

The primary node’s server should take over again.

12.2.2  Preparing to Upgrade with the Server Software Package
Make sure you have done the following to prepare the ZENworks for Servers 3.0.2 servers that you 
have targeted for upgrading at this time:

Fulfill the server requirements in Chapter 5, “Server Requirements,” on page 45
Upgrade all of the ZENworks for Servers 3.0.2 Distributors’ objects and software using the 
graphical interface program option (see Section 12.1, “Upgrade Using the Program CD,” on 
page 186)
Upgrade each Subscriber 3 or 3.0.1 server to version 3.0.2 (see the Novell ZENworks for 
Servers 3.0.2 documentation (http://www.novell.com/documentation/lg/zfs302/index.html))
Upgrade each upgraded Subscriber 3.0.2 server to Interim Release 2 (see TID 2968433 in the 
Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp))
Upgrade all of the ZENworks for Servers 3.0.2 servers to Interim Release 1 Subscriber objects 
using the graphical interface program option (see Section 12.1, “Upgrade Using the Program 
CD,” on page 186)
If you upgrade the software on any Windows servers, make sure that you have closed the 
Services window on each Windows server to be upgraded.
The software package upgrade automatically stops all ZENworks Server Management services. 
However, the Server Management services cannot be registered if the Services window is left 
open when upgrading the server.

12.2.3  Upgrading with the Server Software Package
Using the Tiered Electronic Distribution component of ZENworks 7 Server Management with SP1, 
you can automatically distribute and install the software packages to all Subscriber servers that are 
running the Subscriber and Policy/Package Agent software.

To upgrade using the Server Software Package (zsm7_polydist.cpk):

1 Select a ZENworks 7 with SP1 Distributor server and copy zsm7_polydist.cpk to the 
Distributor’s file system.
The .cpk file is located in:
Compaion 3 CD\zenworks server management - software pkgs\pds

2 Make a note of where you copied zsm7_polydist.cpk on the Distributor server for when you 
create its Server Package Distribution.

3 To set up the Subscribers, do the following:
3a Determine which Subscriber servers you want to upgrade with the software package.
3b Make sure any Channel that services these Subscribers is set to Inactive.

While a Subscriber server is being upgraded, no Distribution activity should be taking 
place on that server.
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After the upgrade software package is sent and extracted, you can reset these Channels 
back to Active in Step 8.

3c Set each Subscriber’s Extract schedule.
Use care in setting your Subscriber’s Extract schedule. If the schedule is set to Run 
Immediate and either the Subscriber is running on the same server as the Distributor, and/
or the Subscriber is a parent and is forwarding the Distribution on to subordinate 
Subscribers, you will likely interrupt the sending of the Distribution to Subscribers 
because the update process involves unloading Java. With Java unloaded, Distributions 
are temporarily halted until Java is reloaded and the Channel’s Send schedule fires.
Therefore, if the Subscriber is a parent that is sending the Distribution to subordinate 
Subscribers, it will be in the process of sending the Distribution when the software 
package tries to unload Java. However, the Distributions continue from where they left off 
after Java is started again.

4 Create a Distribution for this software package.
You can have only one software package per Distribution object. Although the software allows 
more than one software package to be selected in a single Distribution object, this is not 
permitted when distributing zsm7_polydist.cpk. The reason is that installing a software 
package unloads and reloads Java, which can prevent the remaining software packages from 
being successfully processed from a single Distribution object.
Be sure to set the Distribution’s Build schedule.

IMPORTANT: The Distribution containing zsm7_polydist.cpk must be built, sent, 
extracted, and installed before sending any other Distributions containing other software 
packages for upgrading other Server Management components.

For detailed instructions on creating Distributions, see “Tiered Electronic Distribution” in the 
Novell ZENworks 7 Server Management Administration Guide.

5 To set up a Channel for this Distribution:
5a Create a Channel specifically for this software package upgrade.
5b Set the Channel’s Send schedule to Immediate.
5c Associate the Distribution with this Channel so that it is sent based on the Channel’s Send 

schedule.
6 Associate the Subscribers that you identified in Step 3 with the Channel.
7 Send the Distribution.

For example, refresh the Distributor to get the Distribution built so that it can be sent and 
extracted. You do not need to set or change the Distributor’s Refresh schedule if you refresh the 
Distributor manually.
To refresh the Distributor manually, right-click the Distributor object in ConsoleOne and select 
Refresh Distributor.
For detailed instructions on sending Distributions, see “Tiered Electronic Distribution” in the 
Novell ZENworks 7 Server Management Administration Guide.
The Distribution is automatically created when the Distribution’s Build schedule starts. The 
Distribution is automatically sent when the Channel’s Send schedule starts. It is extracted 
according to the Subscriber server’s Extract schedule. At that point, the Subscriber server 
should be finished upgrading to ZENworks 7 with SP1.

8 For each Channel that was set to Inactive for this Distribution process, reset it to Active.
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9 Set the Channel used to send the upgrade software package to Inactive, so that the upgrade 
won’t be sent again to these Subscribers.

10 Determine which components of the software package are installed successfully by using one 
of the following methods:

Use the Tiered Electronic Distribution view in iManager to see information for every 
software package that was installed.
If you use Tiered Electronic Distribution for installation, use Server Management 
reporting to verify the success or failure of individual components of a software package.
Use the \zenworks\zfs-startup.log file contained on the Subscriber Servers to verify 
the success or failure.

Each software package can consist of several components. It is possible that some of these 
components can succeed in installing and others fail. For example, a server platform might 
exist for one of the servers to receive the Distribution, which platform is not contained in the 
requirements for the software package. Therefore, success for the software packages included 
in the installation means that one or more components are successfully installed, not 
necessarily all.
Because several components could fail to install, and the Software Package installation still 
appears as successful, we recommend that you review the success or failure of each component 
of the software package to verify that the components needed on a specific server are installed 
successfully.

11 Verify that the services have started:
11a Verify that the Policy and Distribution Services agents are loaded on NetWare servers:

1. On the target server’s console, press Ctrl+Esc to view the loaded software programs.
2. If the ZENworks Server Management service is not displayed, review the 

\zenworks\zfs-startup.log file, which contains information about why the 
agent did not start. Zfs-startup.log is used to log startup problems only.

3. If the ASA 8.0.2 service is not displayed, review the \zenworks\zfs-startup.log 
file, which contains information about why the Sybase engine database did not start.

4. Repeat 1 through 3 as necessary for each NetWare server that was upgraded.
11b Verify that the Policy and Distribution Services agents are loaded on Windows servers:

1. On the target server, open the Control Panel, double-click Admin Tools > Services, 
then determine if the Novell ZENworks Service Manager and Novell Database - 
Sybase services are running.

2. If the services are not displayed, do the following:
a. Close the Services window.
b. Click Start, click Run, then enter the following command:

zenworks\pds\bin\dservices.bat

This stops the ZENworks Server Management services and unregisters them. 
This is done to make sure clean state exists for registering the services.

c. Click Start, click Run, then enter the following command:
zenworks\pds\bin\sservices.bat
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This registers the ZENworks Server Management services.
d. Open the Control Panel, double-click Admin Tools > Services, then start the 

services by right-clicking them and selecting Start.
3. Repeat 1 and 2 for each Windows server that was upgraded.

12 If you have instances of ConsoleOne that need the snap-ins upgraded, follow the instructions in 
“Upgrade the ConsoleOne Snap-Ins” on page 204, then continue with Step 13.

13 If you have Novell iManager 2.0.2 installed on a server in your network, and you need to 
upgrade the iManager plug-ins to ZENworks 7 with SP1, follow the instructions under 
Section 6.1.2, “Web-Based Management for Policy and Distribution Services,” on page 96.
Otherwise, you have completed upgrading Policy and Distribution Services.
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13Server Inventory

This section provides you with instructions for upgrading to Novell® ZENworks® 7 Server 
Management with Support Pack 1 (SP1) from the Server Inventory component of ZENworks for 
Servers 3.x, ZENworks 6.5 Server Management, ZENworks 6.5 SP1/SP2 Server Management, or 
ZENworks 7 Server Management.

The following sections provide more information:

Section 13.1, “Upgrading from ZENworks for Servers 3.x,” on page 227
Section 13.2, “Upgrading from ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 
Server Management,” on page 240

13.1  Upgrading from ZENworks for Servers 3.x
Before upgrading, do the following:

Make sure that all of the installation requirements outlined in Part II, “Preparation,” on page 27 
are met. 
Review the facts in Section 13.1.1, “Pre-Upgrade Considerations,” on page 227.

To upgrade the following Server Inventory components from ZENworks for Servers 3.x to 
ZENworks 7 Server Management with SP1 using the Novell ZENworks 7 Server Management with 
Support Pack 1 Program CD, see Section 13.1.2, “Upgrading the Server Inventory Components 
Using the Program CD,” on page 229:

Inventory database
Inventory server
Inventory Agent
Server Inventory ConsoleOne® snap-ins

You can automate the upgrading of the Inventory Agent from ZENworks for Servers 3.0.2 or 
ZENworks for Servers 3 SP2 to ZENworks 7 Server Management with SP1 using a Server Software 
Package. For detailed information, see Section 13.1.3, “Upgrading the Inventory Agent Using a 
Server Software Package,” on page 238.

13.1.1  Pre-Upgrade Considerations
Before you upgrade Server Inventory to ZENworks 7 Server Management with SP1 either using the 
Novell ZENworks 7 Server Management with Support Pack 1 Program CD or the Server Software 
Package, review the facts in the following sections:

“Inventory Server” on page 228
“Inventory Agent” on page 228
“Management Console” on page 229
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Inventory Server

ZENworks for Servers 3.x Inventory servers can roll up the inventory data to a ZENworks 7 
Server Management with SP1 Inventory server, but a ZENworks 7 Server Management with 
SP1 Inventory server cannot roll up the inventory data to a ZENworks for Servers 3.x Inventory 
server.
Server Inventory in ZENworks 7 Server Management with SP1 supports backward 
compatibility with ZENworks for Servers 3.x Inventory servers residing on the same Novell 
eDirectory tree.
ZENworks for Servers 3.x Inventory servers must be upgraded to ZENworks 7 Server 
Management with SP1 in a top-down order. If you perform roll-up of your inventory data, the 
Root Server must be upgraded first, then the Intermediate Servers, and lastly the Leaf Servers. 
A ZENworks 7 Server Management with SP1 Inventory server cannot send its inventory data 
to a ZENworks for Servers 3.x Inventory server.
A ZENworks 7 Server Management with SP1 Inventory server can process the .str files of the 
ZENworks for Servers 3.x inventoried servers. The ZENworks for Servers 3.x Inventory agents 
can send the inventory data to a ZENworks 7 Server Management with SP1 Inventory server.
A ZENworks 7 Server Management with SP1 Inventory server can process the .zip files of the 
ZENworks for Servers 3.x Inventory servers.
The ZENworks for Servers 3.x Inventory server and a ZENworks 7 Server Management with 
SP1 Inventory server can use a ZENworks for Servers 3.x Roll-Up policy that is migrated to 
ZENworks 7 Server Management with SP1.
Upgrading a ZENworks for Servers 3.x Inventory server to ZENworks 7 Server Management 
with SP1 does not change the role of the Inventory server.
You can use ZENworks 7 Server Management with SP1 ConsoleOne snap-ins to administer 
both ZENworks for Servers 3.x and ZENworks 7 with SP1 inventory data and inventory objects 
(such as Inventory Service object, database objects, Server Inventory policy, Roll-Up policy 
and Database Location policy).
Do not delete the ZENworks for Servers 3.x .str and .zip files in a ZENworks for Servers 3.x 
Inventory server’s SCANDIR and its subdirectories after you’ve upgraded the Inventory server 
to ZENworks 7 with SP1.
Do not have a ZENworks for Servers 3.x Inventory server and a ZENworks 7 with SP1 
Inventory server store inventory data directly to the same Inventory database.

Inventory Agent

The ZENworks for Servers 3.x Inventory agent can send inventory data to a ZENworks 7 with 
SP1 Inventory server, which means the data can be stored in a ZENworks 7 with SP1 Inventory 
database.
The ZENworks 7 with SP1 Inventory agent cannot send the inventory data to a ZENworks for 
Servers 3.x Inventory server, which means the data cannot be stored in a ZENworks for Servers 
3.x Inventory database.
Do not upgrade to the ZENworks 7 with SP1 Inventory Agent until you’ve upgraded your 
Inventory servers and databases.
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A ZENworks for Servers 3.x or ZENworks 7 Server Management with SP1 Inventory Agent 
can use a ZENworks for Servers 3.x Inventory policy that is upgraded to ZENworks 7 Server 
Management with SP1, or they can use a newly created ZENworks 7 Server Management with 
SP1 Inventory policy.
If the ZENworks for Servers 3.x Inventory Agent and the ZENworks for Servers 3.x Policy and 
Distribution Services are installed on the same machine, and if you upgrade Policy and 
Distribution Services to ZENworks 7 Server Management with SP1, you must upgrade the 
Inventory Agent also to ZENworks 7 Server Management with SP1.

Management Console

You can use ZENworks 7 Server Management with SP1 ConsoleOne snap-ins to administer 
both ZENworks for Servers 3.x and ZENworks 7 with SP1 inventory data and inventory objects 
(such as Inventory Service object, database objects, Server Inventory policy, Roll-Up policy, 
Dictionary Update policy, and Database Location policy).
You cannot use the ZENworks for Servers 3.x ConsoleOne snap-ins to administer ZENworks 7 
Server Management with SP1 inventory data and inventory objects.
Do not use both ZENworks for Servers 3.x and ZENworks 7 Server Management with SP1 
consoles to configure the same ZENworks for Servers 3.x Inventory objects.
The ZENworks 7 with SP1 Server Inventory installation program automatically upgrades an 
existing ZENworks for Servers 3.x ConsoleOne snap-ins to ZENworks 7 with SP1. For more 
information on installing ZENworks 7 with SP1 Server Inventory, see Chapter 6, “Policy-
Enabled Server Management Installation,” on page 65.

13.1.2  Upgrading the Server Inventory Components Using the 
Program CD
Using the Novell ZENworks 7 Server Management with Support Pack 1 Program CD, you can 
upgrade the following Server Inventory components from ZENworks for Servers 3.x to ZENworks 7 
Server Management with SP1: Inventory server, Inventory database, Inventory Agent, and the 
ZENworks 7 Server Management with SP1 snap-ins for ConsoleOne. 

To upgrade Server Inventory from ZENworks for Servers 3.x to ZENworks 7 Server Management 
with SP1, perform the following tasks in the order listed:

1. Perform the tasks explained in “Tasks To Be Performed Before Upgrade and Database 
Migration” on page 230

2. “Upgrading the Inventory Database Using the Program CD” on page 232
3. “Upgrading the Inventory Server Using the Program CD” on page 234
4. “Upgrading the Inventory Agent Using the Program CD” on page 236
5. “Upgrading the Server Inventory ConsoleOne Snap-Ins Using the Program CD” on page 236
6. Perform the tasks explained in “Post Database Migration Tasks” on page 236
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Tasks To Be Performed Before Upgrade and Database Migration

After reviewing the facts mentioned in Section 13.1.1, “Pre-Upgrade Considerations,” on page 227, 
you must perform the following tasks before you upgrade the Server Inventory components from 
ZENworks for Servers 3.x to ZENworks 7 Server Management with SP1:

1 Stop the Inventory service.
On a NetWare Inventory server: At the server console prompt, enter:
sys:\system\invstop.ncf

NOTE: If you do not want the Sybase database to be stopped automatically when you 
stop the Inventory services, comment the Unload dbsrv8.nlm line in the 
sys:\system\invstop.ncf file.

On a Windows 2000/2003 Inventory server: In the Control Panel, double-click 
Administrative Tools, double-click Services, select Novell Inventory Service, then click 
Stop.

2 To stop the Sybase Inventory database:
On NetWare: At the Sybase console prompt, press the q key.
On Windows 2000/2003: In the Control Panel, double-click Administrative Tools, 
double-click Services, right-click Novell Database - Sybase, then click Stop.

3 To stop the ZENworks web server:
On Windows 2000 Server: In the Control Panel, double-click Administrative Tools, 
double-click Services, right-click Novell ZFS Web Server, then click Stop.

4 If Java has not been unloaded on the target NetWare servers, unload java.nlm (at the server 
console, enter java -exit).

IMPORTANT: This command stops all Java processes running on the server. Verify that all 
Java processes can be stopped while you are installing Server Management.

5 On the target Windows servers, close the Services window.
6 Make sure that you have archived a reliable backup of the ZENworks for Servers 3.x database.
7 Before upgrading the Inventory server, make sure that you have upgraded its associated 

database server.
8 Make sure that the ZENworks for Servers 3.x database is not accessed from ConsoleOne.
9 Make sure that the recommended ZENworks 7 with SP1 Server Inventory system requirements 

are met. For more information, see Chapter 5, “Server Requirements,” on page 45.
10 If ZENworks_installation_path\zenworks\inv\server\wminv\ 

properties\inventoryremoval.properties has been modified after the ZENworks for 
Servers 3.x installation, take a reliable backup of  inventoryremoval.properties.

11 Make sure that the Policy and Distribution Services have been upgraded to ZENworks 7 with 
SP1.
For more information on how to upgrade Policy and Distribution Services to ZENworks 7 with 
SP1, see Chapter 12, “Version 3.0.2 Policy and Distribution Services,” on page 185.

12 Make sure that the schema is migrated to ZENworks 7 with SP1.
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You can migrate the schema by using the ZENworks 7 Server Management with SP1 
installation program. For more information on how to migrate the schema, see “Extending the 
Schema” on page 69.

13 If you have a ZENworks for Servers 3.x Oracle Inventory database, you must perform the 
following tasks before the migration:
13a Ensure that the Oracle’s version is 9.2.0.6 or later.
13b In inventory_database_installation_path\init.ora_path\init.ora, set the 

values of the following parameters as shown:

db_cache_size=192M
sort_area_size=10000000
shared_pool_size = 157286400
open_cursors = 2048
log_buffer = 1024000
session_cached_cursors=2048
compatible=9.2.0
You can increase the cache size and shared pool to have Shared Global Area (SGA) to 30-
40% physical RAM size.

13c Ensure that the Inventory database is up and running.
13d Because you must have a larger rollback segment because the database migration and the 

storage of further data cannot succeed because of ORA-01555 and other rollback 
segment-related issues, to increase the value of the rollback segment, execute the 
following SQL script to add an additional data file to the rollback segment (RBS) and to 
add a Redo log group:
connect / as sysdba;

alter tablespace rbs add datafile 
’Inventory_database_installation_path\rbs2.ora’ size 40M autoextend on 
next 50K maxsize 60M;

alter rollback segment rb0 storage (maxextents unlimited);

alter rollback segment rb1 storage (maxextents unlimited); 

ALTER DATABASE ADD LOGFILE GROUP 3 
(’Inventory_database_installation_path\log3.ora’) SIZE 50M;

13e Stop the Inventory database.
13f Ensure that the value of the compatible parameter in 

inventory_database_installation_path\path_to_init.ora\init.ora is set to 
9.1.3.0.0 or later.

13g If the size of any data file is about to exceed 4096 MB, you must add extra data files to the 
corresponding tablespace.

13h Extract the appropriate platform-specific atlasperf_altertablespace.sql from 
ZENworks_installation_directory\zenworks\inv\server\wminv\properties\
sql.zip to C:.
If Oracle is running on Windows, extract atlasperf_altertablespace.sql from the 
oracle\winntspecific directory within sql.zip.
If Oracle is running on UNIX, extract atlasperf_altertablespace.sql from the 
oracle\unixspecific directory within sql.zip.
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13i Edit atlasperf_altertablespace.sql to set the value of MAXSIZE for all data files 
to the nearest multiple of 4 GB.
For example, if the size of CIM8.ora is 5 GB, then set the value of MAXSIZE to 8192 
MB.

13j Ensure that the file path of all data files listed in atlasperf_altertablespace.sql is 
correct.

13k Restart the Inventory database.
13l Execute altaslperf_altertablespace.sql.

Upgrading the Inventory Database Using the Program CD

During the ZENworks 7 Server Management with SP1 installation, if you choose to install Sybase 
and you do not choose to overwrite the database files, the server installation program automatically 
upgrades the existing ZENworks for Servers 3.x database engine only. During the Sybase database 
upgrade, a message indicating that the existing database can be migrated is displayed. If you choose 
Yes, then the existing database is overwritten by the new ZENworks 7 Server Management with SP1 
database files. If you choose No, the database is migrated when the Inventory service starts for the 
first time.

IMPORTANT: If you are upgrading a ZENworks for Servers 3 NetWare Inventory server (on 
which ZENworks for Servers 3 SP2 is installed using the Server Software Package) to ZENworks 7 
Server Management with SP1, the ZENworks 7 Server Management with SP1 installation fails to 
detect the Inventory database installed on the ZENworks for Servers 3 SP2 Inventory server. 
Consequently, the Inventory database check box is not automatically selected during the ZENworks 
7 Server Management with SP1 installation. To install the ZENworks 7 with SP1 Inventory 
database, you must manually select the Inventory database check box during the Server 
Management installation.

However, you must perform the following tasks:

1 If you have a ZENworks for Servers 3.x Oracle database object, or if you have manually 
created Sybase database objects, you must manually migrate the database object using the 
Inventory Migration tool. For more information, see “Manually Migrating the ZENworks for 
Servers 3.x Database Objects” on page 233.

2 If you have a ZENworks for Servers 3.x database running Sybase, ensure that the value of 
Sybase cache (the -c parameter) is set to 25% or higher than the server’s memory.

To change the database cache size on a NetWare database server:
1. Close all connections to the Inventory database.
2. Quit the Sybase server.
3. Open the mgmtdbs.ncf file in the sys:\system directory.
4. Modify the -c parameter. For example, -c 128M sets the cache size to 128 MB.
5. Save the file.
6. On the server console, to load the Inventory database, enter MGMTDBS.
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To change the database cache size on a Windows database server:
1. Stop the Sybase service:

On Windows NT, in the Control Panel, double-click Services, right-click Novell 
Database - Sybase, then click Stop.
On Windows 2000 Server, in the Control Panel, double-click Administrative 
Tools > double-click Services, right-click Novell Database - Sybase, then click 
Stop.

2. On the database server, run the ntdbconfig.exe file from the \dbengine directory.
Ntdbconfig.exe is a ZENworks database configuration utility for the ZENworks 
database using Sybase on Windows NT/2000 servers. This utility enables you to 
reconfigure the Sybase service.

3. Modify the -c parameter.
4. Click OK.
5. Restart the Sybase service:

On Windows NT, in the Control Panel, double-click Services, right-click Novell 
Database - Sybase, then click Start.
On Windows 2000 Server, in the Control Panel, double-click Administrative 
Tools, double-click Services, right-click Novell Database - Sybase, then click 
Start.

3 If you have a ZENworks for Servers 3.x database running MS SQL, ensure that the value of 
fixed memory is 40% or higher.

IMPORTANT: You can upgrade multiple Inventory servers and database servers at the same time 
by running the Server Management installation program. 

However, you must manually migrate the existing ZENworks for Servers 3.x Server Inventory 
policy, Database Location policy, and Roll-Up policy. If you have manually created the database 
object, you must also migrate the database object. For more information on how to manually migrate 
the policies, see “Manually Migrating the ZENworks for Servers 3.x Database Objects” on 
page 233.

Manually Migrating the ZENworks for Servers 3.x Database Objects

1 In ConsoleOne with ZENworks 7 Server Management with SP1 Server Inventory snap-ins 
installed, click Tools > ZENworks Inventory > Inventory migration.

2 Click Browse to browse for and select the database object to be migrated or the container that 
has the database object.

3 If you selected a container in Step 2, do the following:
3a If you want to search for the database object in all of the subcontainers within the selected 

container, select the Search subcontainers check box.
The Search subcontainers check box is available only if you select a container in Search 
context.

3b Select the Search for database objects check box to search for the database objects within 
the selected container to be migrated.
This option is available only if you select a container in Search context. By default, this 
option is selected.
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3c Click Find.
All the ZENworks for Servers 3.x database objects that are found within the specified 
context are displayed in the Report panel.

4 Click Migrate.
5 Click Close.
6 In ConsoleOne, right-click the database object, click Properties, then click the ZENworks 

Database tab.
7 Ensure that the following database object options have the specified values mentioned 

depending on the Inventory database:

8 Click Apply, then click Close.

Upgrading the Inventory Server Using the Program CD

Before upgrading the ZENworks for Servers 3.x Inventory server, make sure that you have upgraded 
the associated database server.

You can upgrade the ZENworks for Servers 3.x Inventory server by installing ZENworks 7 Server 
Management with SP1 Inventory server if the server where you want to install the ZENworks 7 
Server Management with SP1 Inventory Server meets the installation requirements. For more 
information on how to install the ZENworks 7 Server Management with SP1 Inventory Server, see 
Chapter 6, “Policy-Enabled Server Management Installation,” on page 65.

The ZENworks 7 Server Management with SP1 Inventory server supports the same set of roles as 
ZENworks for Servers 3.x. Therefore, when you upgrade from ZENworks for Servers 3.x to 
ZENworks 7 Server Management with SP1, the role of the Inventory server is retained.

Database Object 
Options

Value for the Sybase 
Inventory Database 
Object

Value for the Oracle 
Inventory Database 
Object

Value for the MS 
SQLServer 2000 
Inventory Database 
Object

Database (Read-Write) 
User Name

MW_DBA MW_DBA MW_DBA

Database (Read-Write) 
Password

novell novell novell

Database (Read Only) 
User Name

MW_READER MWO_READER MWM_READER

Database (Read Only) 
Password

novell novell novell

Database (Write Only) 
User Name

MW_UPDATER MWO_UPDATER MWM_UPDATER

Database (Write Only) 
Password

novell novell novell
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IMPORTANT: If you have a ZENworks for Servers 3.x Inventory server attached to a ZENworks 
for Servers 3.x database, and if you upgrade either the Inventory server or the database to ZENworks 
7 Server Management with SP1, you must upgrade the associated component to ZENworks 7 Server 
Management with SP1 (the ZENworks for Servers 3.x Inventory services should not interact with 
ZENworks 7 Server Management with SP1 compliant database, and vice versa).

If you have multiple ZENworks for Servers 3.x Inventory servers connected to a ZENworks for 
Servers 3.x database server, and if you upgrade the database server to ZENworks 7 Server 
Management with SP1, you must also upgrade all of the associated ZENworks for Servers 3.x 
Inventory servers.

The ZENworks 7 Server Management with SP1 installation program automatically migrates only 
the ZENworks for Servers 3.x Inventory Service object to ZENworks 7 Server Management with 
SP1. Before starting the Inventory service, you must manually migrate the existing ZENworks for 
Servers 3.x policies to ZENworks 7 Server Management with SP1 policies using the ZENworks 
Inventory Migration tool. For more information, see “Manually Migrating the ZENworks for 
Servers 3.x Inventory Policies” on page 235.

IMPORTANT: If you are upgrading a ZENworks for Server 3 NetWare Inventory server (on which 
ZENworks for Servers 3 SP2 is installed using the server software package) to ZENworks 7 Server 
Management with SP1, the ZENworks 7 Server Management with SP1 installation fails to detect the 
XML Proxy server installed on the ZENworks for Servers 3 SP2 Inventory server. Consequently, the 
Inventory Proxy Server check box is not automatically selected during the ZENworks 7 Server 
Management with SP1 installation. To install the ZENworks 7 with SP1 XML Proxy, you must 
manually select the Inventory proxy server check box during the Server Management installation.

Manually Migrating the ZENworks for Servers 3.x Inventory Policies

1 In ConsoleOne with ZENworks 7 Server Management with SP1 Server Inventory snap-ins 
installed, click Tools > ZENworks Inventory > Inventory migration.

2 Click Browse to browse for and select the Inventory Service object or the container that has the 
Inventory Service object.

3 If you selected a container in Step 2, do the following:
3a If you want to search for the Inventory Service object in all of the subcontainers within the 

selected container, select the Search subcontainers check box.
The Search subcontainers check box is available only if you select a container in Search 
context.

3b Select the Search for policies check box to search for the Inventory policies associated 
with the Inventory Service object within the selected container.
This option is available only if you select a container in Search context. By default, this 
option is selected.

3c Click Find.
All of the ZENworks for Servers 3.x Inventory policies associated with the Inventory 
Service object that are found within the specified context are displayed in the Report 
panel.

4 Click Migrate.
5 Click Close.
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The ZENworks 7 with SP1 Inventory agents obtain the software scan configuration rules from the 
private dictionary and the general dictionary, instead from the Server Inventory policy. However, the 
ZENworks for Servers 3.x Inventory agents continue to use the Server Inventory policy for software 
configuration.

After migrating the policies, perform the following tasks:

1 (Conditional) If you upgrade a ZENworks for Servers 3.0.2 NetWare database server with 
ZENworks for Servers 3.0.2 Interim Release 2 (IR 2) installed to ZENworks 7 Server 
Management with SP1, you must perform the following tasks:
1a Edit sys:\system\autoexec.ncf to add the following line:

sys:\system\mgmtdbs.ncf

1b Manually start the database server.
2 Start the ZENworks 7 Server Management with SP1 Inventory services.

When you start the Inventory service, the Upgrade Service automatically migrates the 
ZENworks for Servers 3.x database schema and the inventory data to a ZENworks 7 Server 
Management with SP1 database. The data migration process might take a significant amount of 
time. On the Inventory server screen, messages indicating that the database is successfully 
migrated and initialized are displayed. 
After the database is migrated, the Inventory ConsoleOne utilities (Query, Summary, Inventory 
Report, and Database Export) and the Storer can access the database.

3 Create and configure the Dictionary Update policy to obtain the latest version of the dictionary 
for ZENworks 7 with SP1 Inventory Agent. For more information on how to configure the 
Dictionary Update policy, see “Configuring the Dictionary Update Policy” in the Novell 
ZENworks 7 Server Management Administration Guide.

Upgrading the Inventory Agent Using the Program CD

If the machine where you want to install the ZENworks 7 Server Management with SP1 Inventory 
Agent meets the installation requirements, you can upgrade the Inventory Agent of ZENworks for 
Servers 3.x to ZENworks 7 with SP1 using the ZENworks 7 Server Management with SP1 
installation program. For more information about the installation requirements, see Part II, 
“Preparation,” on page 27.

Upgrading the Server Inventory ConsoleOne Snap-Ins Using the Program CD

If the machine where you want to install the ZENworks 7 Server Management with SP1 
ConsoleOne snap-ins meets the installation requirements, you can upgrade the Server Inventory 
ConsoleOne snap-ins of ZENworks for Servers 3.x to ZENworks 7 with SP1 using the ZENworks 7 
Server Management with SP1 installation program.

For more information about the installation requirements, see Chapter 4, “Installation Machine and 
Management Workstation Requirements,” on page 41. For more information on how to install the 
ZENworks 7 Server Management with SP1 ConsoleOne snap-ins, see Section 6.1, “Installation on 
NetWare and Windows Servers,” on page 65.

Post Database Migration Tasks

After migration is complete and the Storer is able to process files, do the following:

1 Stop the Inventory service.
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2 On an Oracle Inventory database, do the following to improve the database performance:
2a In the inventory_database_installation_path\_start.sql file, delete the existing 

entries and add the following entries:
SET ECHO ON

CONNECT INTERNAL

SET ECHO OFF

STARTUP PFILE=
inventory_database_installation_path\path_to_init.ora\init.ora

SET NUMWIDTH 20

SET CHARWIDTH 40

SET ECHO ON

connect mw_dba;

SET ECHO OFF

alter table cim.t$product cache;

SET ECHO ON

connect internal

SET ECHO OFF

@<path to oracle home directory>/rdbms/admin/dbmspool

call sys.dbms_shared_pool.keep(‘zenworks.zenpin', ‘P');

EXIT

2b Extract atlasperf_alterfreelist.sql from 
ZENworks_installation_directory\zenworks\inv\server\wminv\properties\
sql.zip and execute it at the SQLPLUS prompt.

2c Execute the oracle\common\oracle_perf.sql and 
oracle\common\oracle_perf2.sql files from 
Inventory_server_installation_path\zenworks\inv\server\wminv\properti
es\sql.zip to add performance enhancing indexes to the database.

2d Execute oracle_dbexport_perf.sql from the Novell ZENworks 7 with Support Pack 1 
Companion 2 CD’s \database\oracle9i\common directory.
For more information on how to improve the performance of the Inventory database, see 
“Performance Tips” in the Novell ZENworks 7 Server Management Administration Guide.

3 On a MS SQL Inventory database, use the MS SQL Query Analyzer to execute the following 
scripts from 
Inventory_server_installation_path\zenworks\inv\server\wminv\properties\s
ql.zip using the appropriate user login:
3a Log in as “CIM” and execute mssql_perf_cim.sql.
3b Log in as “mw_dba” and execute mssql_perf_mw_dba.sql.
3c Log in as “zenworks” and execute msswl_perf_zenworks.sql.

For more information on how to improve the performance of the Inventory database, see 
“Performance Tips” in the Novell ZENworks 7 Server Management Administration Guide

4 Start the Inventory services.
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13.1.3  Upgrading the Inventory Agent Using a Server Software 
Package
You can also upgrade the Inventory Agent from ZENworks for Servers 3.0.2 or ZENworks for 
Servers 3 SP2 to ZENworks 7 Server Management with SP1 using a Server Software Package 
upgrade file contained on the Novell ZENworks 7 with Support Pack 1 Compaion 3 CD.

This method allows you to automatically upgrade the Inventory Agent installed on NetWare 5.1 SP7 
or later, and Windows 2000 Server.

To upgrade the Inventory Agent, perform the following tasks in the order listed:

1. “Preparing for Upgrade” on page 238
2. “Upgrading the Inventory Agent Using the Software Package” on page 238
3. “Reinstalling the Inventory Agent Using the Software Package” on page 239

Preparing for Upgrade

1 Review the Section 13.1.1, “Pre-Upgrade Considerations,” on page 227.
2 Upgrade Policy and Distribution Services to ZENworks 7 with SP1.

For more information on how to upgrade Policy and Distribution Services to ZENworks 7 with 
SP1, see Chapter 12, “Version 3.0.2 Policy and Distribution Services,” on page 185.

Upgrading the Inventory Agent Using the Software Package

You can automatically install the Inventory Agent .cpk file.

IMPORTANT: You cannot combine software packages into the same Distribution. You must create 
a separate Distribution object for each software package. Also, ensure that the Inventory server and 
the Inventory Agent Distributions are not simultaneously sent to the server using the same Channel. 
You must first send the Inventory server Distribution and after it is complete, you must send the 
Inventory Agent Distribution. This is because each software package unloads the JVM on NetWare, 
which prevents concurrent processing of multiple software packages.

To automatically install the Inventory Agent .cpk file:

1 Copy zsm7_inv_agnt.cpk from the Novell ZENworks 7 with Support Pack 1 Compaion 3 
CD’s zenworks server management - software pkgs\invrm directory to a temporary 
directory on the Distributor server you use to install the software package. 

2 Set the Subscriber’s Extract schedule.
If the schedule is set to Run Immediate, you might interrupt the sending of the Distribution to 
Subscribers because the update process involves unloading Java. With Java unloaded, 
Distributions are temporarily halted until Java is reloaded and the Channel’s Send schedule 
fires.
If the Subscriber is a parent that is sending the Distribution to subordinate Subscribers, it will 
be in the process of sending the Distribution when the software package tries to unload Java. 
However, the Distributions will continue from where they left off after Java is started again.

3 Create a Distribution for this software package.
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You can have only one software package per Distribution object. Although the software allows 
more than one software package to be selected in a single Distribution object, this is not 
permitted when distributing the ZENworks 7 Server Management with SP1 software packages. 
The reason is that installing a software package unloads and reloads Java, which can prevent 
the remaining software packages from being successfully processed from a single Distribution 
object.
Make sure you set the Distribution’s Build schedule.
The Distribution containing ZENworks 7 Server Management with SP1 must be built, sent, 
extracted, and installed before sending any other Distributions containing other ZENworks 7 
Server Management with SP1 software packages.
For detailed instructions on creating Distributions, see “Tiered Electronic Distribution” in the 
Novell ZENworks 7 Server Management Administration Guide.

4 Associate the Distribution with a Channel so that it is sent based on the Channel’s schedule.
You might need to create the Channel. Be sure to set the Channel’s Send schedule.
The ZENworks 7 Server Management with SP1 software packages unload and restart Java as 
part of the installation process. Therefore, you must process each software package 
individually. If you attempt to process multiple ZENworks 7 Server Management with SP1 
software packages simultaneously (such as by processing them at the same time in a given 
Channel), it is probable that one or more of the Software Package Distributions will fail on 
installation.

5 Associate the Subscribers that you want to receive this software package with the Channel.
6 Send the Distribution.

For example, refresh the Distributor to build the Distribution so that it can be sent and 
extracted. For detailed information on sending distributions, see “Tiered Electronic 
Distribution” in the Novell ZENworks 7 Server Management Administration Guide.
The Distribution is automatically created when the Distribution’s Build schedule starts. The 
Distribution is automatically be sent when the Channel’s Send schedule starts. It is extracted 
according to the Subscriber server’s Extract schedule.

7 Review the following log files to verify the success or failure of the Inventory Agent .cpk file 
installation:

NetWare: sys:\etc\cpk7logs\cpk7_invagnt.log
Windows: %windir%\cpk7logs\cpk7_invagnt.log

If the .cpk file is successfully installed, the ZENworks service is automatically started.

NOTE: During the NetWare Inventory agent upgrade, all of the Java services, including the 
ZENworks service, are automatically terminated. After the upgrade, only the ZENworks 
service is automatically started; you must manually start all of the other Java services.

Reinstalling the Inventory Agent Using the Software Package

If you have installed the ZENworks 7 with SP1 Inventory Agent on the inventoried server using the 
Novell ZENworks 7 Server Management with Support Pack 1 Program CD, and now you want to 
reinstall the ZENworks 7 with SP1 Inventory Agent using the software package, you must do the 
following:

1 Ensure that the value of InvAgentPath in sys:\system\zenworks.properties is 
volume_name:\zenworks\inv\agent.
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2 Follow the steps explained in “Upgrading the Inventory Agent Using the Software Package” on 
page 238.

NOTE: During the NetWare Inventory agent upgrade, all of the Java services, including the 
ZENworks service, are automatically terminated. After the upgrade, only the ZENworks 
service is automatically started; you must manually start all of the other Java services.

13.2  Upgrading from ZENworks 6.5 Server 
Management or ZENworks 6.5 SP1/SP2 Server 
Management
Before upgrading, do the following:

Make sure that all of the installation requirements outlined in Part II, “Preparation,” on page 27 
are met. 
Review the facts in Section 13.2.1, “Pre-Upgrade Considerations,” on page 240.

To upgrade the following Server Inventory components from ZENworks 6.5 Server Management or 
ZENworks 6.5 SP1/SP2 Server Management to ZENworks 7 Server Management with SP1, see 
Section 13.2.2, “Upgrading the Server Inventory Components Using the Program CD,” on 
page 242:

Inventory database
Inventory server
Inventory Agent
Server Inventory ConsoleOne® snap-ins

You can automate the upgrading of the Inventory Agent from ZENworks 6.5 Server Management or 
ZENworks 6.5 SP1/SP2 Server Management to ZENworks 7 Server Management with SP1 using a 
Server Software Package. For detailed information, see Section 13.2.3, “Upgrading the Inventory 
Agent Using a Server Software Package,” on page 246.

13.2.1  Pre-Upgrade Considerations
Before you upgrade Server Inventory to ZENworks 7 Server Management with SP1 either using the 
Program CD or the Server Software Package, review the facts in the following sections:

“Inventory Server” on page 240
“Inventory Agent” on page 241
“Management Console” on page 242

Inventory Server

ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management Inventory 
servers can roll up the inventory data to a ZENworks 7 Server Management with SP1 Inventory 
server, but a ZENworks 7 Server Management with SP1 Inventory server cannot roll up the 
inventory data to a ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management Inventory server.
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Server Inventory in ZENworks 7 Server Management with SP1 supports backward 
compatibility with ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management Inventory servers residing on the same Novell eDirectory tree.
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management Inventory 
servers must be upgraded to ZENworks 7 Server Management with SP1 in a top-down order. If 
you perform roll-up of your inventory data, the Root Server must be upgraded first, then the 
Intermediate Servers, and lastly the Leaf Servers. 
A ZENworks 7 Server Management with SP1 Inventory server cannot send its inventory data 
to a ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management 
Inventory server.
A ZENworks 7 Server Management with SP1 Inventory server can process the .str files of the 
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management 
inventoried servers. The ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management Inventory agents can send the inventory data to a ZENworks 7 Server 
Management with SP1 Inventory server.
A ZENworks 7 Server Management with SP1 Inventory server can process the .zip files of the 
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management Inventory 
servers.
The ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management 
Inventory server and a ZENworks 7 Server Management with SP1 Inventory server can use a 
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management Roll-Up 
policy that is migrated to ZENworks 7 Server Management with SP1.
Upgrading a ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management Inventory server to ZENworks 7 Server Management with SP1 does not change 
the role of the Inventory server.
You can use ZENworks 7 Server Management with SP1 ConsoleOne snap-ins to administer 
both ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management, and 
ZENworks 7 with SP1 inventory data and inventory objects (such as Inventory Service object, 
database objects, Server Inventory policy, Roll-Up policy and Database Location policy).
Do not delete the ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management .str and .zip files in a ZENworks 6.5 Server Management or ZENworks 6.5 
SP1/SP2 Server Management Inventory server’s SCANDIR and its subdirectories after you’ve 
upgraded the Inventory server to ZENworks 7 with SP1.
Do not have a ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management Inventory server and a ZENworks 7 with SP1 Inventory server store inventory 
data directly to the same Inventory database.

Inventory Agent

The ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management 
Inventory agent can send inventory data to a ZENworks 7 with SP1 Inventory server, which 
means the data can be stored in a ZENworks 7 with SP1 Inventory database.
The ZENworks 7 with SP1 Inventory agent cannot send the inventory data to a ZENworks 6.5 
Server Management or ZENworks 6.5 SP1/SP2 Server Management Inventory server, which 
means the data cannot be stored in a ZENworks 6.5 Server Management or ZENworks 6.5 SP1/
SP2 Server Management Inventory database.
Do not upgrade to the ZENworks 7 with SP1 Inventory Agent until you’ve upgraded your 
Inventory servers and databases.
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A ZENworks 6.5 Server Management, ZENworks 6.5 SP1/SP2 Server Management, or 
ZENworks 7 Server Management with SP1 Inventory Agent can use a ZENworks 6.5 Server 
Management or ZENworks 6.5 SP1/SP2 Server Management Inventory policy that is upgraded 
to ZENworks 7 Server Management with SP1, or they can use a newly created ZENworks 7 
Server Management with SP1 Inventory policy.
If the ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management 
Inventory Agent and the ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management Policy and Distribution Services are installed on the same machine, and if you 
upgrade Policy and Distribution Services to ZENworks 7 Server Management with SP1, you 
must upgrade the Inventory Agent also to ZENworks 7 Server Management with SP1.

Management Console

You can use ZENworks 7 Server Management with SP1 ConsoleOne snap-ins to administer 
both ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management and 
ZENworks 7 with SP1 inventory data and inventory objects (such as Inventory Service object, 
database objects, Server Inventory policy, Roll-Up policy, Dictionary Update policy, and 
Database Location policy).
You cannot use the ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management ConsoleOne snap-ins to administer ZENworks 7 Server Management with SP1 
inventory data and inventory objects.
Do not use both ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management and ZENworks 7 Server Management with SP1 consoles to configure the same 
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management Inventory 
objects.
The ZENworks 7 with SP1 Server Inventory installation program automatically upgrades an 
existing ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management 
ConsoleOne snap-ins to ZENworks 7 with SP1. For more information on installing ZENworks 
7 with SP1 Server Inventory, see Chapter 6, “Policy-Enabled Server Management Installation,” 
on page 65.

13.2.2  Upgrading the Server Inventory Components Using the 
Program CD
Using the Novell ZENworks 7 Server Management with Support Pack 1 Program CD, you can 
upgrade the following Server Inventory components from ZENworks 6.5 Server Management or 
ZENworks 6.5 SP1/SP2 Server Management to ZENworks 7 Server Management with SP1: 
Inventory server, Inventory database, Inventory Agent, and the ZENworks 7 Server Management 
with SP1 snap-ins for ConsoleOne. 

To upgrade Server Inventory from ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 
Server Management to ZENworks 7 Server Management with SP1, perform the following tasks in 
the order listed:

1. “Tasks To Be Performed Before Upgrade and Database Migration” on page 243.
2. “Upgrading the Server Inventory Components” on page 245
3. “Post Database Migration Tasks” on page 245
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Tasks To Be Performed Before Upgrade and Database Migration

After reviewing the facts mentioned in Section 13.1.1, “Pre-Upgrade Considerations,” on page 227, 
you must perform the following tasks before you upgrade the Server Inventory components from 
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management to ZENworks 7 
Server Management with SP1:

1 Stop the Inventory service.
On a NetWare Inventory server at the server console prompt, enter:
sys:\system\invstop.ncf

NOTE: If you do not want the Sybase database to be stopped automatically when you 
stop the Inventory services, comment the Unload dbsrv8.nlm line in the 
sys:\system\invstop.ncf file.

On a Windows 2000/2003 Inventory server in the Control Panel, double-click 
Administrative Tools, double-click Services, right-click Novell Inventory Service, then 
click Stop.

2 Stop the Inventory database.
To stop the Sybase Inventory database:

On NetWare at the Sybase console prompt, press the q key.
On Windows 2000/2003 in the Control Panel, double-click Administrative Tools, double-
click Services, right-click Novell Database - Sybase, then click Stop.

3 Stop the Novell ZENworks Service Manager service.
On Windows 2000 Server in the Control Panel, double-click Administrative Tools, double-
click Services, right-click Novell ZENworks Service Manager, then click Stop.

4 If Java has not been unloaded on the target NetWare servers, unload java.nlm (at the server 
console, enter java -exit).

IMPORTANT: This command stops all Java processes running on the server. Verify that all 
Java processes can be stopped while you are installing Server Management.

5 On the target Windows servers, close the Services window.
6 Make sure that you have archived a reliable backup of the ZENworks 6.5 Server Management 

or ZENworks 6.5 SP1/SP2 Server Management database.
7 Before upgrading the Inventory server, make sure that you have upgraded its associated 

database server.
8 Make sure that the ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 

Management database is not accessed from ConsoleOne.
9 Make sure that the recommended ZENworks 7 with SP1 Server Inventory system requirements 

are met. For more information, see Chapter 5, “Server Requirements,” on page 45.
10 If ZENworks_installation_path\zenworks\inv\server\wminv\ 

properties\inventoryremoval.properties has been modified after the ZENworks 6.5 
Server Management or ZENworks 6.5 SP1/SP2 Server Management installation, take a reliable 
backup of  inventoryremoval.properties.

11 Make sure that the Policy and Distribution Services have been upgraded to ZENworks 7 with 
SP1.
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For more information on how to upgrade Policy and Distribution Services to ZENworks 7 with 
SP1, see Chapter 12, “Version 3.0.2 Policy and Distribution Services,” on page 185.

12 Make sure that the schema is migrated to ZENworks 7 with SP1.
You can migrate the schema by using the ZENworks 7 Server Management with SP1 
installation program. For more information on how to migrate the schema, see “Extending the 
Schema” on page 69.

13 If you have a ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management Oracle Inventory database, you must perform the following tasks before the 
migration:
13a Ensure that the Oracle’s version is 9.2.0.6 or later.
13b In inventory_database_installation_path\init.ora_path\init.ora, set the 

values of the following parameters as shown:

db_cache_size=192M
sort_area_size=10000000
shared_pool_size = 157286400
open_cursors = 2048
log_buffer = 1024000
session_cached_cursors=2048
compatible=9.2.0
You can increase the cache size and shared pool to have Shared Global Area (SGA) to 30-
40% physical RAM size.!!!

13c Ensure that the Inventory database is up and running.
13d You must have a larger rollback segment because the database migration and the storage 

of further data cannot succeed because of ORA-01555 and other rollback segment-related 
issues.
To increase the value of the rollback segment, execute the following SQL script to add an 
additional data file to the rollback segment (RBS) and to add a Redo log group:
connect / as sysdba;

alter tablespace rbs add datafile 
’Inventory_database_installation_path\rbs2.ora’ size 40M autoextend on 
next 50K maxsize 60M;

alter rollback segment rb0 storage (maxextents unlimited);

alter rollback segment rb1 storage (maxextents unlimited); 

ALTER DATABASE ADD LOGFILE GROUP 3 
(’Inventory_database_installation_path\log3.ora’) SIZE 50M;

13e Stop the Inventory database.
13f Ensure that the value of the compatible parameter in 

inventory_database_installation_path\path_to_init.ora\init.ora is set to 
9.2.0 or later.

13g If the size of any data file is about to exceed 4096 MB, you must add extra data files to the 
corresponding tablespace.

13h Extract the appropriate platform-specific atlasperf_altertablespace.sql from 
ZENworks_installation_directory\zenworks\inv\server\wminv\properties\
sql.zip to C:.
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If Oracle is running on Windows, extract atlasperf_altertablespace.sql from the 
oracle\winntspecific directory within sql.zip.
If Oracle is running on UNIX, extract atlasperf_altertablespace.sql from the 
oracle\unixspecific directory within sql.zip.

13i Edit atlasperf_altertablespace.sql to set the value of MAXSIZE for all data files 
to the nearest multiple of 4 GB.
For example, if the size of CIM8.ora is 5 GB, then set the value of MAXSIZE to 8192 
MB.

13j Ensure that the file path of all data files listed in atlasperf_altertablespace.sql is 
correct. 

13k Restart the Inventory database.
13l Execute altaslperf_altertablespace.sql.

Upgrading the Server Inventory Components

You can upgrade the ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management Server Inventory components by installing ZENworks 7 Server Management with SP1 
if the machine where you want to install ZENworks 7 Server Management with SP1 meets the 
installation requirements. For more information about the installation requirements, see Part II, 
“Preparation,” on page 27.

The ZENworks 7 Server Management with SP1 Inventory server supports the same set of roles as 
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management. Therefore, 
when you upgrade from ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management to ZENworks 7 Server Management with SP1, the role of the Inventory server is 
retained.

The ZENworks 7 Server Management with SP1 installation program automatically migrates all 
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server Management policies to 
ZENworks 7 Server Management with SP1.

Post Database Migration Tasks

After migration is complete and the Storer is able to process files, do the following:

1 Stop the Inventory service.
2 On an Oracle Inventory database, do the following to improve the database performance:

2a Extract atlasperf_alterfreelist.sql from 
ZENworks_installation_directory\zenworks\inv\server\wminv\properties\
sql.zip and execute it at the SQLPLUS prompt.

2b Execute the oracle\common\oracle_perf.sql and 
oracle\common\oracle_perf2.sql files from 
Inventory_server_installation_path\zenworks\inv\server\wminv\properti
es\sql.zip to add performance enhancing indexes to the database.

2c Execute oracle_dbexport_perf.sql from the Novell ZENworks 7 with Support Pack 1 
Companion 2 CD’s \database\oracle9i\common directory.
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2d (Conditional) If you are migrating from ZENworks 6.5 SP1 Server Management Hot 
Patch 1 or Hot Patch 2, or ZENworks 6.5 SP2 Server Management, extract 
\oralce\common\zfd65sp1hp1_65sp2_70.sql from 
ZENworks_installation_directory\zenworks\inv\server\wminv\properties\
sql.zip and execute it at the SQLPLUS prompt.
For more information on how to improve the performance of the Inventory database, see 
“Performance Tips” in the Novell ZENworks 7 Server Management Administration Guide.

3 On a MS SQL Inventory database, use the MS SQL Query Analyzer to execute the following 
scripts from 
Inventory_server_installation_path\zenworks\inv\server\wminv\properties\s
ql.zip using the appropriate user login:
3a Log in as “CIM” and execute mssql_perf_cim.sql.
3b Log in as “mw_dba” and execute mssql_perf_mw_dba.sql.
3c Log in as “zenworks” and execute msswl_perf_zenworks.sql.
3d (Conditional) If you are migrating from ZENworks 6.5 SP1 Server Management Hot 

Patch 1 or Hot Patch 2, or ZENworks 6.5 SP2 Server Management, log in as “CIM” and 
execute \mssql\zfd65sp1hp1_65sp2_70.sql.
For more information on how to improve the performance of the Inventory database, see 
“Performance Tips” in the Novell ZENworks 7 Server Management Administration Guide

4 Start the Inventory services.

13.2.3  Upgrading the Inventory Agent Using a Server Software 
Package
You can also upgrade the Inventory Agent from ZENworks 6.5 Server Management, ZENworks 6.5 
SP1/SP2 Server Management, or ZENworks 7 Server Management to ZENworks 7 Server 
Management with SP1 using a Server Software Package upgrade file contained on the Novell 
ZENworks 7 with Support Pack 1 Compaion 3 CD.

This method allows you to automatically upgrade the Inventory Agent installed on NetWare 5.1 SP7 
or later, and Windows 2000 Server.

To upgrade the Inventory Agent, perform the following tasks in the order listed:

1. “Preparing for Upgrade” on page 246
2. “Upgrading the Inventory Agent Using the Software Package” on page 247
3. “Reinstalling the Inventory Agent Using the Software Package” on page 248

Preparing for Upgrade

1 Review the Section 13.2.1, “Pre-Upgrade Considerations,” on page 240.
2 Upgrade Policy and Distribution Services to ZENworks 7 with SP1.
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For more information on how to upgrade Policy and Distribution Services to ZENworks 7 with 
SP1, see Chapter 12, “Version 3.0.2 Policy and Distribution Services,” on page 185.

3 If you plan to upgrade the Inventory Agent from ZENworks 6.5 SP1 Server Management Hot 
Patch 1, Hot Patch 2, or Hot Patch 3 to ZENworks 7 Server Management with SP1, you must 
apply the patch available with TID 103465 before installing the support pack. For more 
information, see TID 103465 in the Novell Support Knowledgebase (http://support.novell.com/
search/kb_index.jsp).

Upgrading the Inventory Agent Using the Software Package

You can automatically install the Inventory Agent .cpk file.

IMPORTANT: You cannot combine software packages into the same Distribution. You must create 
a separate Distribution object for each software package. Also, ensure that the Inventory server and 
the Inventory Agent Distributions are not simultaneously sent to the server using the same Channel. 
You must first send the Inventory server Distribution and after it is complete, you must send the 
Inventory Agent Distribution. This is because each software package unloads the JVM on NetWare, 
which prevents concurrent processing of multiple software packages.

To automatically install the Inventory Agent .cpk file:

1 Copy zsm7_inv_agnt.cpk from Novell ZENworks 7 with Support Pack 1 Compaion 3 CD’s 
\zenworks server management - software pkgs\invrm directory to a temporary 
directory on the Distributor server that you use to install the software package. 

2 Set the Subscriber’s Extract schedule.
If the schedule is set to Run Immediate, you might interrupt the sending of the Distribution to 
Subscribers, because the update process involves unloading Java. With Java unloaded, 
Distributions are temporarily halted until Java is reloaded and the Channel’s Send schedule 
fires.
If the Subscriber is a parent that is sending the Distribution to subordinate Subscribers, it will 
be in the process of sending the Distribution when the software package tries to unload Java. 
However, the Distributions will continue from where they left off after Java is started again.

3 Create a Distribution for this software package.
You can have only one software package per Distribution object. Although the software allows 
more than one software package to be selected in a single Distribution object, this is not 
permitted when distributing the ZENworks 7 Server Management with SP1 software packages. 
The reason is that installing a software package unloads and reloads Java, which can prevent 
the remaining software packages from being successfully processed from a single Distribution 
object.
Make sure you set the Distribution’s Build schedule.
The Distribution containing ZENworks 7 Server Management with SP1 must be built, sent, 
extracted, and installed before sending any other Distributions containing other ZENworks 7 
Server Management with SP1 software packages.
For detailed instructions on creating Distributions, see “Tiered Electronic Distribution” in the 
Novell ZENworks 7 Server Management Administration Guide.

4 Associate the Distribution with a Channel so that it is sent based on the Channel’s schedule.
You might need to create the Channel. Be sure to set the Channel’s Send schedule.
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The ZENworks 7 Server Management with SP1 software packages unload and restart Java as 
part of the installation process. Therefore, you must process each software package 
individually. If you attempt to process multiple ZENworks 7 Server Management with SP1 
software packages simultaneously (such as by processing them at the same time in a given 
Channel), it is probable that one or more of the Software Package Distributions fails on 
installation.

5 Associate the Subscribers that you want to receive this software package with the Channel.
6 Send the Distribution.

For example, refresh the Distributor to build the Distribution so that it can be sent and 
extracted. For detailed information on sending distributions, see “Tiered Electronic 
Distribution” in the Novell ZENworks 7 Server Management Administration Guide.
The Distribution is automatically created when the Distribution’s Build schedule starts. The 
Distribution is automatically be sent when the Channel’s Send schedule starts. It is extracted 
according to the Subscriber server’s Extract schedule.

7 Review the following log files to verify the success or failure of the Inventory Agent .cpk file 
installation:

On a NetWare server: sys:\etc\cpk7logs\cpk7_invagnt.log
On a Windows server: %windir%\cpk7logs\cpk7_invagnt.log

If the .cpk file is successfully installed, the ZENworks service is automatically started.

NOTE: During the NetWare Inventory agent upgrade, all of the Java services including the 
ZENworks service is automatically terminated. After the upgrade, only the ZENworks service 
is automatically started; you must manually start all other Java services.

Reinstalling the Inventory Agent Using the Software Package

If you have installed the ZENworks 7 with SP1 Inventory Agent on the inventoried server using the 
Novell ZENworks 7 Server Management with Support Pack 1 Program CD, and now you want to 
reinstall the ZENworks 7 with SP1 Inventory Agent using the software package, you must do the 
following:

1 Ensure that the value of InvAgentPath in sys:\system\zenworks.properties is 
volume_name:\zenworks\inv\agent.

2 Follow steps explained in “Upgrading the Inventory Agent Using the Software Package” on 
page 247.

NOTE: During the NetWare Inventory agent upgrade, all of the Java services including the 
ZENworks service is automatically terminated. After the upgrade, only the ZENworks service 
is automatically started; you must manually start all other Java services.
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14Remote Management

This section provides you with instructions for upgrading to Remote Management in Novell® 
ZENworks® 7 Server Management with SP1 from Novell® ZENworks® for Servers 3.0.2, 
ZENworks 6.5.x Server Management, or ZENworks 7 Server Management using menu options on 
the Novell ZENworks 7 Server Management with Support Pack 1 Program CD or using a Server 
Software Package contained on the Novell ZENworks 7 with Support Pack 1 Compaion 3 CD.

Before upgrading, you must meet all of the requirements outlined in Part II, “Preparation,” on 
page 27.

Use the following method to upgrade:

Section 14.1, “Upgrade Using the Program CD,” on page 249

This method is useful for upgrading when you want hands-on configuration of the upgrade 
options. It uses a GUI upgrade program for NetWare and Windows.
Section 14.2, “Upgrading Using a Server Software Package,” on page 250
This method is useful for automating server upgrades.

14.1  Upgrade Using the Program CD
The Novell® ZENworks® 7 Server Management installation program automatically upgrades 
Remote Management for ZENworks for Servers 3.0.2 and ZENworks 6.5 Server Management.

To upgrade Remote Management to version 7, the servers where you have versions 3.0.2 or 6.5 
Remote Management installed must meet the minimum server requirements outlined in Chapter 5, 
“Server Requirements,” on page 45.

For information on how to install Remote Management, see Section 6.1, “Installation on NetWare 
and Windows Servers,” on page 65.

When running the installation program, do the following:

Select only the servers where a previous version of Remote Management is installed that you 
want upgraded
For the selected servers, select only the Remote Management check box under the ZENworks 
Policy-Enabled Management Services section
Do not select any of the boxes under the Additional Options section

IMPORTANT: If you already have a hook driver installed on the machine where you are 
upgrading, the hook driver is uninstalled during the upgrade. If Mirror Driver is not selected during 
the ZENworks 7 with SP1 installation, optimization is disabled for remote sessions and 
consequently, the performance of the remote session degrades.
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14.2  Upgrading Using a Server Software 
Package
The following sections provide detailed instructions for installing the software packages on Remote 
Management and Installation Log Files:

Section 14.2.1, “Automatically Installing Software Packages,” on page 250
Section 14.2.2, “Manually Installing Software Packages,” on page 251
Section 14.2.3, “Installation Log Files,” on page 252

IMPORTANT: If you already have a hook driver installed on the machine where you are 
upgrading, the hook driver is uninstalled during the upgrade. If Mirror Driver is not selected during 
the ZENworks 7 with SP1 installation, optimization is disabled for remote sessions and 
consequently, the performance of the remote session degrades.

NOTE: Apply zfsrmir2.cpk through Hotpatch24, if you have upgraded to ZfS 3.0.2 from ZfS 3.0 
using a Server Software Package. After applying Hotpatch24, you can upgrade to ZENworks 6.5 
Server Management using a Server Software Package.You need not apply HotPatch24 before 
upgrading to ZENworks 6.5 Server Management using a Server Software Package if you have 
upgraded to ZENworks for Server 3.0.2 from ZENworks for Servers 3.0 using the Novell ZENworks 
7 Server Management with Support Pack 1 Program CD, or if you have a fresh installation of 
ZENworks for Servers 3.0.2. For more information, see TID 10096514 in the Novell Support 
Knowledgebase (http://support.novell.com/search/kb_index.jsp).

14.2.1  Automatically Installing Software Packages
Using the Tiered Electronic Distribution component of ZENworks 7 Server Management with SP1, 
you can automatically distribute and upgrade the software packages to all servers that are running 
the Subscriber and Policy Package software.

IMPORTANT: You cannot combine software packages into the same Distribution. You must create 
a separate Distribution object for each software package. This is because each software package 
unloads the JVM on NetWare, which prevents concurrent processing of multiple software packages. 

Make sure you have completed the following prerequisites for automatic installation:

Your servers must meet the general ZENworks 7 with SP1 Remote Management requirements
Policy and Distribution Services must be installed on your servers so that the software package 
Distributions can be sent, received, and upgraded

To automatically install the Remote Management Agent .cpk file:

1 Copy the .cpk files from the ZENworks Server Management - Software Pkgs\InvRM 
directory on the Novell ZENworks 7 Server Management with Support Pack 1 Program CD.
Write down where you copied them for when you create the associated Distribution.

2 Set the Subscriber’s Extract schedule.
3 Create a Distribution for this software package and set the Distribution’s Build schedule.
4 Associate the Distribution with a Channel so that it is sent based on the Channel’s schedule.
 ZENworks 7 Server Management Installation Guide

http://support.novell.com/search/kb_index.jsp
http://support.novell.com/search/kb_index.jsp


novdocx (en)  16 A
pril 2010
You might need to create the Channel and set the Channel’s Send schedule.
5 Associate the Subscribers that you want to receive this software package with the Channel.
6 On a Windows server, for the zsm7_remmgmt.cpk file, create and initialize the following 

package processor variable in the Subscriber objects’ properties:
Variable = MIRROR

If the MIRROR variable value is set to YES, the Mirror Driver is installed, if the value is set to 
NO, it is not installed.
For External Subscribers, put the variable in the tednode.properties file.

IMPORTANT: The Mirror Driver (recommended) provides video adapter independence and 
coexistence with other Remote Control solutions. This is not yet signed by Microsoft. 
Installation overrides any check for it and suppresses any message from Windows.

7 Send the Distribution.
The Distribution is automatically created when the Distribution’s Build schedule starts. The 
Distribution is automatically sent when the Channel’s Send schedule starts. It is extracted 
according to the Subscriber server’s Extract schedule.

8 Review the log file contained in the Subscriber Servers to verify the success or failure of the 
installation.
Several components might fail to install, and the Software Package installation can still appear 
as successful, so you should review the success or failure of each component of the software 
package to ensure that the components needed on a specific server are installed successfully.

14.2.2  Manually Installing Software Packages
You can use a software package to install to a server that is not running Subscriber and the Policy/
Package Agent.

Before you begin a manual installation:

Make sure that you have access to the InvRemStandAlonePacPro.zip file. This file contains 
zsm7_remmgmt.bat, which is used to install the Server Management Agent on Windows 
servers, and zsm7_remmgmt.ncf, which is used to install the Server Management Agent on 
NetWare servers.
Make sure your servers meet the general ZENworks 7 with SP1 Remote Management 
requirements for the component to be updated. (See Chapter 5, “Server Requirements,” on 
page 45.)

To manually install the Remote Management Agent .cpk file:

1 Unzip the InvRemStandAlonePacPro.zip file to the appropriate location:
NetWare: sys:\
Windows: c:\
The Standalone Package Processor files are unzipped into a \temp directory at the root of the 
server’s file system.

2 Copy the .cpk file to be manually installed to the temporary directory where the associated 
.bat or .ncf file exists. For example:
NetWare: sys:\temp\zfs7
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Windows: c:\temp\zfs7
3 If JRE 1.3.1 is not installed on the target Windows server, download the JRE and install it. 
4 In the .bat files corresponding to zsm7_remmgmt.cpk, change the JREROOT variable path to 

JRE_installation_path\JRE\BIN on each of the target Windows servers where JRE 1.3.1 is 
installed.

5 Point the CPKTEMP variable in the batch file to the location of the installation directory. For 
example:
NetWare: CPKTEMP = sys:\temp\zfs7
Windows: CPKTEMP = c:\temp\zfs7

6 To install the zsm7_remmgmt.cpk software package, enter the following at the command 
prompt:
NetWare: sys:\temp\zfs7\zfs7_rm_mgmtagnt.ncf 
Windows: c:\temp\zfs\win\zfs7_rm_mgmtagnt.bat

7 Determine which components of the software package are installed successfully by reviewing 
the log file created during installation. For more information, see Section 14.2.3, “Installation 
Log Files,” on page 252. 

Variables Used by NCF and BAT Files for Manual Installation

The following variable is listed under the software package headings for the applicable .bat and 
.ncf files:

Variable = MIRROR

If the MIRROR variable value is set to YES, the Mirror Driver is installed; if the value is set to NO, 
it is not installed.

IMPORTANT: The Mirror Driver (recommended) provides video adapter independence and 
coexistence with other Remote Control solutions. This is not yet signed by Microsoft. Installation 
overrides any check for it and suppresses any message from Windows. 

The software package for the Server Management Agent uses this variable in the following .bat or 
.ncf files:

zsm7_remmgmt.cpk

zsm7_remmgmt.bat

14.2.3  Installation Log Files
The following log files contain detailed information about the success of the Remote Management 
installation:

NetWare: sys:\etc\cpk7logs\cpk7_rmagnt.log

Windows: %WINDIR%\cpk7logs\cpk7_agnt.log
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15Management and Monitoring 
Services

This section provides you with instructions for upgrading the Management and Monitoring Services 
component of Novell® ZENworks® 7 Server Management with Support Pack 1 (SP1) from Novell® 
ZENworks® for Servers 3.0.2, ZENworks 6.5 Server Management, or ZENworks 7 Server 
Management using menu options on the Novell ZENworks 7 Server Management with Support Pack 
1 Program CD.

Before upgrading, you must meet all of the requirements outlined in Part II, “Preparation,” on 
page 27.

To upgrade ZENworks for Servers 3.0.2, ZENworks 6.5 Server Management, or ZENworks 7 
Server Management to ZENworks 7 Server Management with SP1, review the following sections:

Section 15.1, “Meeting Management and Monitoring Services Upgrade Requirements,” on 
page 253
Section 15.2, “Before Upgrading,” on page 254
Section 15.3, “Upgrading Management and Monitoring Services,” on page 254
Section 15.4, “Migrating Alarm Dispositions from Earlier Version Database to ZENworks 7 
with SP1 Alarm Management Rules,” on page 256

15.1  Meeting Management and Monitoring 
Services Upgrade Requirements
Before you upgrade to ZENworks 7 Server Management with SP1 from ZENworks for Servers 
3.0.2, make sure the following requirements are met:

To upgrade the Site Server, ensure that you have installed the ZENworks for Servers 3.0.2 or 
ZENworks 6.5 Server Management Site Server.
To upgrade the Server Management AgentTM (NMA), ensure that you have installed NMA 
shipped with ZENworks for Servers 3 SP2, or NMA shipped with ZENworks 6.5 Server 
Management, or NMA shipped with ZENworks 6.5 SP1/SP2 Server Management.
To upgrade the Traffic Analysis Agent, ensure that you have installed the LANalyzer Agent 
shipped with ZENworks for Servers 3 SP2, or ZENworks 6.5 Server Management.
To upgrade the Advanced Trending Agent, ensure that you have installed the Advanced 
Trending Agent shipped with ZENworks 6.5 Server Management.
To upgrade the Windows Management Agent (NTMA), ensure you have installed NTMA 
shipped with ZENworks for Servers 3 SP2, or ZENworks 6.5 Server Management.
To upgrade the Traffic Analysis Agent for Windows, ensure that you have installed the Traffic 
Analysis Agent shipped with ZENworks for Servers 3 SP2 or ZENworks 6.5 Server 
Management.
To upgrade the Advanced Trending Agent for Windows, ensure that you have installed the 
Advanced Trending Agent shipped with ZENworks 6.5 Server Management.
Management and Monitoring Services 253



254 Novell

novdocx (en)  16 A
pril 2010
15.2  Before Upgrading 
Before you upgrade to ZENworks 7 Server Management with SP1 from ZENworks for Servers 
3.0.2, ZENworks 6.5 Server Management, or ZENworks 7 Server Management, we recommend that 
you review the following:

Verify that you have Admin or equivalent rights to the target Management server
Verify that you have stopped all of the ZENworks for Servers 3.0.2 or ZENworks 6.5 Server 
Management services
Verify that Sybase is not running on the server where you are upgrading
Ensure that you have installed the required support pack
Authenticate to the tree that contains all of the NetWare servers that you want to upgrade
Extend the schema
For more information, see “Extending the Schema” on page 69. However, if you have already 
extended the schema for ZENworks 7 Server Management with SP1, you do not need to do so 
again.

15.3  Upgrading Management and Monitoring 
Services
To upgrade Management and Monitoring Services, perform the following tasks in order:

Section 15.3.1, “Preparing to Upgrade to ZENworks 7 Server Management with SP1,” on 
page 254
Section 15.3.2, “Using the Upgrade Program,” on page 255

15.3.1  Preparing to Upgrade to ZENworks 7 Server 
Management with SP1
To prepare for upgrading from ZENworks for Servers 3.0.2 or ZENworks 6.5 Server Management:

1 Review the Novell ZENworks 7 Server Management with Support Pack 1 Readme for any last-
minute information concerning upgrading.
Readme_servers.html is located in the \readmes\en directory on the Novell ZENworks 7 
Server Management with Support Pack 1 Program CD, and is also accessible from an 
installation menu option.

2 Make sure you have met all of the server requirements listed in Section 5.4, “Management and 
Monitoring Services,” on page 56.

3 If Java has not been unloaded on the target NetWare servers, unload java.nlm.
For example, at each NetWare server’s console prompt, type:
java -exit

This also causes all ZENworks software to stop running on the server.
4 Select the workstation you will use to perform the upgrade. 
5 Continue with Section 15.3.2, “Using the Upgrade Program,” on page 255.
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15.3.2  Using the Upgrade Program
To upgrade Management and Monitoring Services from ZENworks for Servers 3.0.2 or ZENworks 
6.5 Server Management to ZENworks 7 Server Management with SP1:

1 On the upgrade workstation, insert the Novell ZENworks 7 Server Management with Support 
Pack 1 Program CD.
The startup screen is displayed. If the startup screen is not automatically displayed after 
inserting the CD, run winsetup.exe at the root of the CD.

IMPORTANT: If you copied the Program CD structure to the upgrade workstation’s hard 
drive, the path between the root of the hard drive and the first CD directory can contain only 
directory names that conform to the 8.3-character DOS file naming convention. If any long 
directory names exist in the path, the upgrade program does not work. 

2 Click Management and Monitoring Services. 
3 Select the Site Server upgrade option.

We recommend that you choose the upgrade option only to upgrade the existing version of 
ZENworks for Servers 3.0.2 or ZENworks 6.5 Servers Management to ZENworks 7 Server 
Management with SP1.
The Management and Monitoring Services Upgrade Installation Wizard launches.

4 Click Next to continue.
5 After you have read and agreed to the Software License Agreement, click Yes to continue with 

the installation.
6 Select the desired ZENworks 7 Server Management with SP1 components listed in the 

following table.

IMPORTANT: You need to have Admin or equivalent rights to the target servers. Select the 
shared folder on all servers where the ZENworks for Servers 3.0.2 agents are installed. Share 
the folder if you have not already done so.

7 Click Next.

Server Components Upgrade On 

Management Site Services Management server

Server Management Agent All NetWare and Windows servers that you want to upgrade

Traffic Analysis Agent One server (NetWare or Windows 2000/2003 servers) per 
segment

Advanced Trending Agent Install on all NetWare and Windows servers

IMPORTANT: On a Windows server, the Advanced Trending 
Agent is installed only if either the Server Management Agent or 
the Traffic Analysis Agent of ZENworks for Servers 3.0.2 is 
installed.
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8 If you selected to upgrade the Management Site Services, complete the following; otherwise, 
skip to Step 11:
8a Browse to and select the volume name of the NetWare server to be your Management Site 

Server, then click Next.
8b To start the auto-discovery process, select Start the autodiscovery process. 
8c To start the back-end services, select Start the backend services on the server. 
8d To copy the ConsoleOne snap-ins, select Copy ConsoleOne snap-ins to the Management 

Site Server.
9 If you selected to upgrade only the Site Server, skip to Step 11.

10 If you selected to upgrade Server Management or the LANalyzer Agent in Step 8, complete the 
following:
10a Select the NetWare servers and the agents to upgrade on each server, then click Next.
10b Select the Windows 2000/2003 servers and the agents to upgrade on each server, then 

click Next. 
11 Review the summary list of selections you made in the preceding steps.

To change a setting, click Back.
12 Click Finish to upgrade Management and Monitoring Services to ZENworks 7 Server 

Management with SP1.
13 If you chose not to start all of the back-end services and the autodiscovery process during the 

upgrade, manually start the back-end services and the autodiscovery process now. 
For Managed servers on NetWare, the ZENworks agents are automatically started. For 
Managed servers on Windows 2000/2003, you must manually start the SNMP service after you 
upgrade the agents.

When you upgrade Management and Monitoring Services from ZENworks for Servers 3.0.2 or 
ZENworks 6.5 Server Management to ZENworks 7 Server Management with SP1, new MIBs are 
added to the \MIBPool directory. However, the migrated Management and Monitoring Services 
database will not contain the newly added MIBs. For the database to contain these MIBs, you must 
manually compile them. The console user can select MIB files from the \MIBPool directory for 
placement in the \MIBServerPool directory. The MIB Compiler compiles the files listed in the 
\MIBPool directory into the \MIBServerPool directory.

15.4  Migrating Alarm Dispositions from Earlier 
Version Database to ZENworks 7 with SP1 Alarm 
Management Rules
You can use the mmsdbmigrate command that is available on the Site Server to migrate the Alarms 
and Alarm Dispositions from an earlier database to the upgraded database or empty database. After 
you have completed installing or upgrading ZENworks 7 Server Management with SP1, you must 
run this tool to automatically convert the dispositions to rules and optionally migrate alarms (in case 
of an empty database) to the current database.

IMPORTANT: Make sure that Management and Monitoring Services is upgraded to ZENworks 7 
Server Management with SP1 and it is run at least one time before you migrate.
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The following steps describe the process of migrating existing dispositions to rules on an upgraded 
database:

1 If the Management and Monitoring Services is running on the Site Server, stop all components 
and close the Management and Monitoring Services database.
To stop the Management and Monitoring Services components, enter the following command 
on NetWare server console:
stopmms -n

2 If you have not made a backup copy of the database, make a copy of the \db directory as 
\olddb.

3 Start the database by entering the following command on the NetWare server console:
mgmtdbs

4 Edit the line sys:\zenworks\mms\olddb\mw.db as contained in 
mms_installed_directory\mwserver\bin\mmsdbmigrate.ncf to be the absolute path of 
mw.db in your environment.

5 Run the following command from the command line:
mmsdbmigrate ALARMDISP

You can see the progress of Alarm Disposition migration in a new screen.
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16ManageWise 2.7

This section provides you information on how to upgrade ManageWise® 2.7 to Novell® 
ZENWorks® 7 Server Management with Support Pack 1 (SP1) Management and Monitoring 
Services.

Section 16.1, “Overview of ManageWise 2.7 and ZENworks 7 with SP1 Management and 
Monitoring Services Components,” on page 259
Section 16.2, “Upgrading from ManageWise 2.7,” on page 260
Section 16.3, “Upgrading ManageWise 2.7 in Phases,” on page 261

16.1  Overview of ManageWise 2.7 and ZENworks 
7 with SP1 Management and Monitoring Services 
Components
Before you upgrade ManageWise 2.7 to ZENworks 7 with SP1, you should understand the 
differences in the components of ManageWise 2.7 and ZENworks 7 with SP1 Management and 
Monitoring Services to help you better plan your upgrade from ManageWise 2.7. This section gives 
you information on the following components:

Section 16.1.1, “ManageWise 2.7 Components,” on page 259
Section 16.1.2, “ZENworks 7 with SP1 Management and Monitoring Services Components,” 
on page 259

16.1.1  ManageWise 2.7 Components
The architecture of ManageWise 2.7 includes the following components:

ManageWise console: The ManageWise 2.7 console is a graphical interface that runs on a 
Windows* 95, Windows 98 or Windows NT* 4.x workstation. It provides services for 
managing networking resources, servers, routers, and workstations.
ManageWise server: The ManageWise 2.7 server contains the NetWare® Loadable ModuleTM 
(NLMTM) to run discovery.
Server Management agents: The agents run on the NetWare and Windows NT servers.
Traffic Analysis agents: The agents run on NetWare servers.

16.1.2  ZENworks 7 with SP1 Management and Monitoring 
Services Components
The architecture of ZENworks 7 with SP1 includes the following components:

Management Site Server: The server contains all of the discovery NLM software and also the 
other components like Alarm Manager, MIB Tools, Atlas Manager, and Remote Ping. Some of 
these components are also found in the ManageWise 2.7 console.
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ZfS console: ZENworks 7 with SP1 uses Novell ConsoleOne® as the GUI where you can 
manage all of your network resources.
Server Management Agent: The agents run on NetWare, Windows 2000/2003, and Linux 
servers.
Traffic Analysis Agent: In ZENworks 7 with SP1, Traffic Analysis Agents run on both 
NetWare and Windows 2000/2003 servers.

16.2  Upgrading from ManageWise 2.7
Because the components of ManageWise 2.7 and ZENworks 7 with SP1 are different, this section 
provides you information on how each of the components of ManageWise 2.7 are upgraded to 
components of ZENworks 7 with SP1.

This section contains the following information:

Section 16.2.1, “Upgrading the ManageWise 2.7 Server to a ZENworks 7 with SP1 Site 
Server,” on page 260
Section 16.2.2, “Upgrading the ManageWise 2.7 Console to the ZENworks 7 with SP1 
Console,” on page 260
Section 16.2.3, “Upgrading ManageWise 2.7 Server Management Agents,” on page 260
Section 16.2.4, “Upgrading ManageWise 2.7 Traffic Analysis Agents,” on page 261

16.2.1  Upgrading the ManageWise 2.7 Server to a ZENworks 7 
with SP1 Site Server
If the server meets the installation requirements for the ZENworks 7 with SP1 Site Server, then you 
can install the ZENworks 7 with SP1 Site Server on the ManageWise 2.7 server. The ZENworks 7 
with SP1 Site Server contains all of the discovery NLM software and other components, such as the 
Alarm Manager, Atlas Manager, and MIB Tools. After you upgrade to the ZENworks 7 with SP1 
Site Server, you cannot to use the data on the ManageWise server or the data on the ManageWise 
console with the ZENworks 7 with SP1 Site Server, and you cannot access the data on the 
ManageWise server or ManageWise console from the ZENworks 7 with SP1 Site Server. You must 
run discovery again and reconfigure your Site Server.

16.2.2  Upgrading the ManageWise 2.7 Console to the 
ZENworks 7 with SP1 Console
To upgrade the ManageWise 2.7 console, you must install the ConsoleOne snap-ins for 
ZENworks 7.

16.2.3  Upgrading ManageWise 2.7 Server Management Agents
You can upgrade the ManageWise 2.7 server management agents by installing the ZENworks 7 with 
SP1 server management agents if the server where you want to install the ZENworks 7 with SP1 
agents meets the installation requirements.
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16.2.4  Upgrading ManageWise 2.7 Traffic Analysis Agents
The Traffic Analysis Agents for ZENworks 7 with SP1 run on both NetWare and Windows 2000/
2003 servers. To upgrade, you can install the ZENworks 7 with SP1 Traffic Analysis Agents if the 
server where you want to install the ZENworks 7 with SP1 agents meets the installation 
requirements.

If you have old trend data from the ManageWise 2.7 Traffic Analysis Agents, then you need to 
migrate the data for ZENworks 7 with SP1 Traffic Analysis Agents to use them. For more 
information, see “Migrating Trend Files” in the Novell ZENworks 7 Server Management 
Administration Guide.

16.3  Upgrading ManageWise 2.7 in Phases
You can choose to install ZENworks 7 with SP1 in phases and continue to retain the ManageWise 
2.7 setup to manage your network. Install ZENworks 7 with SP1 on a server other than the 
ManageWise server. The ManageWise server and the ZENworks 7 with SP1 Site Server can exist on 
the same network but cannot exist on the same machine. After you have installed the ZENworks 7 
with SP1 Site Server, you need to run discovery and configure your network.

The ZENworks 7 with SP1 Site Server can work with the existing ManageWise agents. You can 
upgrade the agents in the later phases. However, you need to manually add the IP address of the 
ZENworks 7 with SP1 Site Server in the traptarg.cfg file in the sys:\etc directory. For more 
information, see “Editing the traptarg.cfg File Manually (Management Agent for NetWare Only)” in 
the Novell ZENworks 7 Server Management Administration Guide.

If you have installed the ManageWise server management agents on a Windows 2000/2003 server, 
you cannot install the ZENworks 7 with SP1 agents. You have to uninstall the ManageWise agents 
before you install the ZENworks 7 with SP1 agents.

The ZENworks 7 with SP1 management console (ConsoleOne) and the ManageWise console can 
coexist on the same workstation, if the installation requirements for ConsoleOne are met. For more 
information, see Chapter 3, “Prerequisites,” on page 33.
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VInteroperability

Interoperability is defined as two or more products that interact one with another in the same 
network environment (for example, the same tree, the same server, and so on).

Novell® ZENworks® 7 Desktop Management and ZENworks 7 Server Management, when installed 
to the same network, lets you centrally manage and distribute software, files, and applications, 
monitor the network’s usage and health, and enforce network policies. However, when upgraded or 
installed together, Desktop Management and Server Management can have interoperability issues 
with each other and with their previous versions.

The following sections explain the interoperability issues in ZENworks 7:

Chapter 17, “Interoperability in Policy and Distributions Services,” on page 265
Chapter 18, “Interoperability in Inventory,” on page 267
Chapter 19, “Interoperability in Remote Management,” on page 279
Chapter 20, “Interoperability with Other Products,” on page 281
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17Interoperability in Policy and 
Distributions Services

Review the following sections to understand Policy and Distribution Services interoperability 
between Novell® ZENworks® 7 Server Management and previous versions of ZENworks for 
Servers:

Section 17.1, “Version Interoperability,” on page 265
Section 17.2, “New Features Not Recognized,” on page 266
Section 17.3, “Issues When Both Installing and Upgrading,” on page 266

17.1  Version Interoperability
The following sections explain interoperability between ZENworks 7 Server Management and 
previous versions of ZENworks for Servers with respect to the software versions:

Section 17.1.1, “Interoperability with ZENworks for Servers 2,” on page 265
Section 17.1.2, “Interoperability with ZENworks for Servers 3.x,” on page 265
Section 17.1.3, “Tree Issues for Desktop Application Distributions,” on page 266

17.1.1  Interoperability with ZENworks for Servers 2
You cannot have interoperability between ZENworks for Servers 2 servers and ZENworks 7 Server 
Management servers, because directly upgrading between these versions is not supported. However, 
ZENworks for Servers 2 and ZENworks 7 Server Management can coexist in the same network, but 
not be running on the same server.

Schema extensions are additive, so version 7 schema extensions are ignored by ZENworks for 
Servers 2 components, and ZENworks 7 Server Management ignore version 2 schema extensions 
that it no longer uses.

17.1.2  Interoperability with ZENworks for Servers 3.x
You can have distribution and policy interoperability between ZENworks for Servers 3.0.2 Interim 
Release 1 servers and ZENworks 7 Server Management servers. This means that if you want 
ZENworks 7 Server Management and ZENworks for Servers 3.x to work together, all ZENworks for 
Servers 3.x servers must be updated to version 3.0.2 Interim Release 1 before you can begin an 
incremental upgrade. For instructions, see TID 2968433 in the Novell Support Knowledgebase 
(http://support.novell.com/search/kb_index.jsp).

A single server cannot concurrently run ZENworks for Servers 3.x and ZENworks 7 Server 
Management software. For example, you cannot have a ZENworks 7 Server Management 
Distributor and a ZENworks for Servers 3.x Subscriber running on the same server.
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17.1.3  Tree Issues for Desktop Application Distributions
ZENworks for Servers 3.x Desktop Application Distributions cannot be sent from ZENworks 7 or 
later Distributors to ZENworks for Servers 3.x Subscribers if you are using Novell Application 
LauncherTM folders. This breaks the foldering in the tree because of the newer schema extensions in 
ZENworks 7.

To prevent this, after you upgrade your 3.x Subscribers to version 7, you must re-baseline the 
Desktop Application Distributions to prevent corruption of the Novell Application LauncherTM 
folders on the Subscriber servers.

17.2  New Features Not Recognized
Features new in ZENworks 7 Server Management are simply ignored by ZENworks for 
Servers 3.0.2 Interim Release 1 Subscribers that receive version 7 Distributions. For example:

Dir Sync Granularity
Pre and Post Execution Actions in Distributions
MSI Distributions

However, the new Prohibited File policy can be sent from a version 7 Distributor and extracted and 
enforced on a version 3.0.2 Interim Release 1 Subscriber.

17.3  Issues When Both Installing and Upgrading
If you are upgrading your ZENworks for Servers 3.x servers and also have new servers where 
ZENworks for Servers has not yet been installed, you must do the following to prevent 
interoperability problems:

1. Do each of the following in any order:
Install ZENworks 7 Server Management to any new Distributor servers
Upgrade all ZENworks for Servers 3.x Distributor servers to ZENworks 7

Installing the new Distributors first might be easier.
2. Do each of the following in any order:

Upgrade the existing ZENworks for Servers 3.x Subscribers to version 7
Install ZENworks 7 Server Management to the new Subscriber servers

It doesn’t matter whether Subscriber servers are installed or upgraded first. However, to 
complete upgrading servers where Novell ConsoleOne® is installed on a server, you must use 
the installation program (the upgrade program does not update the ConsoleOne snap-ins). 
Therefore, you could upgrade first, then update the ConsoleOne snap-ins on those existing 3.x 
servers while installing to the new Subscriber servers.

These two steps ensure that all Distributors and Subscribers are interoperable.
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18Interoperability in Inventory

If you are planning to run the Server Inventory component of Novell® ZENworks® 7 Server 
Management in the same environment as the Workstation Inventory component of ZENworks 7 
Desktop Management, you must first understand and plan for the compatibility issues described in 
this section before upgrading or installing these products.

The following prerequisites are especially applicable to Inventory interoperability:

Follow a top-down deployment approach to upgrade the Inventory servers in the Inventory tree. 
Always begin at the topmost level server (Root Server) and proceed with the next lower-level 
servers.
ZENworks 7 Desktop Management and ZENworks 7 Server Management can use the same 
Inventory database (Sybase, Oracle, or MS SQL). If you have installed the Inventory database 
as a part of the ZENworks 7 Server Management installation, you do not need to install an 
Inventory database as a part of the ZENworks 7 Desktop Management installation, or vice 
versa.
To administer Server Inventory and Workstation Inventory, you must install the Novell 
ConsoleOne® Inventory snap-ins for both ZENworks 7 Server Management and ZENworks 7 
Desktop Management. 
If an Inventory server receives Server Inventory scans either directly from inventoried servers 
or through roll-up, you must install ZENworks 7 Server Management on this server.
If an Inventory server should receive Workstation Inventory scans either directly from 
inventoried workstations or through roll-up, you must install ZENworks 7 Desktop 
Management on this server.
The following objects and policies apply to Inventory in both ZENworks 7 Server Management 
and ZENworks 7 Desktop Management:

Database object
Inventory Service object
Dictionary Update policy
Roll-Up policy
ZENworks Database policy

You should make sure that each of the above requirements are met in order to ensure Inventory 
interoperability.

To set up Inventory interoperability, review the following sections:

Section 18.1, “Interoperability Between ZENworks Server Management and ZENworks 
Desktop Management,” on page 268
Section 18.2, “Interoperability Between ZENworks 7 Server Management and Earlier Versions 
of ZENworks Server Management Installed on Multiple Servers,” on page 274
Section 18.3, “Interoperability Between ZENworks 7 and the Earlier ZENworks Versions,” on 
page 275
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18.1  Interoperability Between ZENworks Server 
Management and ZENworks Desktop 
Management

Section 18.1.1, “Interoperability Between ZENworks Server Management and ZENworks 
Desktop Management Installed on the Same Server,” on page 268
Section 18.1.2, “Interoperability Between ZENworks Server Management and ZENworks 
Desktop Management Installed on Multiple Servers,” on page 268

18.1.1  Interoperability Between ZENworks Server Management 
and ZENworks Desktop Management Installed on the Same 
Server
On the same server, the Server Inventory component of ZENworks 7 Server Management is 
interoperable only with the Workstation Inventory component of ZENworks 7 Desktop 
Management, and vice versa.

You must install ZENworks 7 Server Management on the same file system location where you 
install ZENworks 7 Desktop Management, and vice versa.

18.1.2  Interoperability Between ZENworks Server Management 
and ZENworks Desktop Management Installed on Multiple 
Servers 
This section includes installation scenarios that demonstrate interoperability between ZENworks 7 
Server Management and ZENworks 7 Desktop Management when these two capabilities are 
installed on different servers in the same network. 

“Scenario 1: Installing Desktop Management in a Server Management Environment” on 
page 268
“Scenario 2: Installing Server Management in a Desktop Management Environment” on 
page 270
“Scenario 3: Rolling Up Inventory Across Trees” on page 271

Scenario 1: Installing Desktop Management in a Server Management Environment

In this scenario, all of the Inventory servers in your Inventory tree have only ZENworks 7 Server 
Management installed. This scenario is depicted in Figure 18-1:
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Figure 18-1   Scenario 1: Leaf Server Roll-up to Management Root Server

You can install ZENworks 7 Desktop Management on ZENworks 7 Server Management using either 
of two methods:

Method 1: Install ZENworks 7 Desktop Management on all ZENworks 7 Server Management 
Inventory servers in a top-down installation method. Always begin the installation at the 
topmost level Inventory server and proceed with the next lower-level Inventory servers. In the 
sample scenario, install ZENworks 7 Desktop Management first on the Root Server and then on 
the Leaf Servers. (For more information, see the Novell ZENworks 7 Desktop Management 
Installation Guide.) This scenario is depicted in Figure 18-2:

Figure 18-2   Scenario 1, Method 1 for Leaf Server Roll-up to Management Root Server

Method 2: Perform the following tasks in the order listed:
1. Install ZENworks 7 Desktop Management on the Root Server. For more information, see 

see the Novell ZENworks 7 Desktop Management Installation Guide.
2. Add another Leaf Server with ZENworks 7 Desktop Management installed, and configure 

it to roll up to the Root Server. For more information, see the Novell ZENworks 7 Desktop 
Management Installation Guide.

The ZENworks 7 Server Management Leaf Servers receive the .str files from the inventoried 
servers attached to it and the ZENworks 7 Desktop Management Leaf Servers receive the .str 
files from the inventoried workstations attached to them. The ZENworks 7 Server Management 
and the ZENworks 7 Desktop Management Leaf Servers roll up the inventory information to 
the Root Server. This scenario is depicted in Figure 18-3:
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Figure 18-3   Scenario 1, Method 2 for Leaf Server Roll-up to Management Root Server

Scenario 2: Installing Server Management in a Desktop Management Environment

In this scenario, all of the Inventory servers in your Inventory tree have only ZENworks 7 Desktop 
Management installed. This scenario is depicted in Figure 18-4:

Figure 18-4   Scenario 2: Leaf Server Roll-up to Management Root Server

You can install ZENworks 7 Server Management on ZENworks 7 Desktop Management using either 
of two methods:

Method 1: Install ZENworks 7 Server Management on all of the ZENworks 7 Desktop 
Management Inventory servers in a top-down installation method. Always begin the 
installation at the topmost-level Inventory server and proceed with the next lower-level 
Inventory servers. In the sample scenario, install ZENworks 7 Server Management first on the 
Root Server and then on the Leaf Servers. (To install ZENworks 7 Server Management, see 
Chapter 6, “Policy-Enabled Server Management Installation,” on page 65.)

This scenario is depicted in Figure 18-5:
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Figure 18-5   Scenario 2, Method 1 for Leaf Server Roll-up to Management Root Server

Method 2: Perform the following tasks in the order listed:
1. Install ZENworks 7 Server Management on the Root server. To install ZENworks 7 Server 

Management, see Chapter 6, “Policy-Enabled Server Management Installation,” on 
page 65.

2. Add another Leaf Server with ZENworks 7 Server Management installed, and configure 
the Leaf Server to roll up to the Root Server. To install ZENworks 7 Server Management, 
see Chapter 6, “Policy-Enabled Server Management Installation,” on page 65.

The ZENworks 7 Server Management Leaf Server receives the .str files from the inventoried 
servers attached to it and the ZENworks 7 Desktop Management Leaf Servers receives the 
.str files from the inventoried workstations attached to them. The ZENworks 7 Server 
Management and the ZENworks 7 Desktop Management Leaf Servers roll up the inventory 
information to the Root Server. This scenario is depicted in Figure 18-6:

Figure 18-6   Scenario 2, Method 2 for Leaf Server Roll-up to Management Root Server

Scenario 3: Rolling Up Inventory Across Trees

In this scenario, there are two eDirectory trees: T1 and T2. ZENworks 7 Server Management is 
installed on T1 and ZENworks 7 Desktop Management is installed on T2. The Inventory trees in T1 
and T2 must be merged to have one Root Server to receive both server and workstation inventory 
information. This scenario is illustrated in Figure 18-7:
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Figure 18-7   Scenario 3: Rolling Up Inventory Accross Trees

T1 and T2 can be merged using either of two methods:

“Merge Method 1” on page 272
“Merge Method 2” on page 273

Merge Method 1

You can use the following general steps to merge the inventory data in T2 with the inventory data in 
T1:

1. Install ZENworks 7 Desktop Management on Root Server in T1. For more information, see see 
the Novell ZENworks 7 Desktop Management Installation Guide.

2. Change the role of the Root Server in T2 to Intermediate Server with Database and configure it 
to roll up to the Root Server in T1. For more information, see “Changing the Role of the 
Inventory Server” in the Novell ZENworks 7 Desktop Management Installation Guide.

This scenario is illustrated in Figure 18-8:
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Figure 18-8   Scenario 3, Method 1 for Rolling Up Inventory Accross Trees

Merge Method 2

You can use the following general steps to merge the inventory data in T1 with the inventory data in 
T2:

1. Install ZENworks 7 Server Management on Root Server in T2. For more information, see 
Chapter 6, “Policy-Enabled Server Management Installation,” on page 65.

2. Change the role of the Root Server in T1 to Intermediate Server with Database and configure it 
to roll up to the Root Server in T2. For more information, see “Changing the Role of the 
Inventory Server” in the Novell ZENworks 7 Server Management Administration Guide.

This is illustrated in Figure 18-9:

Figure 18-9   Scenario 3, Method 2 for Rolling Up Inventory Accross Trees
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18.2  Interoperability Between ZENworks 7 Server 
Management and Earlier Versions of ZENworks 
Server Management Installed on Multiple Servers 

In this scenario, there are two Leaf Servers with ZENworks for Servers 3.0.2 and ZENworks 6.5 
Server Management installed respectively. The Leaf Servers roll up the inventory information to the 
Root Server with ZENworks 6.5 Server Management installed. This scenario is depicted in Figure 
18-10:

Figure 18-10   Leaf Server Roll-up to Management Root Server in Older ZENworks Versions

To achieve interoperability among ZENworks 7 Server Management, ZENworks 6.5 Server 
Management, and ZENworks for Servers 3.0.2, you must upgrade the Root Server to ZENworks 7 
Server Management. (For more information about upgrading to ZENworks 7 Server Management, 
see Chapter 13, “Server Inventory,” on page 227.) This is illustrated in Figure 18-11:

Figure 18-11   Leaf Server Roll-up to Management Root Server in Older ZENworks Versions Adjusted for 
ZENworks 7
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18.3  Interoperability Between ZENworks 7 and 
the Earlier ZENworks Versions

Section 18.3.1, “Interoperability Between ZENworks 7 and Earlier ZENworks Versions 
Installed on a Single Server,” on page 275
Section 18.3.2, “Interoperability Among ZENworks 7 and Earlier ZENworks Versions 
Installed on Multiple Servers,” on page 276

18.3.1  Interoperability Between ZENworks 7 and Earlier 
ZENworks Versions Installed on a Single Server
The following ZENworks versions or combinations of ZENworks versions might exist on a 
particular server where you want Inventory for both ZENworks 7 Server Management and 
ZENworks 7 Desktop Management to be running on the same server:

ZENworks for Desktops 4.0.1
ZENworks for Desktops 4.0 SP1b
ZENworks for Servers 3.0.2
ZENworks for Servers 3.0 SP2
ZENworks for Desktops 4.0.1 and ZENworks for Servers 3.0.2
ZENworks for Desktops 4.0.1 and ZENworks for Servers 3.0 SP2
ZENworks for Desktops 4.0 SP1b and ZENworks for Servers 3.0.2
ZENworks for Desktops 4.0 SP1b and ZENworks for Servers 3.0 SP2
ZENworks 6.5 Server Management
ZENworks 6.5 Server Management SP1
ZENworks 6.5 Desktop Management
ZENworks 6.5 Desktop Management SP1
ZENworks 6.5 Server Management and ZENworks 6.5 Desktop Management
ZENworks 6.5 Server Management SP1 and ZENworks 6.5 Desktop Management SP1

You can first upgrade or install either ZENworks 7 Server Management or ZENworks 7 Desktop 
Management, then later upgrade or install the other. Then Inventory is interoperable between 
ZENworks 7 Server Management and ZENworks 7 Desktop Management.

For more information about:

Installing ZENworks 7 Desktop Management, see the Novell ZENworks 7 Desktop 
Management Installation Guide.
Upgrading to ZENworks 7 Desktop Management , see “Upgrade” in the Novell ZENworks 7 
Desktop Management Installation Guide.
Installing ZENworks 7 Server Management, see Chapter 6, “Policy-Enabled Server 
Management Installation,” on page 65.
Upgrading to ZENworks 7 Server Management, see Part IV, “Upgrade,” on page 139.
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18.3.2  Interoperability Among ZENworks 7 and Earlier 
ZENworks Versions Installed on Multiple Servers
In this scenario, there are five Leaf Servers namely, A, B, C, D, and E on which the following 
versions of ZENworks are installed:

Table 18-1   ZENworks Versions for Leaf Servers

The Leaf Servers roll up the inventory information to a Root Server having ZENworks 6.5 Desktop 
Management and ZENworks 6.5 Server Management installed. This scenario is depicted in Figure 
18-12:

Figure 18-12   Interoperability Between ZENworks 6.5 Desktop and Server Management and Older ZENworks 
Versions

To achieve interoperability among ZENworks 7 Server Management, ZENworks Desktop 7 
Management, and the earlier versions of ZENworks installed on multiple Inventory servers, you 
must install ZENworks 7 Desktop Management and ZENworks 7 Server Management on the Root 
Server.

This is illustrated in Figure 18-13:

Leaf Server Installed ZENworks Version

Leaf Server A ZENworks 6.5 Desktop Management and ZENworks 6.5 Server Management
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Figure 18-13   Interoperability Between ZENworks 7 Desktop and Server Management and Older ZENworks 
Versions

For more information about installing ZENworks 7 Desktop Management, see the Novell ZENworks 
7 Desktop Management Installation Guide. For more information about installing ZENworks 7 
Server Management, see Chapter 6, “Policy-Enabled Server Management Installation,” on page 65.

Root Server
(ZENworks 7 Desktop Management)

+
(ZENworks 7 Server Management)

Inventory
Database

Leaf Server A
(ZENworks 6.5 Desktop Management)

+
(ZENworks 6.5 Server Management)

Leaf Server B
(ZENworks 6.5 Server Management)

Leaf Server C
(ZENworks 6.5 Desktop Management)

Leaf Server D
(ZENworks for Servers 3.0.2)

Leaf Server E
(ZENworks for Desktops 4.0.1)
Interoperability in Inventory 277



278 Novell

novdocx (en)  16 A
pril 2010
 ZENworks 7 Server Management Installation Guide



19
novdocx (en)  16 A

pril 2010
19Interoperability in Remote 
Management

Remote Management has interoperability between Novell® ZENworks® 7 Server Management and 
ZENworks for Desktops 4.x or ZENworks for Servers 3.x as follows:

The Remote Management console of ZENworks 7 Server Management is interoperable with 
the ZENworks for Servers 3.x Remote Management Agent only
The Remote Management console of ZENworks 7 Server Management is interoperable with 
ZENworks for Desktops 4.x Remote Management Agent in the password mode of 
authentication only, and you can perform Remote Control and Remote View operations
Use the Remote Management console of ZENworks 7 Desktop Management to control 
ZENworks for Desktops 4.x, ZENworks 7 Desktop Management workstations, and ZENworks 
7 Server Management servers
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20Interoperability with Other 
Products

Section 20.1, “Remote Management,” on page 281
Section 20.2, “Novell Clustering Services,” on page 281
Section 20.3, “Nterprise Branch Office,” on page 281

20.1  Remote Management
If you choose to install Mirror Driver on a Windows 2000/2003 server when installing the Remote 
Management component of Novell® ZENworks® 7 Server Management, it can coexist with other 
vendor products offering remote management functionality.

This enables you to use other vendor products offering remote management functionality in the 
same environment with the Remote Management component of ZENworks 7 Server Management.

20.2  Novell Clustering Services
ZENworks Server Management can be installed in an existing Novell Clustering Services 
environment. For more information, see Appendix F, “ZENworks Server Management in a 
Clustered Environment,” on page 343.

Clustering is not supported for Remote Management in ZENworks 7 Server Management.

20.3  Nterprise Branch Office
In ZENworks 7 Server Management, interoperability between Policy and Distribution Services and 
Nterprise Branch OfficeTM 2.0 is not supported, except for ZENworks for Servers 3.0.2 Subscribers 
where Interim Release 1 is applied. Then, a ZENworks 7 Server Management Distributor can send 
version 7 Distributions to ZENworks for Servers 3.0.2 Interim Release 1 Subscribers.

For information on obtaining and installing Interim Release 1, see TID 2968433 in the Novell 
Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).

For information on Nterprise Branch Office, see “Integrating Nterprise Branch Office with 
ZENworks Tiered Electronic Distribution” (http://www.novell.com/documentation/lg/nbo2/
index.html?page=/documentation/lg/nbo2/setupguide/data/aigi61a.html) in the Novell Nterprise 
Branch Office Setup Guide.
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VIUninstallation

The following sections explain how to uninstall the Novell® ZENworks® 7 Server Management 
software.

Chapter 21, “Uninstalling Policy and Distribution Services,” on page 285
Chapter 22, “Uninstalling Server Inventory,” on page 293
Chapter 23, “Uninstalling Remote Management,” on page 303
Chapter 24, “Uninstalling Management and Monitoring Services,” on page 307
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21Uninstalling Policy and 
Distribution Services

The Policy and Distribution Services component in Novell® ZENworks® 7 Server Management 
cannot be uninstalled automatically. You must manually remove the ZENworks Server Management 
software, its Novell eDirectoryTM objects, and the Novell ConsoleOne® files.

You need to remove objects, files, and information on every server and workstation where 
ZENworks Server Management components are installed.

To manually uninstall ZENworks Server Management, proceed in the following order:

1. Section 21.1, “Uninstalling the eDirectory Objects,” on page 285
2. Section 21.2, “Uninstalling the Software on NetWare Servers,” on page 286
3. Section 21.3, “Uninstalling the Software on Windows Servers,” on page 287
4. Section 21.4, “Uninstalling the Software on Linux and Solaris Servers,” on page 289
5. Section 21.5, “Uninstalling the Snap-Ins from ConsoleOne,” on page 289
6. Section 21.6, “Uninstalling the Web Components,” on page 291

21.1  Uninstalling the eDirectory Objects
Removing ZENworks eDirectory objects is optional.

If you do not want to remove the eDirectory objects, follow only the steps to gather information 
concerning working directory locations. You need that information to delete the software.

To remove the ZENworks eDirectory objects and gather information:

1 In ConsoleOne, right-click the Service Location Package, then click Properties.
2 If the Tiered Electronic Distribution policy is enabled, select the policy, click Properties, then 

write down the locations and names of any default log files and working directories that have 
been specified.

3 In ConsoleOne, locate a container holding Tiered Electronic Distribution objects.
3a Write down the locations and names of the log files and working directories that are 

specified in the Tiered Electronic Distribution object properties.
3b Right-click a Tiered Electronic Distribution object, click Delete eDirectory object, then 

click Yes.
Do this for each of the following Tiered Electronic Distribution objects that exist:

Distributor
Distribution
Channel
Subscriber
External Subscriber
Subscriber Group
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4 Repeat Step 3 for all containers in the tree that have Tiered Electronic Distribution objects.
5 Locate a container holding ZENworks Server Management Policy Packages, then delete all 

policy package objects.
6 Repeat Step 5 for all containers in the tree that have policy package objects.
7 Click the plus sign for Server Software Packages so that all package components are visible.
8 Select a software package.

8a Write down the locations of the .spk and .cpk files.
8b Right-click one of its component objects, click Delete, then click Yes.
8c Repeat Step 8b for each component under the selected package.
8d Right-click the software package object, click Remove, then click Yes.

9 Repeat Step 8 for each software package.
10 If you want to remove the Server Management database, right-click the appropriate Database 

object, click Delete eDirectory object, then click Yes.
Make sure you have selected the correct Database object, because there could be other 
Database objects, such as for Server Inventory or Desktop Management.

11 Exit ConsoleOne.

21.2  Uninstalling the Software on NetWare 
Servers
To remove the ZENworks Server Management software files from NetWare® servers:

1 At a server console, unload all ZENworks Server Management Java processes (use EXIT at the 
ZENworks Server Management command line prompt).

2 At the Sybase prompt, type q to stop the database.
3 If you want to remove the Policy and Distribution database file (zfslog.db), delete the 

\database directory.

WARNING: Do not delete the \database directory if it is being used by ZENworks Desktop 
Management, Server Inventory, or Management and Monitoring Services.

4 Using a file manager, delete the \zenworks\pds directory.
This deletes the Distributor, Subscriber, and Server Policies software. It also deletes all 
working directories, including Distribution files, if you used the default working directory 
paths.

WARNING: Do not delete the \pds directory if the \database directory is located under it 
and the database is being used by ZENworks Desktop Management, Server Inventory, or 
Management and Monitoring Services. Instead, delete all of the other directories without 
deleting the \pds directory.

If you have used a different installation path than the default listed above, open the 
\system\zenworks.properties file to find where the \pds directory is located.

5 Delete the zfsversion.class and zfsversion.ncf files from the \zenworks directory.
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WARNING: Do not delete the \zenworks directory. It might be shared by other Novell 
software programs.

6 Delete the \zenworks.properties file from the \system directory.

WARNING: Do not delete the zenworks.properties file if ZENworks Desktop 
Management is installed. Server Management and Desktop Management share this file.

7 Delete the following:
All log files created by the Server Policies, Server Software Packages, and Tiered 
Electronic Distribution components
Any working directories that are created in another location besides the 
\zenworks\pds\ted directory
Any working directories that are created in another location besides the 
\zenworks\pds\smanager directory

This removes all working files, including Distributions. You should have previously gathered 
this information in Step 3a under Section 21.1, “Uninstalling the eDirectory Objects,” on 
page 285.

8 Clean up the NetWare registry:
8a At the NetWare server’s main console prompt, type:

regedit

8b Enter the following command:
cd software\novell\zenworks

8c Do one of the following:
If more Server Management components than Policy and Distribution Services are 
installed, or Desktop Management is also installed, enter:
rd zfs

del pdspath

del pdsdbpath

If only Policy and Distribution Services is installed, enter:
rd zenworks

9 Repeat Step 1 through Step 8 for each server where ZENworks Server Management is 
installed.

10 To remove .cpk and .spk files for the Server Software Packages, locate those files, then delete 
them.
You should have previously gathered this information in Step 8a under Section 21.1, 
“Uninstalling the eDirectory Objects,” on page 285.

21.3  Uninstalling the Software on Windows 
Servers
Toremove the ZENworks Server Management software files from Windows servers:

1 On a Windows NT/2000/2003 server, run REGEDIT, then search for the following key:
HKEY_LOCAL_MACHINE\Software\Novell\ZENworks
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and review the following entries to find the installation paths:

PDS Path
ZENworks Path
ZWS Path

2 Click Start > Run, then enter the following command:
zenworks\pds\bin\dservices.bat

This stops the ZENworks Server Management services and unregisters them. This must be 
done before you can delete ZENworks Server Management directories.

3 To stop the database, do the following on each applicable Windows 2000/2003 server:
3a Open the Control Panel.
3b Double-click Admin Tools > Services.
3c Right-click the Novell Sybase Database service, then click Stop.

4 Using a file manager, delete the following:
All log files created by the Server Policies, Server Software Packages, and Tiered 
Electronic Distribution components
Any working directories that are created in another location besides the 
\zenworks\pds\ted directory
Any working directories that are created in another location besides the 
\zenworks\pds\smanager directory

This removes all working files, including Distributions. You should have previously gathered 
this information in Step 3a under Section 21.1, “Uninstalling the eDirectory Objects,” on 
page 285.

5 If you want to remove the Policy and Distribution database file (zfslog.db), delete the 
\database directory.

WARNING: Do not delete the \database directory if it is being used by ZENworks Desktop 
Management, Server Inventory, or Management and Monitoring Services.

6 Delete the \zenworks\pds directory.
This deletes the Distributor, Subscriber, and Server Policies software.

WARNING: Do not delete the \pds directory if the database file is located there and Server 
Inventory, Management and Monitoring Services, or ZENworks Desktop Management is using 
it. Instead, delete all directories under \pds except the \database directory.
Do not delete the \zenworks directory. It might be shared by other Novell software programs.

7 Open the Windows registry, then under the following location delete the PDSPath and ZWSPath 
entries:
HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS

WARNING: Do not delete the ZWSPath entry if other components of ZENworks Server 
Management that you are not removing are using ZENworks Web Server.

8 Repeat Step 2 through Step 7 for each server where ZENworks Server Management is 
installed.
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9 To remove .cpk and .spk files for the Server Software Packages, locate those files, then delete 
them.
You should have previously gathered this information in Step 8a under Section 21.1, 
“Uninstalling the eDirectory Objects,” on page 285.

21.4  Uninstalling the Software on Linux and 
Solaris Servers
To remove the ZENworks Server Management software files from Linux or Solaris servers:

1 On the Linux or Solaris server, stop all Policy and Distribution Services daemons, as described 
in Appendix C, “Starting and Stopping Server Management Services,” on page 325.

2 To remove the ZFSTed package, enter:
On Linux, use:
rpm -e novell-zen-zfs

rpm -e novell-zen-zws

On Solaris, use:
pkgrm novell-zen-zfs

3 To manually delete the ZENworks executable, enter:
rm /etc/init.d/novell-zfs

4 To manually delete the /var/opt/novell/zenworks directory and any remaining content, 
enter:
rm -rf /var/opt/novell/zenworks

This removes all working files, including Distributions. You should have previously gathered 
this information in Step 3a under Section 21.1, “Uninstalling the eDirectory Objects,” on 
page 285.

5 To manually delete the /var/opt/novell/log/zenworks directory and any remaining log 
files, enter:
rm -rf /var/opt/novell/log/zenworks

6 Repeat Step 1 through Step 5 for each Linux or Solaris server where Policy and Distribution 
Services is installed.

7 To remove .cpk and .spk files for the Server Software Packages, locate those files, then delete 
them.
You should have previously gathered this information in Step 8a under Section 21.1, 
“Uninstalling the eDirectory Objects,” on page 285.

21.5  Uninstalling the Snap-Ins from ConsoleOne
You can delete the .jar files that provide the ConsoleOne snap-ins for ZENworks Server 
Management.

WARNING: Do not remove ConsoleOne itself if you are using it to manage other products.
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To remove only the ConsoleOne snap-ins for ZENworks Server Management:

1 Under the c:\novell\consoleone\1.2 directory on your workstation (your path could be 
different), delete the following files from their subdirectories (do not delete the subdirectories):

\lib\ted\*.jar

\lib\zen\*.jar

\resources\ted\cpkagentres.jar

\resources\ted\fileagentres.jar

\resources\ted\ftpagentres.jar

\resources\ted\httpagent.jar

\resources\ted\installwizardres.jar

\resources\ted\tedlibres.jar

\resources\ted\tedsnapinsres.jar

\resources\rwc\*.jar

\snapins\rwc\*.jar

\snapins\zen\zenpolicy.jar

\snapins\zen\zenreport.jar

\snapins\zen\zfssnap.jar

\snapins\ted\tedsnapins.jar

\snapins\ted\tednalagent.jar

2 Repeat Step 1 for each workstation where the ConsoleOne snap-ins are installed.
3 Under the sys:\public\mgmt\consoleone\1.2 directory on a server (your path could be 

different), delete the following files from their subdirectories (do not delete the subdirectories):

\lib\ted\*.jar

\lib\zen\*.jar

\resources\ted\cpkagentres.jar

\resources\ted\fileagentres.jar

\resources\ted\ftpagentres.jar

\resources\ted\httpagent.jar

\resources\ted\installwizardres.jar

\resources\ted\tedlibres.jar

\resources\ted\tedsnapinsres.jar

\resources\rwc\*.jar

\snapins\rwc\*.jar

\snapins\zen\zenpolicy.jar

\snapins\zen\zenreport.jar

\snapins\zen\zfssnap.jar

\snapins\ted\tedsnapins.jar

\snapins\ted\tednalagent.jar

These are the same files as for Step 1.
4 Repeat Step 3 for each server where the ConsoleOne snap-ins are installed.
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21.6  Uninstalling the Web Components
The Policy and Distribution Services Web components are integrated into the Tomcat Servlet 
Gateway. Follow the appropriate instructions:

Section 21.6.1, “iManager 2.0.2,” on page 291
Section 21.6.2, “iManager 2.5,” on page 291

21.6.1  iManager 2.0.2
To manually remove the integrated software from your Tomcat installation:

1 On the server where Tomcat is installed, stop Tomcat.
2 To remove the Policy and Distribution Services plug-ins for Novell iManagerTM, delete the 

following:
Directories:

\tomcat\4\webapps\nps\portal\modules\zfs

\tomcat\4\webapps\nps\portal\modules\zfsca

\tomcat\4\work\standalone\localhost\nps\portal\modules\zfs

Files:

\tomcat\4\temp\zfs*.npm

\tomcat\4\webapps\nps\packages\zfs*.npm

\tomcat\4\webapps\nps\portal\modules\dev\images\dir\zen*.gif

\tomcat\4\webapps\nps\portal\modules\rwc\skins\default\devices\defaul
t\AvailableZFSAgents.jsp

\tomcat\4\webapps\nps\portal\modules\rwc\skins\default\devices\defaul
t\zfs*.jsp

\tomcat\4\webapps\nps\web-inf\lib\zen*.jar

\tomcat\4\webapps\nps\web-inf\lib\zfsca.jar

3 Start Tomcat.
4 If you installed the Policy and Distribution Web components on multiple servers, repeat Step 1 

through Step 3 for each Tomcat installation.

21.6.2  iManager 2.5
To use the NPM management feature of iManager 2.5 to remove the Server Management plug-ins:

1 Log in to iManager.
2 Click the Configure view.
3 Click Module installation > Installed Novell plug-in modules.
4 Select the ZENworks plug-in modules to be removed.
5 Click Remove.
6 Restart Tomcat.
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22Uninstalling Server Inventory

The Server Inventory component of Novell® ZENworks® 7 Server Management cannot be 
uninstalled automatically. You must manually remove the Inventory server, the Inventory database 
running on Sybase, the Novell eDirectoryTM objects, and the Server Inventory snap-in files from 
Novell ConsoleOne®.

NOTE: If your Inventory database is mounted on Oracle or MS SQL, follow the uninstall procedure 
recommended by Oracle or MS SQL respectively.

To uninstall Server Inventory, you must remove the objects and the files from every server and 
workstation where the Server Inventory components are installed.

In an enterprise deployment of Inventory, uninstall all Leaf Servers first, then proceed to uninstall 
Intermediate Servers, and finally the Root Server. Before uninstalling Server Inventory, make sure 
you have archived a reliable backup of the Inventory database residing at the Root Server.

To manually uninstall Server Inventory, proceed in the following order:

1. Section 22.1, “Uninstalling the Server Inventory eDirectory Objects,” on page 293
2. Section 22.2, “Uninstalling the Database eDirectory Object,” on page 294
3. Section 22.3, “Uninstalling the Sybase Inventory Database,” on page 294
4. Section 22.4, “Uninstalling the Sybase Engine,” on page 295
5. Section 22.5, “Uninstalling the Inventory Agent,” on page 296
6. Section 22.6, “Uninstalling the Inventory Server Software,” on page 297
7. Section 22.7, “Uninstalling the XML Proxy Server,” on page 299
8. Section 22.8, “Uninstalling the Server Inventory Snap-Ins from ConsoleOne,” on page 300

22.1  Uninstalling the Server Inventory eDirectory 
Objects
To remove the ZENworks Server Management Server Inventory eDirectory objects:

1 To stop the Inventory services, on an Inventory server: 
NetWare: At the console prompt, enter StopSer *
Windows 2000/2003: In the Control Panel, double-click Administrative Tools, double-
click Services, right-click Novell Inventory Service, then click Stop

2 In ConsoleOne, right-click the Service Location Package object, click Properties, then click 
Policies.
If the ZENworks Database policy is enabled, select the policy, click Properties, click the 
Inventory Management tab, delete the specified Inventory database entry, then click OK.

IMPORTANT: If the ZENworks Database policy is used by more than one Inventory server, 
you must uninstall those Inventory servers before performing this step.
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3 To disable the Server Inventory policy:
3a Right-click the Distributed Server Package, click Properties, click Policies, then click the 

General (or NetWare or Windows) tab.
3b If the Server Inventory policy is enabled, select the policy, click the Reset button, then 

click Yes.
3c Disable the Server Inventory policy.

If you have configured the Server Inventory policy for more than one operating system, 
select the operating system option from the Policies tab and repeat this step.

3d Click Apply, then click Close.
4 To disable the Roll-Up policy and the Dictionary Update policy (if the policies are enabled):

4a Right-click the Server Package, click Properties, click Policies, then click the NetWare or 
Windows tab.

4b If the Roll-Up policy is enabled, select the policy, click the Reset button, then click Yes.
4c Disable the Roll-Up policy.
4d If the Dictionary Update policy is enabled, select the policy, click the Reset button, then 

click Yes.
4e Disable the Dictionary Update policy.
4f Click Apply, then click Close.

5 In ConsoleOne, locate the container holding the Inventory Service object and delete the object.

22.2  Uninstalling the Database eDirectory Object
In ConsoleOne, locate the container holding the Inventory database object and delete the object.

22.3  Uninstalling the Sybase Inventory Database
Section 22.3.1, “Uninstalling on NetWare Servers,” on page 294
Section 22.3.2, “Uninstalling on Windows Servers,” on page 295

22.3.1  Uninstalling on NetWare Servers
1 Stop Sybase by entering q at the Sybase console prompt.
2 Delete the path to mgmtdb.db from sys:\system\mgmtdbs.ncf.

Do not delete other database paths.
3 Note the value of the INVDBPATH key from sys:\system\zenworks.properties.
4 If you want to use the inventory information stored in the database files, make a reliable backup 

of the database files (mgmtdb*.db) that are located in the INVDBPATH key.
5 From the value identified in the INVDBPATH key, delete the Inventory database files 

(mgmtdb*.db), including mgmtdb.log. 
6 Delete the INVDBPATH key from sys:\system\zenworks.properties.
7 Delete the ZFS_INVENTORY_DATABASE_SERVER key.

Delete the following section from sys:\system\zenworks.properties:
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[ZfS_Inventory_Database_Server]

Version = 7.0. Server Management product build_date

Installed_From = Product CD

Support_Pack = 0

8 If Sybase is not uninstalled and if Sybase is used by other ZENworks products, to start Sybase, 
enter mgmtdbs.ncf at the Sybase console prompt.

22.3.2  Uninstalling on Windows Servers
1 Note the value of the DBENGINEPATH key from the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS registry entry.
2 To stop Sybase:

2a In the Windows Control Panel, double-click Administrative Tools, then double-click 
Services.

2b Right-click Novell Database - Sybase, then click Stop.
3 Delete the path to mgmtdb.db:

3a Run DBENGINE_installation_directory\ntdbconfig.exe.
3b In the NTDBConfig dialog box, remove the path to mgmtdb.db, then click OK.
3c If there are no other .db entries, remove the Sybase engine before proceeding to Step 4. 

For more information on how to remove the Sybase engine, see Section 22.4, 
“Uninstalling the Sybase Engine,” on page 295.

4 Note the value of the INVDBPATH key from the 
HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS registry entry.

5 If you want to use the inventory information stored in the database files, make a reliable backup 
of the database files (mgmtdb*.db) that are located in the INVDBPATH key.

6 From the value identified in the INVDBPATH key, delete the Inventory database files 
(mgmtdb*.db), including mgmtdb.log. 

7 Delete the INVDBPATH key from the HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS 
registry entry.

8 Delete the Inventory database server key from the 
HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZFS registry entry.

9 To start Sybase if it is not uninstalled and if it is used by other ZENworks products:
9a In the Windows Control Panel, double-click Administrative Tools, then double-click 

Services.
9b Right-click Novell Database - Sybase, then click Start.

22.4  Uninstalling the Sybase Engine
You can remove the Sybase engine only if it is not used by other ZENworks products.

Section 22.4.1, “Uninstalling on NetWare Servers,” on page 296
Section 22.4.2, “Uninstalling on Windows Servers,” on page 296
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22.4.1  Uninstalling on NetWare Servers
1 If Sybase is used by other ZENworks products, you must uninstall the database first before 

proceeding to uninstall the Sybase engine.
2 Stop Sybase by entering q at the Sybase Console prompt.
3 Note the value of the DBENGINEPATH key in sys:\system\zenworks.properties.
4 Verify whether the database is mounted on the database server by checking if the 

sys:\system\mgmtdbs.ncf file has a .db entry.
If the file contains a .db entry, do not continue to remove the Sybase engine, because it 
indicates that the database is mounted on the database server. Discontinue these steps.
If the file does not contain a .db entry, delete mgmtdbs.ncf and continue with Step 5.

5 Delete the mgmtdbs.ncf entry from sys:\system\autoexec.ncf.
6 Delete the directory specified in the DBENGINEPATH key.
7 Delete the DBENGINEPATH key from sys:\system\zenworks.properties.

22.4.2  Uninstalling on Windows Servers
1 If Sybase is used by other ZENworks products, you must uninstall the database first before 

proceeding to uninstall the Sybase engine.
2 To stop Sybase:

2a In the Windows Control Panel, double-click Administrative Tools, then double-click 
Services.

2b Right-click Novell Database - Sybase, then click Stop.
3 Note the value of the DBENGINEPATH key from the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS registry entry.
4 To verify whether the database has a .db entry, run 

DBENGINE_installaton_directory\ntdbconfig.exe.
If the file contains a .db entry, do not continue to remove the Sybase engine, it indicates 
that the database is mounted on the database server. Discontinue these steps.
If the file does not contain a .db entry, delete the ASANYS_ZENWORKS key from the 
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES registry entry and 
continue with Step 5.

5 Delete the directory specified in DBENGINEPATH.
6 Delete the DBENGINEPATH key from the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS registry entry.

22.5  Uninstalling the Inventory Agent
Section 22.5.1, “Uninstalling on NetWare Servers,” on page 296
Section 22.5.2, “Uninstalling on Windows Servers,” on page 297

22.5.1  Uninstalling on NetWare Servers
1 Execute the following commands at the server console prompt:
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invagentstop.ncf

java -exit

2 Delete the following files from sys:\system:

hwinvsrc.ini

invaid.nlm

invsetup.ini

mpkscan.nlm

nwapi.bak

nwapi.map

smile.bak

smile.map

suppl.bak

suppl.map

3 Delete sys:\java\bin\invnatve.nlm.
4 Note the value of the ZENWORKSPATH, PDSPATH and the INVAGENTPATH keys from 

sys:\system\zenworks.properties.
5 Delete the Inventory Agent installation directory identified in the INVAGENTPATH key.
6 Delete invagentnw.jar from the PDSPath\smanager\plugins directory.
7 In PDSPath\zfs.ncf, delete the following entry:

load sys:\\java\\bin\\invnatve

22.5.2  Uninstalling on Windows Servers
1 To stop the Inventory Agent service, in the Windows 2000/2003 server’s Control Panel, 

double-click Administrative Tools, double-click Services, right-click ZfS Policies, then click 
Stop.

2 Note the value of the INVAGENTPATH and the PDSPATH key in the 
HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS registry entry.
The INVAGENTPATH key contains the Inventory Agent installation directory and the PDSPATH 
contains the Policy and Distribution Services installation directory.

3 Delete the Inventory Agent installation directory identified in the INVAGENTPATH key.
4 Delete invagentnt.jar from the plug-ins directory, which is located in the directory 

identified in the PDSPATH key.
5 Delete the INVAGENTPATH key from the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS registry entry.
6 Delete the Inventory Agent key from the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZFS entry.

22.6  Uninstalling the Inventory Server Software
Section 22.6.1, “Uninstalling on NetWare Servers,” on page 298
Section 22.6.2, “Uninstalling on Windows Servers,” on page 299
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22.6.1  Uninstalling on NetWare Servers
1 Stop the Inventory Service Manager by entering StopSer * at the server console prompt
2 Unload the java.nlm by entering java -exit at the server console.
3 Note the values of the INVSRVPATH and ZWSPATH keys from 

sys:\system\zenworks.properties.
4 Delete the ZFS_INVENTORY_SERVER key.
5 Delete the following section from sys:\system\zenworks.properties:

[ZfS_Inventory_Server]
Version = 7.0.Server_Management_product_build_date
Installed_From = Product CD
Support_Pack = 0

6 Delete the invsrvpath\scandir directory.
7 Delete the invsrvpath\server directory.
8 Delete the following entries from sys:\system\autoexec.ncf:

; ZENworks Inventory Settings

StartInv.ncf

9 Delete the following files from sys:\system:

addenums.ncf

dbexport.ncf

debug.properties

dupremove.ncf 

enumsmodifier.ncf

invenv.ncf

invenvset.ncf

listser.ncf

startinv.ncf

startser.ncf

startzws.ncf

stopdb.ncf

stopser.ncf

10 If Policy and Distribution Services and the XML Proxy server are not installed on the Inventory 
server, remove the ZENworks Web Server components by deleting the directory specified by 
the ZWSPATH key:
10a Delete the following entries from sys:\system\autoexec.ncf:

; ZENworks Inventory Settings

ZFS.ncf

10b Delete the zwsstart.ncf file from the sys:\system directory.
10c Delete the ZWSPATH key from sys:\system\zenworks.properties.
10d Delete zws_volume:\zfs-startup.xml.
10e Delete zws_volume:\zenworks\zfs.ncf.

11 Delete the INVSRVPATH key from sys:\system\zenworks.properties.
 ZENworks 7 Server Management Installation Guide



novdocx (en)  16 A
pril 2010
22.6.2  Uninstalling on Windows Servers
1 To stop the Inventory Service on the Inventory server:

1a In the Windows Control Panel, double-click Administrative Tools, then double-click 
Services.

1b Right-click Novell Inventory Service, then click Stop.
1c Right-click Novell ZENworks Service Manager, then click Stop.

2 Note the values of the INVSRVPATH and ZWSPATH keys from the 
HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS registry entry.

3 Delete the invsrvpath\scandir directory.
4 Delete the invsrvpath\server directory.
5 Delete the ZENINVENTORY key from the 

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES registry entry.
6 Delete the Inventory Server key from the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZFS registry entry.
7 If Policy and Distribution Services and the XML Proxy server are not installed on the Inventory 

server, remove the ZENworks Web Server components:
7a Delete the \zwspath directory.
7b Delete the ZWSPATH key from the HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS 

registry entry.
7c Delete the ZWSSRV key from the 

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES registry entry.
8 Delete the INVSRVPATH key from the HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS 

registry entry.
9 Reboot the machine for the changes to take effect.

22.7  Uninstalling the XML Proxy Server
Section 22.7.1, “Uninstalling on NetWare Servers,” on page 299
Section 22.7.2, “Uninstalling on Windows Servers,” on page 300

22.7.1  Uninstalling on NetWare Servers
To uninstall the XML Proxy files from the server if Policy and Distribution Services or Inventory is 
not installed on the server:

1 Unload the java.nlm by entering java -killzfsexit at the server console prompt.
2 Note the value of the ZWSPATH from the sys:\system\zenworks.properties file.
3 Delete the following section from sys:\system\zenworks.properties:

[ZfS_XML_Proxy_Server]
Version=7.0.build_date
Installed_From = Product CD
Support_Pack = 0

4 Delete the following entries from sys:\system\autoexec.ncf:
; ZENworks Inventory Settings
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ZFS.ncf

5 Delete the zwsstart.ncf file from the sys:\system directory.
6 Delete the \zwspath directory and the ZWSPATH key entry from the 

sys:\system\zenworks.properties file.
7 Delete zfs-startup.xml and zfs.ncf from zws_volume:\zenworks.

22.7.2  Uninstalling on Windows Servers
To uninstall the XML Proxy files from the server if Policy and Distribution Services or Inventory is 
not installed on the server:

1 To stop the ZENworks Web Server:
1a In the Windows Control Panel, double-click Administrative Tools, then double-click 

Services.
1b Right-click Novell Zenworks Service Manager, then click Stop.

2 Note the value of the ZWSPATH key and the ZENworks Web Server volume from the 
HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS registry entry.
The value indicates the \zwspath directory.

3 Delete the \zwspath directory. 
4 Delete the Inventory Proxy XML server key from the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZFS registry entry.
5 Delete the ZWSSRV key from the 

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES registry entry.
6 Delete the ZWSPATH key from the HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS\ 

registry entry.
7 Delete zws_volume:\zenworks\zfs-startup.xml.

22.8  Uninstalling the Server Inventory Snap-Ins 
from ConsoleOne
Do not uninstall ConsoleOne itself if you are using it to manage other products.

To remove only the Server Inventory snap-ins from ConsoleOne:

1 Close ConsoleOne, if it is running.
If ConsoleOne is invoked directly from the Inventory server on multiple workstations, you 
must close ConsoleOne on each of these workstations.

2 Under the ConsoleOne_installation_directory\1.2 directory on your server or 
workstations (your path might be different), do the following:

Delete the following files (but not the directories):

bin\debug.properties

bin\directoryrights.dll

bin\ntgroups.ini

bin\userreports.ini

help\novellserverinv.hs
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lib\zen\classes12.zip

lib\zen\dbexport.jar

lib\zen\dbexportres.jar

lib\zen\jconn2.jar

lib\zen\jdbcdrv.zip

lib\zen\reportingimages.jar

lib\zen\smanager.jar

lib\zen\zenutility.jar

reporting\export\invxml.dtd

snapins\zen\dataexportsnapins.jar

snapins\zen\inventorysnapins.jar

snapins\zen\jgl3.1.0.jar

snapins\zen\policymigration.jar

snapins\zen\serversnapins.jar

snapins\zen\swdictionarysnapins.jar

snapins\zen\tableutilities.jar

snapins\zen\tracer.jar

Delete the following directories (but not the parent directories shown):

help\en\novell_zfs_server_inventory

reporting\canned\novell reporting\zeninventory

reporting\canned\novell reporting\zeninventory4x

3 If you have not installed the Remote Management ConsoleOne snap-ins on the same 
workstation or server, do the following:

Delete the following files (but not the directories):

\bin\desktop4.exe

\bin\desktop4.ini

\bin\mssql.ini

\bin\multprot.dll

\bin\ndsaccess.dll

\bin\oracle.ini

\bin\remagent.ini

\bin\sybase.ini

\lib\zen\commonsnapins.jar

\lib\zen\desktop.jar

\lib\zen\desktop3x.jar

\lib\zen\desktopcommonutility.jar

\lib\zen\desktoputil.jar

\lib\zen\statuslog.jar

\lib\zen\zeninvimages.jar

\snapins\zen\serversnapins.jar

Delete the \bin\zen\sybaseproxy directory.
4 Repeat Step 1 through Step 3 for each workstation or server where Inventory ConsoleOne 

snap-ins are installed.
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23Uninstalling Remote Management

The Remote Management component of Novell® ZENworks® 7 Server Management cannot be 
uninstalled automatically. You must manually remove the Remote Management Agent and the 
Remote Management server snap-ins from Novell ConsoleOne®.

To manually uninstall Remote Management, perform the following tasks:

Section 23.1, “Uninstalling the Remote Management Agent on Windows Managed Servers,” 
on page 303
Section 23.2, “Uninstalling the Remote Management Agent on Linux Servers,” on page 304
Section 23.3, “Uninstalling the Remote Management Server Snap-Ins from ConsoleOne,” on 
page 304

23.1  Uninstalling the Remote Management Agent 
on Windows Managed Servers

1 To remove Mirror Driver (if installed), you must reinstall Remote Management without 
selecting the Mirror Driver option.
For more information on how to install Remote Management, see Chapter 6, “Policy-Enabled 
Server Management Installation,” on page 65.

2 To stop the Remote Management Agent:
2a In the Windows Control Panel, double-click Administrative Tools > Services.
2b Right-click Novell ZENworks Remote Management Agent, then click Stop.

3 Delete the ZENworks_agent_directory\rmagent directory.
4 Delete ZENworks_agent_directory\pds\smanager\plugins\rmagent.jar.
5 From the \system32 directory, delete following files: 

darpan.dll

darpan.inf

drishti.dll

yukti.dll

6 Delete darpan.sys from the \system32\drivers directory.
7 Delete the following registry keys:

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS\REMOTE MANAGEMENT

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZFS\REMOTE MANAGEMENT

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES\BLANKSCR

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES\REMOTE MANAGEMENT

8 Reboot the managed server.
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23.2  Uninstalling the Remote Management Agent 
on Linux Servers

1 Stop the Remote Management services by entering /etc/init.d/novell-zdm-wol stop.
2 Delete the following line from the etc/opt/novell/zenworks/zenworks.properties file:

rmpath=/etc/opt/novell/zenworks/rm

3 Delete the following section from the etc/opt/novell/zenworks/zenworks.properties 
file:
[zdm_remote_management_server]

installed_from=product cd

support_pack=0

version=7.0.0 <build date>

4 At the server prompt, enter rpm-e novell-zenworks-zdm-wolserver.
5 (Optional) If the debug log files are not required, delete the /etc/opt/novell/zenworks/rm 

directory.
6 Delete the /var/opt/novell/log/zenworks/rm directory.
7 If any of the Inventory Server, Inventory Database, Novell Application Launcher (NAL) 

Database, and Wake-on-LAN components of ZENworks 7 Desktop Management have not been 
installed, delete the following file:
/etc/opt/novell/zenworks/zenworks.properties

In addition, if any of the Workstation Inventory components of ZENworks 7 Desktop 
Management have not been installed, delete the following file:
/etc/opt/novell/zenworks/password.txt

You can perfrom Remote Control and Remote View operations, the Remote Management console of 
ZENworks 7 Server Management is interoperable with ZENworks for Desktops 4.x, and ZENworks 
6.5 Desktop Management Remote Management Agent is in the password mode of authentication 
only.

You can use the Remote Management console of ZENworks 7 Desktop Management to control 
ZENworks for Desktops 4.x, ZENworks 6.5 Desktop Management, ZENworks 7 Desktop 
Management workstations, ZENworks 6.5 Server Management and ZENworks 7 Server 
Management servers.

23.3  Uninstalling the Remote Management 
Server Snap-Ins from ConsoleOne 
Do not uninstall ConsoleOne itself if you are using it to manage other products.

To remove only the Remote Management snap-ins from ConsoleOne:

1 Close ConsoleOne, if it is running.
If ConsoleOne is invoked directly from the Remote Management server on multiple 
workstations, you must close ConsoleOne on each of these workstations.
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2 Under the ConsoleOne_installation_directory\1.2 directory on your servers or 
workstations (your path might be different), do the following:

Delete the following common files used by Server Management and Desktop 
Management (but not their directories):

IMPORTANT: If you have installed Remote Management console of ZENworks 7 
Desktop Management in your setup, do not delete the following files if you want to use 
the ConsoleOne for Desktop Management. After uninstalling Server Management, you 
must edit the query.properties file to change the value of the rmver attribute to “zfd.”

\bin\desktop4.exe

\bin\desktop4.ini

\bin\rmagent.ini

\bin\rmports.ini

\bin\zencutil.dll

\lib\zen\desktop.jar

\bin\query.properties

\bin\drishtitype.ini

Delete the following Server Management specific files (but not their directories):

\snapins\zen\rmserversnapins.jar

\snapins\zen\novell_rconsole_ndszfs.jar

\snapins\zen\novell_rconsole_atlas.jar

\lib\zen\statuslog.jar

Delete the following directories (but not the parent directories shown):

\help\en\novell_zfs_rconsole

\bin\zen\rclaunch

IMPORTANT: If you have installed the Remote Management console of ZENworks 7 
Desktop Management in your setup, do not delete the \bin\zen\rclaunch directory if 
you want to use ConsoleOne for Desktop Management.

3 Repeat Step 1 and Step 2 for each machine where the Remote Management ConsoleOne snap-
ins are installed.
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24Uninstalling Management and 
Monitoring Services

The Management and Monitoring Services component in Novell® ZENworks® 7 Server 
Management cannot be uninstalled automatically. You must manually remove the ZENworks Server 
Management software and its Novell eDirectoryTM objects.

You must remove objects, files, and information on every server and workstation where 
Management and Monitoring Services components are installed.

To manually uninstall Management and Monitoring Services, proceed in the following order:

1. Section 24.1, “Uninstalling Management Site Services,” on page 307
2. Section 24.2, “Uninstalling the Traffic Analysis Agent,” on page 307
3. Section 24.3, “Uninstalling the Management Agent,” on page 309
4. Section 24.4, “Uninstalling the Linux Agent,” on page 310

24.1  Uninstalling Management Site Services
To uninstall the Management Site Services:

1 At the server console prompt, enter stopmms to unload the management server.
It might take some time to shut down all of the Management and Monitoring Services 
processes.

2 At the management server console prompt, to unload the Sybase database engine, switch to the 
Sybase process (for example, using Ctrl+Esc), then enter q to terminate the Sybase database 
engine.

3 From the ZENworks Server Management console, browse to 
volume:\zenworks\mms\mwserver\uninstall and run uninst.bat.

4 Delete the \zenworks\mms directory on the management server.
5 If no other components of ZENworks Server Management are going to be used, remove the 

following line from sys:\system\mgmtdbs.ncf:
volume:\ZfS_installation_directory\MWServer\db\mw.db

or
If mgmtdbs.ncf does not load any other databases, delete this file.

24.2  Uninstalling the Traffic Analysis Agent
Section 24.2.1, “Uninstalling the Traffic Analysis Agent from a NetWare Server,” on page 308
Section 24.2.2, “Uninstalling the Traffic Analysis Agent from a Windows 2000/2003 Server,” 
on page 308
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24.2.1  Uninstalling the Traffic Analysis Agent from a NetWare 
Server
Depending on your network configuration, you might need to uninstall the Traffic Analysis Agent 
for NetWare software to make room for another agent or to upgrade to a more recent version of an 
agent.

You should upgrade all of the Traffic Analysis Agents for NetWare installed on your network to the 
current version shipping with ZENworks Server Management. Uninstall existing agents before you 
install the new agents.

NOTE: Sys:\zfs_agnt\lanz is the default directory where the Traffic Analysis Agent is 
installed.

To uninstall the Traffic Analysis Agent from a NetWare server:

1 Enter ULANZ at the console prompt to unload the Traffic Analysis Agent for NetWare.
2 Search for the Traffic Analysis Agent for NetWare statements in the autoexec.ncf file. 

For example, search for statements beginning with Search add and the \zfs_agnt\lanz 
directory and the lanz.ncf file to locate the directories where the agent is installed.

3 Delete all of the files from the directory where the Traffic Analysis Agent for NetWare is 
installed.

4 Delete the GTREND files from the server. 
Obtain the directory name from the argument to the gtrend.nlm in the lanz.ncf file. The 
default directory name is sys:\gtrend.

5 Delete the following lines from the sys:\system\autoexec.ncf file:
search add sys:\Traffic_Analysis_Agent_installation_directory\LANZ

lanz.ncf

24.2.2  Uninstalling the Traffic Analysis Agent from a Windows 
2000/2003 Server
Uninstalling the Traffic Analysis Agent from a Windows 2000/2003 server stops the services 
provided by the traffic analysis tools.

IMPORTANT: Back up the registry before you modify it.

To uninstall the Traffic Analysis Agent from a Windows 2000/2003 server:

1 Run LANZCON and select Configure > Traffic Analysis Agent Parameters > Network Trends 
to get the name of the trend directory, such as the \gtrend directory.

2 Enter NET STOP SNMP at the DOS prompt to stop the SNMP service.
3 Click Start > Program > ZfS > Uninstall Traffic Analysis Agent.
4 Delete the trend directory identified in Step 1, such as the default directory name of \gtrend.
5 Click Start > Run > Regedit to start REGEDIT, then delete the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\MANAGEWISE\LANZ-NT entry.
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24.3  Uninstalling the Management Agent
Section 24.3.1, “Uninstalling the Server Management Agents from a NetWare Server,” on 
page 309
Section 24.3.2, “Uninstalling the Windows 2000/2003 Management Agent from a Windows 
Server,” on page 309
Section 24.3.3, “Uninstalling the NetWare Advanced Trending Agent,” on page 309
Section 24.3.4, “Uninstalling the Windows 2000/2003 Advanced Trending Agent,” on 
page 310

24.3.1  Uninstalling the Server Management Agents from a 
NetWare Server
To uninstall the NetWare Management AgentTM (NMA):

1 To unload the Server Management Agents, at the NetWare system console, enter unnma5.
2 Delete the sys:\system\nma directory.
3 Edit the sys:\system\autoexec.ncf file and remove the following two lines:

search add sys:\system\nma

nma5.ncf

24.3.2  Uninstalling the Windows 2000/2003 Management Agent 
from a Windows Server

1 To stop the SNMP service on a Windows 2000/2003 server:
1a In the Windows Control Panel, double-click Administrative Tools > Services.
1b Right-click SNMP and then click Stop.

2 Select My Computer > Properties > Environment > System Variables > Path and remove 
c:\zfs_agnt\ntagent\bin from the path string.

3 Click Start > Programs > ZfS > Uninstall Management Agent.

24.3.3  Uninstalling the NetWare Advanced Trending Agent 
1 To unload any advtrend, at the NetWare 5.x/6.x.system console, enter utrend.
2 Delete the install_volume:\install_directory\advtrend directory.
3 Edit the sys:\system\autoexec.ncf file and remove the following two lines:

search add <install_volume>:\<directory>\advtrend
advtrend.ncf
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24.3.4  Uninstalling the Windows 2000/2003 Advanced Trending 
Agent

1 To stop the SNMP service on a Windows 2000/2003 server:
1a In the Windows Control Panel, double-click Administrative Tools > Services.
1b Right-click SNMP and then click Stop.

2 Click Start > Programs > ZfS > Uninstall Advanced Trending Agent.

24.4  Uninstalling the Linux Agent
To uninstall Management and Monitoring Services agents on your Linux servers, you must 
individually uninstall the Linux Management Agent and the Advanced Trending Agent from the 
Linux server.

1 Log in as root.
2 To remove the Advanced Trending Agent package, at the server console prompt enter:

rpm -e novell -zenworks-zsm-lma

3 To remove the Linux Management Agent package, at the server console prompt, enter:
rpm -e novell -zenworks-zsm-advtrend
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VVIIAppendixes

The following sections are referenced from other sections in this Novell® ZENworks® 7 Server 
Management Installation Guide:

Appendix A, “Port Used by Novell ZENworks Server Management,” on page 313
Appendix B, “Upgrading a 90-day Evaluation License,” on page 315
Appendix C, “Starting and Stopping Server Management Services,” on page 325
Appendix D, “Ensuring Successful DNS Name Resolution,” on page 335
Appendix E, “Installing and Configuring the Windows SNMP Service,” on page 341
Appendix F, “ZENworks Server Management in a Clustered Environment,” on page 343
Appendix G, “Installing Additional Security for Non-Secured Connections,” on page 361
Appendix H, “Installation Error Messages,” on page 373
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APort Used by Novell ZENworks 
Server Management

The following table lists the ports that are used by the ZENworks Server Management services:

Service Port Configurable: (Y)

Web Server iManager 8080 (Y)

Tiered Electronic Distribution (TED) 1229

Inventory Sybase Database (server) 2638 (Y)

Oracle Inventory Database JDBC driver (server) 1521

MS SQL Inventory Database JDBC driver (server) 1433

RConsoleJ Agent (server and workstation) 2034

Remote Management Agent (workstation) 1761 (Y)

Remote Management Listener (workstation) 1762 (Y)

Network Discovery (SNMP) 161
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BUpgrading a 90-day Evaluation 
License

You should have received a license code when you purchased the Novell® ZENworks® 7 Server 
Management product. If not, contact Novell, Inc. (http://www.novell.com/licensing).

If you do not enter a valid license code when extending the schema during installation of the 
product, a 90-day evaluation license is in effect. When the evaluation period expires, ZENworks 
Server Management properties are no longer visible when you view an object’s properties.

You can upgrade the evaluation license to an unlimited version by doing one of the following:

Section B.1, “Upgrading an Evaluation License When Prompted,” on page 315
Section B.2, “Upgrading an Evaluation License Using the License Installation Utility,” on 
page 316
Section B.3, “Upgrading an Evaluation License Using the Schema Extension Wizard,” on 
page 318

B.1  Upgrading an Evaluation License When 
Prompted
If a 90-day evaluation license is in effect, the following is displayed as a reminder once per 24 hours 
in the first Novell ConsoleOne® session of the day when you attempt to access the properties of a 
ZENworks Server Management object:

Figure B-1   ZENworks Evaluation Version Dialog Box
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This dialog box indicates how many days are left for the evaluation.

In Novell iManager, a similar dialog box is displayed where the Continue button is named Cancel, 
because a Web browser does not provide the same continuation as ConsoleOne.

To upgrade a 90-day evaluation license to an unlimited version:

1 When the ZENworks Evaluation Version dialog box is displayed, click License.
The Product Licensing dialog box is displayed:

2 Enter a valid license code, then click Continue.
This can be either the Server Management or ZENworks Suite license code.
The product recognizes the unlimited license the next time you open ConsoleOne or iManager.
You should have received a license code when you purchased the Novell® ZENworks® Server 
Management product. If not, contact Novell, Inc. (http://www.novell.com/licensing).

B.2  Upgrading an Evaluation License Using the 
License Installation Utility
This utility can be accessed from either ConsoleOne or iManager:

Section B.2.1, “Using ConsoleOne,” on page 316
Section B.2.2, “Using iManager,” on page 317

B.2.1  Using ConsoleOne
To upgrade a 90-day evaluation license to an unlimited version:

1 In ConsoleOne, select the tree where the 90-day evaluation license is running.
2 Click Tools > ZENworks Licensing.

The Product Licensing dialog box is displayed:
 ZENworks 7 Server Management Installation Guide
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3 Enter a valid license code, then click Continue.
This can be either the Server Management or ZENworks Suite license code.
The product recognizes the unlimited license the next time you open ConsoleOne or iManager.
You should have received a license code when you purchased the Novell® ZENworks® Server 
Management product. If not, contact Novell, Inc. (http://www.novell.com/licensing).

B.2.2  Using iManager
To upgrade a 90-day evaluation license to an unlimited version:

1 In iManager, log in to the tree where the 90-day evaluation license is running.
The following is displayed under the Roles and Tasks heading:

2 Click the plus sign for ZENworks Server Management role to expand it, then select ZENworks 
Licensing.
The Product Licensing dialog box is displayed:
Upgrading a 90-day Evaluation License 317
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3 Enter a valid license code, then click Submit.
This can be either the Server Management or ZENworks Suite license code.
The product recognizes the unlimited license the next time you open ConsoleOne or iManager.
You should have received a license code when you purchased the Novell® ZENworks® Server 
Management product. If not, contact Novell, Inc. (http://www.novell.com/licensing).

B.3  Upgrading an Evaluation License Using the 
Schema Extension Wizard
To upgrade a 90-day evaluation license to an unlimited version:

1 On your workstation, insert the Novell ZENworks 7 Server Management with Support Pack 1 
Program CD to display the main ZENworks menu:
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2 Select the Server Management option to display the Server Management menu options:
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3 Click Schema Extensions and Product Licensing to display the ZENworks License Agreement 
page:
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4 If you agree with the Software License Agreement, click Accept, then click Next to display the 
eDirectory Tree for Creating Objects page; otherwise, click Decline > Cancel to exit.
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5 Select the tree where you installed the ZENworks objects, then click OK to display the 
ZENworks Server Management Licensing page:

6 Enter a valid license code.
This can be either the Server Management or ZENworks Suite license code.
You should have received a license code when you purchased the Novell® ZENworks® Server 
Management product. If not, contact Novell, Inc. (http://www.novell.com/licensing).

7 Click Next to display the Summary page:
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8 To register the license code, click Finish.
The schema extension process runs, but does not add any new extensions.
The product recognizes the unlimited license the next time you open ConsoleOne or iManager.
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CStarting and Stopping Server 
Management Services

The services and agents for the Novell® ZENworks® 7 Server Management components can be 
individually started and stopped. The following instructions are provided by server platform:

Section C.1, “NetWare Servers,” on page 325
Section C.2, “Windows Servers,” on page 327
Section C.3, “Linux or Solaris Servers,” on page 331

C.1  NetWare Servers
Starting and stopping instructions are provided for the following Server Management components:

Section C.1.1, “Policy and Distribution Services,” on page 325
Section C.1.2, “Server Inventory,” on page 326
Section C.1.3, “Management and Monitoring Services,” on page 326

C.1.1  Policy and Distribution Services
“Starting Policy and Distribution Services on a NetWare Server” on page 325
“Stopping Policy and Distribution Services on a NetWare Server” on page 325
“Starting the Sybase Engine on a NetWare Server” on page 325
“Stopping the Sybase Engine on a NetWare Server” on page 325

Starting Policy and Distribution Services on a NetWare Server

To start all Policy and Distribution Services processes, enter the zfs.ncf command at the server’s 
main console prompt.

Stopping Policy and Distribution Services on a NetWare Server

To stop all Policy and Distribution Services processes except the database engine, enter the exit 
command at the server’s ZENworks Server Management console prompt.

Starting the Sybase Engine on a NetWare Server

The Sybase engine is automatically started when Policy and Distribution Services is started.

To start the database manually, on the server’s main console prompt, enter:

sys:\system\mgmtdbs

Stopping the Sybase Engine on a NetWare Server

Type q on the Sybase screen on the server.
Starting and Stopping Server Management Services 325
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C.1.2  Server Inventory
Before you start the Inventory service on the Inventory server, make sure that the Policy and 
Distribution Services components and the Inventory database are up and running. The Inventory 
database is automatically started after installation of the product.

After starting the Inventory service, make sure that the Inventory services are up and running. To list 
all services, enter ListSer * at the Inventory server console prompt. If the services are not up and 
running, check the Server Status log. For more information on the Server Status log, see “Server 
Inventory” in the Novell ZENworks 7 Server Management Administration Guide.

“Starting the Inventory Service on a NetWare Inventory Server” on page 326
“Stopping the Inventory Service on a NetWare Inventory Server” on page 326

Starting the Inventory Service on a NetWare Inventory Server

To start the Inventory services on the NetWare Inventory server, enter startinv at the server 
console prompt.

Stopping the Inventory Service on a NetWare Inventory Server

To stop an Inventory service, enter stopser Inventory_service_name at the server 
console prompt.
To stop all Inventory services, enter stopser * at the server console prompt.

C.1.3  Management and Monitoring Services
“Starting the Agents on NetWare Servers” on page 326
“Stopping the Agents on NetWare Servers” on page 327
“Starting the Management Site Server on NetWare Server” on page 327
“Stopping the Management Site Server on NetWare Server” on page 327

Starting the Agents on NetWare Servers

“Starting the Server Management Agent on NetWare Servers” on page 326
“Starting the Traffic Analysis Agent on NetWare Servers” on page 326
“Starting the Advanced Trending Agent on NetWare Servers” on page 327

Starting the Server Management Agent on NetWare Servers

The installation program for the Server Management Agent for NetWare modifies the 
autoexec.ncf file with the path where the agent is installed.

To start the Server Management Agent:

1 At the server console prompt, enter nma5.ncf.

Starting the Traffic Analysis Agent on NetWare Servers

The installation program for the Traffic Analysis Agent for NetWare modifies the autoexec.ncf 
file with the path where the agent is installed.
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To start the Traffic Analysis Agent:

1 At the server console prompt, enter lanz.ncf.

Starting the Advanced Trending Agent on NetWare Servers

The installation program for the Advanced Trending Agent for NetWare modifies the 
autoexec.ncf file so that the agent starts automatically.

To start the Advanced Trending Agent:

1 At the server console prompt, enter advtrend.ncf.

Stopping the Agents on NetWare Servers

This section contains the following:

“Stopping the Server Management Agent on NetWare Servers” on page 327
“Stopping the Traffic Analysis Agent on NetWare Servers” on page 327
“Stopping the Advanced Trending Agent on NetWare Servers” on page 327

Stopping the Server Management Agent on NetWare Servers

1 At the server console prompt enter unnma5.ncf.

Stopping the Traffic Analysis Agent on NetWare Servers

1 At the server console prompt enter ulanz.ncf.

Stopping the Advanced Trending Agent on NetWare Servers

1 At the server console prompt enter utrend.ncf.

Starting the Management Site Server on NetWare Server

The installation program for the Server Management Agent for NetWare modifies the 
autoexec.ncf file with the path where the Management Site Server is installed.

To start the Management Site Server on a Netware server, enter startmms.ncf at the server console 
prompt.

Stopping the Management Site Server on NetWare Server

1 At the server console prompt, enter stopmms.ncf.
2 To stop and unload all Management and Monitoring Services and the Naming Service, enter 

stopmms -n.

C.2  Windows Servers
Starting and stopping instructions are provided for the following Server Management components:

Section C.2.1, “Policy and Distribution Services,” on page 328
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328 Novell

novdocx (en)  16 A
pril 2010
Section C.2.2, “Server Inventory,” on page 329
Section C.2.3, “Management and Monitoring Services,” on page 330

C.2.1  Policy and Distribution Services
“Starting Policy and Distribution Services on a Windows Server” on page 328
“Stopping Policy and Distribution Services on a Windows Server” on page 328
“Starting the Sybase Engine on a Windows Server” on page 329
“Stopping the Sybase Engine on a Windows Server” on page 329

Starting Policy and Distribution Services on a Windows Server

There are two methods for starting the services:

“Control Panel Method” on page 328
“Command Line Method” on page 328

Control Panel Method

This method presumes the service is already registered and is displayed in the Services listing:

1 In the Control Panel, double-click Administrative Tools.
2 Double-click Services.
3 Right-click Novell ZENworks Service Manager, then click Start.

Command Line Method

With this method, you can both register and start the service.

1 Open the Services window, determine whether Novell ZENworks Service Manager is listed, 
then close the Services window.

2 If the ZENworks service is not registered (listed in the Services window), click Start > Run, 
then enter:
zenworks\pds\bin\sservices.bat

This only registers, but does not start the service.
3 Click Start > Run, then enter:

net start zfsservice

Stopping Policy and Distribution Services on a Windows Server

There are two methods for stopping the services:

“Control Panel Method” on page 328
“Command Line Method” on page 329

Control Panel Method

With this method, you can only stop the service, not unregister it.

1 In the Control Panel, double-click Administrative Tools.
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2 Double-click Services.
3 Right-click Novell ZENworks Service Manager, then click Stop.

Command Line Method

With this method, you have the option to both unregister and stop the service, or only stop the 
service.

1 Close the Services window.
2 If you want to both unregister and stop the service, click Start > Run, then enter:

zenworks\pds\bin\dservices.bat

or
To only stop the service, but leave it registered, click Start > Run, then enter:
net stop zfsservice

Starting the Sybase Engine on a Windows Server

The Sybase engine is automatically started when Policy and Distribution Services is started. 
However, to restart the Sybase engine:

1 In the Control Panel, double-click Administrative Tools.
2 Double-click Services.
3 Right-click Novell Database - Sybase, then click Start.

Stopping the Sybase Engine on a Windows Server

1 In the Control Panel, double-click Administrative Tools.
2 Double-click Services.
3 Right-click Novell Database - Sybase, then click Stop.

C.2.2  Server Inventory
“Starting the Inventory Service on a Windows 2000/2003 Inventory Server” on page 329
“Stopping the Inventory Service on a Windows 2000/2003 Inventory Server” on page 330

Starting the Inventory Service on a Windows 2000/2003 Inventory Server

To start a service on Windows 2000/2003 servers from the console prompt:

1 Go to the installation_directory\inv\server\wminv\bin directory.
2 Enter startser service_name.

where service_name refers to an Inventory service.

To start the Inventory services on the Windows 2000/2003 Inventory server

1 In the Control Panel, double-click Administrative Tools.
2 Double-click Services.
3 Right-click Novell Inventory Service, then click Start.
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Stopping the Inventory Service on a Windows 2000/2003 Inventory Server

To stop a service on Windows 2000/2003 servers from the console prompt:

1 Go to the installation_directory\inv\server\wminv\bin directory.
2 Enter stopser service_name.

where service_name refers to an Inventory service.

To stop the Inventory services on the Windows 2000/2003 Inventory server:

1 In the Control Panel, double-click Administrative Tools.
2 Double-click Services.
3 Right-click Novell Inventory Service, then click Stop.

To stop all Inventory services on a Windows 2000/2003 Inventory server, go to the server console 
prompt and execute stopser * from the 
inventory_server_installation_directory\inv\server\wminv\bin directory.

C.2.3  Management and Monitoring Services
“Starting the Agents on Windows Servers” on page 330
“Stopping the Agents on Windows Servers” on page 330
“Stopping other Agents of Server Management” on page 331

Starting the Agents on Windows Servers

The Management and Monitoring Services agents include the Server Management Agent, the 
Traffic Analysis Agent, and the Advanced Trending Agent.

If you have configured Windows 2000/2003 to automatically start the SNMP service, the agent 
installed on a Windows 2000/2003 server starts with the SNMP service when you start the server.

If you have not configured Windows 2000/2003 to automatically start the SNMP service, to start the 
services:

1 On a Windows 2000/2003 server, from the Control Panel, double-click Administrative Tools > 
Services.

2 Right-click SNMP, then click Start.
When the SNMP service is started, the Server Management Agent, Traffic Analysis Agent, and 
Advanced Trending Agent also start.

Stopping the Agents on Windows Servers

To stop the services on a Windows 2000/2003 server:

1 On a Windows 2000/2003 server, from the Control Panel, double-click Administrative Tools > 
Services.

2 Right-click SNMP, then click Stop.
When the SNMP service is stopped, the Server Management Agent, Traffic Analysis Agent, 
and Advanced Trending Agent also stop.
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Stopping other Agents of Server Management

To stop the Novell Diagnostic Agent:

1 From the Control Panel, click Services.
2 Right-click Novell Diagnostic Agent 3.0, then click Stop

To stop the Novell Find Agent:

1 From the Control Panel, click Services.
2 Right-click Novell Find Agent 3.0, then click Stop

C.3  Linux or Solaris Servers
Starting and stopping instructions are provided for the following Server Management components:

Section C.3.1, “Policy and Distribution Services,” on page 331
Section C.3.2, “Server Inventory,” on page 332
Section C.3.3, “Management and Monitoring Services,” on page 332

C.3.1  Policy and Distribution Services
“Starting Policy and Distribution Services on Linux Servers” on page 331
“Restarting Policy and Distribution Services on Linux Servers” on page 331
“Stopping Policy and Distribution Services on Linux Servers” on page 331

Starting Policy and Distribution Services on Linux Servers

1 At the server console or in the Xterm window, enter /etc/init.d/novell-zfs start.
2 To verify that the Policy and Distribution Services is started, enter /etc/init.d/novell-zfs 

status.

Restarting Policy and Distribution Services on Linux Servers

1 At the server console or in the Xterm window, enter /etc/init.d/novell-zfs restart.
If Policy and Distribution Services is running at the time this command is issued, it is both 
stopped and restarted.

2 To verify that the Policy and Distribution Services is started, enter /etc/init.d/novell-zfs 
status.

Stopping Policy and Distribution Services on Linux Servers

1 At the server console or in the Xterm window, enter /etc/init.d/novell-zfs stop.
2 To verify that the Policy and Distribution Services is stopped, enter /etc/init.d/novell-

zfs status.
Starting and Stopping Server Management Services 331



332 Novell

novdocx (en)  16 A
pril 2010
C.3.2  Server Inventory
“Starting the Inventory Service on Linux Servers” on page 332
“Stopping the Inventory Service on Linux Servers” on page 332

Starting the Inventory Service on Linux Servers

To start all Inventory services:

1 At the Linux server prompt, go to /etc/init.d.
2 Enter ./novell-zdm-inv start. 

To start a specific Inventory service:

1 At the Linux server prompt, go to /opt/novell/bin.
2 Enter StartSer Inventory_service. 

Stopping the Inventory Service on Linux Servers

To stop all Inventory services:

1 At the Linux server prompt, go to /etc/init.d.
2 Enter ./novell-zdm-inv stop. 

To stop a specific Inventory service:

1 At the Linux server prompt, go to /opt/novell/bin.
2 Enter StopSer Inventory_service. 

C.3.3  Management and Monitoring Services
“Starting the Agents on Linux Servers” on page 332
“Stopping the Agents on Linux Servers” on page 333

Starting the Agents on Linux Servers

The installation script automatically starts the Linux Management Agent and the Advanced 
Trending Agent. However, you might want to manually start the agents during specific scenarios. 

The Linux Management Agent comprises of two parts: servinst and novell-log2trapd.

When you start the SNMP service, servinst and the Advanced Trending Agent are automatically 
started.

To manually start servinst:

1 At the server console or in the Xterm window, enter /etc/init.d/snmpd start.
2 To verify that the SNMP service is started, enter /etc/init.d/snmpd status.
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To manually start novell-log2trapd:

1 At the server console or in the Xterm window, enter /etc/init.d/novell-log2trapd 
start.

2 To verify that the SNMP service is started, enter /etc/init.d/novell-log2trapd status.

Stopping the Agents on Linux Servers

You seldom need to stop the Management and Monitoring Services agents on Linux servers.

This procedure is a reference to enable you to manually stop the services during specific scenarios.

To stop the agents:

1 At the server console or in the Xterm window, enter /etc/init.d/snmpd stop.

When you specify the above command, all of the agents working with snmpd stops. If you do not 
want to load the Advanced Trending Agent or servinst, do the following before restarting the snmpd 
service:

1 In the /var/opt/novell/log/zenworks/zfs-mms-advtrend-rpm.log file, locate the line 
Modifying path/*snmpd.conf, where path is the complete path to the configuration file.

2 Open the configuration file specified in the above line.
3 Comment the line dlmod agentname path.

IMPORTANT: The name of the agent is servinst for Server Management and advtrend for 
Advanced Trending Agent.

4 Start the snmpd service. 

To manually stop novell-log2trapd:

1 At the server console or in the Xterm window, enter /etc/init.d/novell-log2trapd stop.
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DEnsuring Successful DNS Name 
Resolution

The Windows workstation you use to install Novell® ZENworks® 7 Server Management 
components to servers throughout your network must have access to a DNS name server. In 
addition, the servers where you install Server Management components must have valid entries in 
DNS.

DNS is not required for Management and Monitoring Services.

If you have a NAT (Network Address Translation) environment, a recipient might or might not be 
able to reply (depending on the routes available back to the sender), because Internet routers drop 
packets having destinations of 10.x.x.x, 172.16.x.x, or 192.168.x.x.

Section D.1, “Understanding DNS Terminology,” on page 335
Section D.2, “Using Underscore Characters in DNS Names,” on page 335
Section D.3, “Testing DNS Functionality,” on page 335

D.1  Understanding DNS Terminology
If you are not already familiar with DNS, review the following terminology:

fully qualified domain name (FQDN): A server name that includes a list of all domains in the 
path from the local domain to the root; for example, server47.servers.novell.com.
forward lookup: Resolves an FQDN into its IP address.
reverse lookup: Resolves an IP address into its FQDN.
ping: The NetWare, Windows, Linux, or Solaris command that accesses DNS to test whether a 
specified FQDN or IP address can be resolved. Refer to your operating system documentation 
for additional information about this command.

D.2  Using Underscore Characters in DNS Names
As of ZENworks 6.5, underscore (_) characters can be used in the DNS names of servers.

D.3  Testing DNS Functionality
The following sections help you test your system for DNS functionality and help you resolve any 
problems that you discover during testing:

Section D.3.1, “Testing and Configuring a Windows Workstation for DNS,” on page 336
Section D.3.2, “Testing and Configuring a NetWare Server for DNS,” on page 336
Section D.3.3, “Testing and Configuring a Windows Server for DNS,” on page 337
Section D.3.4, “Testing and Configuring a Linux or Solaris Server for DNS,” on page 339
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D.3.1  Testing and Configuring a Windows Workstation for DNS
In order to access DNS, a workstation must be enabled for DNS name resolution and be configured 
to locate a valid DNS name server.

“Testing a Windows Workstation for DNS Access” on page 336
“Enabling a Windows Workstation for DNS Name Resolution” on page 336
“Specifying a DNS Name Server for a Windows Workstation” on page 336

Testing a Windows Workstation for DNS Access

From the workstation, ping the servers where you want to install ZENworks Server Management 
components. Specify the servers’ DNS hostnames, not their IP addresses. If the servers do not 
respond to the ping command, the workstation might not be configured for DNS. Continue with 
“Enabling a Windows Workstation for DNS Name Resolution” on page 336.

Enabling a Windows Workstation for DNS Name Resolution

In order for a workstation to perform DNS name resolution, DNS must be selected in the Protocol 
Component Settings list on the Novell Client Protocol Preferences properties tab.

For example, on Windows 2000:

1 Right-click Network Services (the red N), then click Novell Client Properties.
2 Click Protocol Preferences, make sure that DNS is selected in the Protocol Component Settings 

box, then click OK to exit.

Specifying a DNS Name Server for a Windows Workstation

A workstation cannot perform DNS name resolution successfully unless it has access to a DNS 
name server specified on the Internet Protocol (TCP/IP) DNS properties tab.

For example, on Windows 2000/2003:

1 In the Control Panel, double-click Network and Dial-up Connections.
2 Double-click Local Area Network, then click Properties.
3 Select Internet Protocol (TCP/IP) in the components list, then click Properties.

On the General tab, you can choose to let the workstation obtain the DNS name server IP 
address automatically, or you can specify one or more DNS name server IP addresses manually. 
For additional DNS configuration options, click Advanced, then click DNS.

4 Select Novell Client for Windows 2000 in the components list, then click Properties.
5 Click Protocol Preferences, make sure that DNS is listed in the Protocol Component Settings 

box, then click OK > OK > Close to exit the dialog boxes.

D.3.2  Testing and Configuring a NetWare Server for DNS
Review the following sections to make sure that a NetWare server is configured properly for DNS:

“Testing Forward Lookup on NetWare” on page 337
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“Testing Reverse Lookup on NetWare” on page 337
“Configuring a NetWare Server for DNS” on page 337

Testing Forward Lookup on NetWare

From the NetWare server console, ping that server’s own FQDN. For example:

ping nwserver3.servers.novell.com

If the ping returns an IP address (192.68.1.203 in this example), forward lookup is functioning. If 
there is no response from the NetWare server, see “Configuring a NetWare Server for DNS” on 
page 337.

Testing Reverse Lookup on NetWare

From a Windows workstation, ping the NetWare server’s own IP address. For example:

ping -a 192.68.1.203

If the ping returns a DNS hostname (nwserver3.servers.novell.com in this example), reverse 
lookup is functioning. If there is no response from the NetWare server, see “Configuring a NetWare 
Server for DNS” on page 337.

Configuring a NetWare Server for DNS

On the NetWare server, check the sys:\etc\resolv.cfg file to make sure the information it 
contains is correct. 

For more information about DNS on NetWare, see DNS/DHCP Services (http://www.novell.com/
documentation/lg/dns_dhcp/index.html).

D.3.3  Testing and Configuring a Windows Server for DNS
Review the following sections to make sure that a Windows server is configured properly for DNS:

“Testing Domain Configuration on Windows” on page 337
“Testing Forward Lookup on Windows” on page 337
“Testing Reverse Lookup on Windows” on page 338
“Configuring a Windows Server for DNS” on page 338

Testing Domain Configuration on Windows

On the Windows server (such as winserver3.servers.novell.com), ping that server’s own IP 
address. For example:

ping -a 192.68.1.203

If the ping is successful, the domain is configured correctly for that server. If there is no response 
from the Windows server, see “Configuring a Windows Server for DNS” on page 338.

Testing Forward Lookup on Windows

On the Windows server, ping the the server’s own FQDN. For example:
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ping winserver4.servers.novell.com

If the ping returns the server’s IP address (192.68.1.203 in this example), forward lookup is 
functioning. If there is no response from the Windows server, see “Configuring a Windows Server 
for DNS” on page 338.

Testing Reverse Lookup on Windows

On the Windows server (such as winserver3.servers.novell.com), ping the server’s own IP 
address. For example:

ping -a 192.68.1.203

or

nslookup 192.68.1.203

If the ping returns a DNS hostname (winserver3.servers.novell.com in this example), reverse 
lookup is functioning. If there is no response from the Windows server, see “Configuring a Windows 
Server for DNS” on page 338.

Configuring a Windows Server for DNS

Make sure that the Windows server’s DNS short name is exactly the same as the server name. Also 
make sure that the Windows server has a DNS suffix.

To check the server name and DNS suffix:

1 Right-click My Computer, click Properties, then click Network Identification.
The Full Computer Name field displays the server name (for example, winserver5), followed 
by its DNS suffix (for example, servers.novell.com) if one has already been provided. 

2 If the server name does not match the server’s DNS short name:
Rename the server to match the existing DNS entry: On the Network Identification tab, 
click Properties, edit the Computer Name field to match the server’s DNS short name, 
then click OK.
or
Modify the DNS entry to match the existing server name. 

3 If the Full Computer Name field does not include a DNS suffix:
3a Click Properties, then click More.
3b In the Primary DNS Suffix field, specify the DNS suffix for the server.
3c Click OK.

4 Reboot the Windows server to put the new server name information into effect.
5 Check the \winnt\system32\drivers\etc\hosts file to make sure that the information 

listed in it is correct.
For example, you must have a local host entry pointing to 127.0.0.1, which the facilitator 
requires for communicating with ZENworks Web Server.

For more information about DNS on Windows, refer to Windows online help about using the DNS 
administrative tool.
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D.3.4  Testing and Configuring a Linux or Solaris Server for 
DNS
Review the following sections to make sure that a Linux or Solaris server is configured properly for 
DNS:

“Testing Forward Lookup on Linux or Solaris” on page 339
“Testing Reverse Lookup on Linux or Solaris” on page 339
“Configuring a Linux or Solaris Server for DNS” on page 339

Testing Forward Lookup on Linux or Solaris

From the Linux or Solaris server, ping that server’s own FQDN. For example:

ping unxserver3.servers.novell.com

If the ping returns an IP address (192.68.1.203 in this example), forward lookup is functioning. If 
there is no response from the Linux or Solaris server, see “Configuring a Linux or Solaris Server for 
DNS” on page 339.

Testing Reverse Lookup on Linux or Solaris

From a Windows workstation, ping the Linux or Solaris server’s IP address. For example:

ping -a 192.68.1.203

Or from the Linux or Solaris server, use:

nslookup 192.68.1.203

If the ping returns a DNS hostname (unxserver3.servers.novell.com in this example), reverse 
lookup is functioning. If there is no response from the Linux or Solaris server, see “Configuring a 
Linux or Solaris Server for DNS” on page 339.

Configuring a Linux or Solaris Server for DNS

On the Linux or Solaris server, make sure that the /etc/hosts file has the correct IP address and 
FQDN for itself. Make sure that the loopback address line (127.0.0.1) reads 
localhost.localdomain, not the server’s FQDN.

For more information about DNS on Linux or Solaris, refer to your operating system 
documentation.
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EInstalling and Configuring the 
Windows SNMP Service

This section provides you with information on installing and configuring the SNMP service on 
Windows 2000/2003 servers.

To install and configure SNMP on Windows 2000/2003:

1 To install the SNMP service:
1a In the Control Panel, select Add/Remove Programs.
1b Open Add/Remove Windows Components. 
1c In the Windows Components Wizard, double-click Management and Monitoring Tools. 
1d Select Simple Network Management Protocol.
1e Click OK.
1f Click Next.

SNMP is started automatically after installation.
2 To configure the SNMP Trap service to restart automatically:

2a In the Control Panel, select Administrative Tools, then select Services.
2b Click SNMP Trap Service, then click Startup.
2c In the Startup Type options, select Automatic.

3 To specify the trap community name and trap destination address so that the agent sends traps 
to the management server:
3a In the Control Panel, select Administrative Tools, then click Services.
3b Double-click SNMP Service to open the SNMP Service Properties dialog box.
3c Click the Traps tab on this dialog box.
3d Select a name from the Community Names box, then click Add.

The Add button is disabled if there are no community names available.
3e If the public community name is not present, enter public.
3f Click Add.

3g Use the Trap Destinations box to add other DNS names and IP addresses in addition to the 
loopback IP address for the workstations or servers that should receive traps. 

3h Click OK.
4 To set the SNMP security options trap community name so that SNMP packets from any host 

are accepted by the agent:
4a In the Control Panel, select Administrative Tools, then click Services.
4b Double-click SNMP Service.
4c Click Properties.
4d Click the Security tab.
4e In the Accepted Community Names box, click Add.
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4f Select a name from the Community Name box, or type public.
The Accepted Community Names list displays the community names from which 
Windows 2000/2003 accepts requests.

4g Click Add.
4h Select Accept SNMP Packets from Any Host, then click OK.

IMPORTANT: After installing the SNMP services, you should reinstall the Windows service packs 
again.
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FZENworks Server Management in 
a Clustered Environment

This section is designed for those who are performing an initial installation of Novell® ZENworks® 
Server Management components in the context of Novell Cluster ServicesTM.

Section F.1, “Introduction to Novell Cluster Services and ZENworks Server Management,” on 
page 343
Section F.2, “Cluster Ready and Cluster Aware Modes,” on page 344
Section F.3, “Getting Started with Clustering,” on page 344
Section F.4, “Installing Policy and Distribution Services and Server Inventory in a Cluster,” on 
page 347
Section F.5, “Installing Management and Monitoring Services in a Cluster,” on page 359

Clustering is not supported for Remote Management in ZENworks 7 Server Management.

Although you can create multiple virtual servers on a cluster (providing mutliple shared volumes), 
ZENworks does not support this functionality.

F.1  Introduction to Novell Cluster Services and 
ZENworks Server Management
Before implementing ZENworks Server Management with Novell Cluster Services, make sure you 
have a solid understanding of Novell Cluster Services by reviewing the following information 
resources:

NetWare 6.5 Product Documentation: Novell Cluster Services (http://www.novell.com/
documentation/ncs65/index.html)
NetWare 6 Product Documentation: Novell Cluster Services (http://www.novell.com/
documentation/ncs6p/index.html)
NetWare 5.1 Product Documentation: Novell Cluster Services (http://www.novell.com/
documentation/ncs/index.html)

When you review the information resources recommended above, you discover that clustering 
employs very specialized terminology. The following brief glossary provides basic definitions of 
clustering terms and relates them to your ZENworks Server Management component installation:

cluster: A grouping of from 2 to 32 NetWare® servers configured using Novell Cluster 
Services so that data storage locations and applications can transfer from one server to another 
without interrupting their availability to users. It is represented by a Cluster object in Novell 
eDirectoryTM.
node: A clustered server; in other words, a single NetWare server that is part of a cluster.
resource: An IP address, volume, application, service, and so on, that can function successfully 
on any node in the cluster. The volumes where you install ZENworks Server Management 
components are a specific type of cluster resources termed “volume resources.”
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failover: The process of moving cluster resources from a failed node to a functional node so 
that availability to users is uninterrupted. For example, if the node where a Distributor is 
running goes down, the Distributors fail over to a secondary node in the cluster so that the 
Distributor could continue functioning without significant interruption.
failback: The process of returning cluster resources to their preferred node after the situation 
causing the failover is resolved. For example, if Traffic Analysis fails over to a secondary node, 
that cluster resource can be configured to fail back to its preferred node when the problem is 
resolved.
shared disk system: The hardware housing the physical disk volumes that are shared among 
the nodes in a cluster.
shared volume: A volume in a shared disk system that can be accessed from any node that 
needs the data stored on it.
cluster-enabled shared volume: A shared volume for which a Volume Resource object is 
created in eDirectory.

IMPORTANT: Cluster enabling is required for ZENworks Server Management components.

virtual server: A logical server, rather than a physical node, to which cluster-enabled shared 
volumes are tied.
storage area network (SAN): The clustered nodes together with their shared disk system and 
shared volumes.

F.2  Cluster Ready and Cluster Aware Modes
Installation of ZENworks in a cluster can be in one of two cluster modes:

Cluster ready:  ZENworks is installed to the Cluster object that permits failover of 
ZENworks. You can install only one instance of a ZENworks Server Management component 
in such a cluster because ZENworks Server Management treats the whole cluster as if it is a 
single server.
Cluster aware:  ZENworks can be installed to individual nodes. ZENworks simply exists on 
the server that also happens to be a cluster node server.

The following sections apply only to the Cluster Ready mode.

F.3  Getting Started with Clustering
Before you install a ZENworks Server Management component in a clustered environment, you 
must install Novell Cluster Services and perform some preparatory tasks:

Section F.3.1, “Meeting System Requirements for Clustering,” on page 345
Section F.3.2, “Cluster-Enabling Shared Volumes for Use with ZENworks Server Management 
Components,” on page 345
Section F.3.3, “Installing Novell Cluster Services,” on page 347
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F.3.1  Meeting System Requirements for Clustering
ZENworks Server Management components can be installed in a cluster that meets the following 
minimum requirements:

DNS

DNS must be functioning reliably throughout your network so that DNS hostnames and IP 
addresses can always be successfully resolved.
NetWare 6.5 with SP4 or SP5
or
OES NetWare with SP2
or
OES Linux with SP1

IMPORTANT: ZENworks does not support mixed NetWare and Linux operating systems 
within a cluster.

Novell iManager for administering ZENworks Server Management in the cluster
Novell ConsoleOne® for administering Server Inventory in the cluster

F.3.2  Cluster-Enabling Shared Volumes for Use with ZENworks 
Server Management Components
Cluster-enabling the shared volumes where ZENworks Server Management components are 
installed is required.

“Understanding Cluster Enabling” on page 345
“Cluster Enabling a Shared Volume” on page 346

Understanding Cluster Enabling

To review the concept of cluster-enabled shared volumes, see the applicable section of Novell 
Cluster Services Overview and Installation for your version of NetWare:

NetWare 6.5: Cluster-Enabling Shared Volumes for Use with ZfS Components (http://
www.novell.com/documentation/zfs302/zfs_install/data/aewf3me.html#aewfggh)
NetWare 6: Cluster Enable Pools and Volumes (http://www.novell.com/documentation/ncs6p/
orionenu/data/h2mdblj1.html#hrt0ekvg)
NetWare 5.1: Cluster-Enable Volumes (http://www.novell.com/documentation/ncs/orionenu/
data/h2mdblj1.html#hrt0ekvg)

When you cluster enable a volume, additional eDirectory objects are created:
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IMPORTANT: The default object names include the underscore (_) character. However, DNS 
name servers cannot resolve object names that include underscore characters. If you have met the 
requirements described in Section F.3.1, “Meeting System Requirements for Clustering,” on 
page 345, you can rename these objects as needed when you cluster enable the volume.

Cluster Enabling a Shared Volume

To cluster enable a shared volume for use with a ZENworks Server Management component:

1 Complete the steps in the applicable section of Novell Cluster Services Overview and 
Installation for your version of NetWare:

NetWare 6.5: Cluster-Enabling Shared Volumes for Use with ZfS Components (http://
www.novell.com/documentation/zfs302/zfs_install/data/aewf3me.html#aewfggh)
NetWare 6: Cluster Enable Pools and Volumes (http://www.novell.com/documentation/
ncs6p/orionenu/data/h2mdblj1.html#hrt0ekvg)
NetWare 5.1: Cluster-Enable Volumes (http://www.novell.com/documentation/ncs/
orionenu/data/h2mdblj1.html#hrt0ekvg)

2 If necessary, rename cluster-related objects to eliminate the underscore (_) characters that are 
included by default.

3 Repeat Step 1 and Step 2 above for the other shared volumes that need to be cluster-enabled for 
use with ZENworks Server Management components.

4 Install a ZENworks Server Management component in the cluster, following the instructions 
in:

Section F.4, “Installing Policy and Distribution Services and Server Inventory in a 
Cluster,” on page 347
Section F.5, “Installing Management and Monitoring Services in a Cluster,” on page 359

Object Object Name and Description

cluster_name_volume_name (default object name)
A new Volume object represents the cluster-enabled volume. It is created by renaming the 
original Volume object that was tied to a physical server and associating it with a virtual server 
instead.

For example, if your cluster name is “zfscluster” and your original volume name is “zfsvol1,” the 
new Volume object representing the cluster-enabled volume is named zfscluster_zfsvol1.

cluster_name_volume_name_SERVER (default object name)
A new Server object represents the virtual server to which the new cluster-enabled volume is 
tied.

Continuing with the above example, the new Server object representing the virtual server is 
named zfscluster_zfsvol1_server.

volume_name_SERVER.clustername (default object name)
A new Volume Resource object stores property information for the cluster-enabled volume. The 
Volume Resource object is created in the Cluster container object. 

Continuing with the above example, the new Volume Resource object is named 
zfsvol1_server.zfscluster.
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F.3.3  Installing Novell Cluster Services
Install Novell Cluster Services by following the instructions provided in NetWare Cluster Services 
Overview and Installation for your version of NetWare:

NetWare 6.5: Installing ZENworks for Servers in a Clustered Environment (http://
www.novell.com/documentation/zfs302/zfs_install/data/aetx4fj.html#aetx4fj)
NetWare 6: Installation and Setup (http://www.novell.com/documentation/ncs6p/orionenu/
data/hc8jxt45.html#hc8jxt45)
NetWare 5.1: Installation and Setup (http://www.novell.com/documentation/ncs/orionenu/data/
hc8jxt45.html#hc8jxt45)

The installation process includes:

Meeting hardware and software requirements for Novell Cluster Services
Setting up a shared disk system
Creating a new Cluster object to represent the cluster in eDirectory
Adding servers to the cluster
Installing the Novell Cluster Services software on all nodes in the cluster
Mounting the shared volumes where you install ZENworks Server Management components

As you install Novell Cluster Services, record key information about the cluster. You need the 
following information as you install ZENworks Server Management components in the cluster:

eDirectory tree where you create the Cluster object
Name of the Cluster object
Context of the Cluster object

F.4  Installing Policy and Distribution Services 
and Server Inventory in a Cluster

Section F.4.1, “Issues with Using ZENworks in a Cluster,” on page 347
Section F.4.2, “Installation Prerequisites,” on page 348
Section F.4.3, “Installation Steps,” on page 348
Section F.4.4, “Configuring Server Inventory,” on page 351
Section F.4.5, “Uninstalling or Reinstalling Server Inventory in a Cluster,” on page 351

F.4.1  Issues with Using ZENworks in a Cluster

Advantages

Configuring Policy and Distribution Services with Novell Cluster Services ensures high 
availability of Tiered Electronic Distribution
Installing a Distributor and Subscriber in a cluster ensures the transmission and reception of 
policies and software
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Installing the Inventory Agent in a cluster ensures reception of the hardware and software 
inventory information for the cluster nodes
Installing the Server Management database for distribution and policies information in a cluster 
ensures that the database is always available when the Distributor Agent and Policy/Package 
Agent need to log Distribution processing information
Installing the Inventory database in a cluster ensures that the database is always available when 
you need to access or report inventory information
For Policy and Distribution Services only, installing the Web components and supporting 
software in a cluster ensures that you can always monitor and manage the distribution process 
throughout your network

Disadvantages

Installing Policy and Distribution Services and the Inventory Agent on a cluster resource means 
that you can only manage the cluster node running that resource

F.4.2  Installation Prerequisites
Before you install and configure ZENworks 7 Server Management to run with Novell Cluster 
Services, make sure that all of the minimum hardware and software requirements for the respective 
products are met, including:

At least two NetWare® 6 or NetWare 6.5 servers (also called “nodes”) where Novell Cluster 
Services can be installed
Novell Cluster Services 1.6 installed and running on the NetWare 6 servers that are part of the 
cluster
Novell Cluster Services 1.7 installed and running on the NetWare 6.5 servers that are part of the 
cluster
A cluster volume created and cluster-enabled (this is called a virtual server or a cluster server)
For more information on clustering, see the Novell Cluster Services documentation (http://
www.novell.com/documentation).

F.4.3  Installation Steps
The installation program walks you through installing the Policy and Distribution Services software 
for Distributors, Subscribers, and the Policy and Distribution database, and installing the Server 
Inventory software.

You can install Policy and Distribution Services in a cluster in the following scenarios:

Install Policy and Distribution Services in a cluster
Install only the Subscriber software in a cluster and its object in the same tree where the Cluster 
object resides
Install both the Distributor and Subscriber software in a cluster with their objects in a different 
tree than where the Cluster object resides

In the latter two scenarios, the zfs-startup.xml file on the cluster volume must be edited to add 
the -hosts switch before you offline the cluster to bring up ZENworks Server Management 
(documented in Step 2 below).
 ZENworks 7 Server Management Installation Guide

http://www.novell.com/documentation


novdocx (en)  16 A
pril 2010
You can install any or all components of Server Inventory on a cluster node.

To install Policy and Distribution Services and Server Inventory to a cluster:

1 Follow the instructions provided in Section 6.1, “Installation on NetWare and Windows 
Servers,” on page 65, keeping in mind the following cluster-specific details:

In Step 2 on page 78, select the Cluster object, not the specific servers in the cluster.
You can also select non-clustered servers at the same time you are installing to a cluster.

IMPORTANT: In Cluster Ready, you can install only one instance of Policy and 
Distribution Services (one Distributor and/or one Subscriber) in a cluster because Policy 
and Distribution Services treats a cluster as if it is a single server. 

In Step 2 on page 86, specify an installation path on a cluster-enabled volume.

IMPORTANT: Do not use double-byte or extended characters in any part of an 
installation path, including a NetWare volume name.

The installation program installs the Policy and Distribution Services and Server Inventory 
software on the specified cluster-enabled volume. From that location, the Distributor Agent, 
Policy/Package Agent, and Server Inventory components can run on any of the nodes in the 
cluster. If the node where they are running goes down, they automatically fail over to another 
node in the cluster.
The installation program also updates the load and unload scripts associated with the Cluster 
object, which makes the failover/failback process possible.

IMPORTANT: Page faults, which could abend a NetWare server and cause the desired 
failover, is handled by the JVM, preventing a server from abending. To ensure that failover 
occurs when only ZENworks stops while the server continues to operate, you need to add the 
-neh parameter to the Java command line (covered in Step 3 below).

2 If you only installed a Subscriber to the cluster (its software to the cluster volume and its object 
into the same tree where the Cluster object resides), or you installed the Distributor and 
Subscriber software to the cluster volume, but their objects to a different tree than where the 
Cluster object resides, do the following:
2a Open the following file in a text editor:

Installation_path\zenworks\zfs-startup.xml

2b Search for the following class:
<Class>com.novell.application.zenworks.ted.TED</Class>

2c Edit the following parameter that is listed under the class:
<Parameter Name="Hosts" />

Change it to include the DNS hostnames or IP addresses of your hosts. For example:
<Parameter Name="Hosts">192.68.1.203</Parameter>

Note the addition of the closing </Parameter> code and the closing > character after the 
"Hosts" name. Your DNS hostnames and IP addresses go between the codes as shown 
above.
Do not list any that are bound to the server’s NIC card.
If you list more than one host, your list of DNS hostnames and IP addresses should be 
delimited by a semicolon (;). For example:
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<Parameter 
Name="Hosts">192.68.1.201;server002.provo.novell.com;192.68.1.203;192
.68.1.204;server005.provo.novell.com</Parameter>

You can mix DNS hostnames and IP addresses in the list.
2d Save your changes, then close the file.

3 This step is not applicable to the Inventory Agent.
In the text editor, edit the \zenworks\zfs.ncf file and insert the -neh parameter to change 
the line similar to the following from:
java -Xmx384M -envDISPLAY=127.0.0.1:0 -noclassgc -nsac -jszfsexit 
-snZENworks -classpath $tedpath 
com.novell.application.zenworks.loader.ZENLoader 
SYS:\zenworks\zfs-startup.xml

to
java -neh -Xmx384M -envDISPLAY=127.0.0.1:0 -noclassgc -nsac -jszfsexit 
-snZENworks -classpath $tedpath 
com.novell.application.zenworks.loader.ZENLoader 
SYS:\zenworks\zfs-startup.xml

then save your changes and exit the text editor.
4 If you previously installed Server Inventory in a ZENworks 7 Server Management cluster, do 

the following:
4a Open the cluster node unload script for editing.
4b If Sybase is installed, locate and change:

unload dbsrv8.nlm

to read:
unload dbsrv8.nlm <<y

The <<y automatically answers Yes to an unload question that requires a reply to continue.
4c Locate the Java -killzfsexit entry.
4d Insert the following before the above entry:

java -killzenWSInv

delay 8

4e On each cluster node server, open the sys:\system\startinv.ncf file and remove or 
comment out the following entry:
ZWSSTART

4f To configure Server Inventory, continue with Section F.4.4, “Configuring Server 
Inventory,” on page 351, then return to these steps.

5 To start the Server Management components for the first time, offline the cluster and then 
online it again.
This causes the clustering software to reread the updated load script and load the Server 
Management agents.

6 If you need to install Management and Monitoring Services in a cluster, continue with 
Section F.5, “Installing Management and Monitoring Services in a Cluster,” on page 359.
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F.4.4  Configuring Server Inventory
After you have completed the Server Inventory installation, you need to configure Server Inventory 
to work in the clustering environment. The following steps provide the configuration information 
that you need:

1 Configure the Inventory database object.
If you have selected Sybase* during Server Management installation, the installation program 
creates the Database object (Inventory database_server_name) and configures the 
properties of this object; therefore, skip Step 1a and Step 1b.
If you are using Oracle* or MS SQL, continue with Step 1a.
1a If you are maintaining the Inventory database in Oracle or MSSQL, ensure that you have 

created the Database object and configured the properties. For more information, see 
“Configuring the Inventory Database Object on a NetWare Server” on page 124.

1b To configure the Database object for a cluster environment, in ConsoleOne, right-click the 
Database object, click Properties, click ZENworks Database, browse for the DN (NCP 
Server object) of the virtual server or specify the IP address of the virtual server, then click 
OK.

2 If the standalone configuration is not selected during installation, then while creating the 
Database Location policy set Inventory database to Inventory 
database_virtual_server_name.

3 While creating the Server Inventory policy, set the Inventory Service object DN to Inventory 
Service_virtual_server_name.

4 To configure all Roll-Up policies, select the Inventory Service object of the cluster service 
(Inventory Service_virtual_server_name).
For further information on uninstalling or reinstalling Server Inventory in a clustered 
environment, see Section F.4.5, “Uninstalling or Reinstalling Server Inventory in a Cluster,” on 
page 351.

5 Return to Step 5 on page 350.

F.4.5  Uninstalling or Reinstalling Server Inventory in a Cluster
“Uninstalling ZENworks 7 Server Inventory in a Clustered Environment” on page 351
“Reinstalling Server Inventory in a Cluster” on page 358

Uninstalling ZENworks 7 Server Inventory in a Clustered Environment

The Server Inventory component of ZENworks Server Management cannot be uninstalled 
automatically. You must manually remove the Inventory server, the Inventory database running on 
Sybase, the Novell eDirectoryTM objects, Inventory agent, and the Server Inventory snap-in files for 
Novell ConsoleOne®.

NOTE: If your Inventory database is mounted on Oracle or MS SQL, follow the uninstall procedure 
recommended by Oracle or MS SQL, respectively.

You must remove the objects and the files from every server and workstation where the Server 
Inventory components are installed.
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In an enterprise deployment of Inventory, uninstall all Leaf Servers first, then proceed to uninstall 
Intermediate Servers, and finally the Root Server. Before uninstalling Server Inventory, make sure 
you have archived a reliable backup of the Inventory database residing at the Root Server.

To manually uninstall Server Inventory, proceed in the following order:

1. “Uninstalling the Server Inventory eDirectory Objects” on page 352
2. “Uninstalling the Database eDirectory Object” on page 353
3. “Uninstalling the Sybase Inventory Database” on page 353
4. “Uninstalling the Sybase Engine” on page 353
5. “Uninstalling the Inventory Agent” on page 354
6. “Uninstalling the Inventory Server Software” on page 354
7. “Uninstalling the XML Proxy Server” on page 356
8. “Uninstalling the Server Inventory Snap-Ins from ConsoleOne” on page 356
9. “Applying Changes to the Cluster Scripts” on page 357

Uninstalling the Server Inventory eDirectory Objects

To remove the ZENworks Server Management Server Inventory eDirectory objects:

1 On the NetWare Inventory server, stop the Inventory services by entering StopSer * at the 
server console prompt.

2 If the ZENworks Database policy is enabled, to disable it:
2a In ConsoleOne, right-click the Service Location Package object, click Properties, then 

click Policies.
2b Select the ZENworks Database policy, click Properties, then click the Inventory 

Management tab.
2c Delete the specified Inventory database entry, then click OK.

IMPORTANT: If the ZENworks Database policy is used by more than one Inventory 
server, you must uninstall those Inventory servers before performing this step. 

3 Disable the Server Inventory policy.
3a Right-click the Distributed Server Package, click Properties, click Policies, then click the 

General or NetWare tab.
3b If the Server Inventory policy is enabled, select the policy, click the Reset button, then 

click Yes.
3c Disable the Server Inventory policy.

If you have configured the Server Inventory policy for more than one operating system, 
select the operating system option from the Policies tab and repeat this step.

3d Click Apply, then click Close.
4 Disable the Roll-Up policy and the Dictionary Update policy, if the policies are enabled.

4a Right-click the Server Package, click Properties, click Policies, then click the NetWare 
tab.

4b If the Roll-Up policy is enabled, select the policy, click the Reset button, then click Yes.
4c Disable the Roll-Up policy.
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4d If the Dictionary Update policy is enabled, select the policy, click the Reset button, then 
click Yes.

4e Disable the Dictionary Update policy.
4f Click Apply, then click Close.

5 In ConsoleOne, locate the container holding the Inventory Service object and delete the object.

Uninstalling the Database eDirectory Object

In ConsoleOne, locate the container holding the Inventory database object and delete the Inventory 
database object.

Uninstalling the Sybase Inventory Database

1 Stop Sybase by entering q at the Sybase console prompt.
2 Delete the database_path\mgmtdb.db entry from sys:\system\mgmtdbs.ncf on each 

cluster node.

IMPORTANT: Do not delete other database paths.

3 Note the value of the INVDBPATH key in sys:\system\zenworks.properties on any of the 
cluster nodes.

4 From the value identified in the INVDBPATH key, delete the Inventory database files 
(mgmtdb*.db), including mgmtdb.log, on each cluster node.

IMPORTANT: Do not delete the database files if they contain ZENworks 7 Desktop 
Management Workstation Inventory information.

5 Delete the INVDBPATH key from sys:\system\zenworks.properties on each cluster node.
6 Delete the ZFS_INVENTORY_DATABASE_SERVER key.
7 Delete the following section from sys:\system\zenworks.properties on each cluster 

node:
[ZfS_Inventory_Database_Server]

Version = 7.0.Server_Management_product_build_date

Installed_From = Product CD

Support_Pack = 0

8 Start Sybase if it is not uninstalled and if it is used by other ZENworks products.
At the Sybase console prompt, enter mgmtdbs.ncf. 

Uninstalling the Sybase Engine

You can remove the Sybase engine only if it is not used by other ZENworks products.

1 If Sybase is used by other ZENworks products, you must uninstall the database first before 
proceeding to uninstall the Sybase engine.

2 Stop Sybase by entering q at the Sybase Console prompt.
3 Note the value of the DBENGINEPATH key in sys:\system\zenworks.properties on any of 

the cluster nodes.
4 Verify if the database is mounted on the database server.
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The sys:\system\mgmtdbs.ncf file on any cluster node has the .db entry if the database is 
mounted on the database server.

If the file contains the .db entry, do not continue to remove the Sybase engine.
Its presence means the Sybase engine is in use by other software.
If the file does not contain the .db entry, delete mgmtdbs.ncf from each cluster node.

5 Delete the mgmtdbs.ncf entry from the cluster load script on each cluster node.
6 Delete dbsrv8.nlm from the unload script.
7 Delete the directory specified in DBENGINEPATH (identified in Step 3).
8 Delete the DBENGINEPATH key from sys:\system\zenworks.properties on each cluster 

node.

Uninstalling the Inventory Agent

1 Execute the following commands at the server console prompt:
invagentstop.ncf

java -exit

2 Delete the following files from sys:\system on each cluster node:

hwinvsrc.ini

invaid.nlm

invsetup.ini

mpkscan.nlm

nwapi.bak

nwapi.map

smile.bak

smile.map

suppl.bak

suppl.map

3 Delete sys:\java\bin\invnatve.nlm on each cluster node.
4 Note the value of the ZENworksPath, PDSPath and the InvAgentPath keys in 

sys:\system\zenworks.properties on any of the cluster nodes.
5 Delete the Inventory Agent installation directory identified in the InvAgentPath key on each 

cluster node.
6 Delete invagentnw.jar from the PDSPath\smanager\plugins directory on each cluster 

node.
7 Delete the Inventory Agent key from the 

HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZFS registry entry on each cluster 
node.

8 In PDSPath\zfs.ncf, delete the following entry on each cluster node:
load sys:\\java\\bin\\invnatve

Uninstalling the Inventory Server Software

1 On the NetWare Inventory server, stop the Inventory service by entering StopSer * at the 
console prompt.
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2 Unload the java.nlm by entering java -exit at the NetWare Inventory server console.
3 Note the values of the INVSRVPATH and ZWSPATH keys in 

sys:\system\zenworks.properties on any of the cluster nodes.
4 Delete the ZFS_INVENTORY_SERVER key.

Delete the following section from sys:\system\zenworks.properties from each cluster 
node:
[ZfS_Inventory_Server]
Version = 7.0.build_date
Installed_From = Product CD
Support_Pack = 0

5 Delete the invsrvpath\scandir directory on each cluster node.
6 Delete the invsrvpath\server directory on each cluster node.
7 Delete the following entries from the cluster load script on each cluster node:

; ZENworks Inventory Settings

StartInv.ncf

8 Delete the following entries from the unload script:
java -killzenwsinv

java -killzwexit

9 Delete the following files from sys:\system directory on each cluster node:

addenums.ncf

dbexport.ncf

debug.properties

dupremove.ncf 
enumsmodifier.ncf

invenv.ncf

invenvset.ncf

listser.ncf

startinv.ncf

startser.ncf

startzws.ncf

stopdb.ncf

stopser.ncf

10 If Policy and Distribution Services and the XML Proxy server are not installed on the Inventory 
server, remove the ZENworks Web Server components by deleting the directory specified by 
the ZWSPATH key.
10a Delete the following entries from the cluster load script on each cluster node:

; ZENworks Inventory Settings

ZFS.ncf

10b Delete zwsstart.ncf from the sys:\system directory on each cluster node.
10c Delete the ZWSPATH key from sys:\system\zenworks.properties on each cluster 

node.
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10d Delete zws_volume:\zfs-startup.xml.
10e Delete zws_volume:\zenworks\zfs.ncf.

11 Delete the INVSRVPATH key from sys:\system\zenworks.properties on each cluster 
node.

Uninstalling the XML Proxy Server

1 Unload the java.nlm by entering java -killzfsexit at the server console prompt.
2 Note the value of the ZWSPATH in sys:\system\zenworks.properties on any of the cluster 

nodes.
3 Delete the following section from sys:\system\zenworks.properties on each cluster 

node:
[ZfS_XML_Proxy_Server]
Version=7.0.Server_Management_product_build_date
Installed_From = Product CD
Support_Pack = 0

4 Delete the following entries from the cluster load script on each cluster node:
; ZENworks Inventory Settings

ZFS.ncf

5 Delete zwsstart.ncf file from the sys:\system directory on each cluster node.
6 Delete the \zwspath directory and the ZWSPATH entry from 

sys:\system\zenworks.properties on each cluster node.
7 Delete zws_volume:\zenworks\zfs-startup.xml and zws_volume:\zenworks\zfs.ncf 

on each cluster node.

Uninstalling the Server Inventory Snap-Ins from ConsoleOne

Do not uninstall ConsoleOne itself if you are using it to manage other products.

To remove only the Server Inventory snap-ins from ConsoleOne:

1 Close ConsoleOne, if it is running.
If ConsoleOne is invoked directly from the Inventory server on multiple workstations, you 
must close ConsoleOne on all of these workstations.

2 Under the ConsoleOne_installation_directory\1.2 directory on your server or 
workstations, do the following:

Delete the following files (but not the directories):

bin\debug.properties

bin\directoryrights.dll

bin\ntgroups.ini

bin\userreports.ini

help\novellserverinv.hs

lib\zen\classes12.zip

lib\zen\dbexport.jar

lib\zen\dbexportres.jar

lib\zen\jconn2.jar

lib\zen\jdbcdrv.zip
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lib\zen\reportingimages.jar

lib\zen\smanager.jar

lib\zen\zenutility.jar

reporting\export\invxml.dtd

snapins\zen\dataexportsnapins.jar

snapins\zen\inventorysnapins.jar

snapins\zen\jgl3.1.0.jar

snapins\zen\policymigration.jar

snapins\zen\serversnapins.jar

snapins\zen\swdictionarysnapins.jar

snapins\zen\tableutilities.jar

snapins\zen\tracer.jar

Delete the following directories (but not the parent directories shown):

help\en\novell_zfs_server_inventory

reporting\canned\novell reporting\zeninventory

reporting\canned\novell reporting\zeninventory4x

3 If you have not installed the Remote Management ConsoleOne snap-ins on the same 
workstation or server, do the following:

Delete the following files (but not the directories):

\bin\desktop4.exe

\bin\desktop4.ini

\bin\mssql.ini

\bin\multprot.dll

\bin\ndsaccess.dll

\bin\oracle.ini

\bin\remagent.ini

\bin\sybase.ini

\lib\zen\commonsnapins.jar

\lib\zen\desktop.jar

\lib\zen\desktop3x.jar

\lib\zen\desktopcommonutility.jar

\lib\zen\desktoputil.jar

\lib\zen\statuslog.jar

\lib\zen\zeninvimages.jar

\snapins\zen\serversnapins.jar

Delete the \bin\zen\sybaseproxy directory.
4 Repeat Step 1 through Step 3 for each workstation or server where Inventory ConsoleOne 

snap-ins are installed.

Applying Changes to the Cluster Scripts

To apply changes to the cluster scripts, which you made in the previous sections, you must offline 
the cluster and then online it again.
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Reinstalling Server Inventory in a Cluster 

You might need to reinstall the Server Inventory component of Server Management Services in a 
cluster environment because it failed to install properly or because data corruption, such as an 
inadvertent file deletion, has occurred and the data can only be fixed by reinstalling.

IMPORTANT: Reinstallation does not require the schema to be extended again.

This section includes information that focuses on reinstalling the Server Inventory component:

“Preparing to Reinstall Server Inventory” on page 358
“Reinstalling Server Inventory” on page 358
“Determining if Reinstalling Server Inventory Was Successful” on page 358

Preparing to Reinstall Server Inventory

1 Identify the servers that need Server Inventory reinstalled.
2 Stop the Inventory database by pressing q at the NetWare Sybase console prompt.
3 If Java has not been unloaded on the target NetWare servers, unload java.nlm (at the server 

console, enter java -exit).

IMPORTANT: This command stops all Java processes running on the server. Verify that all 
Java processes can be stopped while you are installing Desktop Management.

4 Log in to the Novell eDirectoryTM tree that has the servers where you want to reinstall.
5 Continue with Section F.4, “Installing Policy and Distribution Services and Server Inventory in 

a Cluster,” on page 347.

Reinstalling Server Inventory

If you reinstall Server Inventory over a prior installation, ZENworks 7 Server Management Server 
Inventory uses the existing configured policies and the \scandir directory. 

On the File Installation Location page during reinstallation, the installation program searches 
for the previous installation path. If it is detected, the Server Inventory or Remote Management 
files is installed to the same path.
On the Database Installation Location page during a reinstallation, the installation program 
searches for the previous installation path. If it is detected, the database is installed to the same 
path.

Determining if Reinstalling Server Inventory Was Successful

1 After the installation has finished, review the installation log file to determine whether any 
components failed to install.

2 If you reinstalled to fix a file corruption or missing file problem, check to see if the problem is 
fixed.
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F.5  Installing Management and Monitoring 
Services in a Cluster
Before installing Management and Monitoring Services in a cluster, make sure that you can map to 
the cluster volume using the name of the virtual server for the cluster node that is using the Novell 
Client.

The installation program walks you through installing the Management and Monitoring Services 
software.

To install Management and Monitoring Services in a cluster:

1 Follow the instructions provided in Section 7.1, “Installation on NetWare and Windows,” on 
page 131, keeping in mind the following cluster-specific detail:

In Step 9 on page 132, choose the destination volume for the components from the 
Authenticated Tree option through the cluster virtual server. 
The DNS entry for the virtual server object must be there, or the hosts file in the 
\Windows folder needs to have an entry for the virtual server object for the cluster volume 
where you want to install.
If the same cluster volume is selected using the mapped drive option or by expanding the 
cluster node servers, then the install is considered to be a normal install and the system 
files are copied to all of the cluster nodes. Therefore the product only works on that node.

IMPORTANT: The NetWare Management Agent cannot be installed on a cluster volume 
because it is used to manage the cluster node servers. To manage all nodes, the Netware 
Management Agent needs to be present on all of the nodes. 

2 After installation in the cluster, manually add the following line to the cluster volume load 
script:
sys:\system\mmsstart.ncf

3 Manually add the following line to the cluster volume unload script:
sys:\system\mmsstop.ncf

4 Make sure that the following lines are present in the beginning of a cluster volume unload 
script:
sys:\system\mmsstop.ncf

unload dbsrv8.nlm

IMPORTANT: If you have already installed ZENworks 7 Server Inventory in a clustered 
environment, add the sys:\system\mmsstop.ncf line before the unload dbsrv8.nlm entry.

5 Ensure that the volume ID is less than 32 for NetExplorerTM to work. This is because of the 
BTRIEVE database restriction. To specify the volume ID, use the following command in the 
load script:
mount volume_name VOLID = volume_number 

6 You must install the Traffic Analysis Agent on the cluster volume only if all of the cluster 
nodes are on the same segment. If you do not, the agent does not provide consistent information 
when you change the cluster node. 
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If you are installing Traffic Analysis Agent or Management Site Server on the cluster shared 
volume, you must add sys:\system\mmsstart.ncf to the shared volume load script and 
sys:\system\mmsstop.ncf to the shared volume unload script.
When a shared volume is loaded on a node, the mmsstart.ncf file contains the information to 
start the Database, Naming Server, Discovery, and Sloader processes if the Management Site 
Server is installed, and information to start the Traffic Analysis Agent if the Traffic Analysis 
Agent is installed on that cluster-shared volume. When a shared volume is unloaded from a 
node, mmsstop.ncf contains the information to stop the Naming Server, Discovery, and 
Sloader processes, and to stop the Traffic Analysis Agent, depending on whether it is installed.
If you are installing the Traffic Analysis Agent on a shared volume, update the lanz.ncf file 
in the \zfs_agnt\lanz directory by adding the location where you want the trend files to be 
generated. For example:
load gtrend.nlm \dvolume_name:\directory
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GInstalling Additional Security for 
Non-Secured Connections

Novell® ZENworks® Server Management automatically uses XMLRPC (Extensible Markup 
Language Remote Procedure Call) for inter-server communications for Policy and Distribution 
Services. XMLRPC optionally provides security for inter-server communications across non-
secured connections.

This section documents how to install and set up this additional security. For more information and 
to determine whether you need XMLRPC security, see “Security for Inter-Server Communication 
Across Non-Secured Connections” in the Novell ZENworks 7 Server Management Administration 
Guide.

If you want to encrypt Distributions for Windows, Linux, or Solaris servers, you need to install NICI 
2.6.4 on those servers. For more information, see “Installing NICI 2.6.4” in the Novell ZENworks 7 
Server Management Administration Guide. However, if you already have NICI 2.4.6 installed, it is 
optional whether you upgrade to NICI 2.6.4, because these versions are compatible with each other.

To install and set up XMLRPC security, do the following in order:

1. Section G.1, “Fulfill the Installation Prerequisites,” on page 361
2. Section G.2, “Gather Information for Installation,” on page 362
3. Section G.3, “Install Inter-Server Communications Security,” on page 363
4. Section G.4, “Enable Inter-Server Communications Security,” on page 370

G.1  Fulfill the Installation Prerequisites
You must meet the following software prerequisites before installing inter-server communications 
security. Meeting these prerequisites might include installing or configuring software.

Prerequisites Explanation

ZENworks Server 
Management

Policy and Distribution Services must be installed and running.

For information on installing Policy and Distribution Services, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

Tomcat Tomcat 4 must be installed, with or without Apache. This provides the servlet 
gateway.

ZENworks Web 
Server

The Web server should be installed, configured correctly, and running. 

For information on installing the ZENworks Web Server, see Section 6.1.2, “Web-
Based Management for Policy and Distribution Services,” on page 96.

Novell iManager iManager must be installed and running somewhere in the network.

For information on installing iManager, see Section 4.3, “Management-Specific 
Workstation Requirements,” on page 42 for iManager installation instructions, and 
Section 6.1.2, “Web-Based Management for Policy and Distribution Services,” on 
page 96 for installing the ZENworks plug-ins to iManager.
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To sign a CSR, the requesting client must authenticate with a username and password. Because these 
are normally sent over the network in clear text, SSL should be used to keep this information secure.

Continue with Section G.2, “Gather Information for Installation,” on page 362.

G.2  Gather Information for Installation
You need to know the following information before running the Inter-Server Communications 
Security Installation Wizard:

TCP/IP address or DNS name of the machine running iManager
Port used by the Certificate Authority
This is the port number to use when communicating with iManager. If SSL is used, the port 
number is most likely 443. If you are not using SSL, use port 80 if Tomcat is integrated with a 
Web server, or 8080 if not.
Username and password for accessing iManager
This allows access to the Certificate Authority server’s signing functionality. If authentication 
fails, this user cannot continue with the inter-server communications security installation.
TCP/IP addresses or DNS names of all servers where you want to use inter-server 
communications security
You only need to sign the certificates for servers where you send encrypted Distributions.

IMPORTANT: For NetWare® servers, DNS names cannot have underscores. We recommend 
that you use dashes instead of underscores as word separators.

During installation you have three methods for obtaining valid IP addresses, one of which you 
can also use for obtaining DNS names. You can use one or all three of these methods to select 
your servers. The methods are:

List: Allows you to enter individual IP addresses or DNS names of servers where you 
want certificates signed, or a filename containing valid IP addresses or DNS names of the 
servers.
Wildcard: You can build a list of servers using wildcard characters. The asterisk (*) 
represents numbers from 0 - 999 in any IP address field, and the question mark (?) 
represents 0 - 9 in a single IP address number position within a field.
Range: You can build a list of servers using an IP address range.

More detail on using these options is provided in the installation steps.

IMPORTANT: The Inter-Server Communications Security Installation Wizard does not 
attempt to check whether any IP addresses you enter are valid. The wizard only builds a list of 
addresses for use when the wizard subsequently signs certificates for each machine matching 

Certificate 
Authority Installed

When installing the ZENworks plug-ins to iManager, you must select the Install the 
ZENworks Certificate Authority option so that this signing authority is available to 
sign the security certificates during installation of the additional Inter-Server 
Communications Security.

For information on installing the ZENworks plug-ins to iManager, see Section 6.1.2, 
“Web-Based Management for Policy and Distribution Services,” on page 96.

Prerequisites Explanation
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an IP address. If an IP address is invalid (not accessible by the workstation you are using), an 
error is given for that IP address. You must know which addresses are valid to prevent 
receiving certificate signing errors. The installation program gives you an option to stop and 
resolve the connection problem, or to just write the errors to an installation log so that you can 
review them later.
The installation program gives you an option to stop and resolve the connection problem, or to 
just write the errors to an installation log so that you can review them later. Therefore, you 
shoujld not run this installation unattended.

Continue with Section G.3, “Install Inter-Server Communications Security,” on page 363.

G.3  Install Inter-Server Communications Security
1 Make sure you have fulfilled the prerequisites (see Section G.1, “Fulfill the Installation 

Prerequisites,” on page 361) and gathered the information you need during installation (see 
Section G.2, “Gather Information for Installation,” on page 362).

2 On the server running iManager, start Tomcat if it is not running by entering tomcat4 at the 
server’s main console prompt.

3 Run the following executable from the Novell ZENworks 7 Server Management with Support 
Pack 1 Program CD:
\zfs\tedpol\sfiles\securityinstall\setup.exe

This starts the Inter-Server Communications Security Installation Wizard.

4 If you agree with the Software License Agreement, click Accept, then click Next to display the 
Certificate Authority Information page.
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5 Fill in the fields from the information you previously gathered:
DNS/IP address: Enter the TCP/IP address or DNS name of the server running the ZENworks 
Certificate Authority (where iManager is running).

IMPORTANT: For NetWare servers, DNS names cannot have underscores. We recommend 
that you use dashes instead of underscores as word separators.

Port: This is the port number to use when communicating with iManager. It is most likely 443 
if SSL is used. It can be 80 if Tomcat is integrated with a Web server, or 8080 if not.
Use SSL: By default, this check box is selected. Deselect to disable if you are not using SSL.
iManager username: Enter the iManager name (excluding context) of the user with rights to 
iManager. Installation halts if the username cannot authenticate. The username/password 
combination grants the user access to the Certificate Authority server’s signing functionality.
iManager password: Specify the iManager password of the user with rights to iManager.

6 When finished with the Certificate Authority Information page, click Next to display the Target 
Server Identification page.
If any information is invalid, the following dialog box is displayed:
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If this dialog box is displayed, click Yes to continue with the Target Server Identification page.

7 Click a radio button to use one of the following methods for selecting server IP addresses or 
DNS names:

List 
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You can make three types of entries in this field:
IP addresses of servers
DNS names of servers
Delimited ASCII file of server IP addresses and/or DNS names
For this option, you can access the following dialog box to fill in the field:

1. Browse for and select the delimited ASCII text file containing the list of IP 
addresses and/or DNS names that you previously created (see Section G.2, 
“Gather Information for Installation,” on page 362).

2. Click the down arrow button for the File Delimiter field.
You can use only one of the following delimiter characters in the text file that 
lists your servers’ addresses:

semicolon (;)
colon (:)
comma (,)
forward slash (/)
backslash (\)
pipe (|)
carriage return
carriage return line feed
tab

3. Select the character (which must be valid for the whole file).
4. Click OK.

All of the addresses contained in the text file are available to add into the Target 
servers list box.

IMPORTANT: For NetWare servers, DNS names cannot have underscores. We 
recommend that you use dashes instead of underscores as word separators.

In the Target servers list box, you can remove unwanted IP addresses and DNS 
names from those that you import from the file.

Wildcard 
You can use the multiple-character (*) or single-character (?) wildcards in any IP address 
field. Any numbers you enter are exactly matched.
The * wildcard character can only be used by itself in a field, meaning any number from 0 
to 255 is matched. You cannot use the * and ? wildcard characters in the same field.
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The ? wildcard character can be used in place of a number, and any number found between 
0 and 9 is considered a match. However, the ? character cannot be used consecutively. For 
example, ?3, 3?, 3?3, ?3?, ?33, and 33? are all valid; but, ??3 and 3?? are not valid.
For example:
10.1?.10.*

could return the following IP addresses:

10.10.10.0 through 10.10.10.255
10.11.10.0 through 10.11.10.255
10.12.10.0 through 10.12.10.255
10.13.10.0 through 10.13.10.255
and so on, where the two uses of 10 are exactly matched, 1? matches any numbers from 
10 through 19, and * matches any numbers from 0 through 255.
In the Target servers list box you can remove unwanted IP addresses from the list that you 
create using wildcard characters.
Range 
Specify an IP address range. Wildcards cannot be used with this method.
All servers having IP addresses within the given range are available for adding to the list.
In the Target servers list box you can remove unwanted IP addresses from the list that you 
create using a range.

Any server having an IP address matching the patterns you provide is available for adding to 
the list.

8 Click Add servers to add your selected servers to the Target servers list box.
If you see IP addresses in the list that you do not want to include, select the IP addresses, then 
click Remove. You can use the Ctrl and Shift keys to select multiple addresses for removal.

9 Repeat Step 7 and Step 8 as necessary for each method you use to add servers to the list.
You can use all three methods, one at a time, to fill in the Target servers list box.

10 Click Next when finished adding your servers’ IP addresses to the list box to view the Summary 
page.
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11 Select the Pause signing when necessary to display messages and report errors check box if 
you want to view detailed messages as signing errors are encountered.
This causes the process to pause on an error. You can then click the View Log button to review 
the error information. The log also lists information for each success. It is stored as 
\zfs\security.txt in the user’s home directory (such as c:\documents and 
settings\administrator) on the workstation being used to install the security.

12 On the Summary page, review the IP addresses and DNS names listed for correctness.
To make changes, click Back.
If you click Cancel here, the information you gathered on the Target Server Identification page 
is not saved.
For servers where an error is encountered, the information is listed in a log file so that you can 
rerun the wizard for those servers. To view the log file, click View log on the Certificate 
Signing page.

13 To begin signing the certificates on each listed server, click Finish.
Signing is done sequentially, one server at a time. The signing progress is displayed for each 
server, as shown in the following examples:
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14 If you receive a general I/O error for an instance of iManager running on a Linux or Solaris 
server, in order for that instance of iManager to use XMLRPC and to continue the installation 
program, do the following to set the correct permissions:
14a To set the group on the \security directory to be “novlwww,” enter the following shell 

command on the server where iManager is running:
chown root:novlwww /opt/novell/java/jre/lib/security

14b To verify that the permissions are set correctly, enter:
chmod 775 /opt/novell/java/jre/lib/security

Certificate signing continues.
15 One of two dialog boxes is displayed during or at the conclusion of certificate signing:

Continue: This dialog box is displayed if the Pause signing when necessary to display 
messages and report errors option is selected and an error is encountered. The following 
options are available:

Button to Click Result

Back Allows you to make corrections to previous wizard pages, visit the server to fix 
the problem, then click Finish to continue.

No Returns you to the Certificate Signing page, where you can view the error 
information for the offending server by clicking the View log button.

Yes Just logs the error and continues with signing the rest of the certificates.
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Certificate signing progress: This dialog box indicates that the signing session has 
completed. It indicates whether there are errors. The following options are available:

IMPORTANT: If you click Cancel before all servers have had their certificates signed, the 
signing process stops and does not finish. However, the certificates for all servers processed so 
far remain signed.

16 If you selected to view the installation error log, it is displayed in your default text file viewer:

After all certificates have been signed, servers with a certificate signed by this Certificate 
Authority are able to communicate securely with each other across non-secured connections, 
but only after enabling the security.

17 To enable the security, continue with Section G.4, “Enable Inter-Server Communications 
Security,” on page 370.

G.4  Enable Inter-Server Communications 
Security
After you have exited the Inter-Server Communications Security Installation Wizard, create and 
distribute a Text File Changes policy that is used to enable the security. To create and distribute the 
policy, complete the following in order:

1. “Creating a Text File Changes Policy for Enabling Inter-Server Communications Security” on 
page 371

2. “Distributing the Text File Changes Policy” on page 371

Button to Click Result

No Both the dialog box and the wizard are exited.

Yes Accesses the Log window, where you can do the following:

Click Save to save the log file for future use. It lists all machines that are 
processed, including information for both successes and failures in 
signing certificates.

Click Close to exit both the dialog box and the wizard.
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G.4.1  Creating a Text File Changes Policy for Enabling 
Inter-Server Communications Security

1 In ConsoleOne®, right-click the container where you want the Policy Package object stored, 
click New, then click Policy Package.
This starts the Policy Package Wizard.

2 Under Policy Packages, select Distributed Server Package, then click Next.
3 Name the package, then click Next.

Make the package name unique to identify its purpose.
4 Click Define Additional Properties, then click Finish.
5 Click the Policies > General tab, then click Add.

This policy can apply to any platform.
6 In the Add Policy dialog box, click Text File Changes, enter a name for the policy, then click 

OK.
The new policy is enable and automatically selected.

7 Click Properties.
The Text File Policy tab is displayed.
Because the security=false line could exist, you need to create two text file changes in order 
to effectively change security from false to true. This is accomplished in the next two steps.

8 Click Add, then do the following:
8a Enter  sys:\zenworks\zws\zws.properties in the Filename field.
8b Replace the “Change #1” text that defaults with a descriptive change tag; for example, 

Delete Security Line.
8c In the Change Mode field, select Search File.
8d In the Search Type field, select Entire Line.
8e In the Search String field, enter security=false.
8f In the Result Action field, select Delete Line.

9 Click the down arrow button for the drop-down field next to the Add button, select Change, 
click Add, then do the following:
9a Replace the “Change #2” text that defaults with a descriptive change tag; for example, 

Append Security Line.
9b In the Change Mode field, select Append to File.
9c In the New String field, enter security=true.

This string is case sensitive.
10 Click OK to save the policy, then click OK to exit.
11 Continue with Section G.4.2, “Distributing the Text File Changes Policy,” on page 371.

G.4.2  Distributing the Text File Changes Policy
1 In ConsoleOne, right-click your TED container, click New > Object, select TED Distribution, 

then click OK.
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2 Enter the Distribution’s name.
Make the Distribution’s name unique to identify its purpose.

3 Browse for the Distributor object, click Define Additional Properties, then click OK.
4 Click the Type tab, in the Select Type drop-down box, select Policy Package, then click Add.
5 Browse for the policy package you created in Section G.4.1, “Creating a Text File Changes 

Policy for Enabling Inter-Server Communications Security,” on page 371, click Select, then 
click OK.

6 Click the Schedule tab, click the arrow for the drop-down box of the Schedule Type field, select 
Run Immediately, then click OK.
This schedule type causes the Subscriber to extract the Distribution and enforces the policy as 
soon as it is received.

7 Click the Channel tab, click Add, browse for the Channel, click Select, then click OK.
Make sure the Channel is listed as Active in the Channels list.

8 When finished configuring the Distribution, click OK.
You are prompted to resolve the certificates.

9 Click Yes to resolve the certificates.
This copies the security certificates from the Distributor to the Subscribers that are subscribed 
to the Channel.

IMPORTANT: If you have Linux or Solaris Subscribers and do not have drives mapped from 
your workstation to those servers, you must resolve certificates to those servers manually. For 
more information, see “Resolving Certificates” in the Novell ZENworks 7 Server Management 
Administration Guide.

After the Text File Changes policy Distributions are sent, received, and extracted on each target 
server, inter-server communications security is in effect.
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HInstallation Error Messages

During installation of Novell® ZENworks® 7 Server Management components, you might receive 
an error message if a ZENworks Server Management component cannot be installed successfully. 
This section provides information for resolving any error messages you might receive while 
installing ZENworks Server Management components.

Select the ZENworks Server Management component that you are trying to install:

Section H.1, “Novell eDirectory Schema Extension Errors,” on page 373
Section H.2, “Policy and Distribution Services Installation Errors on NetWare and Windows 
Servers,” on page 373
Section H.3, “Policy and Distribution Services Installation Errors on Linux or Solaris Servers,” 
on page 377
Section H.4, “Policy and Distribution Services Web Component Installation Errors,” on 
page 382
Section H.5, “Server Inventory Installation Errors,” on page 383
Section H.6, “Remote Management Installation Errors,” on page 419
Section H.7, “Management and Monitoring Services Installation Errors,” on page 423

H.1  Novell eDirectory Schema Extension Errors
Before installing a ZENworks Server Management component, you must extend the Novell 
eDirectoryTM schema to accommodate the new objects used by the ZENworks Server Management 
component that you want to install. If the schema extension is not successful, the installation 
program logs an error message in the c:\winnt\zwschema.log file.

Contact Novell Support (http://support.novell.com) if you cannot extend the schema successfully.

H.2  Policy and Distribution Services Installation 
Errors on NetWare and Windows Servers
If the Policy and Distribution Services installation is not successful on NetWare® or Windows 
servers, the installation program logs an error message in the c:\temp\_resn.log file:

A target directory installation_path could not be created
Failed to create object.context in tree: eDirectory_error_code
Failed to set rights for object_DN in tree: eDirectory_error_code
Setup found no space to copy files on server
Setup found the JVM loaded on the server (NetWare)
The file in installation_directory is read-only
Unable to allocate the memory required to complete the copy file process
Unable to copy the requested file
Unable to open the input file
Unknown cause of error
Installation Error Messages 373

http://support.novell.com


374 Novell

novdocx (en)  16 A
pril 2010
Unspecified error occurred while copying files

A target directory installation_path could not be created

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program cannot create the installation directory you specified.

Possible Cause: You specified an invalid path.

Action: Make sure that the path you specified is appropriate to the platform where you 
are installing Policy and Distribution Services.

Possible Cause: You are logged in as a user who does not have sufficient access rights to the 
location where you want to create the installation directory.

Action: See Section 3.1, “Installation User Rights,” on page 33 and make sure you are 
logged in as a user that meets the specified requirements.

Failed to create object.context in tree: eDirectory_error_code

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program is unable to create a Distributor, Subscriber, or 
ZENworks Database object.

Possible Cause: eDirectory is not responding to the installation program as expected.

Action: Look up the eDirectory error code in Novell eDirectory Error Codes (http://
www.novell.com/documentation/lg/ndsedir/index.html).

Failed to set rights for object_DN in tree: eDirectory_error_code

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program was unable to correctly set rights on an eDirectory 
object.

Possible Cause: You are logged into eDirectory as a user that does not have sufficient rights to 
modify the root of the tree.

Possible Cause: You are logged into eDirectory as a user that does not have sufficient rights to 
modify a Server object.

Action: See Section 3.1, “Installation User Rights,” on page 33 and make sure you are 
logged in as a user that meets the specified requirements.

Action: On a NetWare server, authenticate to the tree where the Distributor object is 
located, then manually set the password on the Distributor object using the 
command:

SETPASS distributor_object.context password

Use all lowercase for the password. Make sure that the Distributor object is a 
trustee of the root of the tree.
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Possible Cause: You are installing Policy and Distribution Services in a very large Novell 
eDirectory tree. The installation program was unable to set rights on one or 
more Subscriber objects.

Action: After the installation, in ConsoleOne®, manually make each Subscriber object 
where rights are not set a trustee of the Server object.

Action: Look up the eDirectory error code in Novell eDirectory Error Codes (http://
www.novell.com/documentation/lg/ndsedir/index.html).

Setup found no space to copy files on server

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program has detected that a server where you want to install 
ZENworks Server Management software does not have sufficient disk space 
for a successful installation.

Action: Review the system requirements in Chapter 5, “Server Requirements,” on 
page 45 for the ZENworks Server Management components you are installing.

Action: If you are installing multiple components at one time, be sure to add up the 
total disk space requirements for all components being installed together on 
the same server.

Schema is not extended on the tree tree_name

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare servers.

Explanation: The installation program creates the Distributor and/or Subscriber objects in 
the eDirectory tree when you install the Policy and Distribution Services 
software. The eDirectory schema must be extended to accommodate Tiered 
Electronic Distribution objects before you begin the installation.

Possible Cause: You are trying to install Policy and Distribution Services without extending the 
schema first.

Action: Follow the instructions in Chapter 6, “Policy-Enabled Server Management 
Installation,” on page 65. 

Setup found the JVM loaded on the server (NetWare)

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare servers.

Explanation: The installation program has detected that Java is running on a target NetWare 
server. The installation program cannot update the Java files on that server if 
they are in use by a running program.

Action: At the NetWare server console, enter java -exit to stop Java, then continue 
with the installation.

The file in installation_directory is read-only

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.
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Explanation: The installation program cannot copy a file over a file with the same name that 
is read-only. 

Possible Cause: After a previous installation of Policy and Distribution Services, someone has 
marked one or more files in the installation directory as read-only.

Action: In Windows Explorer, right-click the read-only file, click Properties, then 
deselect the Read-Only attribute.

Action: Delete the previous installation and start the installation over again.

Unable to allocate the memory required to complete the copy file process

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program has insufficient memory to run successfully.

Action: Exit some other programs to free up memory on your workstation for use by 
the installation program.

Unable to copy the requested file

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program could not copy a file to the installation directory.

Possible Cause: Unknown.

Action: Delete the unsuccessful installation, review the system requirements and 
installation instructions provided in Section 6.1, “Installation on NetWare and 
Windows Servers,” on page 65, then repeat the installation. 

Unable to open the input file

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program has encountered a problem with the file that it is 
trying to copy.

Possible Cause: The Novell ZENworks 7 Server Management with Support Pack 1 Program 
CD is damaged.

Action: Obtain a usable CD.

Possible Cause: You copied the contents of the Program CD to a location on your network and 
the copy is somehow different from the original CD.

Action: Copy the CD again, then repeat the installation.

Unknown cause of error

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program has encountered a problem for which no specific 
error message is provided.

Action: Contact Novell Support (http://support.novell.com).
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Unspecified error occurred while copying files

Source: ZENworks Server Management; Policy and Distribution Services installation 
on NetWare and Windows servers.

Explanation: The installation program has encountered a problem while copying files for 
which no specific error message is provided.

Action: Contact Novell Support (http://support.novell.com).

H.3  Policy and Distribution Services Installation 
Errors on Linux or Solaris Servers
If the Policy and Distribution Services installation is not successful on a Linux or Solaris server, the 
installation script logs an error message in the /var/log/ZFSinstall.log file:

Copy failed file_name
Could not change the access rights of /var/opt/novell/zenworks/zfs/smanager/ZWSSRV.sh
Could not change the access rights of /var/opt/novell/zenworks/zfs/pds/ted/TEDSRV.sh
Could not print to /var/opt/novell/zenworks/zfs/smanager/ZWSSRV.sh
Could not print to /var/opt/novell/zenworks/zfs/pds/ted/TEDSRV.sh
Could not print to /var/opt/novell/zenworks/zfs/pds/xConf
The installation was aborted because the DS object wasn’t created
The package ZFSTed has already been installed
The package ZFSTed-0.1-1.i386 failed to install
The RPM ZFSTed-0.1-1.i386 failed to install
The schema needs to be extended on this tree
The subscriber DS object needs to be created manually
Unable to create the shell script /var/opt/novell/zenworks/zfs/pds/ted/TEDSRV.sh
Unable to create the XML configuration file
Unable to open log file
Unable to open the TED configuration file /var/opt/novell/zenworks/zfs/pds/ted/tedconf
You attempted to install to a non-Linux or SunOS platform

Copy failed file_name

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script could not copy one file.

Possible Cause: Unknown.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114.

Action: Contact Novell Support (http://support.novell.com).

Could not change the access rights of /var/opt/novell/zenworks/zfs/smanager/
ZWSSRV.sh

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.
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Explanation: The installation script must set the access rights on a customized version of the 
zwssrv.sh file during installation. It was unable to do so.

Possible Cause: You are not logged in to the server as root.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114.

Action: Contact Novell Support (http://support.novell.com).

Could not change the access rights of /var/opt/novell/zenworks/zfs/pds/ted/
TEDSRV.sh

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script must set the access rights on a customized version of the 
tedsrv.sh file during installation. It was unable to do so.

Possible Cause: You are not logged in to the server as root.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114.

Action: Contact Novell Support (http://support.novell.com).

Could not print to /var/opt/novell/zenworks/zfs/smanager/ZWSSRV.sh

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script must write to a customized version of the zwssrv.sh 
file during installation. It was unable to do so.

Possible Cause: You are not logged in to the server as root.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114.

Action: Contact Novell Support (http://support.novell.com).

Could not print to /var/opt/novell/zenworks/zfs/pds/ted/TEDSRV.sh

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script must write to a customized version of the tedsrv.sh file 
during installation. It was unable to do so.

Possible Cause: You are not logged in to the server as root.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114.

Action: Contact Novell Support (http://support.novell.com).

Could not print to /var/opt/novell/zenworks/zfs/pds/xConf

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.
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Explanation: The installation script must write to a customized version of the XML 
configuration file during installation. It was unable to do so.

Possible Cause: You are not logged in to the server as root.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 1141.

Action: Contact Novell Support (http://support.novell.com).

The context container_object does not exist

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script needs to create the Distributor and/or Subscriber objects 
in the eDirectory tree when you install the Policy and Distribution Services 
software. It could not locate the container object where you specified to create 
the objects.

Possible Cause: You typed the context information incorrectly when you specified the 
Distributor or Subscriber object as you edited the Tiered Electronic 
Distribution configuration file.

Action: When the installation script gives you the opportunity to reconfigure, verify 
the object context that you specified in the Tiered Electronic Distribution 
configuration file.

Action: Use ConsoleOne to verify that the container object does exist.

The installation was aborted because the DS object wasn’t created

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script needs to create the Distributor and/or Subscriber objects 
in the eDirectory tree when you install the Policy and Distribution Services 
software. It was unable to do so.

Possible Cause: The installation script cannot access eDirectory because you are not logged in 
to eDirectory.

Action: Log in to eDirectory, then restart the installation.

Possible Cause: You are logged in to eDirectory as a user that does not have sufficient rights to 
create eDirectory objects in the selected context.

Action: Review the rights listed in Section 3.1, “Installation User Rights,” on page 33, 
log in to eDirectory as a user with appropriate rights in the selected context, 
then restart the installation.

Possible Cause: You typed the tree name incorrectly when you edited the Tiered Electronic 
Distribution configuration file.

Action: When the installation script gives you the opportunity to reconfigure, verify 
the tree name you specified in the Tiered Electronic Distribution configuration 
file.

Possible Cause: You incorrectly typed the name of the server that holds a replica of the tree 
when you edited the Tiered Electronic Distribution configuration file.
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Action: When the installation script gives you the opportunity to reconfigure, verify 
the server name you specified in the Tiered Electronic Distribution 
configuration file.

Possible Cause: The server that holds the replica of the tree is currently down.

Action: Contact the administrator of that server.

The package ZFSTed has already been installed

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: A package can only be installed once. 

Possible Cause: A problem occurred during package installation that kept it from installing 
completely. You need to install the package again so that it can run 
successfully to completion.

Possible Cause: You want to reinstall for some other reason.

Action: Follow the instructions in Section 21.4, “Uninstalling the Software on Linux 
and Solaris Servers,” on page 289.

The package ZFSTed-0.1-1.i386 failed to install

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Solaris servers.

Explanation: On Solaris, the installation script uses the pkgadd command to install the 
program files. The pkgadd command has failed and the installation script has 
returned a Solaris error message.

Action: Resolve the Solaris error, then repeat the installation.

The RPM ZFSTed-0.1-1.i386 failed to install

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux servers.

Explanation: On Linux, the installation script uses the Red Hat Package Manager (RPM) to 
install the program files. RPM has failed and the installation script has 
returned a Linux error message.

Action: Resolve the Linux error, then repeat the installation.

The schema needs to be extended on this tree

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script creates the Distributor and/or Subscriber objects in the 
eDirectory tree when you install the Policy and Distribution Services software. 
The eDirectory schema must be extended to accommodate Tiered Electronic 
Distribution objects before you begin the installation.

Possible Cause: You have not yet extended the eDirectory schema for Tiered Electronic 
Distribution objects.
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Action: Follow the instructions in “Extending the Schema” on page 69, then rerun the 
installation.

The subscriber DS object needs to be created manually

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script was unable to create the Subscriber object for the Linux 
or Solaris server in eDirectory.

Action: Create the Subscriber object manually. In ConsoleOne, right-click the 
container where you want to create the Subscriber object, click New > Object, 
double-click TED Subscriber, then click OK. Configure the Subscriber object 
as needed. See “Configuring Subscribers” in the Novell ZENworks 7 Server 
Management Administration Guide.

The tree tree_name does not have the latest ZENworks Server Management schema 
extensions

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script creates the Distributor and/or Subscriber objects in the 
eDirectory tree when you install the Policy and Distribution Services software. 
The eDirectory schema must be extended to accommodate Tiered Electronic 
Distribution objects before you begin the installation.

Action: See “The schema needs to be extended on this tree” on page 380.

Unable to create the shell script /var/opt/novell/zenworks/zfs/pds/ted/TEDSRV.sh 

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script must create a customized version of the tedsrv.sh file 
during installation. It was unable to do so.

Possible Cause: You are not logged in to the server as root.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114.

Action: Contact Novell Support (http://support.novell.com).

Unable to create the XML configuration file

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script must record eDirectory object information in the XML 
configuration file (/var/opt/novell/zenworks/zfs/pds/xConf), which it 
passes to the program that creates the Policy and Distribution Services 
eDirectory objects. It was unable to do so.

Possible Cause: You are not logged in to the server as root.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114.
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Action: Contact Novell Support (http://support.novell.com).

Unable to open log file

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: The installation script must write installation information to /var/opt/
novell/log/zenworks/zfs302nstall.log. It was unable to do so.

Action: Follow the instructions provided in Section 6.3, “Installation on Linux and 
Solaris Servers,” on page 114.

Action: Contact Novell Support (http://support.novell.com).

Unable to open the TED configuration file /var/opt/novell/zenworks/zfs/pds/ted/
tedconf

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: the tiered electronic distribution configuration file /var/opt/novell/
zenworks/zfs/pds/ted/tedconf is created automatically by the installation 
script but is missing for some reason when the installation script needs to 
access it.

Action: Follow the instructions in Section 21.4, “Uninstalling the Software on Linux 
and Solaris Servers,” on page 289 to remove the current installation, then 
perform the installation again.

Action: Contact Novell Support (http://support.novell.com).

You attempted to install to a non-Linux or SunOS platform

Source: ZENworks Server Management; Policy and Distribution Services installation 
on Linux or Solaris servers.

Explanation: You can install Policy and Distribution Services only on the types of Linux or 
Solaris listed in Section 5.3.4, “Linux and Solaris Server Requirements,” on 
page 51.

Action: Install Policy and Distribution Services on a supported Linux or Solaris 
platform.

H.4  Policy and Distribution Services Web 
Component Installation Errors
If the Policy and Distribution Services Web components installation is not successful, the 
installation program logs an error message in the c:\temp\_resn.log file:

Novell iManager is not installed at directory
Tomcat directory does not exist

Novell iManager is not installed at directory

Source: ZENworks Server Management; Policy and Distribution Services Web 
components installation.
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Explanation: The installation program requires a valid iManager installation before you can 
install the Web components.

Possible Cause: You have not yet installed iManager.

Action: Follow the instructions at the Novell Documentation Web site (http://
www.novell.com/documentation/lg/imanager20/index.html).

Tomcat directory does not exist

Source: ZENworks Server Management; Policy and Distribution Services Web 
components installation.

Explanation: The installation program cannot locate the directory you specified.

Possible Cause: You typed the Tomcat installation directory path incorrectly.

Action: Browse to the path instead of typing it.

H.5  Server Inventory Installation Errors
If the Server Inventory components installation is not successful, the installation program logs one 
of the following error messages in the log files located at:

Installing on NetWare or Windows: c:\documents and settings\administrator\local 
settings\temp

801: The installation program was unable to rename filename on the server server_name. Filename 
may be in use

804: Unable to add the startinv.ncf entry in the filename file on the server server_name
807: Unable to assign rights to the SCANDIR directory on server server_name
812: Unable to create the password for the Service object Inventory_Service_object_name
813: Unable to get the volumes on the server server_name
814: An internal error occurred while getting the volumes on the server server_name
817: An internal error occurred while creating rights for the scandir directory on the server 

server_name
819: Unable to create the configuration property file on the server server_name
826: Unable to load the mgmtdbs.ncf file on the server server_name
831: Unable to add the mgmtdbs.ncf entry in the filename on the server server_name
836: The installation program creates a new mgmtdbs.ncf file. The installation program was unable 

to rename the existing mgmtdbs.ncf file on the server server_name. Rename mgmtdbs.ncf before 
proceeding with the installation

837: Unable to create the TracerMedia property file on the server server_name
874: Unable to create the Service Manager as a service on Windows NT/ Windows 2000/ Windows 

Server 2003 server_name
875: Unable to get the path for the shared directory where database is installed on server 

server_name
876: Unable to create the Sybase service on the Windows NT/ Windows 2000/ Windows Server 

2003 server_name
887: An internal error occurred while creating the database object object_name on the server 

server_name
1051: Unable to write the JRE path to javadir.bat on server server_name
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1052: Unable to create the filename file on the server server_name
1053: Unable to get the path for the Share share_name on the server server_name
1060: Unable to add the STOPSER * entry in the filename file for the server server_name
1061: Unable to add the UNLOAD DBSRV8.NLM entry in the sys:\system\invstop.ncf on the 

server server_name
1066: Unable to assign public rights to ODBC parameters of the Database object 

database_object_name
1071: Input-output error occurred while modifying the existing mgmtdbs.ncf for the server 

server_name
1080: Unable to create Inventory Service object for the server server_name
1081: Unable to assign supervisor privileges to the Service object service_object_name
1082: Unable to assign Inventory Service object as trustee of the NCP server server_name
1084: Unable to initialize zwinstal.dll
1087: Unable to detect the operating system of the workstation where install is running
1088: An internal error occurred while checking for entry in file filename on the server server_name
1089: Unable to get LDAP port number for the server server_name
1091: Unable to create the zwsenv.ncf file on the server server_name
1092: Unable to append entries to the zwssrv.cfg file on the server server_name
1093: Unable to append entries to the zws.properties file on the server server_name
1094: Unable to modify Inventory Service object for the server server_name
1095: Unable to create the invenvset.ncf file on the server server_name
1097: Unable to modify mgmtdbs.ncf on server server_name
1098: Unable to create mgmtdbs.ncf on server server_name
1102: Unable to set the Inventory installation path on server server_name
1104: Unable to set the ZENworks Web Server installation path on server server_name
1105: An input-output error occurred while reading the zenworks.properties file, for the server 

server_name. The previous installations of the Inventory server could not be detected
1106: Unable to detect a valid database installation on server server_name
1107: The installation path for Inventory components on server server_name is invalid
1118: Unable to create query.properties on the server server_name
1121: Unable to rename the database object old_database_object_name to 

new_database_object_name, on the server server_name
1122: Unable to modify the database object on the server server_name
1123: Failed to update load and unload scripts on the server server_name
1124: Unable to remove old Inventory entries from the autoexec.ncf file on server server_name
1125: Unable to create the database object database_object_name on the server server_name
1128: Unable to add the Zenworks Web Server entry in file filename, on the server server_name
1129: Unable to set the ZENworks installation path on server server_name
1130: Unable to set the database engine installation path on server server_name
1131: Unable to set the Inventory database installation path on server server_name
1133: Unable to configure SSL on the server server_name
1135: The install path for XML Proxy components on server server_name is invalid
1137: Unable to add Inventory entries to the load script on the server server_name
1138: Unable to add Inventory entries to the unload script on the server server_name
1139: Unable to add database entries to the load script on the server server_name
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1140: Unable to add database entries to the unload script on the server server_name
1143: Unable to retrieve the path where Inventory was installed for server server_name
1148: Unable to create ZENworks Web Server as a service on Windows NT/2000 server 

server_name
1149: Unable to add the ZENworks Web Server path to invenvset.bat on the server server_name
1150: Unable to add ZENworks Web Server entry to the load script on server_name
1151: Unable to add ZENworks Web Server entry to the unload script on server_name
1153: Unable to add Inventory entries to the password.txt file on the server server_name
1154: Unable to add the password.txt file path entry to zws.properties file on the server server_name
1156: Unable to add the SSL entry to filename file on the server server_name
1157: Unable to modify the LDAP Allow Clear Text Password attribute of the LDAP Group object 

of the server server_name
1160: Unable to replace entry1 with entry2, in the file filename
1161: A previous installation of Policy and Distribution Services has been detected on server 

server_name. Install cannot start Inventory service automatically. Start Policy and Distribution 
Services and then the Inventory Service

1162: An incomplete installation of the Inventory server was detected on server server_name. Please 
reinstall the Inventory server

1163: Unable to start the ZENworks Web Server on server server_name. For more information, see 
the error message documentation

1164: Unable to start the Inventory service on server server_name. For more information, see the 
error message documentation

1166: Unable to create zwssearch.ncf file on the server server_name
1167: Unable to add a search path to the ZENworks Web Server on server server_name
1168: Unable to write version information to the registry on the server server_name
1169: Unable to remove the old Inventory entries from file filename, on server server_name
1170: Unable to add entries to the zenworks.properties file, on server se rver_name
1171: Unable to add the ZENworks Web Server entries to the file filename, on the server 

server_name
2701: Unable to create the zwsstart.ncf file on the server server_name
2702: Unable to remove the entries from the load script on the server server_name
2703: Unable to remove the entries from the unload script on server server_name
2704: Unable to append entries to zws.ncf file on the server sever_name
2707: Unable to create dbconfig.properties file on the server server_name
2708: Unable to assign rights to the directory directory_name on server server_name
Error(s) occurred while installing the Inventory Agent on server_name. Reinstall the Inventory 

Agent
Error(s) occurred while installing the Inventory ConsoleOne components on server_name. Reinstall 

the Inventory ConsoleOne components
Error(s) occurred while installing the Inventory database on server_name. Reinstall the Inventory 

database
Error(s) occurred while installing the Inventory server on server_name. Reinstall Inventory server
Error(s) occurred while installing the proxy server on server_name. Reinstall the Proxy server
Some of the Inventory Agent or Inventory Server files are locked during copying files to 

server_name
Unable to copy the file filename
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Unable to find zfssrv.cfg on server_name
Unable to get the install response filename. Install will now exit
Unable to load the DLL DLL_name. The install will exit now
The install path is too long
Failed to create share_name share on server_name at directory_path

801: The installation program was unable to rename filename on the server 
server_name. Filename may be in use

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Informational

Explanation: If the installation program detects a previous installation on the machine, it 
renames the files. This error occurs if the installation program is unable to 
rename the files. 

Action: None. The installation program proceeds without renaming the files.

804: Unable to add the startinv.ncf entry in the filename file on the server 
server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: On NetWare servers, the installation program adds the following entries to 
sys:\system\autoexec.ncf file on the Inventory server:

SEARCH ADD ZEN_web_server_installation_path
ZWS.NCF
SEARCH ADD sys:\java\njclv2\bin
;ZENworks Inventory Settings
StartInv.ncf

This error occurs if the installation program is unable to add these entries in the 
autoexec.ncf file.

Possible Cause: Autoexec.ncf is in use or locked by some other application or does not exist.

Action: Follow these steps:

1 (Conditional) If the autoexec.ncf file does not exist, manually create 
the file in the sys:\system directory.

2 Add the following entries to the file:
SEARCH ADD ZENworks_web_server_installation_path
ZWS.NCF
SEARCH ADD sys:\java\njclv2\bin
;ZENworks Inventory Settings
StartInv.ncf
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807: Unable to assign rights to the SCANDIR directory on server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The installation program was unable to assign rights to the scandir directory.

Possible Cause: You have not logged into the Windows server as an administrator or with the 
equivalent administrator rights. 

Action: Ensure that you have logged into to the Windows server as an administrator or 
with the equivalent administrator rights. For more information, see 
Section 3.1, “Installation User Rights,” on page 33.

Possible Cause: The installation program is not running from a Windows workstation or server.

Action: Ensure that the recommended installation workstation requirements for 
Windows workstation or server are met. For more information, see 
Section 4.2, “Installation-Specific Machine Requirements,” on page 42.

Action: Ensure that the network is up and running. 

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

812: Unable to create the password for the Service object 
Inventory_Service_object_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Action: Reinstall the Inventory server. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

813: Unable to get the volumes on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Important

Explanation: If Sybase has already been installed on the server, the installation program 
displays the volumes of the server that you specify. This error occurs if the 
installation program is unable to display the volumes.

Action: None. The installation program considers this to be a fresh installation and 
proceeds.

814: An internal error occurred while getting the volumes on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers
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Severity: Important

Explanation: If Sybase has already been installed on the server, the installation program 
displays the volumes of the server that you specify. This error occurs if the 
installation program is unable to display the volumes.

Action: None. The installation program considers this to be a fresh installation and 
proceeds.

817: An internal error occurred while creating rights for the scandir directory on the 
server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The installation program assigns the [Root] as a trustee of the scandir directory 
with Create, Erase, and Write rights. This error occurs if the installation 
program is unable to assign these rights to scandir.

Action: Ensure that you have logged in to the server as an administrator or with the 
equivalent administrator rights. For more information, see Section 3.1, 
“Installation User Rights,” on page 33.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).

819: Unable to create the configuration property file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical 

Explanation: The installation program creates the 
Inventoryserver_installationpath\zenworks\inv\server\ 
wminv\properties\config.properties file with the following entries:

NDSTree=Novell_eDirectory_tree_name
InventoryServiceDN=DN_of_Inventory_Service_object
SingletonPort=65433
StoreRolledupAuditData=false
LDAPServer=DNS_name_of_the_Inventory_server
LDAPPort=LDAP_port_number

This error occurs if the installation program is unable to create the 
config.properties file.

Possible Cause: An input-output error occurred while creating the config.properties file.

Action: Follow these steps:

1 Note the LDAP port number.
1a In ConsoleOne, right-click the NCPTM server object, then click 

Properties.
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1b Click the Other tab.
1c In the Attributes list, double-click LDAP Server, then read the value 

of the LDAP server object.
1d Click Cancel.
1e In ConsoleOne, right-click the LDAP server object, then click 

Properties.
1f In the General tab, click the LDAP Server General option.

If you have selected to configure SSL during the installation, the 
LDAP port number is the SSL port value; otherwise, it is the TCP 
port value.

2 (Conditional) If config.properties does not exists, manually create 
the file in 
Inventoryserver_installationpath\zenworks\inv\server\wmin
v\properties.

3 Add the following entries:
NDSTree=Novell_eDirectory_tree_name
InventoryServiceDN=DN_of_Inventory_Service_object
SingletonPort=65433
StoreRolledupAuditData=false
LDAPServer=DNS_name_of_the_Inventory_server
LDAPPort=LDAP_port_number

826: Unable to load the mgmtdbs.ncf file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Important

Explanation: The installation program is unable to start Sybase after the installation.

Action: Manually load the mgmtdbs.ncf file by entering 
sys:\system\mgmtdbs.ncf at the NetWare console prompt.

831: Unable to add the mgmtdbs.ncf entry in the filename on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Possible Cause: The autoexec.ncf file is locked by some other application or does not exist.

Action: Follow these steps:

1 (Conditional) If the autoexec.ncf file does not exist, create the file in 
sys:\system.

2 Add the following entries to the file:
;ZENworks Database Settings
sys:\system\mgmtdbs.ncf
Installation Error Messages 389



390 Novell

novdocx (en)  16 A
pril 2010
836: The installation program creates a new mgmtdbs.ncf file. The installation 
program was unable to rename the existing mgmtdbs.ncf file on the server 
server_name. Rename mgmtdbs.ncf before proceeding with the installation

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical 

Explanation: The installation program tries to back up the mgmtdbs.ncf file before making 
changes to it. This error occurs if it fails to back up.

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

837: Unable to create the TracerMedia property file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical 

Explanation: The installation program creates tracermedia.properties in the 
Inventory_server_installaton_path\zenworks\inv\server\wminv\ 
properties directory. This error occurs if the installation program fails to create 
the file.

Possible Cause: An input-output error occurred while creating the tracemedia.properties 
file.

Action: Create the tracermedia.properties file in the 
Inventory_server_installaton_path\zenworks\inv\server\wminv\ 
properties directory with the following content:

com.novell.utility.trace.TraceMediumConsole = ON; INFORMATION

com.novell.utility.trace.TraceMediumFile = ON; ALL; 
Inventory_server_logs_path

com.novell.utility.trace.TraceMediumWindow = OFF; VERBOSE

874: Unable to create the Service Manager as a service on Windows NT/ Windows 
2000/ Windows Server 2003 server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The installation program creates the Service manager as a service on the 
Windows Inventory server. This error occurs if the installation is not 
successful.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).
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875: Unable to get the path for the shared directory where database is installed on 
server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical 

Possible Cause: You have not logged into the Windows server as an administrator or with 
equivalent administrator rights.

Action: Ensure that you log into the Windows server as an administrator or with the 
equivalent administrator rights. For more information, see Section 3.1, 
“Installation User Rights,” on page 33.

876: Unable to create the Sybase service on the Windows NT/ Windows 2000/ 
Windows Server 2003 server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

887: An internal error occurred while creating the database object object_name on 
the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The installation program creates a database object for Sybase and configures 
the properties of the object. This error occurs if the installation program is 
unable to create the object.

Action: Contact Novell Support (http://support.novell.com).

1051: Unable to write the JRE path to javadir.bat on server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The installation program creates javadir.bat in the 
Inventory_server_installation_directory\zenworks\server\wminv
\bin directory with the following entry:

set java_dir=installation_path\Inv\jre

This error occurs if the installation program fails to create javadir.bat file 
with the specified contents.
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Action: Create javadir.bat in the 
Inventory_server_installation_directory\zenworks\server\wminv
\bin directory with the following entry:

set java_dir=installation_path\Inv\jre

1052: Unable to create the filename file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The installation program creates javadir.bat in the 
Inventory_server_installation_path\zenworks\server\wminv\bin 
directory with the following entry:

set java_dir=absolute_path_of_sys_share\
ZENWORKS\JRE\1.3

This error occurs if the installation program is unable to create javadir.bat.

Possible Cause: An input-output error occurred while creating javadir.bat.

Action: Create javadir.bat in the 
Inventory_server_installation_path\zenworks\server\wminv\bin 
directory with the following entry:

set java_dir=installation_path\Inv\jre

1053: Unable to get the path for the Share share_name on the server server_name

Source: ZENworks Server Management; Server Inventory, Inventory Database, or 
Proxy Service installation on NetWare servers

Severity: Critical

Possible Cause: An error occurred while retrieving the path where the component is installed.

Action: Ensure that you have logged in to the server as an administrator or with the 
equivalent administrator rights.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

1060: Unable to add the STOPSER * entry in the filename file for the server 
server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The installation program was unable to add entries in invstop.ncf to stop the 
Inventory services.

Possible Cause: An input-output error occurred while adding the entries to invstop.ncf.
 ZENworks 7 Server Management Installation Guide



novdocx (en)  16 A
pril 2010
Action: Follow these steps:

1 (Conditional) If invstop.ncf does not exist, create it in the 
sys:\system directory.

2 Add the following entries to the file:
;ZENworks Inventory Settings

;-----Stop Inventory services and the Inventory database-
----

StopSer *

IMPORTANT: If invstop.ncf already exists, add the entries specified 
above before the database entry: unload dbsrv8.nlm. 

1061: Unable to add the UNLOAD DBSRV8.NLM entry in the sys:\system\invstop.ncf 
on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The installation program is unable to add the entries in invstop.ncf to stop 
the Sybase database.

Possible Cause: An input-output error occurred while adding the entries to invstop.ncf.

Action: In the sys:\system\invstop.ncf file, add the following entries:

;ZENworks Database Settings
Unload dbsrv8.nlm

1066: Unable to assign public rights to ODBC parameters of the Database object 
database_object_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Warning

Explanation: An internal error has occurred during the configuration of the Database object.

Action: Follow these steps: 

1 In ConsoleOne, right-click the database object, then click Properties.
2 Click NDS Rights, Trustees of this Object, then click Add Trustees.
3 Select Public, then click OK.
4 Click Add Property > zendbODBCConnectionParameters > OK.
5 Click Add Property > zendbODBCDriverFileName > OK.
6 Click Add Property > zendbODBCDataSourceName > OK.
7 Click OK.
8 Click Apply, then click Close.
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1071: Input-output error occurred while modifying the existing mgmtdbs.ncf for the 
server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical 

Explanation: The installation program is unable to modify the existing mgmtdbs.ncf file.

Possible Cause: An input-output error occurred while modifying the existing mgmtdbs.ncf 
file.

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65. 

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1080: Unable to create Inventory Service object for the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The installation program is unable to create the Inventory Service object for 
the server.

Action: Reinstall the Inventory server. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1081: Unable to assign supervisor privileges to the Service object 
service_object_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The installation program is unable to assign the Inventory Service object entry 
rights to itself with supervisor privileges.

Action: Assign the supervisor rights to the Inventory Service object by following the 
procedure below:

1 In ConsoleOne, right-click the Inventory Service object, then click 
Trustees of this Object.

2 Click the Add Trustee button, then select the Inventory Service object.
3 From the Property list, select [Entry Rights]. 
4 From the Rights list, click the Supervisor check box.
5 Click OK.
6 Click Apply, then click Close.
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1082: Unable to assign Inventory Service object as trustee of the NCP server 
server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The Inventory Service object is made a trustee of the NCP Server object with 
Read and Compare privileges given for [All Attribute Rights]. 

Action: Assign the Inventory Service object as a trustee of the NCP Server object:

1 In ConsoleOne, right-click the NCP Server object, then click Trustees of 
this Object.

2 Click the Add Trustee button.
3 Select the Inventory Service object.
4 From the Property list, select [All Attributes Rights]. 
5 From the Rights list, click the Read and Compare check boxes.
6 Click OK.
7 Click Apply, then click Close.

1084: Unable to initialize zwinstal.dll

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1087: Unable to detect the operating system of the workstation where install is 
running

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical 

Explanation: The ZENworks 7 Server Management installation program is unable to detect 
the operating system of the workstation where the installation program is 
running.

Action: Make sure you are using a workstation that meets the requirements listed in 
Section 4.2, “Installation-Specific Machine Requirements,” on page 42.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).
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1088: An internal error occurred while checking for entry in file filename on the 
server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1089: Unable to get LDAP port number for the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical 

Explanation: The installation program adds the following entry in the 
Inventoryserver_installation_directory\zenworks\inv\server\ 
wminv\properties\config.properties file:

LDAPPort=LDAP_port_number

This error occurs when installation program is unable to get the LDAP port 
number.

Action: Follow these steps:

1 Note the LDAP port number.
1a In ConsoleOne, right-click the NCP server object, then click 

Properties.
1b Click the Other tab.
1c In the Attributes list, double-click LDAP Server, then read the value 

of the LDAP server object.
1d Click Cancel.
1e In ConsoleOne, right-click the LDAP server object, then click 

Properties.
1f In the General tab, click the LDAP Server General option.

If you have selected to configure SSL during the installation, the 
LDAP port number is the SSL port value; otherwise, it is the TCP 
port value.

2 Manually add the LDAP port number in the 
Inventoryserver_installation_directory\zenworks\inv\serve
r\ wminv\properties\config.properties file.

1091: Unable to create the zwsenv.ncf file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical
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Explanation: The installation program creates zwsenv.ncf in the \zws directory with the 
following entry:

envset zwsinstallpath=ZWS_installation_path

This error occurs if the installation program fails to create the zwsenv.ncf in 
the \zws directory.

Action: Follow these steps:

1 To get the ZENworks Web Server installation path, note the value of the 
ZWSPath key in the sys:\system\zenworks.properties file.

2 Create zwsenv.ncf in the \zws directory with the following entry:
envset zwsinstallpath=ZWS_installation_path

1092: Unable to append entries to the zwssrv.cfg file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The installation program appends the following entries to the 
zenworks_web_server_installation_directory\bin\zwssrv.cfg file:

Computer=Windows_machine_name

CLASSPATH=ZWS_installation_directory\ZenWebServer.jar; 
ZWS_installation_directory\xmlrpcext.jar;
ZWS_installation_directory\xmlrpcservlet.jar;
ZWS_installation_directory\jcert.jar;
ZWS_installation_directory\jnet.jar;
ZWS_installation_directory\jdom.jar;
ZWS_installation_directory\jsse.jar;
ZWS_installation_directory\xmlrpc.jar;
ZWS_installation_directory\servlet.jar; 
ZWS_installation_directory\xerces.jar;

BinDirectory=ZWS_installation_directory\bin

WorkingDirectory=ZWS_installation_directory\bin

This error occurs if the installation program fails to appends the entries.

Possible Cause: An input-output error occurred while appending to the file.

Action: Follow these steps:

1 Note the ZENworks Web Server installation path.
1a Invoke REGEDIT.
1b In HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS, read the 

value of the ZWSPath attribute.
2 Add the following entries to 

zenworks_web_server_installation_directory\bin\zwssrv.cfg
:
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Computer=Windows_machine_name

CLASSPATH=ZWS_installation_directory\ZenWebServer.jar; 
ZWS_installation_directory\xmlrpcext.jar;
ZWS_installation_directory\xmlrpcservlet.jar;
ZWS_installation_directory\jcert.jar;
ZWS_installation_directory\jnet.jar;
ZWS_installation_directory\jdom.jar;
ZWS_installation_directory\jsse.jar;
ZWS_installation_directory\xmlrpc.jar;
ZWS_installation_directory\servlet.jar;
ZWS_installation_directory\xerces.jar;

BinDirectory=ZWS_installation_directory\bin

WorkingDirectory=ZWS_installation_directory\bin

1093: Unable to append entries to the zws.properties file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical 

Explanation: The installation program is unable to edit the zws.properties file. 

Possible Cause: An input-output error occurred while adding entries to the zws.properties 
file.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1094: Unable to modify Inventory Service object for the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The installation program is unable to modify the existing Inventory Service 
object.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1095: Unable to create the invenvset.ncf file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The installation program creates the invenvset.ncf file in the sys:\system 
directory of a NetWare Inventory server with the following contents:

envset inv_install_dir= Inventory_server_installation_path
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envset zws_install_dir=ZWS_installation_path

Action: Follow these steps:

1 To get the Inventory server installation path, read the value of the 
InvSrvpath key in the sys:\system\zenworks.properties file.

2 To get the ZENworks Web Server installation path, read the value of the 
ZWSPath key in the sys:\system\zenworks.properties file.

3 Create invenvset.ncf in the sys:\system directory with the following 
entries:
envset inv_install_dir= 
Inventory_server_installation_path

envset zws_install_dir=ZWS_installation_path

1097: Unable to modify mgmtdbs.ncf on server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Possible Cause: An input-output error occurred while editing mgmtdbs.ncf.

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1098: Unable to create mgmtdbs.ncf on server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Possible Cause: An input-output error occurred while creating mgmtdbs.ncf.

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1102: Unable to set the Inventory installation path on server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Possible Cause: The installation program was unable to update the Inventory server install path 
in the registry.

Action: Reinstall Inventory server. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).
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1104: Unable to set the ZENworks Web Server installation path on server 
server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Possible Cause: The installation program is unable to update the ZENworks Web Server 
installation path in the registry.

Action: Reinstall the Inventory server. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1105: An input-output error occurred while reading the zenworks.properties file, for 
the server server_name. The previous installations of the Inventory server could not 
be detected

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Informational 

Explanation: The following according to platform:

NetWare: The installation program reads the 
sys:\system\zenworks.properties file to detect if Inventory was 
previously installed.

Action: None.

1106: Unable to detect a valid database installation on server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Informational

Possible Cause: Unable to detect the location of the database engine from the registry. 

Action: None. The installation program considers this to be a fresh installation and 
proceeds.

1107: The installation path for Inventory components on server server_name is 
invalid

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Action: Reinstall the Inventory server. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).
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1118: Unable to create query.properties on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The ZENworks 7 Server Management installation program creates the 
query.properties file in ConsoleOne_installation_path\bin with the 
entry, insver=zfs. If Server Inventory is installed over the Workstation 
Inventory component of ZENworks 7 Desktop Management, it is changed to 
insver=both.

Possible Cause: An input-output error occurred while creating or updating the 
query.properties file

Action: If the query.properties file already exists, ensure that the value of insver= 
is correct.

Action: If the query.properties file does not exist, manually create the file in the 
ConsoleOne_installation_path\bin directory with the following content:

If you are installing Server Inventory on a fresh setup, enter insver=zfs.
If you are installing Server Inventory over the Workstation Inventory 
component of ZENworks 7 Desktop Management, enter insver=both.

1121: Unable to rename the database object old_database_object_name to 
new_database_object_name, on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical 

Explanation: If you are installing the Server Inventory component of ZENworks 7 Server 
Management over ZENworks for Servers 3.x, the installation program renames 
the ZENworks for Servers 3.x database object to 
server_name_invDatabase. This error occurs if the installation program is 
unable to rename the database object.

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1122: Unable to modify the database object on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The installation program is unable to modify the existing database object on 
the server.

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).
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1123: Failed to update load and unload scripts on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The installation program adds entries in the load script and the unload script 
for the NetWare cluster server. This error occurs when the installation program 
is unable add the entries to these scripts.

Action: During installation, if you chose to install either the Inventory server or the 
Database, reinstall the selected component. If you chose to install both the 
Inventory server and the Database, reinstall both the components. For more 
information, see Section 6.1, “Installation on NetWare and Windows Servers,” 
on page 65.

1124: Unable to remove old Inventory entries from the autoexec.ncf file on server 
server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Important

Explanation: The installation program normally deletes the following entries from the 
sys:\system\autoexec.ncf file on the server: 

gatherer.ncf
master.ncf
mgmtdbs.ncf
storer.ncf
sybase.ncf

The above error occurs if the installation program is unable to delete the 
specified entries.

Action: Manually delete the following entries from autoexec.ncf:

gatherer.ncf
master.ncf
mgmtdbs.ncf
storer.ncf
sybase.ncf

1125: Unable to create the database object database_object_name on the server 
server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).
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1128: Unable to add the Zenworks Web Server entry in file filename, on the server 
server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Important

Explanation: The installation program was unable to add entries in the 
sys:\system\autoexec.ncf file to launch the ZENworks Web Server. 

Action: In the sys:\system\autoexec.ncf file, add the following entries:

SEARCH ADD zenworks_web_server_installation_path
zenworks_installation_volume\zenworks\zfs.ncf

1129: Unable to set the ZENworks installation path on server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The installation program failed to set the ZENworks path in the registry.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1130: Unable to set the database engine installation path on server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1131: Unable to set the Inventory database installation path on server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The installation program is unable to set the Inventory database installation 
path in the registry.

Action: Reinstall the Inventory database. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1133: Unable to configure SSL on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers
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Severity: Critical

Explanation: The installation program is unable to configure the Secure Socket Layer 
(SSL).

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1135: The install path for XML Proxy components on server server_name is invalid

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The installation program failed to get a valid path to install XML Proxy 
Service.

Action: Reinstall the XML Proxy service. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1137: Unable to add Inventory entries to the load script on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The installation program makes the following entries in the load script after the 
database entries:

SEARCH ADD zws_installation_path

invclst:\zenworks\zfs.ncf
SEARCH ADD SYS:\JAVA\NJCLV2\BIN
;ZENworks Inventory Settings
StartInv.ncf

This error occurs if the installation program is unable to add the specified 
entries in the load script.

Action: In the load script, add the following entries after the database entries:

SEARCH ADD zws_installation_path

invclst:\zenworks\zfs.ncf
SEARCH ADD SYS:\JAVA\NJCLV2\BIN
;ZENworks Inventory Settings
StartInv.ncf

1138: Unable to add Inventory entries to the unload script on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical
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Explanation: The installation program adds the following entries to unload scripts before the 
del secondary ipaddress line:

java -killzenWSInv
delay 8
java -killzfsexit

This error occurs if the installation program is unable to add the specified 
entries to the unload scripts.

Action: In the unload script, add the following entries after the Inventory entries (if 
any) but before the “del secondary ipaddress” entry:

java -killzenWSInv
delay 8
java -killzfsexit

1139: Unable to add database entries to the load script on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The installation program adds the following entries to the load script:

;ZENworks Database Settings
sys:\system\mgmtdbs.ncf

This error occurs if the installation program is unable to add the specified 
entries to the load scripts.

Action: In the load script, add the following entries before the Inventory entries:

;ZENworks Database Settings
sys:\system\mgmtdbs.ncf

1140: Unable to add database entries to the unload script on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical 

Explanation: The installation program adds the following entry to the unload scripts:

unload dbsrv8.nlm <<y

This error occurs if the installation program is unable to add the specified entry 
to the unload scripts.

Action: In the unload scripts, add the following entry after the Inventory entries and 
before the “del secondary ipaddress” entry:

unload dbsrv8.nlm <<y
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1143: Unable to retrieve the path where Inventory was installed for server 
server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Important

Explanation: The ZENworks 7 Server Management installation program is unable to detect 
the path where the earlier versions of ZENworks is installed.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1148: Unable to create ZENworks Web Server as a service on Windows NT/2000 
server server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1149: Unable to add the ZENworks Web Server path to invenvset.bat on the server 
server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The installation program creates invenvset.bat in the 
Inventory_server_installation_path\zenworks\inv\server\wminv\
bin directory with the following entry:

set zws_install_dir=ZWS_installation_path

This error occurs if the installation program is unable to retrieve the 
ZENworks Web Server installation path from the registry.

Action: In the invenvset.bat file, manually add the following entry:

set zws_install_dir=ZWS_installation_path

To get the ZENworks Web Server installation path:

1 Invoke REGEDIT.
2 In HKEY_LOCAL_MACHINE\SOFTWARE\NOVELL\ZENWORKS, read the value 

of the ZWSPath attribute.

1150: Unable to add ZENworks Web Server entry to the load script on server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers
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Severity: Critical

Explanation: The installation program adds the following entries to the load script:

invclst:\zenworks\zfs.ncf

This error occurs if the installation program is unable to add the specified 
entries to the load script.

Action: Add the following entries to the load script.

SEARCH ADD zws_installation_path

invclst:\zenworks\zfs.ncf

1151: Unable to add ZENworks Web Server entry to the unload script on 
server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The installation program adds the following entry to the unload scripts:

java -killzfsexit

This error occurs if the installation program is unable to add the specified entry 
to the unload scripts.

Action: Manually add the specified entry to the unload scripts before the del 
secondary ipaddress entry.

1153: Unable to add Inventory entries to the password.txt file on the server 
server_name

Source: ZENworks Server Management; Server Inventory installation NetWare or 
Windows servers

Severity: Critical 

Explanation: The installation program creates the password.txt file in the ZENworks Web 
Server installation directory with the following entry:

inventory=novell

Possible Cause: An input-output error occurred while creating the password.txt file.

Action: Follow these steps:

1 (Conditional) If password.txt does not exist, create it in the ZENworks 
Web Server installation directory.

2 Add the following entry to the file:
inventory=novell
Installation Error Messages 407



408 Novell

novdocx (en)  16 A
pril 2010
1154: Unable to add the password.txt file path entry to zws.properties file on the 
server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical 

Explanation: The installation adds the following entry in 
ZENworks_Web_Server_installation_directory\zws.properties:

passwordFile=path_of_password.txt

This error occurs if the installation program is unable to create the 
zws.properties file with the specified entries.

Possible Cause: An input-output error occurred while creating the zws.properties file.

Action: Follow these steps:

1 (Conditional) If zws.properties does not exist, create it in the 
ZENworks Web Server installation directory.

2 Add the following entry to the file:
passwordFile=path_of_password.txt

1156: Unable to add the SSL entry to filename file on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: During the installation, if you choose to configure SSL, then the installation 
program adds the following entry in the directory.properties file:

ssl=true

If you choose not to configure SSL, the following entry is added to the 
directory.properties file:

ssl = false

This error occurs if the installation program fails to add the appropriate entry 
in the directory.properties file.

Possible Cause: An input-output error occurred while adding the appropriate entry to the 
directory.properties file.

Action: Add the appropriate entry in the 
inventory_installation_volume\zenworks\inv\server\wminv\prope
rties\directory.properties file.

1157: Unable to modify the LDAP Allow Clear Text Password attribute of the LDAP 
Group object of the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical 
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Explanation: The installation program sets the LDAP Clear Text Password attribute of the 
LDAP Group object to true or false based on whether the Configure SSL 
option is selected during the Server Inventory installation.

Action: Follow these steps:

1 In ConsoleOne, right-click the LDAP Server object, then click 
Properties.

2 In the General tab, click the LDAP group general option, then read the 
value of the LDAP Group field.

3 Click Cancel.
4 In ConsoleOne, right-click the LDAP Group object, then click Properties.
5 In the General tab, click the LDAP group general option.

If you have selected to configure the SSL during installation, select Allow 
clear text passwords.

1159: Unable to add entry entry to file filename on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Possible Cause: An error occurred while changing the classpath in the zfs.ncf, ted.ncf, 
zfssrv.cfg, or tedsrv.cfg files.

Action: Do the following: 

On NetWare:
If the error has occurred in the zfs.ncf file, edit the 
pds_installation_directory\zfs.ncf file to add the following 
lines at the end of the envset section: 
envset 
smclasses=$smclasses;zws_installation_directory\zenwe
bserverres.jar

envset smclasses=$smclasses 
zws_installation_directory\xmlrpcextres.jar

If the error has occurred in the ted.ncf, edit the 
pds_installation_directory\ted\ted.ncf file to add the 
following lines at the end of the envset section:
envset 
tedpath=$tedpath;zws_installation_directory\zenwebser
verres.jar;

envset 
smclasses=$smclasses;zws_installation_directory\xmlrp
cextres.jar

NOTE: Pds_installation_directory is the value of the 
PDSPATH subkey in the sys:system\zenworks.properties file, 
and zws_installation_directory is the value of the zwspath in 
the sys:\system\zenworks.properties file.
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On Windows, if the error has occurred in the zfssrv.cfg or 
tedsrv.cfg file, edit the 
pds_installation_directory\bin\zfssrv.cfg and the 
pds_installation_directory\bin\tedsrv.cfg files to add the 
following lines at the end of the files:
classpath=%classpath%;zws_installation_directory\xmlrpcex
tres.jar;zws_installation_directory\zenwebserverres.jar

NOTE: Pds_installation_directory is the value of the pdspath 
subkey under hkey_local_machine\software\novell\zenworks and 
zws_installation_directory is the value of the zwspath subkey 
under hkey_local_machine\software\novell\zenworks.

1160: Unable to replace entry1 with entry2, in the file filename

Source: ZENworks Server Management; Proxy Service installation on NetWare or 
Windows servers

Severity: Critical

Explanation: During the reinstallation of the Proxy Service, the installation program 
replaces the proxy port value in the zws.properties file with the new value. 
This error occurs if the installation program is unable to replace the proxy port 
value with the new value.

Action: In the ZWS_installation_directory\zws.properties file, manually 
enter the new value of the proxy port.

1161: A previous installation of Policy and Distribution Services has been detected 
on server server_name. Install cannot start Inventory service automatically. Start 
Policy and Distribution Services and then the Inventory Service

Source: ZENworks Server Management; Standalone pre-configuration on NetWare 
and Windows servers

Severity: Informational

Explanation: If you choose the Standalone pre-configuration during the ZENworks 7 
installation, the installation program configures for a Standalone server and 
automatically starts the Inventory and ZENworks Web Server services. But if 
Policy and Distribution Services of ZENworks 7 Server Management is 
already installed, the ZENworks 7 installation program does not automatically 
start the Inventory and the ZENworks Web Server services.

Action: You must manually start the Policy and Distribution Services before starting 
the Inventory services. For more information on how to start the Policy and 
Distribution Services, see the ZENworks 7 documentation Web site (http://
www.novell.com/documentation/zenworks7). 

1162: An incomplete installation of the Inventory server was detected on server 
server_name. Please reinstall the Inventory server

Source: ZENworks Server Management; Standalone pre-configuration on NetWare 
and Windows servers

Severity: Critical
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Explanation: The ZENworks 7 installation program searches for the ZWS path in 
zenworks.properties before launching the ZENworks Web Server service. 
This error occurs when the installation program fails to find this path.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

1163: Unable to start the ZENworks Web Server on server server_name. For more 
information, see the error message documentation

Source: ZENworks Server Management; Standalone pre-configuration on NetWare 
servers

Severity: Critical

Explanation: The ZENworks 7 installation program failed to start ZENworks Web Server 
service.

Action: Manually run sys:\system\zws.ncf on the server.

1164: Unable to start the Inventory service on server server_name. For more 
information, see the error message documentation

Source: ZENworks Server Management; Standalone pre-configuration on NetWare 
servers

Severity: Important

Explanation: The ZENworks 7 installation program failed to start the Inventory services.

Action: Manually run sys:\sytem\startinv.ncf on the server.

1166: Unable to create zwssearch.ncf file on the server server_name

Source: ZENworks Server Management; Standalone pre-configuration on NetWare 
servers

Severity: Important

Explanation: The ZENworks 7 installation program creates the 
sys:\system\zwssearch.ncf file on the server with the entry SEARCH ADD 
ZENworks_Web_server_installation path .

Action: Manually create the sys:\system\zwssearch.ncf file on the server.

1167: Unable to add a search path to the ZENworks Web Server on server 
server_name

Source: ZENworks Server Management; Server Inventory or Proxy Service 
installation on NetWare servers

Severity: Important

Explanation: The ZENworks 7 installation program is unable to launch 
sys:\system\zwssearch.ncf on the server.

Action: Manually run sys:\system\zwssearch.ncf on the server. This 
automatically adds the search path to the ZENworks Web Server.
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1168: Unable to write version information to the registry on the server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare and 
Windows servers

Severity: Critical

Explanation: The ZENworks 7 installation program failed to write the version information 
to the registry.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1169: Unable to remove the old Inventory entries from file filename, on server 
server_name

Source: ZENworks Server Management; Sybase Inventory database installation on 
NetWare servers

Severity: Important

Explanation: If you are upgrading from ZENworks for Servers 3.x to ZENworks 7 Server 
Management, the ZENworks 7 installation program deletes ZENworks for 
Servers 3.x Inventory entries.

This error occurrs if the the ZENworks 7 installation program fails to remove 
the ZENworks for Servers 3.x Inventory entries.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1170: Unable to add entries to the zenworks.properties file, on server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare 
servers

Severity: Critical

Explanation: The ZENworks 7 installation program failed to write the version information 
and the installation path to the zenworks.properties file.

Action: Reinstall Server Inventory. For more information, see Section 6.1, “Installation 
on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

1171: Unable to add the ZENworks Web Server entries to the file filename, on the 
server server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare and 
Windows 

Severity: Critical

Explanation: This error occurs if the installation fails to add the ZENworks Web Server 
entries to the invenv.ncf file for NetWare and Windows.
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Possible Cause: An input-output error has occurred while modifying the file.

Action: Do the following:

On NetWare add the following entry, if it is not already present, in the 
invenv.ncf file:

envset tmppath=$tmppath;$zws_install_dir\xmlpcextRes.jar

On Windows add the following entry, if it is not already present, in the 
inventory_install_path\wminv\bin\invenv.bat file:

tmppath=%tmppath%;%zws_install_dir%\xmlpcextRes.jar

2701: Unable to create the zwsstart.ncf file on the server server_name

Source: ZENworks Server Management; Server Inventory or Proxy Service 
installation on NetWare servers

Severity: Critical

Explanation: The installation program creates the sys:\system\zwsstart.ncf file to 
launch the ZENworks Web Server. This error occurs if the installation program 
fails to create the zwsstart.ncf file.

Possible Cause: An input-output error occurred while creating the zwsstart.ncf file.

Action: Follow these steps:

1 Note the value of the ZWSPath key in the 
sys:\system\zenworks.properties file to get the ZENworks Web 
Server installation path.

2 (Conditional) If the zwsstart.ncf does not exist, create the file in the 
sys:\system directory.

3 Add the following entries to the file:
ZENworks_Web_Server_installation_path\zwsenv.ncf

ZENworks_Web_Server_installation_path\zws\zws.ncf

2702: Unable to remove the entries from the load script on the server server_name

Source: ZENworks Server Management; Server Inventory database or Proxy Service 
installation on NetWare servers

Severity: Critical

Possible Cause: If you are installing ZENworks 7 Server Management over a previous version 
of ZENworks for Servers or ZENworks for Desktops, the installation program 
cleans up the entries from the load scripts. This error occurs if the installation 
fails to clean up the entries from the load scripts.

Action: Contact Novell Support (http://support.novell.com). 

2703: Unable to remove the entries from the unload script on server server_name

Source: ZENworks Server Management; Server Inventory database or Proxy Service 
installation on NetWare servers

Severity: Critical
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Possible Cause: If you are installing ZENworks 7 Server Management over a previous version 
of ZENworks for Servers or ZENworks for Desktops, the installation program 
cleans up the entries from the load scripts. This error occurs if the installation 
fails to clean up the entries from the load scripts.

Action: Using ConsoleOne, remove the dbsrv8.nlm entry from the unload script.

2704: Unable to append entries to zws.ncf file on the server sever_name

Source: ZENworks Server Management; Inventory Server or Proxy Service 
installation on NetWare or Windows servers

Severity: Critical

Explanation: This error occurs if the ZENworks 7 Server Management installation fails to 
add the ZEN loader entries to zfs.ncf.

Possible Cause: An input-output error has occurred while modifying zfs.ncf.

Action: Reinstall the following components of ZENworks 7 Server Management: 
Inventory server and Inventory Proxy server (XML Proxy). For more 
information, see Section 6.1, “Installation on NetWare and Windows Servers,” 
on page 65.

2707: Unable to create dbconfig.properties file on the server server_name

Source: ZENworks Server Management; Inventory Server or Proxy Service 
installation on NetWare or Windows servers

Severity: Important

Explanation: This error occurs if the installation fails to add the ZENworks Web Server 
entries to the invenv.ncf file.

Possible Cause: An input-output error has occurred while modifying the file.

Action: Ensure that invconfig.properties file exists in the 
Inventory_database_volume\zenworks\database\inventory directory. 
If the file is not present, manually create the file with the following entry:

DBObjectDN=DN of the inventory database object in eDirectory

2708: Unable to assign rights to the directory directory_name on server 
server_name

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Explanation: The Installation program was unable to assign rights to the \scandir or 
\dictdir directories.

Possible Cause: You have not logged into the Windows server as an administrator or with the 
equivalent administrator rights. 

Action: Ensure that you have logged into to the Windows server as an administrator or 
with the equivalent administrator rights. See Section 3.1, “Installation User 
Rights,” on page 33.
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Possible Cause: The installation program is not running from a Windows workstation or server.

Action: Ensure that the recommended installation workstation requirements for 
Windows workstation or server are met. See Section 4.2, “Installation-Specific 
Machine Requirements,” on page 42.

Action: Ensure that the network is up and running.

Action: Do the following:

1 Stop the Inventory service.
2 Assign rights to the \scandir or \dictdir directories.

Scandir: Share the 
inventory_installation_drive\zenworks\inv\scandir 
directory as “ScanDir” and assign the Create rights to everyone.
Dictdir: Share the 
inventory_installation_drive\zenworks\inv\dictdir 
directory as “DictDir” and assign the Full rights to everyone.

3 Start the Inventory service.

Action: If the problem persists, contact Novell Support (http://support.novell.com).

Error(s) occurred while installing the Inventory Agent on server_name. Reinstall the 
Inventory Agent

Source: ZENworks Server Management; Inventory Agent installation on NetWare or 
Windows servers

Severity: Critical

Explanation: This error occurs if the installation program is unable to install the Inventory 
Agent on the selected servers.

Action: Ensure that the Subscriber is installed on the target machine. If the Subscriber 
has not been installed, install the Subscriber before reinstalling Inventory 
Agent. For more information, see Section 6.1, “Installation on NetWare and 
Windows Servers,” on page 65.

Possible Cause: The directory where you want to copy the Inventory Agent files is locked by 
some other process.

Action: Release the lock and reinstall the Inventory Agent. For more information, see 
Section 6.1, “Installation on NetWare and Windows Servers,” on page 65.

Action: Check for any error codes in the error log file and look for the detailed 
explanation for that error.

Error(s) occurred while installing the Inventory ConsoleOne components on 
server_name. Reinstall the Inventory ConsoleOne components

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical
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Action: Ensure that ConsoleOne version 1.3.6 is installed on the target server. For 
more information, see Section 4.4, “Installing ConsoleOne 1.3.6e,” on 
page 43.

Action: If you are installing to a NetWare cluster server, ensure that all of the nodes on 
the cluster server are configured properly.

Possible Cause: The directory where you want to copy the Inventory Agent files is locked by 
some other process.

Action: Unlock the directory and reinstall the Inventory ConsoleOne components.

Action: Check for any error codes in the error log file and look for the detailed 
explanation for that error code.

Error(s) occurred while installing the Inventory database on server_name. Reinstall 
the Inventory database

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Possible Cause: The Sybase database is not shut down during the ZENworks Server 
Management Server Inventory installation on Windows server.

Action: Quit Sybase and reinstall the Inventory database.

Possible Cause: The target directory is locked by some other process.

Action: Release the lock and reinstall the Inventory database. For more information on 
how to reinstall the Inventory database, see Section 6.1, “Installation on 
NetWare and Windows Servers,” on page 65.

Action: If you are installing to a NetWare cluster server, ensure that all of the nodes on 
the cluster server are configured properly.

Action: Check for any error codes in the error log file and look for the detailed 
explanation for that error code.

Error(s) occurred while installing the Inventory server on server_name. Reinstall 
Inventory server

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Action: If you are installing to a NetWare cluster server, ensure that all of the nodes on 
the cluster server are configured properly.

Action: If this message is displayed during reinstall, ensure that the Inventory services 
are not running during reinstallation. If you are reinstalling on a NetWare 
server, also ensure that the JVM is unloaded.

Action: Check for any error codes in the error log file and look for the detailed 
explanation for that error code.
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Error(s) occurred while installing the proxy server on server_name. Reinstall the 
Proxy server

Source: ZENworks Server Management; Proxy server installation on NetWare or 
Windows servers

Severity: Critical

Action: Reinstall the Proxy service. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

Action: If you are installing to a NetWare cluster server, ensure that all of the nodes on 
the cluster server are configured properly.

Possible Cause: The directory where you want to copy the Proxy service files is locked by 
some other process.

Action: Unlock the directory and reinstall the Proxy service. For more information on 
how to reinstall the Proxy service, see Section 6.1, “Installation on NetWare 
and Windows Servers,” on page 65

Action: Check for any error codes in the error log file and look for the detailed 
explanation for that error code.

Some of the Inventory Agent or Inventory Server files are locked during copying files 
to server_name

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Possible Cause: The files are locked or in use by some other application.

Action: Unlock the files and reinstall the Server Inventory component. For more 
information on how to reinstall the Server Inventory component, see 
Section 6.1, “Installation on NetWare and Windows Servers,” on page 65.

Explanation: If the problem persists, reboot the server and reinstall the Server Inventory 
component. For more information on how to reinstall the Server Inventory 
component, see Section 6.1, “Installation on NetWare and Windows Servers,” 
on page 65.

Unable to copy the file filename

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Possible Cause: The file is in use or locked by some other application.

Action: Close all running programs and reinstall Server Inventory. For more 
information on how to reinstall the Server Inventory component, see 
Section 6.1, “Installation on NetWare and Windows Servers,” on page 65.

Action: If the problem persists, reboot the server.
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Unable to find zfssrv.cfg on server_name

Source: ZENworks Server Management; Inventory Agent installation on Windows 
servers

Severity: Critical

Possible Cause: The installation of Policy and Distribution Services failed on the specified 
server.

Action: Reinstall Policy and Distribution Services and the Server Inventory 
components. For more information, see Section 6.1, “Installation on NetWare 
and Windows Servers,” on page 65

Unable to get the install response filename. Install will now exit

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Action: Follow these steps:

1 Delete all files from the Windows \temp directory.
2 Close all running programs.
3 Reinstall Server Inventory. For more information, see Section 6.1, 

“Installation on NetWare and Windows Servers,” on page 65.

Unable to load the DLL DLL_name. The install will exit now

Source: ZENworks Server Management; Server Inventory installation on NetWare or 
Windows servers

Severity: Critical

Explanation: The installation program is unable to load the specified DLL.

Action: Follow these steps:

1 Delete all files from the Windows \temp directory.
2 Reboot the installation workstation.
3 Reinstall Server Inventory. For more information, see Section 6.1, 

“Installation on NetWare and Windows Servers,” on page 65.

Action: Ensure that the specified DLL is located in the \zfs\rminv\libs\dll 
directory on the Novell ZENworks 7 Server Management with Support Pack 1 
Program CD. If the file is not present, contact Novell Support (http://
support.novell.com).

The install path is too long

Source: ZENworks Server Management; Server Inventory installation on NetWare and 
Windows servers

Severity: Critical

Action: Ensure that the characters specified for the installation path do not exceed 169 
characters.
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Failed to create share_name share on server_name at directory_path

Source: ZENworks Server Management; Server Inventory installation on Windows 
servers

Severity: Critical

Possible Cause: The machine where you want to create the share is not reachable.

Action: Ensure that the machine is reachable. Ping the machine to check the 
connectivity of the machine.

Action: Try to access any other share on the machine through Windows Explorer.

H.6  Remote Management Installation Errors
The following sections contain detailed explanations of error messages you could encounter while 
installing Remote Management.

Error(s) occurred while installing the Remote Management Agent on server_name. Reinstall the 
Remote Management Agent.

Some of the Remote Management files are locked during copying files to server_name
Unable to copy the file filename
Unable to create the password file on server_name. You must manually set the password on the 

server. For more information, see the online ZENworks error message documentation at http://
www.novell.com/documentation

Unable to create the Remote Management service on server_name. For more information, see the 
online ZENworks error message documentation at http://www.novell.com/documentation

Unable to find zfssrv.cfg on server_name
Unable to get the install response filename. Install will now exit
Unable to load the DLL DLL_name. The install will exit now
Unable to start the Remote Management service on server_name. For more information, see the 

online ZENworks error message documentation at http://www.novell.com/documentation
Unable to stop the ZENworks for Servers 2 Remote Management service on server_name. For more 

information, see the online ZENworks error message documentation at http://www.novell.com/
documentation

Unable to stop the ZfS 3 Remote Management service on server_name. For more information, see 
the online ZENworks error message documentation at http://www.novell.com/documentation

Error(s) occurred while installing the Remote Management Agent on server_name. 
Reinstall the Remote Management Agent.

Source: ZENworks Server Management; Remote Management installation on NetWare 
or Windows servers

Severity: Critical

Action: If you are installing to a NetWare cluster server, ensure that all of the nodes on 
the cluster server are configured properly.

Possible Cause: The directory where you want to copy the Remote Management Agent files is 
locked by some other process.
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Action: Unlock the directory and reinstall the Remote Management Agent. For more 
information, see Section 6.1, “Installation on NetWare and Windows Servers,” 
on page 65.

Some of the Remote Management files are locked during copying files to 
server_name 

Source: ZENworks Server Management; Remote Management installation on 
Windows servers

Severity: Informational

Explanation: During the installation, some Remote Management files located in the 
Windows \system directory are locked. This is a non-fatal error. The 
installation program registers the locked files in the registry of the target server 
and maintains the new files as a reference to overwrite the locked files.

Action: Reboot the server. 

Unable to copy the file filename

Source: ZENworks Server Management; Remote Management installation on NetWare 
or Windows servers

Severity: Critical

Possible Cause: The file is in use or locked by some other application.

Action: Close all running programs and reinstall Remote Management. For more 
information, see Section 6.1, “Installation on NetWare and Windows Servers,” 
on page 65.

Action: If the problem persists, reboot the server.

Unable to create the password file on server_name. You must manually set the 
password on the server. For more information, see the online ZENworks error 
message documentation at http://www.novell.com/documentation

Source: ZENworks Server Management; Remote Management installation on 
Windows servers

Severity: Critical

Possible Cause: On the managed server, the password file is in use.

Action: After installing Remote Management, manually set the password at the 
managed server.

To set the password at the managed server:

1 Right-click the Remote Management Agent icon.
2 Click Set Password.
3 Enter the password.
4 Click OK.
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Unable to create the Remote Management service on server_name. For more 
information, see the online ZENworks error message documentation at http://
www.novell.com/documentation

Source: ZENworks Server Management; Remote Management installation on 
Windows servers

Severity: Critical

Possible Cause: The Novell ZENworks Remote Management service is in the Disabled state.

Action: Reboot the managed server and reinstall the Remote Management 
components. For more information, see Section 6.1, “Installation on NetWare 
and Windows Servers,” on page 65.

Unable to find zfssrv.cfg on server_name

Source: ZENworks Server Management; Remote Management installation on 
Windows servers

Severity: Critical

Possible Cause: The installation of Policy and Distribution Services failed on the specified 
server.

Action: Reinstall Policy and Distribution Services before reinstalling Remote 
Management. For more information, see Section 6.1, “Installation on NetWare 
and Windows Servers,” on page 65.

Unable to get the install response filename. Install will now exit

Source: ZENworks Server Management; Remote Management installation on NetWare 
or Windows servers

Severity: Critical

Action: Follow these steps:

1 Delete all files from the Windows \temp directory.
2 Close all running programs.
3 Reinstall Remote Management. For more information, see Section 6.1, 

“Installation on NetWare and Windows Servers,” on page 65.

Unable to load the DLL DLL_name. The install will exit now

Source: ZENworks Server Management; Remote Management installation on NetWare 
or Windows servers

Severity: Critical

Explanation: The installation program is unable to load the specified DLL.

Action: Follow these steps:

1 Delete all files from the Windows \temp directory.
2 Reboot the installation workstation.
3 Reinstall Remote Management. For more information, see Section 6.1, 

“Installation on NetWare and Windows Servers,” on page 65. 
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Action: Ensure that the specified DLL is located in the \zfs\rminv\libs\dll directory on 
the Novell ZENworks 7 Server Management with Support Pack 1 Program 
CD.If the file is not present, contact Novell Support (http://
support.novell.com)

Unable to start the Remote Management service on server_name. For more 
information, see the online ZENworks error message documentation at http://
www.novell.com/documentation 

Source: ZENworks Server Management; Remote Management installation on 
Windows servers

Severity: Critical

Possible Cause: One or more Remote Management files on the managed server are corrupt or 
do not exist.

Action: Reboot the managed server and reinstall the Remote Management 
components. For more information, see Section 6.1, “Installation on NetWare 
and Windows Servers,” on page 65.

Unable to stop the ZENworks for Servers 2 Remote Management service on 
server_name. For more information, see the online ZENworks error message 
documentation at http://www.novell.com/documentation

Source: ZENworks Server Management; Remote Management installation on 
Windows servers

Severity: Critical

Possible Cause: The ZENworks for Servers 2 Remote Management service is not responding to 
the Service Control Manager within the stipulated time.

Action: Follow these steps: 

1 Stop the ZENworks for Servers 2 Remote Management service.
On a Windows 2000 managed server, from the Control Panel, double-
click Administrative Tools, double-click Services, right-click the ZfS 2 
Remote Management service, then click Stop.

2 Reinstall ZENworks Server Management Remote Management. For more 
information, see Section 6.1, “Installation on NetWare and Windows 
Servers,” on page 65.

Unable to stop the ZfS 3 Remote Management service on server_name. For more 
information, see the online ZENworks error message documentation at http://
www.novell.com/documentation

Source: ZENworks Server Management; Remote Management installation on 
Windows servers

Severity: Critical

Possible Cause: The ZENworks 7 Remote Management service is not responding to the 
Service Control Manager within the stipulated time.
 ZENworks 7 Server Management Installation Guide

http://support.novell.com


novdocx (en)  16 A
pril 2010
Action: Follow these steps: 

1 To stop the Remote Management service:
On a Windows 2000 managed server, from the Control Panel, double-
click Administrative Tools, double-click Services, right-click Novell 
ZENworks Remote Management Agent, then click Stop.

2 Reinstall Remote Management. For more information, see Section 6.1, 
“Installation on NetWare and Windows Servers,” on page 65.

H.7  Management and Monitoring Services 
Installation Errors
If the Management and Monitoring Services components installation is not successful, the 
installation program logs an error message in the following log files: mwinssum.wri, 
instrace.txt, rbs.ini, and license.ini. The summary file that is displayed at the end of the 
install specifies the location of these log files. The log files are also placed in the \temp directory on 
your machine.

103: Specified document cannot be selected or deselected
108: Insufficient disk space
112: Specified file cannot be opened
113: Specified file cannot be opened as read-only
115: Specified file cannot be opened as write
136: Unable to allocate memory

103: Specified document cannot be selected or deselected

Source: ZENworks Server Management; Management and Monitoring Services 
installation 

Severity: Critical

Possible Cause: ComponentSelectItem was called to select or deselect a component required 
by a currently selected component. 

Action: Contact Novell Support (http://support.novell.com).

108: Insufficient disk space

Source: ZENworks Server Management; Management and Monitoring Services 
installation

Severity: Critical

Possible Cause: The target disk or directory has insufficient free space, or the disk space cannot 
be determined because TARGETDIR is invalid, or a script-defined directory of 
a component has not been set.

Action: Contact Novell Support (http://support.novell.com).

112: Specified file cannot be opened

Source: ZENworks Server Management; Management and Monitoring Services 
installation
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Severity: Critical

Possible Cause: The specified file or the file in the data1.cab (or one of the other data CAB 
files) is missing or corrupted; or an uncompressed data file is missing from the 
CD.

Action: Contact Novell Support (http://support.novell.com).

113: Specified file cannot be opened as read-only 

Source: ZENworks Server Management; Management and Monitoring Services 
installation

Severity: Critical

Possible Cause: The file data1.cab (or one of the other data CAB files) is missing or 
corrupted; or an uncompressed data file is missing from the CD.

Action: Contact Novell Support (http://support.novell.com).

115: Specified file cannot be opened as write 

Source: ZENworks Server Management; Management and Monitoring Services 
installation 

Severity: Critical

Possible Cause: An attempt was made to overwrite a locked file belonging to a file group that 
does not have the Potentially Locked or Shared property set to Yes.

Possible Cause: An attempt was made to install a file with a long filename (or to a directory 
with a long pathname) in a 16-bit setup. 

Possible Cause: The path to the target directory is invalid.

Action: Contact Novell Support (http://support.novell.com).

136: Unable to allocate memory 

Source: ZENworks Server Management; Management and Monitoring Services 
installation

Severity: Critical

Possible Cause: Insufficient memory is available to the setup.

Action: Close down all other applications

Action: Cancel the setup, reboot the system, and restart the setup.
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ILicense Agreements for XMLRPC

The following are license agreements for third-party XMLRPC code that is used in Novell® 
ZENworks® Server Management software:

Section I.1, “HELMA License,” on page 425
Section I.2, “John Wilson License,” on page 425
Section I.3, “Brett McLaughlin & Jason Hunter License,” on page 426

I.1  HELMA License
Copyright (c) 1999-2001, Hannes Wallnöfer (hannes@helma.at).
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of Helma nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY HANNES WALLNÖFER "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL HANNES WALLNÖFER BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

I.2  John Wilson License
Copyright (c) 1999, John Wilson (tug@wilson.co.uk).
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.
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Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

All advertising materials mentioning features or use of this software must display the following 
acknowledgement:

This product includes software developed by John Wilson. The name of John Wilson may not be 
used to endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY JOHN WILSON "AS IS" AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL JOHN WILSON BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

I.3  Brett McLaughlin & Jason Hunter License
Copyright (C) 2001 Brett McLaughlin & Jason Hunter.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, 
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions, and the disclaimer that follows these conditions in the documentation and/or other 
materials provided with the distribution.

3. The name “JDOM” must not be used to endorse or promote products derived from this 
software without prior written permission. For written permission, please contact 
license@jdom.org.

4. Products derived from this software may not be called “JDOM,” nor may “JDOM” appear in 
their name, without prior written permission from the JDOM Project Management 
(pm@jdom.org).

In addition, we request (but do not require) that you include in the end-user documentation provided 
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the JDOM Project (http://www.jdom.org/).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
www.jdom.org/images/logos.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 
 ZENworks 7 Server Management Installation Guide



novdocx (en)  16 A
pril 2010
IN NO EVENT SHALL THE JDOM AUTHORS OR THE PROJECT CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the JDOM 
Project and was originally created by Brett McLaughlin <brett@jdom.org> and Jason Hunter 
<jhunter@jdom.org>. For more information on the JDOM Project, please see <http://
www.jdom.org/>.
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JLicense Agreement for Java 2 
Runtime Environment

The following license agreement is for third-party Java 2 Runtime Environment (JRE) code that is 
used in Novell® ZENworks® Server Management software:

License to Distribute Software.  Subject to the terms and conditions of this Agreement, including, 
but not limited to Section 4 (Java Technology Restrictions) of these Supplemental Terms, Sun grants 
you a non-exclusive, non-transferable, limited license to reproduce and distribute the Software, 
provided that (i) you distribute the Software complete and unmodified (unless otherwise specified in 
the applicable Readme file) and only bundled as part of, and for the sole purpose of running, your 
Programs, (ii) the Programs add significant and primary functionality to the Software, (iii) you do 
not distribute additional software intended to replace any component(s) of the Software (unless 
otherwise specified in the applicable Readme file), (iv) you do not remove or alter any proprietary 
legends or notices contained in the Software, (v) you only distribute the Software subject to a license 
agreement that protects Sun’s interests consistent with the terms contained in this Agreement, and 
(vi) you agree to defend and indemnify Sun and its licensors from and against any damages, costs, 
liabilities, settlement amounts and/or expenses (including attorneys’ fees) incurred in connection 
with any claim, lawsuit or action by any third party that arises or results from the use or distribution 
of any and all Programs and/or Software. (vi) include the following statement as part of product 
documentation (whether hard copy or electronic), as a part of a copyright page or proprietary rights 
notice page, in an “About” box or in any other form reasonably designed to make the statement 
visible to users of the Software: “This product includes code licensed from RSA Security, Inc.”, and 
(vii) include the statement, “Some portions licensed from IBM are available at http://
oss.software.ibm.com/icu4j/.”
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KLicense Agreements for UCD-
SNMP and NET-SNMP

The following are license agreements for third-party for UCD-SNMP and NET-SNMP code that is 
used in Novell® ZENworks® Server Management software:

Section K.1, “CMU/UCD Copyright Notices BSD Like,” on page 431
Section K.2, “Networks Associates Technology, Inc Copyright Notice (BSD),” on page 431
Section K.3, “Cambridge Broadband Ltd. Copyright Notice (BSD),” on page 432

K.1  CMU/UCD Copyright Notices BSD Like
Copyright 1989, 1991, 1992 by Carnegie Mellon University 

Derivative Work - 1996, 1998-2000 

Copyright 1996, 1998-2000 The Regents of the University of California

All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose 
and without fee is hereby granted, provided that the above copyright notice appears in all copies and 
that both that copyright notice and this permission notice appear in supporting documentation, and 
that the name of CMU and The Regents of the University of California not be used in advertising or 
publicity pertaining to distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL 
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR 
THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

K.2  Networks Associates Technology, Inc 
Copyright Notice (BSD)
Copyright (c) 2001-2002, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.
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Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.
Neither the name of the Networks Associates Technology, Inc nor the names of its contributors 
may be used to endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

K.3  Cambridge Broadband Ltd. Copyright Notice 
(BSD)
Portions of this code are copyright (c) 2001-2002, Cambridge Broadband Ltd.All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.
The name of Cambridge Broadband Ltd. may not be used to endorse or promote products 
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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LLicense Agreement for Regular 
Expression Implementation

The following license agreement is for third-party Regular Expression Implementation code that is 
used in Novell® ZENworks® 7 Server Management software:

Copyright 1992, 1993, 1994 Henry Spencer. 

All rights reserved.

This software is not subject to any license of the American Telephone and Telegraph Company or of 
the Regents of the University of California. 

Permission is granted to anyone to use this software for any purpose on any computer system, and to 
alter it and redistribute it, subject to the following restrictions:

1. The author is not responsible for the consequences of use of this software, no matter how 
awful, even if they arise from flaws in it.

2. The origin of this software must not be misrepresented, either by explicit claim or by omission. 
Since few users ever read sources, credits must appear in the documentation.

3. Altered versions must be plainly marked as such, and must not be misrepresented as being the 
original software. Since few users ever read sources, credits must appear in the documentation.

4. This notice may not be removed or altered.
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MLicense Agreement for Xerces 
XML Parser

The following license agreement is for third-party Xerces XML Parser code that is used in Novell® 
ZENworks® 7 Server Management software:

The Apache Software License, Version 1.1

 Copyright (c) 2000 The Apache Software Foundation.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment:  
"This product includes software developed by the Apache Software Foundation (http://
www.apache.org/) ."
Alternately, this acknowledgment may appear in the software itself,  if and wherever such 
third-party acknowledgments normally appear.
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NLicense Agreement for Expat XML 
Parser

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper

Copyright (c) 2001, 2002, 2003 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, 
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, 
subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT.

IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY

CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,

TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE

SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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OLicense Agreement for Boost 
Regular Expression Parser

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the 
software and accompanying documentation covered by this license (the "Software") to use, 
reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative works of 
the Software, and to permit third-parties to whom the Software is furnished to do so, all subject to 
the following:

The copyright notices in the Software and this entire statement, including the above license grant, 
this restriction and the following disclaimer, must be included in all copies of the Software, in whole 
or in part, and all derivative works of the Software, unless such copies or derivative works are solely 
in the form of machine-executable object code generated by a source language processor.
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PLicense Agreement for XML Pull 
Parser

Boost Software License - Version 1.0 - August 17th, 2003

Indiana University Extreme! Lab Software License 

Version 1.1.1

Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment:
"This product includes software developed by the Indiana University Extreme! Lab (http://
www.extreme.indiana.edu/) ."
Alternately, this acknowledgment may appear in the software itself, if and wherever such third-
party acknowledgments normally appear.
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QDocumentation Updates

This section contains information on documentation content changes that were made in this 
Installation Guide after the initial release of Novell® ZENworks® 7 Server Management. The 
information can help you to keep current on updates to the documentation.

All changes that are noted in this section are also made in the documentation. The documentation is 
provided on the Web in two formats: HTML and PDF. The HTML and PDF documentation are both 
kept up-to-date with the documentation changes listed in this section.

The documentation update information is grouped according to the date the changes are published. 
Within a dated section, the changes are alphabetically listed by the names of the main table of 
contents sections in the guide.

If you need to know whether a copy of the PDF documentation you are using is the most recent, the 
PDF document contains its publish date on the front title page.

The documentation was updated on the following dates:

Section Q.1, “December 15, 2010,” on page 443
Section Q.2, “November 18, 2009,” on page 444
Section Q.3, “June 17, 2009 (Support Pack 1 Interim Release 4),” on page 444
Section Q.4, “April 29, 2008(SP1 IR3a),” on page 444
Section Q.5, “December 14, 2007,” on page 446
Section Q.6, “September 27, 2007,” on page 446
Section Q.7, “March 29, 2007,” on page 447
Section Q.8, “December 20, 2006,” on page 447
Section Q.9, “October 19, 2006,” on page 447
Section Q.10, “August 16, 2006,” on page 448
Section Q.11, “July 14, 2006 (Support Pack 1),” on page 449
Section Q.12, “January 31, 2006,” on page 450
Section Q.13, “December 9, 2005,” on page 450
Section Q.14, “October 7, 2005,” on page 451

Q.1  December 15, 2010 
Updates were made to the following sections:
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Q.1.1  Server Requirements

Q.2  November 18, 2009 
Updates were made to the following sections:

Q.2.1  Server Requirements

Q.3  June 17, 2009 (Support Pack 1 Interim 
Release 4)
Updates were made to the following sections:

Q.3.1  Server Requirements

Q.3.2  What’s New in Support Pack 1

Q.4  April 29, 2008(SP1 IR3a)
Updates were made to the following sections:

Location Change

Part VII, 
“Appendixes,” on 
page 311

Added the section:  Appendix A, “Port Used by Novell ZENworks Server 
Management,” on page 313.

Location Change

Chapter 5, “Server 
Requirements,” on 
page 45

Updated the section to add the tested platforms for SP1IR4.

Location Change

Chapter 5, “Server 
Requirements,” on 
page 45

Updated the supported platforms table.

Location Change

Section 10.7, “New 
in SP1 Interim 
Release 4,” on 
page 153

Added the section.
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Q.4.1  Uninstalling Remote Management

Q.4.2  Management and Monitoring Services Installation

Q.4.3  Version 6.5 or Later Policy and Distribution Services

Q.4.4  Upgrade
The following changes were made in this section:

Location Change

Section 23.1, 
“Uninstalling the 
Remote 
Management Agent 
on Windows 
Managed Servers,” 
on page 303

Edited the registry keys in Step 7 on page 303. 

Location Change

 “Installing the 
ODBC Drivers” on 
page 134

Changed the URL of Microsoft Download Center to http://www.microsoft.com/
downloads/.

Location Change

Section 11.2.1, 
“Upgrade Concepts 
and Issues,” on 
page 178

Changed the Novell ZENworks Companion number to 3.

“Upgrading the 
Plug-ins to 
iManager 2.5 or 
2.6” on page 172

Corrected the the link to Installing Novell Plug-in Modules.

Location Change

Section 10.6, “New 
in SP1 Interim 
Release 3a,” on 
page 152

Added this section showing what’s new in SP1 IR1.
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Q.5  December 14, 2007
Updates were made to the following sections:

Q.5.1  Policy-Enabled Server Management Installation

Q.5.2  Management and Monitoring Services Installation

Q.5.3  Version 6.5 or Later Policy and Distribution Services

Q.6  September 27, 2007
Updates were made to the following sections:

Location Change

 “Installing the 
ODBC Drivers” on 
page 128

Changed the URL of Microsoft Download Center to http://www.microsoft.com/
downloads/.

Location Change

 “Installing the 
ODBC Drivers” on 
page 134

Changed the URL of Microsoft Download Center to http://www.microsoft.com/
downloads/.

Location Change

Section 11.2.1, 
“Upgrade Concepts 
and Issues,” on 
page 178

Changed the Novell ZENworks Companion number to 3.

“Upgrading the 
Plug-ins to 
iManager 2.5 or 
2.6” on page 172

Corrected the the link to Installing Novell Plug-in Modules.

Location Change

Chapter 5, “Server 
Requirements,” on 
page 45

Added support for Windows Server 2003 SP2 and SUSE Linux Enterprise Server 
10 SP1.
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Q.7  March 29, 2007
Updates were made to the following sections:

Q.8  December 20, 2006
Updates were made to the following sections:

Server Requirements

Q.8.1  Server Requirements
The following changes were made in this section:

Q.9  October 19, 2006
Updates were made to the following sections:

Installation

Q.9.1  Installation
The following changes were made in this section:

Location Change

Section 6.2, 
“Installation on 
Windows 
Workstations,” on 
page 101

Added a paragraph explaining that the ZENworks Server Management installation 
does not install Remote Management or Server Inventory to a workstation.

Section 17.1.3, 
“Tree Issues for 
Desktop 
Application 
Distributions,” on 
page 266

Updated this section to clarify the tree issue with Desktop Application Distributions.

Location Change

Chapter 5, “Server 
Requirements,” on 
page 45

Corrected information concerning support for Server Inventory.
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IMPORTANT: All references to Server Inventory on Linux in this guide have been removed. 
Server Inventory is not supported on Linux in ZENworks 7 Server Management with SP1.

Q.10  August 16, 2006
Updates were made to the following sections:

Ensuring Successful DNS Name Resolution
Policy-Enabled Server Management Installation

Q.10.1  Ensuring Successful DNS Name Resolution
The following changes were made in this section:

Q.10.2  Policy-Enabled Server Management Installation
The following changes were made in this section:

Location Change

“Verifying on 
NetWare Servers” 
on page 94 and 
“Verifying that the 
Services Have 
Started” on 
page 182

Correction: ASA 8.0.3 ... should be listed instead of Syabase Database when 
viewing ZENworks services on a NetWare console.

Location Change

Section D.2, “Using 
Underscore 
Characters in DNS 
Names,” on 
page 335

Replaced the previous three paragraphs with:

As of ZENworks 6.5, underscore (_) characters can be used in the DNS names of 
servers.

Location Change

“Installation 
Summary” on 
page 93

Added the following information to the end of this section:

The following NetWare registry entries are made in \\my 
server\software\novell\ZENWORKS\zfs\:

PDS
PDSDB
Inventory Database Server
RconsoleJ Agent for NetWare
Inventory Server
Inventory Agent
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Q.10.3  Version 6.5 or Later Policy and Distribution Services
The following changes were made in this section:

Q.11  July 14, 2006 (Support Pack 1)
Updates were made to the following sections:

Preparation
Upgrade

Q.11.1  Preparation
The following changes were made in this section:

Q.11.2  Upgrade
The following changes were made in this section:

“Web-Based 
Management for 
Policy and 
Distribution 
Services” on 
page 96

Updated this section to include separate instructions for installing the iManager 
plug-ins for ZENworks 7 to iManager 2.0.2 and iManager 2.5 or 2.6.

Location Change

“Upgrading the 
Novell iManager 
Plug-Ins” on 
page 167

Updated this section to include separate instructions for upgrading the iManager 
plug-ins for ZENworks 7 to iManager 2.0.2 and iManager 2.5 or 2.6.

Location Change

Section 3.4, “DNS 
Requirement,” on 
page 39

Changed the requirement information for DNS, that it is required for all supported 
platforms for Policy and Distribution Services, Server Inventory, and Remote 
Management. DNS is not required for Management and Monitoring Services.

Location Change

“What the Upgrade 
Server Software 
Package Does Not 
Do” on page 219

Added the following note under the “The schema is not automatically extended” 
bullet:

IMPORTANT: Server Software Packages do not check to see whether the schema 
has been properly upgraded. The installation of the .cpk files will complete without 
error; however, the software will not run correctly because of the missing schema 
extensions. We recommend that you extend the schema before upgrading using 
the .cpk files; however, you can do this immediately after upgrading.

Location Change
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Q.11.3  ZENworks Server Management in a Clustered 
Environment
The following changes were made in this section:

Q.12  January 31, 2006
Updates were made to the following sections:

Upgrade

Q.12.1  Upgrade
The following changes were made in this section:

Q.13  December 9, 2005
Page design is reformatted to comply with revised Novell documentation standards.

Chapter 10, 
“What’s New in 
Support Pack 1,” on 
page 151

Added this section showing what’s new in SP1, Beta 1.

Location Change

Section F.3.1, 
“Meeting System 
Requirements for 
Clustering,” on 
page 345

Updated this section to reflect changes in the requirements for clustering in 
ZENworks 7 Server Management with SP1.

Location Change

Section 13.1, 
“Upgrading from 
ZENworks for 
Servers 3.x,” on 
page 227

In “Tasks To Be Performed Before Upgrade and Database Migration” on page 230, 
added the following point to the list of tasks to be performed before upgrade:

If ZENworks_installation_path\zenworks\inv\server\wminv\ 
properties\inventoryremoval.properties has been modified after the 
ZENworks for Servers 3.x installation, take a reliable backup of  
inventoryremoval.properties.

Section 13.2, 
“Upgrading from 
ZENworks 6.5 
Server 
Management or 
ZENworks 6.5 SP1/
SP2 Server 
Management,” on 
page 240

In “Tasks To Be Performed Before Upgrade and Database Migration” on page 243, 
added the following point to the list of tasks to be performed before upgrade:

If ZENworks_installation_path\zenworks\inv\server\wminv\ 
properties\inventoryremoval.properties has been modified after the 
ZENworks 6.5 Server Management or ZENworks 6.5 SP1/SP2 Server 
Management installation, take a reliable backup of  
inventoryremoval.properties.

Location Change
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Q.14  October 7, 2005
Updates were made to the following sections:

Preparation
Upgrade

Q.14.1  Preparation
The following changes were made in this section:

Q.14.2  Upgrade
The following changes were made in this section:

Location Change

Chapter 5, “Server 
Requirements,” on 
page 45

Updated the supported platforms information.

Section 6.1.2, 
“Web-Based 
Management for 
Policy and 
Distribution 
Services,” on 
page 96

Added Step 1 to remind you to have Tomcat running for authentication in order to 
install the Web-based management software.

Location Change

Part IV, “Upgrade,” 
on page 139

Updated this section to apply to all ZENworks 6.5 Server Management support 
packs by adding SP2 references where applicable.

“Post Database 
Migration Tasks” on 
page 245

Added the reference to ZENworks 6.5 SP2 Server Management in Step 2d and 
Step 3d.

“Preparing for 
Upgrade” on 
page 246

Added the following point to the list of tasks to be performed before upgrading the 
Inventory Agent to ZENworks 7 Server Management with SP1 using a server 
software package:

“If you plan to upgrade the Inventory Agent from ZENworks 6.5 SP1 Server 
Management Hot Patch 1, Hot Patch 2, or Hot Patch 3 to ZENworks 7 Server 
Management with SP1, you must apply the patch available with TID 103465 before 
installing the support pack. For more information, see TID 103465 in the Novell 
Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).
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